
說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

本指南介紹 ILME-FR7 / ILME-FR7K 可換鏡頭數位攝像機的配置和操作。

如有需要，請參閱本說明書和相關裝置的操作說明。

概述

典型用法應用程式

系統配置

使用隨附的紅外線遙控器控制單個裝置

使用平板電腦或電腦控制單個裝置

使用外部紅外線遙控器控制單個裝置

使用外部遙控器控制多個裝置

零件的位置和功能

正視圖

後視圖

連接器插頭塊

側面圖

俯視圖

仰視圖

鏡頭支架

紅外線遙控器（隨附）按鍵的位置和功能

網路應用程式畫面

網路應用程式畫面概述

通用區域畫面的結構

即時操作畫面的結構

播放操作畫面的結構

設定畫面的結構
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準備工作

攝像機功能表

攝像機畫面顯示

安裝裝置

直立安裝在固定位置

直立安裝在高處的固定位置

安裝在天花板上

安裝/取下鏡頭

安裝/取下鏡頭時的注意事項

檢查鏡頭開關

使用變焦鏡頭時的注意事項

安裝鏡頭

取下鏡頭

連接纜線

透過有線連接將本機連接到網路裝置

連接電源

使用交流電

使用 PoE++ 電源

重設平移/傾斜

拍攝前配置

使用網路應用程式初始化本裝置

從網頁瀏覽器存取網路應用程式

初始化本裝置

配置基本操作

準備記憶卡

支援的記憶卡

插入記憶卡

彈出記憶卡
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拍攝

格式化（初始化）記憶卡

檢查剩餘錄製時間

還原記憶卡

基本操作

開始/停止錄製

在記憶卡之間切換

檢查音訊

指定時間資料

查核錄製 (Rec Review)

調整取景

取景調整畫面

調整拍攝方向

使用網路應用程式調整拍攝方向

設定平移/傾斜操作速度

設定平移/傾斜操作加速

使用隨附的紅外線遙控器調整拍攝方向

調整變焦

設定變焦類型

使用網路應用程式調整變焦

設定變焦操作速度

使用隨附的紅外線遙控器調整變焦

儲存/復原攝影機平移/傾斜/變焦位置（預設位置）

校準 E 接環鏡頭

使用網路應用程式來儲存/復原平移/傾斜、變焦位置和對焦設定

使用網路應用程式重新命名預設位置

使用網路應用程式將儲存預設位置替換成新的位置

使用網路應用程式來刪除已儲存的預設位置

恢復預設位置時同步平移/傾斜操作和變焦/對焦操作
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在恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）

使用隨附的紅外線遙控器儲存/恢復平移/傾斜和變焦位置

錄製/播放攝影機取景操作（PTZ 追蹤）

使用網路應用程式進行攝影機取景操作的錄製

使用網路應用程式進行攝影機取景操作

使用網路應用程式刪除攝影機錄製的取景操作

使用隨附的紅外線遙控器錄製攝影機取景操作

使用隨附的紅外線遙控器播放攝影機取景操作

調整對焦

對焦調整畫面

手動調整對焦 (Manual Focus)

使用網路應用程式手動調整

使用隨附的紅外線遙控器手動調整

透過指定對焦位置進行對焦（點對焦）

暫時使用自動對焦 (Push Auto Focus (AF))

使用單次自動對焦 (Push Auto Focus (AF-S))

自動調整對焦 (Auto Focus)

使用網路應用程式自動調整

使用隨附的紅外線遙控器自動調整

設定自動對焦區域/位置（對焦區域）

快速變更對焦區域（對焦設定）

使用觸控操作來移動對焦區域框（觸控對焦區域）

調整自動對焦操作（AF 轉變速度、AF 拍攝對象移動靈敏度）

使用網路應用程式手動設定自動對焦目標 (AF Assist)

使用隨附的紅外線遙控器在自動對焦期間手動對焦

在自動對焦期間暫時使用手動對焦（鍵控手動對焦）

使用臉部和眼部偵測進行追蹤 (Face/Eye Detection AF)

追蹤指定拍攝對象（即時追蹤自動對焦）

調整亮度
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實用的功能

亮度調整畫面

設定基本感光度

設定自動亮度調整的目標程度

調整光圈

自動調整光圈

手動調整光圈

調整增益

自動調整增益

手動調整增益

調整快門

自動調整快門

手動調整快門

調整亮度等級 (ND 濾鏡)

關於 ND 濾鏡

在預設模式中調整

在可變模式中自動調整

在可變模式中手動調整

調整自然色彩（白平衡）

白平衡調整畫面

自動調整白平衡

手動調整白平衡

執行自動白平衡

配置要錄製的音訊

音訊配置畫面

選取音訊輸入裝置

自動調整音訊錄製音量

手動調整音訊錄製音量

直接功能表操作

5



可指派按鈕

慢動作和快動作

間歇錄製視訊 (Interval Rec)

錄製快取的圖像 (Picture Cache Rec)

同時錄製到記憶卡 A 和 B (2-slot Simul Rec)

視訊訊號監視器

剪輯旗標

呼吸補償

代理錄製

代理錄製概述

錄製代理

以所需風格拍攝

風格概述

選取風格

匯入所需的基本風格

自訂風格

儲存風格

刪除基本風格

以後期製作的風格調整進行拍攝

以後期製作的風格調整進行拍攝

將 LUT 套用於 HDMI 輸出和串流

變更 LUT

變更錄製影像中陰暗區域和明亮區域的分佈

RAW 錄製

錄製 RAW 視訊

以慢動作和快動作模式錄製 RAW 視訊

調整散景（散景控制功能）

開啟/關閉散景控制功能
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網路功能

縮圖畫面

攝像機功能表和詳細設定

調整散景的程度

儲存和載入配置資料

儲存和載入配置資料概述

儲存 ALL 檔案

載入 ALL 檔案

傳輸檔案

關於檔案傳輸

登錄檔案傳輸目的地

選取檔案並上傳

從縮圖畫面上傳記憶卡上的代理檔案

從縮圖畫面上傳記憶卡上的原始檔案

檢查檔案傳輸狀態

使用安全 FTP 上傳

配置串流

關於串流

設定串流格式

設定串流的視訊轉碼器

設定串流的音訊轉碼器

開始/停止串流

縮圖畫面

播放剪輯和其他剪輯操作

播放錄製的剪輯

已錄製剪輯的操作

攝像機功能表配置

操作攝像機功能表

操作攝像機功能表

7



輸入字元字串

User 功能表

User

Edit User 功能表

Edit User

Shooting 功能表

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project 功能表

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look 功能表

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt 功能表

P/T Acceleration

TC/Media 功能表

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring 功能表

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio 功能表
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Audio Input

Audio Output

Thumbnail 功能表

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical 功能表

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network 功能表

Wired LAN

File Transfer

Maintenance 功能表

Language

Clock Set

Hours Meter

Shooting 功能表設定和預設值

ISO/Gain 設定和預設值
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網路功能表和詳細設定

AGC Limit 設定和預設值

對於每個拍攝模式儲存的影像品質設定

網路功能表配置

網路功能表操作

Shooting 功能表

Focus

Project 功能表

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look 功能表

Base Look

Pan-Tilt 功能表

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring 功能表

Output Format

Output Display

Audio 功能表

Audio Input
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Audio Output

Technical 功能表

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network 功能表

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 至 3

SSL

Referer Check

Brute Force Attack Protection

Stream 功能表

Stream

Video Stream

Audio Stream

Maintenance 功能表

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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外部裝置連接

附錄

Service

EULA

Software

連接外部監視器和錄製裝置

連接 RCP/MSU（選購件）

與 RCP/MSU 連接

裝置與 RCP 之間的一對一連接

透過 MSU/攝像機遠端控制軟體在多攝像機環境中使用本裝置

支援功能清單

使用 RM-IP500 遙控器（選購件）進行操作

關於使用 RM-IP500 遙控器（選購件）進行的操作

連接 RM-IP500 遙控器

與外部裝置同步

關於與外部裝置同步

同步視訊訊號的相位（同步鎖定）

將時間碼鎖定到其他裝置

連接外部麥克風或外部音訊裝置

使用電腦管理/編輯剪輯

輸出光纖訊號

連接提示訊號

輸出追蹤資料 (free-d)

連接鏡頭控制器

使用鏡頭控制器進行變焦調整

使用注意事項

輸出格式和限制

疑難排解

錯誤/警告訊息

13



5-041-957-83(1) Copyright 2022 Sony Corporation

功能表項目清單

預設位置儲存項目

區塊圖

更新 E 接環鏡頭軟體

安裝鏡頭釋放按鈕蓋

授權

規格

商標
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

系統配置

本裝置可以搭配周邊裝置，組合成各種系統配置。

E 接環鏡頭1.

LA-EA3/LA-EA4 A 接環轉接器2.

紅外線遙控器（隨附）3.

CFexpress Type A 記憶卡/SDXC 記憶卡4.

CFexpress Type A 讀卡機/SD 卡讀卡機5.

ECM-680S、ECM-678*、ECM-674* 麥克風6.
EC-0.5X3F5M 3 針腳 → 5針腳 XLR 需要變壓器纜線。*

交流變壓器（隨附）7.

視訊監視器8.

RM-IP500 遙控器9.
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5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用隨附的紅外線遙控器控制單個裝置

您可以使用隨附的紅外線遙控器遠端控制單個裝置。

 視訊訊號
 訊號流程

5-041-957-83(1) Copyright 2022 Sony Corporation

紅外線遙控器（隨附）1.

視訊監視器2.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用平板電腦或電腦控制單個裝置

您可以將平板電腦或電腦連接到本裝置，然後使用網頁瀏覽器控製本裝置。

 視訊訊號
 遙控訊號

  訊號流程

5-041-957-83(1) Copyright 2022 Sony Corporation

視訊監視器1.

平板電腦2.

電腦3.

存取點4.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用外部紅外線遙控器控制單個裝置

您可以使用遙控器遠端控制裝置。

 視訊訊號
 遙控訊號

  訊號流程

5-041-957-83(1) Copyright 2022 Sony Corporation

視訊監視器1.

RM-IP500 遙控器2.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用外部遙控器控制多個裝置

您可以使用單個遙控器遠端控制多達 100 台裝置。

 視訊訊號
 遙控訊號
 提示/接觸訊號

  訊號流程

5-041-957-83(1) Copyright 2022 Sony Corporation

視訊監視器1.

視訊切換器2.

乙太網路集線器3.

RM-IP500 遙控器4.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

正視圖

本主題介紹裝置正面各個零件的位置和功能。

提示

本說明是未安裝鏡頭的裝置圖示。

攝像機頭部

注意

避免攝像機頭部受到強烈衝擊。

1.

錄製/提示燈
配置為錄製燈時，在記錄到記憶卡時會亮紅燈。當錄製媒介的剩餘可用空間不足或發生錯誤時，指示燈會閃爍。

如需詳細資料，請參閱“錯誤/警告訊息”。

2.
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配置為提示燈時，指示燈會根據外部提示訊號亮紅色或綠色。

有關詳細資料，請參閱“連接提示訊號”。
影像感測器

注意

切勿直接用手觸控。

3.

鏡頭釋放按鈕
按壓以取下鏡頭。

有關詳細資料，請參閱“取下鏡頭”。

4.

鏡頭訊號觸點

注意

切勿直接用手觸控。

5.

POWER 燈6.

NETWORK 燈
本機的狀態由 POWER 燈和 NETWORK 燈的顯示顏色和亮起狀態（亮起、閃爍、未亮起）組合予以指示。

7.

POWER 燈 NETWORK
燈

本機狀態

亮起綠燈*1
亮起綠燈 開啟電源（網路已連接）

未亮起 開啟電源（網路未連接）

閃爍綠燈 未亮起 開啟電源程序進行中

亮起橘燈 未亮起 電源待機狀態

閃爍黃燈 未亮起 軟體更新進行中

緩慢閃爍橘

燈*2
緩慢閃爍綠燈
*2

本裝置無法正常運作。有關詳細資料，請查看系統日誌。如果將本裝置置於待機模式
或者關閉電源並重新開啟後問題仍然存在，請聯繫您的 Sony 服務代表。

快速閃爍橘

燈*3
快速閃爍綠燈
*3 本裝置發生故障。請與您的 Sony 服務代表聯繫。

接收到隨附的紅外線遙控器發出的命令時閃爍綠燈。*1

緩慢閃爍：每秒閃爍一次*2

快速閃爍：每秒閃爍四次*3

紅外線遙控感測器
接收來自隨附紅外線遙控器的控制信號。

8.

進風孔

注意

切勿遮蔽氣流。否則，可能會導致故障。

9.
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相關主題

錯誤/警告訊息

連接提示訊號

取下鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

後視圖

本主題介紹裝置背面各個零件的位置和功能。

相關主題

側面圖

5-041-957-83(1) Copyright 2022 Sony Corporation

攝像機頭部鎖定桿
鎖定攝像機頭部之向前/向後移動。

注意

不更換鏡頭時，務必設定至鎖定位置。

運輸本裝置時，務必取下鏡頭，並將其置於鎖定位置。

關閉本裝置電源，並在操作鎖定桿之前使用平移/傾斜鎖定桿水平鎖定攝像機頭部，以免因夾住手指而受傷。有關平移/傾斜鎖
定桿的詳細資料，請參閱“側面圖”中的“平移/傾斜鎖定桿”。

1.

滑座2.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

連接器插頭塊

本主題介紹裝置連接器插頭塊各個零件的位置和功能。

 （接地）連接
透過連接到電源插座的接地端子或接地棒來接地。

1.

DC IN 連接器（標準 DC 插孔）
連接到交流變壓器。

注意

只能使用提供的交流變壓器。如連接其他變壓器，可能會導致火災或故障。

2.

 LAN（網路）連接器 (RJ-45)
連接用於網路通訊和 PoE++* 電源的網路纜線（5e 類或更高類別）。

速度 LED 顯示狀態
表示網路連線的速度。

3.

PoE++：透過乙太網路 Plus Plus 供電。符合 IEEE802.3bt (Type 4 Class 8)。有關連接的詳細資料，請參閱電源裝置的操作說明。*
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Link/ACT LED 顯示狀態
表示網路連線的狀態。

注意

將本產品連線到網際網路上時，透過可提供保護功能的系統（例如，路由器或防火牆）進行連線。如果在沒有此類保護的情況
下連線，則可能會發生安全問題。

顯示  連線速度

未亮起
10 Mbps 連接

100 Mbps 連接

亮起橘燈 1000 Mbps 連接

顯示  連線狀態

 未亮起 無連結

閃爍綠燈 已建立連線，資料有效

亮起綠燈 作用中連結

TC IN 連接器
輸入外部參考時間碼訊號。

如需詳細資料，請參閱“將時間碼鎖定到其他裝置”。

4.

HDMI 連接器
將本裝置的視訊作為 HDMI 訊號輸出。

有關詳細資料，請參閱“連接外部監視器和錄製裝置”中的“HDMI 連接器（Type A 連接器）”。

5.

HDMI 纜線固定板安裝螺絲
為防止 HDMI 纜線鬆脫，請使用隨附的安裝螺絲（M2.6×6）安裝隨附的 HDMI 纜線固定板，然後使用市售的電纜束帶
或帶子固定 HDMI 纜線。

有關安裝 HDMI 纜線固定板的詳細資料，請參閱“連接纜線”。

6.

OPTION 連接器
用於連接來自外部裝置或鏡頭控制器的提示訊號。

如需詳細資料，請參閱“連接提示訊號”和“連接鏡頭控制器”。

7.

電線夾
用於固定交流變壓器電源線。

8.

RESET 開關
使用筆尖或類似物品按下至少 5 秒鐘，將裝置的設定重設為原廠預設值。
使用 SETUP 開關 1，您可以選擇僅重設網路連線設定或者重設所有設定。

9.

OPTICAL 輸出連接器
連接 SFP+ 模組（選購件）時，輸出轉換為光學格式的 SDI 訊號。

有關詳細資料，請參閱“輸出光纖訊號”。

10.

SETUP 開關11.
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配置下列設定。
開關 1：設定按下 RESET 開關時重設哪些設定。

開關 2：設定連接音訊輸入裝置時是否打開/關閉 +48 V 電源（幻象電源）。該設定將立即套用。
攝像機功能表中的 [Audio] > [Audio Input] > [AUDIO IN Select] 設定為 [MIC] 時，此功能會啟用。

注意

將開關 2 設定為 ON 位置並連接與 +48 V 電源不相容的麥克風，可能會損壞連接的裝置。連接裝置之前，請檢查設定。

開關 3：啟用/停用 VISCA over IP 通訊。開啟攝像機時，會套用設定。
連接到遙控器 (RM-IP500) 時，設定為 ON 位置，以使用本裝置。

注意

如果尚未配置管理員密碼，則無論開關設定如何，都會停用 VISCA over IP 通訊。有關配置管理員密碼的詳細資料，請參閱“初
始化本裝置”。

開關 4：更改從紅外線遙控器發送的平移/傾斜操作速度。該設定將立即套用。

設定 描述

OFF（預
設）

僅重設網路連線設定。本裝置的網路設定、安全設定和使用者資訊（使用者名稱和密碼）將被重
設。

ON 將全部設定均重設為原廠預設值。

設定 描述

OFF（預
設）

切勿提供 +48 V 電源（幻象電源）。使用外部音訊裝置（例如混音器）、動圈式麥克風或含內置電池
的麥克風時，請配置此設定。

ON 向連接到 AUDIO IN 連接器（CH-1 或 CH-2）的幻象電源相容麥克風提供 +48 V 電源（幻象電源）。

設定 描述

OFF（預設） 將不會回應 VISCA over IP 命令。

ON 接受 VISCA over IP 命令。

設定 描述

OFF（預設） 以正常速度運行。

ON 以最大速度運行。

SDI OUT 連接器
將本裝置的視訊以 12G/6G/3G/HD-SDI 訊號輸出。
該裝置還可以配置為 RAW 訊號輸出。

12.
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相關主題

將時間碼鎖定到其他裝置

連接外部監視器和錄製裝置

連接纜線

連接提示訊號

連接鏡頭控制器

輸出光纖訊號

初始化本裝置

同步視訊訊號的相位（同步鎖定）

連接外部麥克風或外部音訊裝置

5-041-957-83(1) Copyright 2022 Sony Corporation

如需詳細資料，請參閱“連接外部監視器和錄製裝置”中的“SDI OUT 連接器（BNC 類型）”。
 紅外線遙控感測器（後側）

隨附紅外線遙控器的紅外線感測器。
13.

風扇/出風孔
從裝置內部散熱。

注意

切勿遮蔽出風孔。否則，可能會導致故障。

請注意，出風口附近的區域可能會變熱。

14.

GENLOCK 連接器
用於輸入外部同步訊號。

如需詳細資料，請參閱“同步視訊訊號的相位（同步鎖定）”。

15.

AUDIO IN 連接器（XLR 型 5 針連接器）
用於輸入來自外部麥克風或音訊裝置的訊號。
作為 AUDIO IN CH-1 連接器或 AUDIO IN CH-2 連接器。

如需詳細資料，請參閱“連接外部麥克風或外部音訊裝置”。

16.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

側面圖

本主題介紹裝置側面各個零件的位置和功能。

提示

本說明是未安裝鏡頭的裝置圖示。

平移/傾斜鎖定桿
鎖定本裝置的平移/傾斜機構。用於下列情況。

運輸或包裝本裝置時。
安裝或取下鏡頭時。有關詳細資料，請參閱“安裝鏡頭”或“取下鏡頭”。
使用不支持平移/傾斜操作的鏡頭時（例如 Sony SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM
鏡頭）。
運輸本裝置時，務必取下鏡頭，並將其置於鎖定位置。

提示

1.
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相關主題

安裝鏡頭

取下鏡頭

插入記憶卡

從網頁瀏覽器存取網路應用程式

5-041-957-83(1) Copyright 2022 Sony Corporation

平移/傾斜移動可以固定在下列角度。

滑座2.

外部裝置的螺絲孔（4 處）
適用最長 6 公釐的 M3 螺絲。

注意

請勿使用長度超過 6 公釐的螺絲。否則，可能會導致故障。

3.

存取指示燈 A4.

存取指示燈 B
插入錄製媒介時，指示燈亮起或閃爍。

有關詳細資料，請參閱“插入記憶卡”。

5.

CFexpress Type A / SD 記憶卡插槽 (A)6.

CFexpress Type A / SD 記憶卡插槽 (B)
用於插入錄製媒介。

有關詳細資料，請參閱“插入記憶卡”。

7.

用於網路連接的 QR 碼
於配置初始設定時使用。

有關詳細資料，請參閱“從網頁瀏覽器存取網路應用程式”。

8.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

俯視圖

本主題介紹裝置頂部各個零件的位置和功能。

提示

本說明是未安裝鏡頭的裝置圖示。

5-041-957-83(1) Copyright 2022 Sony Corporation

外部裝置的螺絲孔（2 處）
與三腳架的 1/4-20 UNC 螺絲相容。
最大長度為 6 公釐。

1.

ɸ（成像儀標記）
成像儀標記與影像感測器位於同一平面上。
為準確測量本裝置和拍攝對象之間的距離，請使用此成像儀標記做為參考點。

2.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

仰視圖

本主題介紹裝置底部各個零件的位置和功能。

提示

本說明是未安裝鏡頭的裝置圖示。

天花板托架安裝螺絲孔（6 處，5.5 公釐有效螺紋深度）
將本裝置安裝在天花板或高處的架子上時，請使用這些螺絲孔中的六顆機身板托安裝螺絲，將機身板托（選購件）安
裝到本裝置的底座上。

有關安裝的詳細資料，請參閱“直立安裝在高處的固定位置”和“安裝在天花板上”。

1.

三腳架安裝螺絲（2 處）
將本裝置安裝在攝影機三腳架上時使用（選購件，1/4-20 UNC 螺絲，最長 5.5 公釐）。

注意

2.
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相關主題

直立安裝在高處的固定位置

安裝在天花板上

5-041-957-83(1) Copyright 2022 Sony Corporation

請勿使用長度超過 5.5 公釐的螺絲。否則，可能會導致故障。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

鏡頭支架

本主題介紹本裝置鏡頭支架零件的位置和功能。

提示

本說明是未安裝鏡頭的裝置圖示。

鏡頭支架撐桿 (2)
支撐鏡頭。
也可用於安裝一般 Ø15 桿配件。

1.
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鏡頭支撐座
鏡頭支架可以根據鏡頭向前或向後滑動，然後固定。

2.

鏡頭支架底座連結螺絲
安裝到鏡頭支架底座上。您可以向上/向下調整螺絲，以符合鏡頭支架底座的高度。

3.

鏡頭支架撐桿夾緊桿（2 處）
固定鏡頭支撐座的向前/向後位置。

4.

鏡頭支架底座連結螺絲夾緊桿
固定鏡頭支架底座連結螺絲的垂直位置。

提示

如果夾緊桿處於難以轉動的位置，請鬆開夾緊桿，並將其旋轉到易於操作的角度。處於所需位置時，關閉夾緊桿。

A：鏡頭支架底座連結螺絲夾緊桿
B：鏡頭支架撐桿夾緊桿

注意

為防止鏡頭支撐座干擾平移/傾斜操作，在不使用鏡頭支撐座時，將鏡頭支撐座向上移動到攝像機頭部上，並將鏡頭支撐座連結
螺絲移動到最高位置（最靠近鏡頭）。

5.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

紅外線遙控器（隨附）按鍵的位置和功能

本主題介紹紅外線遙控器（隨附）各個按鍵的位置和功能。

REC●( 錄製 START/STOP )按鈕
按下以開始或停止錄製。

1.

MENU 按鈕
按下以顯示或隱藏攝像機功能表。

2.

GUI 控制按鈕
按下可在攝像機功能表、包含按鈕的訊息對話框及其他畫面顯示功能中執行操作。

3.

CANC./BACK 按鈕
按下可取消設定或者返回本裝置攝像機功能表的前一個畫面。

4.

平移和傾斜控制按鈕5.
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紅外線遙控電池

紅外線遙控器需要安裝兩顆 AA (LR6) 電池。
如下圖所示，將電池插入紅外線遙控器。

按下箭頭按鈕，可控制攝像機平移/傾斜。按下 HOME 按鈕，可將攝像機的方向返回至正面。
預設位置控制按鈕
按住 PRESET 按鈕並按下 1 至 3 按鈕之一，將攝像機方向、變焦和對焦調整狀態儲存在按下的數字按鈕中。
按下已儲存設定的數字按鈕可叫用已保存的狀態。

6.

對焦控制按鈕
用於調整對焦。
要自動對焦，請按下 AF 按鈕。
要手動對焦，請按下 MF 按鈕，然後按下 F（遠）按鈕以對焦遠距離對象，或者按下 N（近）按鈕以對焦近距離對象。

7.

可指派按鈕 1 至 3
使用攝像機功能表，執行指派給可指派按鈕的功能。
如果將 [Direct Menu] 功能指派給可指派按鈕，您可以使用 GUI 控制按鈕來調整曝光、白平衡及其他設定。

有關使用攝像機功能表進行指派的詳細資料，請參閱“可指派按鈕”。

有關直接功能表的詳細資料，請參閱“直接功能表操作”。

8.

 （電源）按鈕
按下可開啟本裝置或者將電源切換至待機狀態。

9.

THUMBNAIL 按鈕
顯示縮圖畫面，以顯示記錄在本裝置記憶卡上的剪輯。

有關縮圖畫面的詳細資料，請參閱“縮圖畫面”。

您可以使用 GUI 控制按鈕在縮圖畫面上選擇剪輯和控製播放。

有關選擇剪輯和控製播放的詳細資料，請參閱“播放錄製的剪輯”和“已錄製剪輯的操作”。

10.

SLOT SEL（記憶卡插槽 (A)/(B) 選取）按鈕
插入兩張記憶卡後，按下按鈕可在兩張記憶卡之間切換進行錄製。
顯示縮圖畫面時，按下此按鈕，可在要查看的記憶卡之間進行切換。

11.

P/T RESET（重設平移/傾斜）按鈕
重設平移/傾斜功能。當 POWER 燈和 NETWORK 燈同時閃爍或當網路應用程式的取景控制面板中顯示 [Execute Pan-
Tilt Reset] 時按下該按鈕。

12.

變焦控制按鈕
如需放大，按下 T（望遠）按鈕。
如需縮小，按下 W（廣角）按鈕。

13.
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注意

只能使用錳電池或鹼性電池，否則電池可能會破裂。

請根據國家或地區的法律及法規來處理廢舊電池。

相關主題

可指派按鈕

直接功能表操作

縮圖畫面

播放錄製的剪輯

已錄製剪輯的操作

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

網路應用程式畫面概述

透過連接平板電腦或電腦，您可以從網頁瀏覽器平移/傾斜、變焦、錄製、播放錄製的視訊以及配置本裝置（此功能在下文
稱為“網路應用程式”）。

有關啟動網路應用程式的詳細資料，請參閱“從網頁瀏覽器存取網路應用程式”。

注意

網路應用程式不支援攝像機音訊輸出。

當網路應用程式啟動時，會出現下列即時操作畫面。

即時操作畫面

有關即時操作畫面的詳細資料，請參閱“即時操作畫面的結構”。
即時操作畫面和播放操作畫面的通用按鈕和圖示將顯示在畫面頂部。

有關畫面通用區域的詳細資料，請參閱“通用區域畫面的結構”。
您可以按下通用區域中的畫面切換索引標籤來切換畫面。
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播放操作畫面

按下 [Playback] 索引標籤，顯示播放操作畫面。

有關播放操作畫面的詳細資料，請參閱“播放操作畫面的結構”。

設定畫面

按下 [Settings] 索引標籤，顯示設定畫面（以下稱為網路功能表）。
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注意

在網路功能表中，除非按下 [OK] 按鈕，否則不會套用設定。如果在顯示 [OK] 按鈕的頁面上變更設定，請務必按下 [OK] 按鈕。

有關設定畫面的詳細資料，請參閱“設定畫面的結構”。
在本說明指南中，網路應用程式的設定畫面稱為網路功能表。

相關主題

從網頁瀏覽器存取網路應用程式

即時操作畫面的結構

通用區域畫面的結構

播放操作畫面的結構

設定畫面的結構

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

通用區域畫面的結構

本主題介紹通用區域畫面的結構。

攝像機名稱
顯示攝像機的名稱。
您可以使用網路功能表中的 [Network] > [Camera Name] 來更改名稱。
背景顏色將根據外部提示訊號而變化。

1.

電源開關
當本裝置開啟時，會顯示 [Power ON]。您可以按下開關並選擇 [Power Standby]，將本機的電源設定為待機狀態。
顯示 [Power Standby] 時，您可以按下開關並選擇 [Power ON]，以開啟本裝置的電源。

2.

操作畫面切換索引標籤
按下索引標籤，顯示相應的操作畫面。
[Live] 索引標籤：顯示即時操作畫面。
[Playback] 索引標籤：顯示播放操作畫面。
[Settings] 索引標籤：顯示設定畫面（網路功能表）。

3.

通知標記
收到訊息時，標記指示會發生下列變化。

（開啟通知）
根據攝像機影像窗格中顯示的訊息，採取必要的措施。

注意

在網路功能表中將 [Monitoring] > [Output Display] > [HDMI/Stream] 設定為 [Off] 時，不會顯示訊息。設定為 [On]，以檢查訊息
的內容。

4.

 （攝影機狀態）按鈕
按下此按鈕，可在單獨畫面上顯示攝影機錄製的影像/輸出影像訊號資訊、鏡頭資訊和鏡頭控制器（選購件）狀態。

5.
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當出現鏡頭控制器（選購件）相關通知時，顯示會發生以下變化。

畫面操作鎖定開關
（操作解鎖）：將開關撥到左側，可控制即時操作畫面和播放操作畫面的操作。
（操作鎖定）：將開關撥到右側，可鎖定即時操作畫面和播放操作畫面，以防止不慎操作。

6.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

即時操作畫面的結構

本主題介紹即時操作畫面的結構。

預設位置控制面板
使用縮圖顯示預設的登錄的位置。雙擊縮圖，可返回預設中儲存的位置。

有關預設位置的詳細資料，請參閱“使用網路應用程式來儲存/復原平移/傾斜、變焦位置和對焦設定”。
有關 PTZ 追蹤的詳細資料，請參閱“使用網路應用程式錄製攝影機取景操作”。

1.

攝像機影像面板
顯示當前攝像機影像和本裝置狀態。
顯示與 HDMI 輸出相同的影像。
影像上方顯示下列狀態。根據接收到的外部提示訊號，影像周圍還會顯示紅框或綠框。

2.
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[Display] 按鈕
按下此按鈕，可在影像上顯示攝像機資訊。
顯示攝像機資訊時，再次按下可隱藏攝像機資訊。

除了標記之外，也會根據狀態顯示一些與自動對焦有關的指示燈和訊息，按下 [Display] 按鈕無法隱藏這些指示燈和訊
息。

有關所顯示攝像機資訊的詳細資料，請參閱“攝像機畫面顯示”。

即時追蹤自動對焦停止按鈕
按下按鈕，以停止追蹤對象。

編
號

顯示 描述

2-1 對焦模式指示燈 請參閱“攝像機畫面顯示”中的“對焦模式指示燈”。

2-2
錄製模式、插槽 A/B、Interval Rec 錄
製間隔指示燈

請參閱“攝像機畫面顯示”中的“錄製模式、插槽 A/B、Interval Rec 錄
製間隔指示燈”。

2-3 串流狀態指示燈
串流期間顯示（僅限 [Stream Setting] 設定為 [RTMP] 或 [SRT-Caller]
時）

2-4 RAW 輸出操作狀態指示燈
顯示 RAW 訊號的輸出狀態。有關 RAW 的詳細資料，請參閱“錄製
RAW 視訊”。

2-5 剩餘媒介容量指示燈 請參閱“攝像機畫面顯示”中的“剩餘媒介容量指示燈”。

2-6 變焦位置指示燈
請參閱“攝像機畫面顯示”中的“變焦位置指示燈”。
連接鏡頭控制器（選購件）時，  會顯示。如果鏡頭控制器（選購
件）發生錯誤，  會顯示。

2-7 AE 模式/AE 等級指示燈 請參閱“攝像機畫面顯示”中的“AE 模式/AE 等級指示燈”。
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有關詳細資料，請參閱“追蹤指定拍攝對象（即時追蹤自動對焦）”。
錄製 START/STOP 按鈕
按下按鈕開始錄製。錄製過程中，錄製 START/STOP 按鈕會亮紅燈。
在錄製過程中按下可停止錄製。
您可以將 Hold 開關設定為 Hold 狀態，以防止誤操作錄製 START/STOP 按鈕。

3.

攝像機基本配置面板
在按鈕上顯示拍攝所需的基本功能設定。按下按鈕，可顯示下方攝像機基本配置調整面板 (5) 中每個功能相對應的設定
畫面。

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

有關詳細資料，請參閱各功能說明。

4.

功能 參考資料

FPS “慢動作和快動作”

ISO/Gain “調整增益”中的“設定基本感光度”、“自動調整增益”及“手動調整增益”

Exposure Index “設定基本感光度”及“變更錄製影像中陰暗區域和明亮區域的分佈”

Shutter “調整快門”中的“自動調整快門”及“手動調整快門”

Iris “調整光圈”中的“自動調整光圈”及“手動調整光圈”

ND Filter “調整亮度等級 (ND 濾鏡)”中的“關於 ND 濾鏡”

Scene File “以所需風格拍攝”中的“風格概述”和其他主題

Base Look/LUT “以後期製作的風格調整進行拍攝”

White Balance “白平衡調整畫面”

可指派按鈕/攝像機基本配置調整面板
在正常操作期間顯示可指派的按鈕。按下攝像機基本配置面板按鈕（項目 4），顯示相對應的設定項目。按下 [X] 按鈕
或再次按下攝影機設定區塊按鈕，以返回可指派按鈕顯示畫面。

5.
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有關可指派按鈕的詳細資料，請參閱“可指派按鈕”。
有關攝像機基本配置調整面板的詳細資料，請參閱各功能說明。

取景控制面板/GUI 控制面板
使用頂部的索引標籤在取景控制面板/GUI 控制面板兩者之間切換。
您可以按下畫面右上角的 （關閉）按鈕來隱藏控制面板，防止不慎操作。如果控制面板並未顯示，按下 （開
啟）按鈕來顯示。
使用取景控制面板來調整取景。按下 （平移/傾斜/變焦）索引標籤，顯示取景控制面板。

有關操作的詳細資料，請參閱“調整取景”。

提示

停用平移/傾斜操作和需要進行平移/傾斜初始化時，取景控制面板的控制桿部分如下顯示。

當使用平移/傾斜鎖定桿來鎖定平移/傾斜操作時

當平移/傾斜操作未初始化時

當平移/傾斜操作需要重設時

6.
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當平移/傾斜操作停用時

當平移/傾斜操作未初始化或者需要重設時，您可以按下控制桿下方顯示的訊息，從而快速存取攝影機控制面板中的 
（重設平移/傾斜）按鈕。

使用 GUI 控制區塊來操作攝像機功能表、剪輯播放及其他功能。按下 （攝影機 GUI）索引標籤，顯示 GUI
控制面板。

有關操作的詳細資料，請參閱“操作攝像機功能表”和“播放錄製的剪輯”。
攝像機控制面板
用於配置操作攝像機所需的功能。
使用頂部的索引標籤，在顯示的畫面之間切換。
您可以按下畫面右上角的 （關閉）按鈕來隱藏控制面板，防止不慎操作。如果控制面板並未顯示，按下 （開
啟）按鈕來顯示。

有關詳細資料，請參閱各功能說明。

  (Main) 索引標籤
顯示常用功能的設定項目。
按下 [▼] 按鈕，並從顯示的列表中進行選擇，即可變更頂部和底部滑桿功能。可選擇的功能如下。

ND Filter
Iris
ISO*

7.
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Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus) 索引標籤
顯示與對焦相關的設定項目。

  (Audio) 索引標籤

顯示與音訊相關的設定項目。

根據功能表設定來顯示。*
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相關主題

使用網路應用程式來儲存/復原平移/傾斜、變焦位置和對焦設定

使用網路應用程式進行攝影機取景操作的錄製

 (Stream) 索引標籤
顯示與串流相關的設定項目。
顯示的項目因串流格式設定而異。
設定為 [RTMP] 或 [SRT-Caller] 時，可以在此畫面上開始/停止串流。

如需詳細資料，請參閱“配置串流”中的“關於串流”及其他主題。
如果連線失敗，會顯示錯誤訊息。如需錯誤資訊的詳細資料，請參閱“錯誤/警告訊息”。

 (Others) 索引標籤
顯示與其他功能相關的設定項目。

按下 [Full Screen Display] 按鈕可在網頁瀏覽器中開啟新索引標籤，並以全螢幕顯示攝像機影像面板影像。
僅顯示影像；觸控 AF 和其他功能不可用。

注意

原始索引標籤上的即時操作畫面繼續正常工作。如果不需要操作，建議您關閉該索引標籤以減少同時連接數。

按下 （初始化鏡頭控制器）按鈕，可初始化鏡頭控制器（第三方選購件）。只有當網路功能表中的
[Technical] > [Lens Controller] > [Zoom] > [Setting] 設定為 [On] 時，此功能會啟用。
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攝像機畫面顯示

錄製 RAW 視訊

追蹤指定拍攝對象（即時追蹤自動對焦）

慢動作和快動作

設定基本感光度

自動調整增益

手動調整增益

變更錄製影像中陰暗區域和明亮區域的分佈

自動調整快門

手動調整快門

自動調整光圈

手動調整光圈

關於 ND 濾鏡

風格概述

以後期製作的風格調整進行拍攝

白平衡調整畫面

可指派按鈕

播放錄製的剪輯

操作攝像機功能表

關於串流

錯誤/警告訊息

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

播放操作畫面的結構

本主題介紹播放操作畫面的結構。

攝像機影像面板
顯示播放影像及相關資訊。停止播放時，會顯示攝像機影像畫面。

1.
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1-1 拍攝日期和時間
1-2 播放狀態指示燈
1-3 播放格式（圖像尺寸）指示燈
1-4 播放格式（轉碼器）指示燈
1-5 剪輯名稱顯示
1-6 剪輯編號/剪輯總數
1-7 LUT 名稱顯示
1-8 串流狀態指示燈
1-9 播放格式（畫面速率和掃描方式）指示燈
1-10 錄製風格指示燈

播放控制面板

顯示播放控制按鈕。

[Display] 按鈕
按下可切換顯示在影像上的畫面。
[Thumbnail] 按鈕
在攝像機影像窗格中，將記憶卡上錄製的剪輯以縮圖顯示。

2.

按鈕 功能

（播放/暫停）按鈕 播放剪輯。播放期間，暫停剪輯。

（快速前進）按鈕、 （快速倒退）按鈕 高速播放剪輯。按下按鈕時，播放速度分三階段變化。

（下一個）按鈕、 （上一個）按鈕 跳到剪輯的開頭或上一個/下一個剪輯。

（停止）按鈕 停止播放。
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相關主題

縮圖畫面

可指派按鈕

播放錄製的剪輯

5-041-957-83(1) Copyright 2022 Sony Corporation

在縮圖畫面顯示其間按下 [Thumbnail] 按鈕可關閉縮圖畫面並返回攝像機影像。

有關縮圖畫面的詳細資料，請參閱“縮圖畫面”。

[Slot Select] 按鈕
在目標播放媒體之間切換。

可指派按鈕
顯示指派給裝置功能的可指派按鈕。

有關可指派按鈕的詳細資料，請參閱“可指派按鈕”。

3.

GUI 控制面板
使用 GUI 控制區塊來操作攝像機功能表、剪輯播放及其他功能。

有關操作的詳細資料，請參閱“操作攝像機功能表”和“播放錄製的剪輯”。

4.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定畫面的結構

使用設定畫面配置本裝置的各種設定項目，包括使用網路功能表的初始設定、網路設定、拍攝/播放設定。

注意

在網路功能表中，通常在您按下 [OK] 按鈕之前，不會套用設定。如果在顯示 [OK] 按鈕的頁面上變更設定，請務必按下 [OK] 按
鈕。

有關設定畫面的詳細資料，請參閱“網路功能表和詳細設定”。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

攝像機功能表

按下即時操作畫面或播放操作畫面的 GUI 控制面板中的 [Menu] 按鈕，在攝影機影像窗格中顯示攝影機功能表。

您可以使用攝像機功能表來配置拍攝和播放所需的設定。
顯示攝影機功能表時，按下 [Menu] 按鈕，以隱藏攝影機功能表。
使用 GUI 控制面板操作攝像機功能表。

有關攝像機功能表的詳細資料，請參閱“攝像機功能表和詳細設定”。

注意

當網路功能表中的 [Monitoring] > [Output Display] > [HDMI/Stream] 設定為 Off （停用畫面顯示上的資訊重疊）時，攝像機功能表
不會顯示在攝像機影像面板中。然而，請注意 GUI 控制面板中的功能表操作仍在啟用中。為避免意外操作，當 [HDMI/Stream] 設
定為 Off　時，請注意不要使用 GUI 控制面板執行任何功能表操作。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

攝像機畫面顯示

您可以在攝像機輸出的影像上疊加顯示本裝置的狀態和設定。您可以使用網路功能表中的 [Monitoring] > [Output Display]
來設定啟用畫面顯示的輸出。
您可以使用　[Display] 按鈕來顯示/隱藏資訊。即使資訊已隱藏，也會在執行直接功能表操作時出現。
您可以使用攝像機功能表中的 [Monitoring] > [Display On/Off] 來單獨顯示/隱藏項目。

拍攝時畫面上顯示的資訊

上傳指示燈/剩餘檔案指示燈

有關傳輸檔案的詳細資料，請參閱“傳輸檔案”中的“關於檔案傳輸”及其他主題。

1.

對焦區域指示燈
顯示自動對焦的對焦區域。

有關自動對焦的詳細資料，請參閱“自動調整對焦 (Auto Focus)”中的“使用網路應用程式自動調整”及其他主題。

2.

錄製模式、插槽 A/B、Interval Rec 錄製間隔指示燈

有關 Interval Rec 的詳細資料，請參閱“間歇錄製視訊 (Interval Rec)”。

3.

顯示 意義

●Rec 錄製

Stby 錄製待機

景深指示燈4.

成像儀掃描模式指示燈
如果鏡頭的影像圈尺寸與有效圖像尺寸的成像儀掃描模式設定不相符，則會顯示 （不符）標記。
Imager Scan Mode設定為 FF 時，在視角較窄（裁斷）的模式中會顯示“C”標記。

5.
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裁斷會在下列模式中發生。

錄製格式為 3840×2160 且 S&Q Motion 畫面速率為 100 fps 或 120 fps 時
[Codec] 設定為 RAW 或 RAW & XAVC-I 且 RAW 輸出格式為 3840×2160 時
有關成像儀掃描模式的詳細資料，請參閱“配置基本操作”中的“設定成像儀掃描模式”。

RAW 輸出操作狀態指示燈
顯示 RAW 訊號的輸出狀態。

有關 RAW 的詳細資料，請參閱“錄製 RAW 視訊”。

6.

慢動作和快動作拍攝畫面速率指示燈

有關慢動作和快動作的詳細資料，請參閱“慢動作和快動作”。

7.

對焦位置指示燈

顯示對焦位置。

8.

對焦模式指示燈

Face/Eye Detection AF

有關臉部/眼部偵測 AF，請參閱“使用臉部和眼部偵測進行追蹤 (Face/Eye Detection AF)”。

9.

顯示 意義

Focus Hold Focus Hold 模式

MF MF 模式

AF AF 模式

（即時追蹤自動對焦模式） 即時追蹤自動對焦模式

顯示 意義

 (Face/eye detection AF) 表示臉部/眼部偵測 AF 已啟動

（僅自動對焦臉部/眼部） 表示 Face/Eye Only AF 已啟動

（已儲存追蹤臉部） 表示已儲存追蹤臉部

（AF 暫停） 表示 AF 已暫停*

在沒有儲存的追蹤臉部且未偵測到臉部時顯示，或者在有儲存的追蹤臉部但未偵測到追蹤目標臉部時顯示。*

變焦位置指示燈
顯示變焦位置，範圍為 0（廣角）至 99（望遠）（如果安裝了支援變焦設定顯示的鏡頭）。
您還可以使用攝像機功能表中的 [Technical] > [Lens] > [Zoom Position Display] 設定，將指示燈更改為長條顯示或焦距
顯示。
Clear Image Zoom 啟用後，下列項目會新增到顯示中。

10.

顯示 意義

（Clear Image Zoom 已啟用） Clear Image Zoom 已啟用

放大倍率值 使用 Clear Image Zoom 時
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有關變焦的詳細資料，請參閱“調整變焦”中的“設定變焦類型”及其他主題。
影像穩定模式指示燈11.

SDI 輸出/HDMI 輸出錄製控制狀態指示燈
顯示 REC 控制訊號的輸出狀態。

有關詳細資料，請參閱“連接外部監視器和錄製裝置”。

12.

對焦指示燈

如需詳細資料，請參閱“調整對焦”中的“使用單次自動對焦 (Push Auto Focus (AF-S))”。

13.

剩餘媒介容量指示燈
如果記憶卡有寫入保護，會顯示 （保護）圖示。

14.

白平衡模式指示燈15.

顯示 意義

 (ATW) 自動模式

 (ATW Hold) 自動模式已暫停

W:P 預設模式

W:A 記憶卡 A 模式

時間碼外部鎖定指示燈/時間資料顯示
鎖定到外部裝置的時間碼時顯示“EXT-LK”。

有關時間碼的詳細資料，請參閱“指定時間資料”。

16.

ND 濾鏡指示燈

有關 ND 濾鏡的詳細資料，請參閱“調整亮度等級 (ND 濾鏡)”。
有關散景控制的詳細資料，請參閱“調整散景（散景控制功能）”。

17.

顯示 意義

 (A) 自動模式

 (B) 散景控制模式

場景檔案指示燈

有關場景檔案的詳細資料“以所需風格拍攝”中的“風格概述”和其他主題。

18.

光圈指示燈
顯示光圈位置（F 值）（如果安裝了支援光圈設定顯示的鏡頭）。

有關光圈的詳細資料，請參閱“自動調整光圈”和“手動調整光圈”。

19.

視訊層級警告指示燈20.

增益指示燈
在 Cine EI/Cine EI Quick 模式中，顯示 EI 值。

21.
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有關增益的詳細資料，請參閱“自動調整增益”和“手動調整增益”。
有關 Cine EI/Cine EI Quick 模式的詳細資料，請參閱“配置基本操作”中的“設定拍攝模式”。

顯示 意義

 (A) 自動模式

L 預設 L 模式

（暫時調整模式） 暫時調整模式

 (B) 散景控制模式

剪輯名稱顯示
顯示正在錄製或下一個要錄製的剪輯的名稱。
如果它閃爍，則錄製媒介上的最後一個剪輯與 [Camera ID] 或 [Reel Number] 設定不相符。如需詳細資料，請參閱[Clip
Name Format] > [Auto Naming] 描述。

22.

快門指示燈

有關快門的詳細資料，請參閱“自動調整快門”和“手動調整快門”。

23.

AE 模式/AE 等級指示燈

有關自動曝光　(AE),的詳細資料，請參閱“設定自動亮度調整的目標程度”。

24.

水平儀指示燈
以 ±1° 的增量顯示水平高度，最大 ±15°。

25.

音訊音量表
顯示每個通道的音訊音量。

26.

視訊訊號監視器
顯示波形、向量示波器和直方圖。
橘線表示亮度等級標記的設定值。
在日誌拍攝模式中，監視器目標 LUT 類型顯示在顯示幕上方。

有關詳細資料，請參閱“視訊訊號監視器”。
有關日誌拍攝模式的詳細資料，請參閱“配置基本操作”中的“設定拍攝模式”。

27.

Base Sensitivity 指示燈/Base ISO 指示燈
在 Custom 模式中，將顯示使用攝像機基本配置面板中的 [ISO/Gain / Exposure Index] 按鈕或者攝像機功能表中
[Shooting] > [ISO/Gain/EI] > [Base Sensitivity] 設定的基本感光度。
在日誌拍攝模式中，將顯示使用攝影機基本配置面板格中的 [ISO/Gain / Exposure Index] 按鈕或攝影機功能表中的
[Shooting] > [ISO/Gain/EI] > [Base ISO] 進行設定的 Base ISO 感光度。

有關基本感光度的詳細資料，請參閱“選擇基本感光度”。
有關日誌拍攝模式的詳細資料，請參閱“配置基本操作”中的“設定拍攝模式”。

28.

監視風格指示燈
在日誌拍攝模式中，將顯示監視器 LUT 設定。

有關 LUT 設定的詳細資料，請參閱“以後期製作的風格調整進行拍攝”。
有關日誌拍攝模式的詳細資料，請參閱“配置基本操作”中的“設定拍攝模式”。

29.

基本風格/錄製風格指示燈
顯示基本風格設定。
在日誌拍攝模式中，將顯示要在記憶卡上錄製的視訊訊號。

30.
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播放期間畫面上顯示的資訊

下列資訊會疊加在播放的圖像上。

有關基本風格的詳細資料，請參閱“以所需風格拍攝”中的“風格概述”。
有關日誌拍攝模式的詳細資料，請參閱“配置基本操作”中的“設定拍攝模式”。

代理狀態指示燈31.

錄製格式（轉碼器）指示燈
顯示要在記憶卡上錄製的格式名稱。
使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Codec] 來設定錄製格式（轉碼器）。

32.

錄製格式（畫面速率和掃描方式）指示燈33.

錄製格式（圖像尺寸）指示燈
顯示要在記憶卡上錄製的圖像尺寸。
使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Codec] 來設定錄製格式（圖像尺寸）。

34.

提示指示燈
根據接收到的外部提示訊號，影像周圍會顯示紅框或綠框。

35.

上傳指示燈/剩餘檔案指示燈1.

剪輯數量2.

播放狀態指示燈3.

播放格式（畫面速率和掃描方式）指示燈4.

播放格式（圖像尺寸）指示燈5.

播放格式（轉碼器）指示燈6.

媒介指示燈
如果記憶卡有寫入保護，會顯示 （保護）圖示。

7.

時間資料顯示8.
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相關主題

關於檔案傳輸

使用網路應用程式自動調整

間歇錄製視訊 (Interval Rec)

配置基本操作

錄製 RAW 視訊

慢動作和快動作

使用臉部和眼部偵測進行追蹤 (Face/Eye Detection AF)

設定變焦類型

連接外部監視器和錄製裝置

使用單次自動對焦 (Push Auto Focus (AF-S))

指定時間資料

風格概述

自動調整光圈

手動調整光圈

自動調整增益

手動調整增益

自動調整快門

手動調整快門

設定自動亮度調整的目標程度

視訊訊號監視器

以後期製作的風格調整進行拍攝

Clip Name Format

5-041-957-83(1) Copyright 2022 Sony Corporation

剪輯名稱顯示9.

Gamma 顯示輔助指示燈10.

音訊音量表
顯示播放音訊音量。

11.

基本風格/錄製風格指示燈12.

提示指示燈13.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

直立安裝在固定位置

本主題介紹如何將裝置安裝在桌面或三腳架上。

安裝注意事項

鏡頭安裝完畢前，為保護鏡頭和本裝置的鏡頭連接器插頭塊，請保持本裝置護蓋和外蓋的連接。
為防止鏡頭故障，作業時切勿握住鏡頭部分。
為防止裝置故障，作業時切勿握住攝像機頭部。

檢查安裝空間。

安裝在桌面上時
將本裝置安裝在平坦表面上，同時考慮轉動鏡頭及本裝置後側接線所需的空間。

注意

安裝在不會受到震動影響的平穩位置。如安裝在會受到震動影響的位置，可能導致影像出現震動。

如果設備必須安裝在傾斜的表面上，請保持在水平線 ±15° 範圍內，並採取相應措施，以防止裝置掉落。

安裝在三腳架上時
將三腳架安裝到底部的三腳架安裝螺絲孔中。
使用具有如下所示安裝面突出量的三腳架安裝螺絲，並用手動螺絲起子鎖緊。

A：三腳架安裝螺絲 1/4-20 UNC, ISO 1222（6.35 公釐）
B：突出（4.5 公釐至 5.5 公釐）

切勿使用三腳架螺絲將本裝置安裝在高處。

1
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接下來，安裝鏡頭。請參閱“安裝鏡頭”，並將“安裝/取下鏡頭時的注意事項”、“檢查鏡頭開關”和“使用變焦鏡頭時的注意事
項”中的資訊納入考量。

相關主題

安裝/取下鏡頭時的注意事項

檢查鏡頭開關

使用變焦鏡頭時的注意事項

安裝鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation

注意

請選擇即使鏡頭轉動也不會翻倒的三腳架。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

直立安裝在高處的固定位置

本主題介紹使用天花板托架（CIB-PCM1（選購件））將本裝置直立安裝在高處的步驟。

要將本裝置安裝在高處，請諮詢專業的承包商。
在高處安裝時，請確保安裝面和安裝材料（不包括配件）可支撐 200 公斤以上的重量，並按照本說明指南所述內容安
裝裝置。如果安裝不夠牢固，裝置可能會掉落並造成嚴重傷害。
將隨附的防落鋼索連接到 CIB-PCM1 天花板托架（選購件），以防止裝置掉落。
如果將本裝置安裝在高處，應每年檢查一次，確認安裝處是否鬆脫。根據使用狀況，縮短檢查時間間隔。

安裝注意事項

鏡頭安裝完畢前，為保護鏡頭和本裝置的鏡頭連接器插頭塊，請保持鏡頭與本裝置護蓋或外蓋的連接。
為防止鏡頭故障，作業時切勿握住鏡頭部分。
為防止裝置故障，作業時切勿握住攝像機頭部。

檢查高處位置安裝配件和安裝空間。

CIB-PCM1 天花板托架套件（選購件）
開始之前，請檢查是否已備齊以下零件。

機身托架 (1)
天花板托架 (1)
鏡頭釋放按鈕蓋 (1)
防落鋼索 (1)
+PSW M3×8 螺絲 (9)
+PSW M4×8 不鏽鋼防落鋼索螺絲 (1)

注意

防落鋼索的設計用於在懸掛時支撐裝置。切勿向其施加除本裝置負載以外的任何負載。

1
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安裝空間
決定安裝位置和方向時，請參考下圖，同時考慮轉動鏡頭及本裝置後側接線所需的空間。

A：攝像機頭部移動範圍（如 SEL70200GM2（附帶 SEL20TC）：Ø370）
B：天花板托架（安裝面側孔 (Ø150)）
C：安裝定位孔

注意

安裝在不會受到震動影響的平穩位置。如安裝在會受到震動影響的位置，可能導致影像出現震動。

如果設備必須安裝在傾斜的表面上，請保持在水平線 ±15° 範圍內，並採取相應措施，以防止裝置掉落。

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。

注意

2
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當鎖定桿處於 LOCK 位置時，如果平移/傾斜鎖定桿滑沒有鎖定，請手動移動攝像機頭部，直至其鎖定到位。

使用隨附的六顆螺絲 (M3×8)，將機身托架安裝到裝置底部。

使用隨附的螺絲。必須使用隨附的螺絲，以免損壞本裝置內部。

3

將防落鋼索安裝到機身拖架上。4
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A：隨附鋼索　
B：隨附十字螺絲 (M4×8)
C：鋼索金屬環

使用隨附的螺絲。必須使用隨附的螺絲，以免降低鋼索功能的效力。

將天花板托架安裝到打算安裝裝置的表面，例如架子。5
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A：牆壁　
B：△ 標記（攝像機朝向的方向）
C：連接纜線的孔
D：架子或其他安裝面

將防落鋼索安裝在靠近安裝面的位置。

使用 M5（3/16 英吋）六角承窩圓柱頭螺絲（選購件），將其安裝到架子或天花板托架所連接表面附近的物體上。

6
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A：鋼索　
B：六角承窩圓柱頭螺絲（M5，3/16 英吋）

將機身托架前方的 〇 螺絲孔對準天花板托架的 ◇ 孔，插入本裝置，並順時針轉動本裝置，將機身托架暫時固定在天
花板托架上。

7
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A：〇 孔
B：◇ 孔

使用隨附的三顆旋轉鎖定螺絲 (M3×8)，連接機身托架和天花板托架。8
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接下來，安裝鏡頭。請參閱“安裝鏡頭”，並將“安裝/取下鏡頭時的注意事項”、“檢查鏡頭開關”和“使用變焦鏡頭時的注意事
項”中的資訊納入考量。

注意

安裝鏡頭後，檢查鏡頭是否安裝牢固。
鏡頭沒有任何防墜落保護。如鏡頭從本裝置掉落，Sony 一律不承擔任何責任。

相關主題

安裝/取下鏡頭時的注意事項

檢查鏡頭開關

使用變焦鏡頭時的注意事項

安裝鏡頭

檢查安裝狀態。

具體而言，檢查以下項目。 

安裝螺絲已正確安裝。
防落鋼索已正確連接，且沒有扭轉。
裝置呈水平（無傾斜或搖晃）。
裝置在轉動時不會隨意旋轉。

9
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5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

安裝在天花板上

本主題介紹使用天花板托架（CIB-PCM1（選購件））將本裝置安裝在天花板上的步驟。

要將本裝置安裝在天花板上，請諮詢專業的承包商。
在天花板上安裝時，請確保安裝面和安裝材料（不包括配件）可支撐 200 公斤或以上的重量，並按照本說明指南所述
內容安裝裝置。如果安裝不夠牢固，裝置可能會掉落並造成嚴重傷害。
將隨附的防落鋼索連接到 CIB-PCM1 天花板托架（選購件），以防止裝置掉落。
如果將本裝置安裝在天花板上，應每年檢查一次，確認安裝處是否鬆脫。根據使用狀況，縮短檢查時間間隔。

安裝注意事項

鏡頭安裝完畢前，為保護鏡頭和本裝置的鏡頭連接器插頭塊，請保持鏡頭與本裝置護蓋或外蓋的連接。
為防止鏡頭故障，作業時切勿握住鏡頭部分。
為防止裝置故障，作業時切勿握住攝像機頭部。

檢查天花板安裝配件和安裝空間。

CIB-PCM1 天花板托架套件（選購件）
開始之前，請檢查是否已備齊以下零件。

機身托架 (1)
天花板托架 (1)
鏡頭釋放按鈕蓋 (1)
防落鋼索 (1)
+PSW M3×8 螺絲 (9)
+PSW M4×8 不鏽鋼防落鋼索螺絲 (1)

注意

防落鋼索的設計用於在懸掛時支撐裝置。切勿向其施加除本裝置負載以外的任何負載。

1
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安裝空間
決定安裝位置和方向時，請參考下圖，同時考慮轉動鏡頭及本裝置後側接線所需的空間。

A：攝像機頭部移動範圍（如 SEL70200GM2（附帶 SEL20TC）：Ø370）
B：天花板托架（天花板側孔 (Ø150)）
C：安裝定位孔

注意

安裝在強度足夠的天花板（例如混凝土）上。

要將本裝置安裝在強度不足的天花板上，請提供足夠的加固措施。

安裝在不會受到震動影響的平穩位置。如安裝在會受到震動影響的位置，可能導致影像出現震動。

如果設備必須安裝在傾斜的表面上，請保持在水平線 ±15° 範圍內，並採取相應措施，以防止裝置掉落。

天花板托架上與 △ 孔相對的一側是拍攝方向（攝像機正面側）。

將平移/傾斜鎖定桿滑到 UNLOCK 位置以解除平移/傾斜鎖定，並在傾斜方向將攝像機頭部旋轉 180°。2

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。3
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攝像機頭部旋轉 180°

注意

當鎖定桿處於 LOCK 位置時，如果平移/傾斜鎖定桿滑沒有鎖定，請手動移動攝像機頭部，直至其鎖定到位。

使用隨附的六顆螺絲 (M3×8)，將機身托架安裝到裝置底部。4
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使用隨附的螺絲。必須使用隨附的螺絲，以免損壞本裝置內部。

將天花板托架安裝到安裝板（選購件）上，然後將該板安裝到天花板上。5
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A：天花板托架
B：天花板
C：安裝板
D：△ 孔
根據天花板托架的方向來安裝托架
請注意，安裝在天花板上時，與正常的直立安裝相比，攝像機正面將位於天花板托架的另一側。請參閱安裝方向指示
圖，確保正確安裝。

A：直立安裝的正面（△ 孔方向）
B：天花板安裝之正面

注意

安裝表面材料由客戶自行負擔。

將防落鋼索安裝到天花板上。6
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A：天花板托架
B：六角承窩圓柱頭螺絲（M5，3/16 英吋）
C：鋼索（隨附）
D：安裝板
E：天花板

將防落鋼索從天花板托架中心的孔洞中拉出，然後連接到機身托架上。

將防落鋼索穿過機身托架的鋼索金屬環，並使用隨附的不鏽鋼螺絲 (M4×8) 將其牢牢固定在支架上。

A：隨附鋼索
B：隨附十字螺絲 (M4×8)
C：鋼索金屬環

7
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使用隨附的螺絲。必須使用隨附的螺絲，以免降低鋼索功能的效力。

注意

建議一人如下圖所示握住本裝置，另一人安裝本裝置。

安裝本裝置時，切勿握住攝像頭或鏡頭支架。如果本裝置跌落或墜落，有可能會造成損壞或傷害。

接線時請小心，避免電連接器和纜線因防落鋼索而造成短路。

該安裝座可支撐的懸掛質量最高 8.8 公斤（包含鏡頭）。為防止裝置掉落，請勿超過最大預期質量。

將機身托架上的螺絲孔 (A) 與天花板托架上的 ◇ 孔 (B) 對齊，插入本裝置，並順時針旋轉約 60 度，直到螺絲孔 (A)
和螺絲孔 (C) 對齊。

8
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A：機身托架上的螺絲孔
B：天花板托架上的螺絲孔（◇ 孔）
C：螺絲孔
D：天花板
E：安裝板

使用隨附的三顆旋轉鎖定螺絲 (M3×8)，連接機身托架和天花板托架。9
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接下來，安裝鏡頭。請參閱“安裝鏡頭”，並將“安裝/取下鏡頭時的注意事項”、“檢查鏡頭開關”和“使用變焦鏡頭時的注意事
項”中的資訊納入考量。

注意

要在本裝置安裝在天花板上時正確操作平移/傾斜，請在網路功能表中將 [Pan-Tilt] > [Direction] > [Ceiling] 設為 [On]。

安裝鏡頭後，檢查鏡頭是否安裝牢固。
鏡頭沒有任何防墜落保護。如鏡頭從本裝置掉落，Sony 一律不承擔任何責任。

相關主題

安裝/取下鏡頭時的注意事項

檢查鏡頭開關

使用變焦鏡頭時的注意事項

檢查安裝狀態。

具體而言，檢查以下項目。

安裝螺絲已正確安裝。
防落鋼索已正確連接，且沒有扭轉。
裝置呈水平（無傾斜或搖晃）。
裝置在轉動時不會隨意旋轉。

10
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安裝鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

安裝/取下鏡頭時的注意事項

切勿將鏡頭朝向太陽。陽光直射會穿過鏡頭進入，聚焦在裝置中，可能引起火災。

注意

在本裝置關閉時安裝/取下鏡頭。

鏡頭是精密元件。切勿在鏡頭接環朝下時將鏡頭放在表面上。裝上隨附的鏡頭接環護蓋。

提示

有關攝影機支援的鏡頭詳細資料，請聯絡 Sony 服務代表。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

檢查鏡頭開關

根據鏡頭類型，需要執行以下檢查和設定。

針對附帶對焦模式開關的鏡頭

將開關設定為 AF/MF 或 AF。
如果開關設定為 MF 或 Full MF，只能使用鏡頭環來調整焦點。

注意

使用 A 接環鏡頭時，可能無法從遙控器手動調整。

針對附帶變焦開關的鏡頭

將開關設定為 SERVO。
如果開關設定為 MANUAL，則只能使用變焦環來調整變焦。本裝置的變焦控制沒有作用。

針對附帶 Auto Iris 開關的鏡頭

將開關設定為 AUTO。
未設定為 AUTO 時，只能使用鏡頭環來調整光圈。本裝置的光圈操作沒有作用。

針對附帶影像穩定開關的鏡頭

將開關設定為 OFF。
如果開關設定為 ON，則在平移/傾斜操作期間，可能會發生非預期的行為。

SELP28135G

A：將對焦環移至前方位置（AF/MF 模式）。
B：將 ZOOM 開關設定至 SERVO 位置。
C：將光圈環設定為“A”，並將 IRIS LOCK 開關設定至 LOCK 位置。
D：將影像穩定器開關設定為 OFF。
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5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用變焦鏡頭時的注意事項

使用變焦鏡頭（非電動變焦鏡頭）時，變焦位置可能因安裝環境而異。根據使用目的，用膠帶將變焦環固定到位。

塑膠薄膜膠帶：471 BLA 50 或同等產品

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

安裝鏡頭

本主題介紹如何安裝 E 接環鏡頭或 A 接環鏡頭。

注意

請勿在尚未安裝鏡頭的情況下運輸本裝置。

使用 A 接環鏡頭時，手動設定光圈並將對焦設定為 MF。

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。

注意

當鎖定桿處於 LOCK 位置時，如果平移/傾斜鎖定桿滑沒有鎖定，請手動移動攝像機頭部，直至其鎖定到位。

1

逆時針轉動鏡頭支架底座連結螺絲的夾緊桿，以鬆開鎖定，然後將鏡頭支架底座連結螺絲移動到不會干擾鏡頭的位
置。

A：正確

2
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B：錯誤

沿箭頭方向轉動攝像機頭部鎖定桿，以解鎖攝像機頭部。

注意

再次鎖定攝像機頭部之前，攝像機頭部可能會在自身重量的作用下移動。執行作業時，請用手支撐攝像機頭部。

3

將攝像機頭部滑動到最前面的位置。4

沿箭頭方向轉動攝像機頭部鎖定桿，以鎖定攝像機頭部。5
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注意

確保攝像機頭部鎖定桿不接觸其他零件，以免干擾傾斜操作。

從本裝置和鏡頭取下護蓋和外蓋。6

將鏡頭接環標記（白色）與本裝置對齊，小心地將鏡頭插入攝像機頭部，然後順時針轉動鏡頭直至其卡入正確鎖定位
置。

A：接環標記（白色）

注意

若要使用 A 接環鏡頭，請先將鏡頭接環轉接器（選購件）安裝至本裝置，再安裝 A 接環鏡頭。

7

沿箭頭方向轉動攝像機頭部鎖定桿，以解鎖攝像機頭部。8
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注意

再次鎖定攝像機頭部之前，攝像機頭部可能會在自身重量的作用下移動。執行作業時，請用手支撐攝像機頭部。

保持攝像機頭部的前後平衡，使滑動底座保持水平。

如果使用下列鏡頭之一，您可以參考滑動底座上的刻度，以大略平衡本裝置和鏡頭。

9

刻度位置 鏡頭名稱

0.5 SEL70200GM（附帶 SEL20TC）

1.7 SEL70200GM

2.0 SEL70200GM2（附帶 SEL20TC）

3.0 SELP28135G, SEL70200GM2

3.5 SELP18110G

3.6 SELC1635G

4.3 SEL70200G

5.0 或更高 SEL1224GM、SEL1635GM、SELP1635G、SELP18105G、SELP1020G
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注意

使用滑動底座刻度作為大略平衡的參考。

安裝鏡頭時，進行適當的平衡調整，確保本裝置不會前後傾斜。

請在水平面上調整平衡。

使用 SELC1635G 時，請取下鏡頭支撐座。

沿箭頭方向轉動攝像機頭部鎖定桿，以鎖定攝像機頭部。

注意

確保攝像機頭部鎖定桿不接觸其他零件，以免干擾傾斜操作。
確認方法：將平移/傾斜鎖定桿滑動到 UNLOCK 位置，用手轉動攝像機區塊使其朝上，並且目視確認並未接觸其他零件。如
果接觸，請沿箭頭方向再次轉動攝像機頭部鎖定桿。

10

逆時針轉動鏡頭支架夾緊桿，以鬆開鏡頭支撐座。

A：鏡頭支架撐桿夾緊桿（2 處）
B：鏡頭支撐座

11

移動鏡頭支撐座，使鏡頭支架底座與鏡頭支架底座連結螺絲對齊，然後順時針轉動螺絲，以固定鏡頭支架底座。12
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注意

確保鏡頭支架底座與鏡頭支架底座連結螺絲垂直，然後鎖緊。

順時針轉動鏡頭支架底座連結螺絲的夾緊桿，以鎖定鏡頭支架底座連結螺絲。

A：鏡頭支架底座連結螺絲
B：連結螺絲孔
C：鏡頭支架底座連結螺絲夾緊桿

提示

如果夾緊桿處於難以轉動的位置，請鬆開夾緊桿，並將其旋轉到易於操作的角度。處於所需位置時，關閉夾緊桿。

A：鏡頭支架底座連結螺絲夾緊桿
B：鏡頭支架撐桿夾緊桿

13

順時針轉動兩個鏡頭支架夾緊桿，以固定鏡頭支撐座。14

檢查兩根夾緊桿是否擰緊且沒有鬆脫、鏡頭是否正確安裝以及鏡頭開關是否正確設定。

如果夾緊桿鬆脫或鏡頭未正確安裝，鏡頭可能會掉落並損壞。
使用 E 接環電動變焦鏡頭時，還必須個別校準鏡頭，以便將相機中儲存的變焦位置準確復原成預設位置。有關詳
細資料，請參閱“校準 E 接環鏡頭”。

15
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相關主題

校準 E 接環鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

取下鏡頭

採用與安裝鏡頭相反的步驟取下鏡頭。

注意

用手緊握鏡頭，防止鏡頭掉落。

如果不立即安裝其他鏡頭，務必蓋上機身護蓋。

相關主題

安裝鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation

確認平移/傾斜已鎖定。1

逆時針轉動鏡頭支架底座連結螺絲的夾緊桿，以鬆開鎖定。2

取下鏡頭支撐座上的鏡頭支架底座連結螺絲，並移至不會干擾鏡頭的位置。3

解鎖攝像機頭部，並將攝像機頭部滑動到最前面的位置。

有關詳細資料，請參閱“安裝鏡頭”中的步驟 3 至 5。

4

按住鏡頭釋放按鈕，並在支撐鏡頭時逆時針轉動鏡頭。5

將攝像機的安裝標記（白色）與鏡頭對齊，並將鏡頭向前拉出。6
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

連接纜線

本主題介紹纜線連接。

5-041-957-83(1) Copyright 2022 Sony Corporation

將所需的纜線接到後側面板上的連接器。

為防止 HDMI 纜線鬆脫，請從連接器插頭塊上取下 HDMI 纜線固定板安裝螺絲（M2.6×6，黑色），然後使用安裝螺
絲安裝隨附的 HDMI 纜線固定板。使用市售纜線束帶或帶子，將 HDMI 纜線固定到 HDMI 纜線固定板。

A：HDMI 纜線固定板安裝螺絲（M2.6×6，黑色）
B：市售纜線束帶或帶子
C：HDMI 纜線固定板（隨附）

1
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

透過有線連接將本機連接到網路裝置

本主題介紹如何透過有線連接將本機連接到網路裝置。

5-041-957-83(1) Copyright 2022 Sony Corporation

使用 5e 類或更高類別的 LAN 纜線，將本機連接到網路裝置（例如 Wi-Fi 存取點或切換型集線器）。1
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用交流電

本主題介紹使用交流電為裝置供電的過程。

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。1

將交流變壓器（隨附）連接到本裝置的 DC IN 連接器，然後將電源線（隨附）連接到交流電電源。

A：DC IN 連接器
B：電源線
C：交流變壓器

2

為防止電源線鬆脫，請使用電線夾來固定交流變壓器電源線。

解鎖電線夾，如下圖所示將電源線穿過電線夾，然後鎖定電線夾。

3
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注意

只能使用本裝置隨附的交流變壓器或電源線。如連接其他變壓器或電源線，可能會導致火災或故障。

切勿在狹窄的空間內（例如，牆壁和家具之間）連接和使用交流變壓器。

切勿使交流變壓器插頭的金屬部份短路。否則，可能會導致故障。

將交流變壓器連接到最鄰近的交流電電源。如果在操作過程中出現問題，請立即從交流電電源拔除電源線。

使交流變壓器與本裝置中斷連線時，抓住插頭將其直接拔出。拉動纜線可能會造成故障。

A：電線夾
B：電線夾鎖
C：交流變壓器電源線

檢查裝置前方的 POWER 燈是否從閃爍綠燈變為持續綠燈並完成啟動。

當本裝置正常啟動並連接到網路時，NETWORK 燈將亮綠燈。

使用不支援平移/傾斜操作的鏡頭時，鎖定平移/傾斜鎖定桿並跳過以下步驟。有關可支援平移/傾斜的鏡頭的詳細
資料，請聯絡您的經銷商或 Sony 服務代表。

4

將平移/傾斜鎖定桿滑到 UNLOCK 位置，以解鎖攝像機頭部平移/傾斜。5

重設平移/傾斜。

有關詳細資料，請參閱“重設平移/傾斜”。

6
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相關主題

重設平移/傾斜

5-041-957-83(1) Copyright 2022 Sony Corporation

100



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用 PoE++ 電源

將本裝置連接到 PoE++ 相容供電裝置時，可透過市售網路纜線向本裝置供電。
這種方式無需電源接線，適合在安裝位置附近沒有電源插座的環境中為本裝置供電。

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。1

使用市售的網路纜線，連接本裝置及 PoE++ 相容供電裝置。

A：網路纜線
B：PoE++ 相容供電裝置

2

檢查裝置前方的 POWER 燈是否從閃爍綠燈變為持續綠燈並完成啟動。

當本裝置正常啟動並連接到網路時，NETWORK 燈將亮綠燈。

注意

透過 PoE++ 供電時，將在啟動完成之前的時間間隔內執行初始驗證。

3
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注意

本裝置符合 IEEE802.3bt Type 4 Class 8。有關經過驗證的相容 PoE++ 供電裝置的詳細資料，請聯絡您的經銷商或 Sony 服務代
表。

本裝置符合軟體驗證 (LLDP)，但可能需要配置網路裝置（符合 IEEE802.3bt）。

在啟用軟體驗證 (LLDP) 的情況下使用 PoE++ 供電時，切勿連接交流變壓器。

如果同時連接交流變壓器和 PoE++ 供電裝置，則會由交流變壓器供電。

透過 PoE++ 供電時，請使用 5e 類或更高類別的網路纜線。

透過 PoE++ 供電時，再次開啟本裝置後，請等候約 10 秒。

使用 PoE++ 供電時，連接接地端子來接地。

透過連接 PoE++ 供電時，請勿在室外接線。

相關主題

重設平移/傾斜

5-041-957-83(1) Copyright 2022 Sony Corporation

使用不支援平移/傾斜操作的鏡頭時，鎖定平移/傾斜鎖定桿並跳過以下步驟。有關可支援平移/傾斜的鏡頭的詳細資料，請聯
絡您的經銷商或 Sony 服務代表。

將平移/傾斜鎖定桿滑到 UNLOCK 位置，以解鎖攝像機頭部平移/傾斜。4

重設平移/傾斜。

有關詳細資料，請參閱“重設平移/傾斜”。

5
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

重設平移/傾斜

例如，當您更換鏡頭時，您可以根據下列步驟重設平移/傾斜。

5-041-957-83(1) Copyright 2022 Sony Corporation

將平移/傾斜鎖定桿滑到 UNLOCK 位置，並確認攝像機頭部的平移/傾斜是否解鎖。1

執行重設平移/傾斜功能。

可以透過紅外線遙控器、網路應用程式或 RM-IP500 遙控器（選購件）執行重設平移/傾斜。

使用紅外線遙控器進行操作：按下 P/T RESET 按鈕。
使用網路應用程式進行操作：在即時操作畫面的攝影機控制面板中的  (Others) 索引標籤上，按下 （重
設平移/傾斜）按鈕。
使用 RM-IP500 進行操作：請參閱 RM-IP500 的操作說明。

注意

執行重設平移/傾斜，會導致攝像機頭部和鏡頭轉動。執行此操作前，請檢查鏡頭是否被物體阻擋。

本裝置具有限制平移/傾斜範圍的功能，但當本裝置開啟或執行重設平移/傾斜時，此功能會被停用。

提示

重設平移/傾斜完成後，本裝置將返回預先執行位置。

2
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從網頁瀏覽器存取網路應用程式

您可以將本裝置連接到平板電腦或電腦，以便從網頁瀏覽器操作和配置本裝置。

檢查您的平板電腦或電腦是否支援網頁瀏覽器操作。

注意

如果未滿足建議的環境需求，或者根據平板電腦/電腦的使用情形，可能會對網頁瀏覽器中的視訊播放操作產生不利影響。

本裝置的網路應用程式使用 JavaScript。如果在平板電腦/電腦上使用防毒軟體，網頁可能無法正確顯示。

1

項目 需求

顯示
建議解析度 1080×810 或以上
平板電腦顯示器尺寸：建議 10 英吋或以上

支援 OS 及網頁瀏覽器

Windows
OS Windows 10 或更新版本

網頁瀏覽器 Google Chrome

Mac

OS macOS 10.15 或更新版本

網頁瀏覽器
Google Chrome
Safari

iPad

OS iPadOS 15 或更新版本

網頁瀏覽器
Google Chrome
Safari

Android
OS Android 12 或更新版本

網頁瀏覽器 Google Chrome

檢查本裝置、平板電腦或電腦以及周邊裝置是否已開啟。2

檢查本裝置和平板電腦或電腦是否透過連接 Wi-Fi 或有線區域網路進行網路連線。3

從平板電腦或電腦的網頁瀏覽器連線到本裝置。

使用 QR 碼連接
使用平板電腦的相機掃描印在本機側面媒介外蓋的 QR 碼。

4
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注意

如果 HTTP 連接埠號碼不是數值 80，請在網址列中輸入“http://本裝置的 IP 位址:連接埠號碼”。

使用 QR 碼或透過在 Web 瀏覽器的網址列中輸入 URL 進行連線時，請使用支援 mDNS* 的裝置。

提示

隨後，您可以使用網頁瀏覽器的書籤功能來快速存取本裝置。

5-041-957-83(1) Copyright 2022 Sony Corporation

開啟平板電腦上顯示的連結。
平板電腦上的網頁瀏覽器會啟動並顯示本裝置的網路應用程式畫面。

透過在網頁瀏覽器的網址列中輸入 URL 進行連線
在平板電腦或電腦上啟動網頁瀏覽器，然後輸入印在本機側面媒介外蓋上的 URL。
網頁瀏覽器會顯示本裝置的網路應用程式畫面。

透過在網頁瀏覽器的網址列中輸入本裝置的 IP 位址來進行連線
在平板電腦或電腦上啟動網頁瀏覽器，然後在網址列中輸入“http://本裝置的 IP 位址”。
網頁瀏覽器會顯示本裝置的網路應用程式畫面。

mDNS：一種通訊協定，用於根據本地網路上的主機名稱來確定 IP 位址。*
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初始化本裝置

首次使用本裝置時，請務必依照下列步驟配置本裝置。

提示

如果備用電池完全放電，您將需要重新配置初始設定。

從平板電腦或電腦連線到本裝置，然後啟動網路應用程式。

首次使用本裝置時，會提示您在網頁瀏覽器中輸入使用者名稱和密碼。輸入下列設定。

使用者名稱：admin
密碼：（保留空白）

按照畫面上的說明，進行初始設定的配置。

1

輸入管理員 (Administrator) 使用者名稱和密碼，然後按下 [OK] 按鈕。

1：輸入管理員使用者名稱。
2：設定管理員密碼。
3：再次輸入相同的密碼進行確認。

注意

使用者名稱和密碼可以使用下列字元。密碼必須包含至少一個大寫字母、一個小寫字母和一個數字，而且長度必須為 8 ~ 64
個字元。

英數字元
符號 (!$%`*+-./<=>?@[]^_{|}~)

2

106



拍攝操作的即時畫面隨即顯示。根據操作模式，繼續配置本裝置的基本操作。

提示

在某些情況下，例如將本裝置與平板電腦配對使用時，為本裝置使用固定 IP 位址可能會更容易。

若要設定固定 IP 位址，首先關閉網路功能表的 [Network] > [Wired LAN] > [IPv4] > [DHCP]（滑桿開關位於左側位置）。

出現與固定 IP 位址相關的設定項目。配置項目，然後按下畫面上的 [OK] 按鈕。

5-041-957-83(1) Copyright 2022 Sony Corporation

您的網頁瀏覽器將重新載入，並提示您輸入使用者名稱和密碼。

輸入在步驟 2 中配置的使用者名稱和密碼。

語言和時鐘設定畫面隨即出現。

3

指定下列項目，並按下 [OK] 按鈕。

[Language]
選取用於網路應用程式和攝影機畫面顯示的語言。變更語言將變更網路應用程式的顯示語言。
[Date & Time Format]
從下列選項中，選取日期和時間的顯示格式。
[yyyy-mm-dd hh:mm:ss]、[mm-dd-yyyy hh:mm:ss]、[dd-mm-yyyy hh:mm:ss]
“yyyy”表示年，“mm”表示月，“dd”表示日，“hh”表示小時，“mm”表示分鐘，“ss”表示秒。
[12 h/24 h]
選取以 [12 h]（12 小時制）或 [24 h]（24 小時制）來顯示時間。
[Time Setting]
選取設定日期/時間的方法。
[Synchronize with PC]：與電腦或平板電腦的日期/時間同步。
[Manual setting]：手動設定。選擇此方式時，會出現日期和時間的輸入欄位。
[Time Zone]
選取時區。

4
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配置基本操作

本主題介紹如何配置本裝置以進行基本操作。

設定拍攝模式

您可以為本裝置選擇符合工作流程的拍攝模式。

Custom模式：在拍攝過程中靈活建立影像。
日誌拍攝模式：錄製 S-Log 內容。

Flexible ISO模式：曝光設定透過與拍攝場景相符的 ISO 值調整進行設定。
Cine EI 模式/Cine EI Quick 模式：操作本裝置的方式類似於膠片攝影機（拍攝時不會完全建立影像），且錄製的片
段將經過後期製作的處理。

在 Cine EI Quick 模式中，會自動選擇適合曝光指數設定的基本感光度。
使用網路功能表或攝像機功能表中的 [Project] > [Base Setting] > [Shooting Mode] 來切換拍攝模式。

Custom 模式

您可以選擇視訊標準。
使用網路功能表或攝像機功能表中的 [Project] > [Base Setting] > [Target Display] 進行切換。

[SDR(BT.709)]：按照高畫質播送標準進行拍攝
[HDR(HLG)]：按照新世代 4K 播送標準進行拍攝

如需詳細資料，請參閱“以所需風格拍攝”中的“風格概述”和其他主題。

日誌拍攝模式
（Flexible ISO 模式/Cine EI 模式/Cine EI Quick 模式）

在日誌拍攝模式中，您可以選擇錄製訊號和輸出訊號的基本色域。此處選取的色域是 [LUT On/Off] 設定為 [MLUT Off] 時的
視訊輸出色域。
您可以使用攝影機功能表中的 [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] 切換色域。

[S-Gamut3.Cine/SLog3]：輕鬆調整數位電影的色域 (DCI-P3)。
[S-Gamut3/SLog3]：涵蓋 ITU-R BT.2020 色域的 Sony 寬色域。

有關詳細資料，請參閱“以後期製作的風格調整進行拍攝”。
 
下表列出了每種拍攝模式支援的功能。
●：支援，–：不支援

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ●（連結到 EI）

Exposure Index – – ● ●
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提示

Cine EI Quick 模式和 Cine EI 模式中，為盡可能提高影像感測器的性能，在不使用增益的情況下，以基本 ISO 感光度進行拍攝。
使用照明和 ND 濾鏡來調整亮度，調整到達影像感測器的光量。

設定系統頻率

使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Frequency] 進行切換。按照選取的值，裝置可能會在切換
後自動重新啟動。

注意

您無法在錄製或播放期間切換系統頻率。

設定成像儀掃描模式

您可以設定影像感測器的有效圖像尺寸和解析度。
使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Imager Scan Mode] 進行切換。
[FF]：全畫面尺寸。
[S35]：Super 35mm 尺寸。

注意

您無法在錄製或播放期間切換成像儀掃描模式。

設定為 S35 時，視訊格式限制為 1920×1080。

設定轉碼器

您可以設定錄製的轉碼器。
使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Codec] 進行切換。

注意

您無法在錄製或播放期間切換轉碼器。

設定視訊格式

您可以設定錄製的視訊格式和從攝像機輸出的視訊格式。

使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Video Format] 來切換錄製的視訊格式。
使用網路功能表或攝像機功能表中的 [Monitoring] > [Output Format] 來切換來自 SDI OUT 和 HDMI OUT 連接器的輸
出格式。

注意

Custom Flexible ISO Cine EI Cine EI Quick

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
（不包括 Base Look）

● – – –
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您無法在錄製或播放期間切換視訊格式。

來自 SDI OUT 和 HDMI OUT 連接器的訊號可能受到限制，具體取決於視訊格式設定。

相關主題

風格概述

以後期製作的風格調整進行拍攝

5-041-957-83(1) Copyright 2022 Sony Corporation
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支援的記憶卡

裝置使用插入記憶卡插槽中的 CFexpress Type A 記憶卡（另售）或 SDXC 記憶卡（另售）來錄製音訊和視訊。記憶卡也
用於代理錄製。

CFexpress Type A 記憶卡

使用本裝置“推薦錄製媒介”中所列的 Sony CFexpress Type A 記憶卡*。
如需使用其他製造商的媒介進行操作的詳細資料，請參閱媒介的操作說明或參閱製造商的資訊。

SDXC 記憶卡

使用本裝置“推薦錄製媒介”中所列的 SDXC 記憶卡*。

推薦錄製媒介

保證的操作條件取決於 Rec Format 和 Recording 設定。

CFexpress Type A
符合 VPG400
支援本裝置的所有錄製格式。

SDXC
在下表所述條件下支援。“●”表示操作經過驗證，“–”表示操作不予保證。

RAW Out & XAVC-I，4096×2160 Class 300，正常模式

RAW Out & XAVC-I，3840×2160 Class 300，正常模式

本說明指南稱為“CFexpress 記憶卡”。*

本說明指南稱為“SD 記憶卡”。*

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I，3840×2160 Class 300，S&Q（60 fps 或以下）

RAW Out & XAVC-I，3840×2160 Class 300，S&Q（100 fps、120 fps）
已驗證媒介不可用。

XAVC-I，4096×2160 Class 300，正常模式

XAVC-I，4096×2160 Class 300，S&Q（60 fps 或以下）

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I，3840×2160 Class 300，正常模式

XAVC-I，3840×2160 Class 300，S&Q（60 fps 或以下）

XAVC-I，3840×2160 Class 300，S&Q（100 fps、120 fps）
已驗證媒介不可用。

XAVC-I，1920×1080 Class 100，正常模式

XAVC-I，1920×1080 Class 100，S&Q（60 fps 或以下）

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●
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XAVC-I，1920×1080 Class 100，S&Q（100 fps、120 fps）

XAVC-I，1920×1080 Class 100，S&Q（150 fps、180 fps）
已驗證媒介不可用。

XAVC-I，1920×1080 Class 100，S&Q（200 fps、240 fps）
已驗證媒介不可用。

XAVC-L，3840×2160 420，正常模式

XAVC-L，3840×2160 420，S&Q（60 fps 或以下）

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L，3840×2160 420，S&Q (100 fps、120 fps)

XAVC-L，1920×1080 HD50，正常模式

XAVC-L，1920×1080 HD50，S&Q（60 fps 或以下）

XAVC-L，1920×1080 HD50，S&Q（100 fps、120 fps）

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L，1920×1080 HD50，S&Q（150 fps、180 fps）

XAVC-L，1920×1080 HD50，S&Q（200 fps、240 fps）

XAVC-L，1920×1080 HD35，正常模式

XAVC-L，1920×1080 HD35，S&Q（60 fps 或以下）

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L，1920×1080 HD35，S&Q（100 fps、120 fps）

XAVC-L，1920×1080 HD35，S&Q（150 fps、180 fps）

XAVC-L，1920×1080 HD35，S&Q（200 fps、240 fps）

5-041-957-83(1) Copyright 2022 Sony Corporation

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

系統頻率 Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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插入記憶卡

本主題介紹插入記憶卡時的注意事項。

開啟記憶卡插槽部分的媒介外蓋。1

插入記憶卡。

插入 CFexpress 記憶卡時，標籤朝上。

注意

插入安裝在天花板上的裝置時，標籤朝下。

插入 SD 記憶卡時，標籤朝下。

注意

插入安裝在天花板上的裝置時，標籤朝上。

存取指示燈亮起紅燈，如果記憶卡可用，則變成綠燈。

2
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注意

如果朝不正確的方向將記憶卡推入插槽，則記憶卡、記憶卡插槽和記憶卡上的影像資料可能會損壞。

錄製到插入 CFexpress Type A/SD 記憶卡插槽 A 和 B 的媒介時，將兩個媒介插入建議以錄製格式操作的兩個插槽中。

5-041-957-83(1) Copyright 2022 Sony Corporation

注意

如果存取指示燈持續閃爍紅燈，且沒有變為綠燈，則請暫時關閉裝置，取出記憶卡再重新插入。

蓋上媒介外蓋。3
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彈出記憶卡

開啟記憶卡插槽部分的媒介外蓋，然後輕輕壓入記憶卡以彈出記憶卡。

注意

如果在存取記憶卡時關閉攝影機或取出記憶卡，將無法保證記憶卡中的資料完整性。記憶卡上錄製的所有資料可能會遺失。關閉裝
置或取出記憶卡之前，始終確保存取指示燈為綠燈或熄滅。

錄製完成後立即取出記憶卡時，記憶卡可能很熱，不過這並不表示有問題。

5-041-957-83(1) Copyright 2022 Sony Corporation
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格式化（初始化）記憶卡

如果插入未格式化的記憶卡或以其他規格格式化的記憶卡，攝影機影像窗格中將顯示“Media Needs to be Formatted”訊
息。
請按照下列程序將記憶卡格式化。

注意

將記憶卡格式化會刪除所有資料，包括錄製的視訊資料和設定檔案。

在執行過程中可能會出現訊息，具體取決於格式化過程的持續時間。

如果格式化失敗

本裝置不支援的記憶卡無法格式化。
顯示警告訊息。請按照說明將記憶卡換成支援的記憶卡。

在另一台裝置的插槽中使用本裝置格式化的記憶卡

首先，備份記憶卡，然後在要使用的裝置中重新將記憶卡格式化。

5-041-957-83(1) Copyright 2022 Sony Corporation

在攝像機功能表中選擇 [TC/Media] > [Format Media]。1

選取 Media(A)（插槽 A）或 Media(B)（插槽 B），然後選取格式化方法（Full Format 或 Quick Format）。

確認訊息將出現。
[Full Format]：將媒介完全初始化，包括資料區域和資料管理資訊。
[Quick Format]：僅初始化媒介的資料管理資訊。

2

選取 [Execute]。

在格式化過程中會顯示訊息，而且存取指示燈會亮起紅燈。
格式化結束後，將顯示完成訊息。

3
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檢查剩餘錄製時間

拍攝（錄製/待機）時，您可以使用攝像機影像窗格器中的插槽 A/B 剩餘媒介指示燈來監視每個插槽中記憶卡的剩餘容量。
剩餘錄製時間是按照每個插槽中的媒介剩餘容量和目前錄製格式（錄製位元速率）計算而得，並顯示為分鐘數。

記憶卡更換時間

當兩張記憶卡上的總計剩餘錄製時間少於 5 分鐘時，會顯示訊息“Media Near Full”，並且錄製/提示燈會開始閃爍來警告
您。
更換成有可用空間的媒介。
如果繼續錄製直到剩餘的總錄製時間達到零，訊息會變成“Media Full”，而且錄製會停止。

注意

記憶卡最多可以錄製約 600 個剪輯。

5-041-957-83(1) Copyright 2022 Sony Corporation
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還原記憶卡

如果記憶卡由於某種原因出現錯誤，則必須在使用前予以還原。
裝入需要還原的記憶卡時，攝像機影像窗格上會出現訊息，詢問您是否要還原記憶卡。

還原記憶卡

使用 GUI 控制面板中的箭頭按鈕來選擇 [Execute]，然後按下 [Set] 按鈕。
在格式化過程中會顯示訊息和進度狀態 (%)，而且存取指示燈會亮起紅燈。
還原結束後，將顯示完成訊息。

如果還原失敗

無法還原發生記憶體錯誤的記憶卡。顯示警告訊息。請按照說明更換記憶卡。
如果將發生記憶體錯誤的記憶卡重新格式化，則可以繼續使用它。
在某些情況下，某些剪輯可以還原，而在其他某些情況下則無法還原。可以正常播放還原的剪輯。

注意

要還原本裝置所錄製的媒介，請務必使用本裝置。

對於本裝置以外的裝置或者不同版本的其他裝置（即使是相同機型）所錄製的媒介，可能無法使用本裝置進行還原。

無法還原不到 2 秒的剪輯。

5-041-957-83(1) Copyright 2022 Sony Corporation
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開始/停止錄製

本主題介紹如何開始/停止錄製。

連接必要的裝置，並檢查本裝置和周邊裝置是否已通電。1

插入記憶卡。2

在網路應用程式畫面的左上方，檢查本裝置的電源狀態。

當電源開啟時
當本裝置開啟時，網路應用程式畫面上方的電源開關上會顯示 [Power ON]。

本裝置前方的 POWER 燈亮起，並且攝像機影像會出現在網路應用程式的即時操作畫面上。

注意

如果尚未配置管理員密碼，會出現提示您配置密碼的畫面。請參閱“初始化本裝置”。

當電源處於待機狀態時
當本裝置的電源處於待機狀態時，網路應用程式的電源開關上會顯示 [Power Standby]。

在此狀態下，按下電源開關並選擇 [Power ON]。本裝置開啟，本裝置前方的 POWER 燈會亮起綠色，而且攝像機影
像會出現在網路應用程式的即時操作畫面上。

提示

您也可以使用隨附紅外線遙控器上的電源按鈕來開啟本裝置。

3

按下錄製 START/STOP 按鈕。4
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將本裝置的電源切換至待機狀態

按下網路應用程式中的電源開關並選擇 [Power Standby]，將本裝置的電源設定為待機狀態。

提示

您也可以使用隨附紅外線遙控器上的電源按鈕，將電源設定為待機狀態。

相關主題

初始化本裝置

5-041-957-83(1) Copyright 2022 Sony Corporation

當錄製開始，本裝置的錄製/提示燈（2 處）會亮起。
錄製過程中，錄製 START/STOP 按鈕會亮起。此外，還會顯示目標錄製媒介的圖示和 [●Rec]。

若要停止錄製，請再次按下錄製 START/STOP 按鈕。

錄製停止，本裝置的錄製/提示燈（2 處）關閉。
錄製待機狀態下，錄製 START/STOP 按鈕不會亮起。此外，還會顯示目標錄製媒介的圖示和 [Stby]。

提示

您還可以使用隨附紅外線遙控器上的錄製 START/STOP 按鈕來開始/停止錄製。

5
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在記憶卡之間切換

插入兩張記憶卡時，您可以按下網路應用程式播放控制面板上的 [Slot Select] 按鈕來切換記憶卡。

提示

您也可以按下隨附紅外線遙控器上的 SLOT SEL（記憶卡插槽 (A)/(B) 選取）按鈕來切換記憶卡。

關於中繼錄製

錄製時，在第一張記憶卡的剩餘容量減少到零之前，本裝置會自動切換到第二張記憶卡（中繼錄製）。切換記憶卡時，可
以將已滿的記憶卡換成新的記憶卡來繼續連續錄製。

注意

在播放模式中無法在記憶卡之間切換。此外，對於插槽 A 和插槽 B 中的媒介，不支援連續播放跨越這些媒介的剪輯。

關於錄製資料

停止錄製時，從錄製開始到結束的視訊、音訊和隨附資料將做為單一“剪輯”儲存在記憶卡上。

錄製資料的剪輯名稱

使用攝像機功能表中的 [TC/Media] > [Clip Name Format]，自動指派本裝置所錄製的每個剪輯的名稱。

剪輯持續時間上限

每個剪輯最多 6 小時。
連續錄製的持續時間上限與剪輯的持續時間上限相同。如果錄製時間超過剪輯的持續時間上限，則會自動建立新的剪輯並
繼續錄製。新剪輯在縮圖畫面上顯示為單獨的剪輯。
中繼錄製期間會連續錄製多個剪輯，不過錄製將在大約 24 小時後自動停止。

注意

錄製過程中切勿彈出記憶卡。錄製時，僅更換插槽存取指示燈熄滅的插槽中插入的記憶卡。

若正在錄製的記憶卡的剩餘容量不足一分鐘，並且在另一個插槽中插入可錄製的記憶卡，將出現“Will Switch Slots Soon”訊息。切
換記憶卡插槽後，這個訊息會消失。

如果記憶卡剩餘容量不足一分鐘，則開始錄製時，中繼錄製可能無法操作。為正確進行中繼錄製，請在開始錄製之前檢查記憶卡的
剩餘容量是否超過一分鐘。

使用中繼錄製功能所建立的視訊無法在本裝置上無縫播放。

若要對使用中繼錄製功能所建立的視訊進行合併，請使用“Catalyst Browse”軟體。

5-041-957-83(1) Copyright 2022 Sony Corporation
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檢查音訊

音訊從本裝置的 SDI 和 HDMI 連接器輸出。使用攝像機功能表中的 [Audio] > [Audio Output] > [HDMI/Stream Output CH]
選擇從 HDMI 連接器輸出的音訊通道組合。
CH1/CH2：CH1 和 CH2 組合
CH3/CH4：CH3 和 CH4 組合
在網路應用程式中監聽音訊時，請使用攝像機影像右下方的音訊音量表。

5-041-957-83(1) Copyright 2022 Sony Corporation
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指定時間資料

本主題介紹如何設定時間資料。

設定時間碼

使用攝像機功能表中的 [TC/Media] > [Timecode]，設定要錄製的時間碼。

設定使用者位元

您可以將 8 位數十六進制數字做為使用者位元新增到錄製的影像中。您也可以將使用者位元設定為目前時間。使用攝像機
功能表中的 [TC/Media] > [Users Bit] 進行設定。

顯示時間資料

使用攝像機功能表中的 [TC/Media] > [TC Display] > [Display Select]，設定要顯示的時間碼。
按下已指派 [DURATION/TC/U-BIT] 的可指派按鈕，將依次切換顯示時間碼、使用者位元和持續時間。

5-041-957-83(1) Copyright 2022 Sony Corporation
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查核錄製 (Rec Review)

您可以在畫面上查核最後錄製的剪輯（錄製查核）。

注意

如果在錄製剪輯後變更視訊格式，則不支援 Rec Review。

設定 Rec Review 開始位置

您可以使用攝像機功能表中的 [Technical] > [Rec Review]，將播放開始位置設定為下列其中之一。

剪輯的最後 3 秒
剪輯的最後 10 秒
剪輯開始

提示

如果想在錄製多個剪輯後查核特定的剪輯，請按下 [Thumbnail] 按鈕以顯示縮圖畫面，然後選取剪輯開始播放。

您也可以按下隨附的紅外線遙控器的 THUMBNAIL 按鈕來顯示縮圖畫面。

Rec Review 方法

預先將 Rec Review 功能指派給基本配置調整面板上的可指派按鈕之一。

有關指派的詳細資料，請參閱“實用的功能”中的“可指派按鈕”。

停止錄製，然後按下指派給 Rec Review 功能的可指派按鈕，開始播放之前錄製的剪輯。
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當剪輯播放到結尾，Rec Review 便會結束，裝置則返回 Stby（待機）模式。

停止 Rec Review
按下指派給 Rec Review 的可指派按鈕，或按下 [Cancel/Back] 按鈕。
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提示

您也可以按下隨附的紅外線遙控器的 [Cancel/Back] 按鈕來停止 Rec Review 功能。

相關主題

可指派按鈕

5-041-957-83(1) Copyright 2022 Sony Corporation
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取景調整畫面

使用即時操作畫面的下列部分來調整取景。

注意

根據攝像機的方向、鏡頭的焦距和變焦位置，可能會看到連接至連接器插頭塊的部分裝置或纜線。拍攝前，請檢查當前鏡頭和焦距
的視野。您還可以使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 來控制平移/傾斜範圍。當本裝置開啟或執行平移/傾斜重設
時，此範圍限制設定將被忽略。有關詳細資料，請參閱網路功能表中的 [Pan-Tilt] > [P/T Range Limit]。

提示

您還可以使用隨附的紅外線遙控器來控制取景。

5-041-957-83(1) Copyright 2022 Sony Corporation

預設位置控制面板1.

 (Main) 索引標籤/  (Others) 索引標籤2.

取景控制面板3.
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使用網路應用程式調整拍攝方向

水平移動攝像機稱為平移，垂直移動攝像機稱為傾斜。
您可以使用平移/傾斜操作來調整拍攝方向。

提示

如果控制桿下方顯示 [Execute Pan-Tilt Reset]，表示在本裝置的平移/傾斜控制原點資訊中出現不一致。執行重設平移/傾斜功能，
以更新原點資訊。有關詳細資料，請參閱“重設平移/傾斜”。

將攝像機背對前方

按下攝影機控制面板中  (Others) 索引標籤上的 （平移/傾斜主目錄）按鈕。

注意

根據攝像機的方向、鏡頭的焦距和變焦位置，可能會看到連接至連接器插頭塊的部分裝置或纜線。拍攝前，請檢查當前鏡頭和焦距
的視野。您還可以使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 來控制平移/傾斜範圍。當本裝置開啟或執行平移/傾斜重設
時，此範圍限制設定將被忽略。有關詳細資料，請參閱網路功能表中的 [Pan-Tilt] > [P/T Range Limit]。

相關主題

重設平移/傾斜

5-041-957-83(1) Copyright 2022 Sony Corporation

按下取景控制面板中的 （平移/傾斜/變焦）索引標籤，以顯示控制桿。1

監視攝像機影像窗格時，拖動控制桿的中心朝向您想要查看的方向。

攝像機的方向和速度會隨著拖動方向和水平的變化而變化。
透過按下控制桿的周邊區域，您可以更精準地調整平移/傾斜。

2
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定平移/傾斜操作速度

您可以透過操作取景控制面板中的控制桿，使用攝像機控制面板中的 [Pan-Tilt Speed] 滑桿來變更平移/傾斜操作速度。

注意

如果攝像機的移動範圍內有牆壁或其他障礙物，請在平移/傾斜操作期間務必小心，避免撞到攝像機或鏡頭。

平移/傾斜加速取決於物理特性，例如鏡頭的重量平衡。您可以使用網路功能表或攝像機功能表中的 [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] 更改加速設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下攝像機控制面板中的  (Main) 索引標籤。1

從列表中，選擇 [Pan-Tilt Speed] 滑桿。

如果沒有顯示 [Pan-Tilt Speed] 滑桿，選擇兩個滑桿功能選擇按鈕之一，以顯示滑桿。

2

向左或向右移動滑桿旋鈕。

將旋鈕向左移動會降低操作速度，將旋鈕向右移動會提高操作速度。

3
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定平移/傾斜操作加速

您可以使用網路功能表或攝像機功能表中的 [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] 來設定 9 個等級的加速操作。
增加數值以實現更快速的速度變化，或者減小數值以實現更平緩的速度變化。
若要在操作平移/傾斜時獲得更好的回應性，請選擇 7 至 9 之間的數值。
為了在移動到開始/結束的預設位時置獲得更高的位置精準度，建議使用 1 至 6 之間的數值。

有關預設位置的詳細資料，請參閱“儲存/還原平移/傾斜和變焦位置”。

注意

當該值設置得較高時，如果安裝了較重的鏡頭，該功能可能無法正常運作。實際使用前，請檢查操作。

[Ramp Curve] 設定與平移/傾斜操作之間的關係

操作平移/傾斜時

叫用預設位置時
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用隨附的紅外線遙控器調整拍攝方向

您可以使用用隨附紅外線遙控的平移/傾斜操作按鈕來調整拍攝方向。

將攝像機背對前方

按下 HOME 按鈕。

注意

根據攝像機的方向、鏡頭的焦距和變焦位置，可能會看到連接至連接器插頭塊的部分裝置或纜線。拍攝前，請檢查當前鏡頭和焦距
的視野。您還可以使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 來控制平移/傾斜範圍。當本裝置開啟或執行平移/傾斜重設
時，此範圍限制設定將被忽略。有關詳細資料，請參閱網路功能表中的 [Pan-Tilt] > [P/T Range Limit]。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下箭頭按鈕，可控制平移/傾斜。

監視攝像機影像時，按下您要查看的方向之箭頭按鈕。
要移動較短距離，請短按箭頭按鈕。
要移動較長距離，請長按箭頭按鈕。
要沿對角線移動，按住 （向上箭頭）或 （向下箭頭）按鈕，然後按下 （向左箭頭）或 （向右箭頭）按
鈕。

1
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定變焦類型

使用攝像機功能表中的 [Technical] > [Zoom] > [Zoom Type] 來設定變焦類型。
變焦類型取決於所安裝的鏡頭類型。

注意

在下列情況下，無法使用 Clear Image Zoom。

當 [Shooting] > [S&Q Motion] > [Setting] 設定為 On 且攝像機功能表中的 [Frame Rate] 設定高於 60 fps 時
當攝影機功能表中的 [Project] > [Rec Format] > [Codec] 設定為 [RAW] 或包含 RAW 的選項時

操作鏡頭上的 SERVO/MANUAL 選取開關，可將 Clear Image Zoom 的放大倍率重設為 1 倍。

Clear Image Zoom 期間，不支援 AF-S。

Clear Image Zoom

裝置配備變焦功能，使用稱為 Clear Image Zoom 的影像訊號處理。啟用 Clear Image Zoom 後，即使使用定焦鏡頭也支
援變焦。這也可以用於將範圍擴展到電動變焦鏡頭的光學範圍之外。
使用 Clear Image Zoom 的最大變焦倍率按照錄製解析度而有所不同。

對於 QFHD/4K 錄製解析度：1.5×
對於高畫質錄製解析度：2×

5-041-957-83(1) Copyright 2022 Sony Corporation

所安裝鏡頭的類型
[Zoom Type] 設定

[Optical Zoom Only] [On(Clear Image Zoom)]

定焦鏡頭/手動變焦鏡頭 不支援變焦操作。 支援 Clear Image Zoom。

電動變焦鏡頭 僅支援光學變焦。 支援光學變焦和 Clear Image Zoom。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用網路應用程式調整變焦

您可以使用光學變焦或 Clear Image Zoom 來調整本裝置的變焦。本主題介紹如何使用網路應用程式進行調整。有關 Clear
Image Zoom 的詳細資料，請參閱“設定變焦類型”。

注意

根據攝像機的方向、鏡頭的焦距和變焦位置，可能會看到連接至連接器插頭塊的部分裝置或纜線。拍攝前，請檢查當前鏡頭和焦距
的視野。您還可以使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 來控制平移/傾斜範圍。當本裝置開啟或執行平移/傾斜重設
時，此範圍限制設定將被忽略。有關詳細資料，請參閱網路功能表中的 [Pan-Tilt] > [P/T Range Limit]。

實際變焦速度和準確度會因鏡頭而異。使用前，請檢查操作。

提示

您可以使用與本機相容的鏡頭控制器（選購件）來控制手動變焦鏡頭的變焦。如需詳細資料，請參閱“連接鏡頭控制器”和“使用鏡頭
控制器調整變焦”。

相關主題

設定變焦類型

連接鏡頭控制器

使用鏡頭控制器進行變焦調整

5-041-957-83(1) Copyright 2022 Sony Corporation

按下取景控制面板中的 （平移/傾斜/變焦）索引標籤，顯示平移/傾斜控制面板。1

向 [T]（望遠）方向或 [W]（廣角）方向滑動 [Zoom] 滑桿旋鈕，以調整變焦。

縮放速度會隨滑桿的移動而變化。

2
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定變焦操作速度

您可以使用攝像機控制面板中的 [Zoom] 滑桿更改取景控制面板中的 [Zoom Speed] 滑桿的變焦操作速度。

注意

實際變焦速度和準確度會因鏡頭而異。使用前，請檢查操作。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下攝像機控制面板中的  (Main) 索引標籤。1

從列表中，選擇 [Zoom Speed] 滑桿。

如果沒有顯示 [Zoom Speed] 滑桿，選擇兩個滑桿功能選擇按鈕之一，以顯示滑桿。

 

2

向左或向右移動 [Zoom Speed] 滑桿旋鈕。

將旋鈕向左移動會降低操作速度，將旋鈕向右移動會提高操作速度。

3

140



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用隨附的紅外線遙控器調整變焦

您可以使用光學變焦或 Clear Image Zoom 來調整本裝置的變焦。本主題介紹如何使用隨附的紅外線遙控器進行調整。有
關 Clear Image Zoom 的詳細資料，請參閱“設定變焦類型”。

注意

根據攝像機的方向、鏡頭的焦距和變焦位置，可能會看到連接至連接器插頭塊的部分裝置或纜線。拍攝前，請檢查當前鏡頭和焦距
的視野。您還可以使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 來控制平移/傾斜範圍。當本裝置開啟或執行平移/傾斜重設
時，此範圍限制設定將被忽略。有關詳細資料，請參閱網路功能表中的 [Pan-Tilt] > [P/T Range Limit]。

提示

您可以使用與本機相容的鏡頭控制器（選購件）來控制手動變焦鏡頭的變焦。如需詳細資料，請參閱“連接鏡頭控制器”和“使用鏡頭
控制器調整變焦”。

相關主題

設定變焦類型

連接鏡頭控制器

使用鏡頭控制器進行變焦調整

5-041-957-83(1) Copyright 2022 Sony Corporation

按下變焦按鈕來調整變焦。

監視畫面時，按下 T（望遠）或 W（廣角）按鈕，以調整變焦。
如需放大，按下 T 按鈕。
如需縮小，按下 W 按鈕。

1
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

校準 E 接環鏡頭

使用 E 接環電動變焦鏡頭時，可以執行校準，以校正因各個鏡頭差異所導致的變焦位置差異。
要準確計算變焦位置，請使用以下步驟校準鏡頭，以校正鏡頭之間的個別差異。

校準資料

本裝置最多可以儲存 5 個鏡頭的校準資料。校準第 6 個或更多鏡頭時，最早的資料將被覆寫。
透過按下網路應用程式畫面通用區域中 （攝影機狀態）按鈕並選擇 [Lens] > [Calibration Data]，檢查所安裝鏡頭之
校準資料是否可用。

5-041-957-83(1) Copyright 2022 Sony Corporation

如果鏡頭有 SERVO/MANUAL 開關，請設定到 SERVO 位置。

注意

如果開關設定為 MANUAL，鏡頭將無法接收來自本裝置的變焦指令。

1

使用攝像機功能表中的 [Technical] > [Lens] > [Lens Calibration] 來運行校準。

校準過程中，變焦鏡頭會自動移動並進行測量。

2
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用網路應用程式來儲存/復原平移/傾斜、變焦位置和對焦設定

您可以儲存平移/傾斜、變焦位置和對焦設定，並在需要時使用網路應用程式叫用（預設位置功能）。

有關可儲存/可還原項目的詳細資料，請參閱“預設位置儲存項目”。

注意

如果 Clear Image Zoom 倍率超過 1 倍，則無法儲存預設位置。

如果網路功能表中的 [Pan-Tilt] > [P/T Direction] > [Ceiling] 設定發生變更，則所有已儲存的預設位置都將被刪除。

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。1

使用平移/傾斜和變焦操作來決定要儲存的位置。2

按下預設位置控制面板中的 [+] 按鈕。

已儲存位置的影像會顯示在預設位置控制面板中。

提示

如果預設位置控制區塊沒有顯示，按下 （開啟）按鈕來顯示。

位置從 [Preset1] 開始依序儲存。

如果預設序列中存在未使用的預設，則位置將從未使用的預設開始儲存至預設中。例如，若預設位置儲存在 [Preset1] 和
[Preset3] 中，但未儲存在 [Preset2] 中，則下一個預設位置將儲存在 [Preset2] 中，接著將儲存在 [Preset4] 中。

最多可儲存 100 個預設位置。

您可以重新命名所有預設位置。如需詳細資料，請參閱“使用網路應用程式重新命名預設位置”。

3
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取消恢復預置位操作

恢復預置位操作期間，按下預置位控制面板上顯示的 （取消恢復）按鈕，可取消恢復操作。使用控制桿和 [Zoom] 滑桿
來調整取景。

相關主題

預設位置儲存項目

使用網路應用程式重新命名預設位置

在恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）

設定平移/傾斜操作加速

5-041-957-83(1) Copyright 2022 Sony Corporation

復原已儲存的位置。

連按兩下預設位置控制面板中您想要復原的位置縮圖，以復原對應位置。

提示

您也可以透過按下影像、按下出現的 （預設位置功能表）按鈕和選擇 [Recall] 來復原位置。

儲存位置轉變速度由儲存位置時網路功能表中的 [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt Speed for Common] 設定來
決定。您還可以在儲存後變更轉換速度。如需詳細資料，請參閱“恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）”。

可以使用轉換速度和 [Ramp Curve] 設定來調整移動到預設位置時平移/傾斜視角的變化程度。如需詳細資料，請參閱“恢復預
設位置時變更轉變速度（平移-傾斜/變焦/對焦）”和“設定平移/傾斜操作加速”。

如果在預設播放期間叫用不同的預設，則第一個叫用的預設的操作將停止，隨後叫用的預設的操作將開始。

注意

如果儲存預設位置和播放預設位置之間的環境溫度發生顯著變化，可能會出現取景偏差。

恢復預置位過程中，無法執行除恢復或取消預置位以外的任何操作。

4
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用網路應用程式重新命名預設位置

您可以重新命名已儲存的預設位置。

5-041-957-83(1) Copyright 2022 Sony Corporation

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。1

按下您想要重新命名的預設位置。

（預設位置功能表）按鈕會出現在影像的右上角。

2

按下 （預設位置功能表）按鈕，並從顯示的功能表中選取 [Rename]。3

輸入新的預設名稱。4
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可換鏡頭數位攝像機
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使用網路應用程式將儲存預設位置替換成新的位置

您可以使用新的位置來替換已儲存的預設位置。

5-041-957-83(1) Copyright 2022 Sony Corporation

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。1

使用平移/傾斜和變焦操作來決定要儲存的位置。2

在預設位置控制面板，按下您想要替換的位置影像。

（預設位置功能表）按鈕會出現在影像的右上角。

3

按下 （預設位置功能表）按鈕，並從顯示的功能表中選取 [Replace]。

將當前設定替換為新的位置。

4
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可換鏡頭數位攝像機
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使用網路應用程式來刪除已儲存的預設位置

您可以刪除已儲存的預設位置。

5-041-957-83(1) Copyright 2022 Sony Corporation

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。1

在預設位置控制面板，按下您想要刪除的位置影像。

（預設位置功能表）按鈕會出現在影像的右上角。

2

按下 （預設位置功能表）按鈕，並從顯示的功能表中選取 [Delete]。

儲存的位置將被刪除。

3
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可換鏡頭數位攝像機
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恢復預設位置時同步平移/傾斜操作和變焦/對焦操作

恢復已儲存的預設位置時，可以同步平移/傾斜操作和變焦操作，以實現更平滑的取景。

提示

您可以預先指定用於註冊預設位置的設定。在網路功能表中，將 [Pan-Tilt] > [P/T Preset] > [Default] > [Zoom Sync] 設定為 [On]。

當 [Pan-Tilt] > [P/T Preset] > [Speed Select] 設定為 [Common] 時，所有預設位置都將使用以 [Pan-Tilt] > [P/T Preset] > [Common
Speed] 設定的速度恢復。

變焦移動完成後，攝影機會移動到已儲存的焦點位置。

動作完成後，[AF Transition Speed] 會恢復為其原始設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。1

針對您想要變更轉變速度的預設位置，按下影像。

（預設位置功能表）按鈕會出現在影像的右上角。

2

按下 （預設位置功能表）按鈕，並從顯示的功能表中選取 [Edit…]。

出現所選預設位置的設定畫面。

3

滑動 [Zoom Sync] 切換到右側以開啟該功能，然後按下 [OK] 按鈕。

下次恢復儲存的位置時，攝像機將以配置的速度移動。

4
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在恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）

恢復已儲存的預設位置時，您可以變更轉變速度（平移/傾斜操作、變焦操作、對焦操作）。

提示

當 [Pan-Tilt] > [P/T Preset] > [Speed Select] 設定為 [Common] 時，所有位置都將使用以 [Pan-Tilt] > [P/T Preset] > [Common
Speed] 設定的速度恢復。

變焦移動完成後，攝影機會移動到已儲存的焦點位置。

動作完成後，[AF Transition Speed] 會恢復為其原始設定。

在網路功能表中，將 [Pan-Tilt] > [P/T Preset] > [Speed Select] 設定為 [Separate]。1

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。2

針對您想要變更轉變速度的預設位置，按下影像。

（預設位置功能表）按鈕會出現在影像的右上角。

3

按下 （預設位置功能表）按鈕，並從顯示的功能表中選取 [Edit…]。

出現所選預設位置的設定畫面。

4

使用滑桿來設定要變更的轉變速度（平移傾斜/變焦/對焦），或者直接輸入值，並按下 [OK] 按鈕。

下次恢復儲存的位置時，攝像機將以配置的速度移動。

5
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使用隨附的紅外線遙控器儲存/恢復平移/傾斜和變焦位置

您可以儲存平移/傾斜和變焦位置，並在需要時使用隨附的紅外線遙控器叫用它們。

相關主題

在恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）

5-041-957-83(1) Copyright 2022 Sony Corporation

調整攝像機的平移/傾斜和變焦。1

在網路應用程式之預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Pos.]。2

按下 PRESET 按鈕，並按下 1 至 3 按鈕之一。

位置已儲存。

3

復原已儲存的位置。

按下 1 至 3 按鈕之一，即可恢復該預設位置。

提示

恢復預置位置時的轉變速度由網路功能表中儲存的 [Pan-Tilt] > [P/T Preset] > [Pan-Tilt Speed] 值決定。您可以在儲存後變更
轉變速度。如需詳細資料，請參閱“恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）”。

4
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使用網路應用程式進行攝影機取景操作的錄製

您可以使用網路應用程式來錄製攝影機取景操作。

調整攝影機的操作開始位置。1

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Trace]。2

按下預設位置控制面板中的 [+] 按鈕。

新增縮圖，且攝影機切換到錄製待機狀態。

提示

按下 縮圖上的（關閉）按鈕可退出錄製待機狀態並恢復正常操作。

3
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提示

錄製時，剩餘錄製時間會顯示在攝影機影像面板的頂部。

注意

如果切換到天花板安裝，錄製的取景操作將被刪除

切換系統頻率，可能會刪除錄製的取景操作。

連接鏡頭控制器時，不會錄製變焦操作。

單次取景操作的錄製最長持續時間為 3 分鐘。錄製達到 3 分鐘時，錄製將自動停止。

如果 Clear Image Zoom 倍率大於 1 倍，則無法開始取景操作的錄製。

如果在錄製取景操作時從其他裝置操作攝影機，也會錄製其他裝置的操作。如需使用第三方遙控器進行錄製操作的詳細資料，請聯
絡相應製造商。

此功能不會錄製焦點和影像品質設定。

取景播放過程中，無法準確重現錄製取景作業時所錄製的平移/傾斜/變焦操作。

錄製取景操作後，如果使用網頁功能表中的 [Pan-Tilt] > [P/T Range Limit]，則在取景播放期間不會套用平移/傾斜範圍限制。如果要
同時使用取景操作和水平/傾斜限制功能，請在錄製取景作業之前設定水平/傾斜範圍限制。

選擇 RAW 視訊輸出時，無法播放錄製的取景操作。

視訊訊號未從 SDI 輸出連接器輸出時，無法播放錄製的取景操作。

使用控制桿和 [Zoom] 滑桿，開始取景操作。

自取景作業開始，錄製也將開始。

4

按下縮圖上的 （停止錄製）按鈕可停止錄製。5
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使用網路應用程式進行攝影機取景操作

您可以使用網路應用程式來播放已錄製的攝影機取景操作。

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Trace]。1

選擇包含待播放取景操作的縮圖。

（準備）按鈕出現在縮圖上。

2

按下 （準備）按鈕。

攝影機移動到取景操作開始位置，並切換到播放待機狀態。

3

按下縮圖上的 （播放）按鈕。4
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提示

播放待機狀態和播放過程中，您可以執行下列任意操作來取消播放並恢復正常操作。

按下縮圖上或預設位置控制面板中的 （停止）按鈕。
操作控制桿。
操作 [Zoom] 滑桿。

播放期間，已播放時間顯示在攝影機影像面板的頂部。

注意

如果取景操作之錄製和播放之間的 Clear Image Zoom 設定不同，則可能會出現意外行為。

連接鏡頭控制器時，不支援變焦操作播放。操作變焦，將停止取景操作的播放。

取景操作播放期間，無法使用網路功能表中的 [Pan-Tilt] > [P/T Range Limit] 變更平移/傾斜範圍限制。錄製取景操作之前，設定平
移/傾斜範圍限制。

5-041-957-83(1) Copyright 2022 Sony Corporation

取景播放開始。
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使用網路應用程式刪除攝影機錄製的取景操作

您可以使用網路應用程式來刪除攝影機錄製的取景操作。

5-041-957-83(1) Copyright 2022 Sony Corporation

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Trace]。1

選擇包含待刪除取景操作的縮圖。

（追蹤功能表）按鈕出現在縮圖上。

2

按下 （追蹤功能表）按鈕。

出現功能表。

3

從顯示的功能表中，選擇 [Delete]。

選擇的取景操作會被刪除。

4
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使用隨附的紅外線遙控器錄製攝影機取景操作

您還可以使用隨附的紅外線遙控器來錄製攝影機取景操作。

如需播放錄製的取景操作的詳細資料，請參閱“使用隨附的紅外線遙控器播放攝影機取景操作”。

注意

單次取景操作的錄製最長持續時間為 3 分鐘。錄製達到 3 分鐘時，錄製將自動停止。

如果在錄製取景操作時從其他裝置操作攝影機，則其他裝置的操作也會被錄製為取景操作的一部分。

如果在錄製取景作業時調整影像質量，則不會錄製該變更。

相關主題

使用隨附的紅外線遙控器播放攝影機取景操作

5-041-957-83(1) Copyright 2022 Sony Corporation

進入網路應用程式的即時操作畫面。1

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Trace]。2

使用紅外線遙控器，調整攝影機的操作開始位置。3

按下 PRESET 按鈕，並按下 POSITION1 至 3 按鈕之一。

攝影機切換到錄製待機狀態。

4

執行您要錄製的取景操作。5

若要結束錄製，請按住 PRESET 按鈕，然後按下步驟 4 中選擇的 POSITION 按鈕。6
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使用隨附的紅外線遙控器播放攝影機取景操作

您還可以使用隨附的紅外線遙控器來播放錄製的攝影機取景操作。

注意

攝影機的平移/傾斜/變焦操作將停止播放。

相關主題

使用隨附的紅外線遙控器錄製攝影機取景操作

5-041-957-83(1) Copyright 2022 Sony Corporation

進入網路應用程式的即時操作畫面。1

在預設位置控制面板頂部的下拉式清單中，將 PTZ 輔助模式設定為 [Trace]。2

對於已錄製的取景作業，選擇並按下 POSITION1 至 3 按鈕之一。

攝影機的平移/傾斜/變焦會移動到播放開始位置。

3

攝影機移動到播放開始位置後，再次按下相同的 POSITION 按鈕。

開始播放。

4
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對焦調整畫面

使用即時操作畫面的下列部分來調整對焦。

5-041-957-83(1) Copyright 2022 Sony Corporation

攝像機影像面板
您可以透過觸控攝像機影像來調整對焦。您可以透過關閉攝像機控制面板的  (Focus) 索引標籤上的 [Touch Focus]
開關來停用網路應用程式中的觸控操作。

1.

攝像機控制面板 –  (Focus) 索引標籤2.

GUI 控制面板3.

160



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用網路應用程式手動調整

例如，在下列情況下，您可以手動調整對焦。

被水滴遮擋一部份的拍攝對象
在背景下對比度較低的拍攝對象
拍攝對象比附近的拍攝對象更遠

注意

進行變焦操作時，無法從網路應用程式控制手動對焦。

提示

手動調整為主要操作方法時，也可以使用自動對焦。有關詳細資料，請參閱“使用網路應用程式手動設定自動對焦目標 (AF
Assist)”。

相關主題

檢查鏡頭開關

使用網路應用程式手動設定自動對焦目標 (AF Assist)

5-041-957-83(1) Copyright 2022 Sony Corporation

如果鏡頭裝有對焦選取器開關，請將開關設定在“AF/MF”或“AF”位置。

注意

如果將開關設定在“Full MF”或“MF”位置，則無法從裝置操作鏡頭對焦。請參閱“檢查鏡頭開關”中的“針對附帶對焦模式開關的
鏡頭”。

1

將 [Auto Focus] 開關滑到攝像機控制面板的左側位置，以關閉自動對焦。

啟動手動對焦。

 (MF)

2

使用  (Focus) 索引標籤底部的滑桿來進行調整。3
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使用隨附的紅外線遙控器手動調整

您可以使用隨附的紅外線遙控器手動調整對焦。

提示

手動調整為主要操作方法時，也可以使用自動對焦。有關詳細資料，請參閱“使用隨附的紅外線遙控器在自動對焦期間手動對焦”。

相關主題

使用隨附的紅外線遙控器在自動對焦期間手動對焦

5-041-957-83(1) Copyright 2022 Sony Corporation

按下紅外線遙控器上的 MF 按鈕。1

使用 F（遠）按鈕和 N（近）按鈕來手動調整對焦。

要對焦位於遠處的對象，請按下 F 按鈕。
要對焦位於近處的對象，請按下 N 按鈕。

2
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透過指定對焦位置進行對焦（點對焦）

在手動對焦模式中，您可以在攝像機影像窗格中指定要調整對焦的位置。

注意

如果將鏡頭設定為手動對焦，則 Spot Focus 功能將不會起作用。

提示

在點對焦模式中，您可以按下指派了 [Push AF/MF] 的可指派按鈕來暫時停止點對焦，並在按下該按鈕時啟用自動對焦。釋放按鈕
後，對焦將恢復手動對焦。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表或攝像機功能表中，將 [Shooting] > [Focus] > [Touch Function in MF] 設定為 [Spot Focus]。1

將  (Focus) 索引標籤上的 [Touch Focus] 開關滑動到右側位置以將其開啟。2

將  (Focus) 索引標籤上的 [Auto Focus] 開關滑動到左側位置以將其關閉。3

指定對焦位置。

點對焦標記出現，且影像被調整為在該位置對焦。

透過觸控操作來指定位置的範例

4
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暫時使用自動對焦 (Push Auto Focus (AF))

在手動對焦模式中，您可以按下 [Push AF/MF] 按鈕，在按下按鈕時暫時使用自動對焦來調整對焦。
您要在手動對焦期間將對焦從一個拍攝對象緩慢移到另一個拍攝對象時，此功能很實用。

注意

如果將鏡頭設定為手動對焦，則 Push Auto Focus 功能將不會起作用。

提示

使用指派給 [Push AF/MF] 的可指派按鈕支援相同的操作。

5-041-957-83(1) Copyright 2022 Sony Corporation

在攝像機功能表中，將 [Shooting] > [Focus] > [Push AF Mode] 設定為 [AF]。1

將  (Focus) 索引標籤上的 [Auto Focus] 開關滑動到左側位置以將其關閉。2

按下 [Push AF/MF] 按鈕。

在按下該按鈕時可啟動自動對焦。

鬆開按鈕時，將解除鍵控自動對焦，並變回手動對焦。

3
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使用單次自動對焦 (Push Auto Focus (AF-S))

在手動對焦模式中，您可以按下 [Push AF/MF] 按鈕進行自動高速對焦。
此功能可方便您在拍攝之前對焦於拍攝對象。

注意

如果將鏡頭設定為手動對焦，則 Push Auto Focus 功能將不會起作用。

使用 [Display] 按鈕時，不會隱藏對焦區域框。

在 Clear Image Zoom 操作期間，無法設定 [Focus Area (AF-S)] 框位置。在鍵控自動對焦操作期間，自動對焦操作也優先作用於中
央位置。

提示

在網路功能表或攝像機功能表中，將 [Shooting] > [Focus] > [Push AF Mode] 設定為 [Single-shot AF(AF-S)]。1

使用攝像機功能表中的 [Shooting] > [Focus] > [Focus Area (AF-S)] 來指定要調整對焦的位置。

提示

按下指派給 [Focus Setting] 的可指派按鈕以便在對焦區域周圍顯示橘色框，並使用觸控操作選擇位置，即可變更位置。

2

將  (Focus) 索引標籤上的 [Auto Focus] 開關滑動到左側位置以將其關閉。3

按下 [Push AF/MF] 按鈕。

如果您在對焦完成前鬆開按鈕，鍵控自動對焦將停止。

鍵控自動對焦期間，對焦狀態將由對焦指示燈顯示。
亮起：對焦固定在對焦位置。
閃爍：對焦模糊。由於本裝置不會自動對焦，請變更構圖和對焦設定以實現對焦。
釋放按鈕後，對焦將恢復手動對焦。

4
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使用指派給 [Push AF/MF] 的可指派按鈕支援相同的操作。

您也可以將 [Push AF Mode] 指派給可指派按鈕。

您也可以將 [Focus Area (AF-S)] 指派給可指派按鈕。

您可以使用攝像機功能表的 [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] 來顯示/隱藏對焦區域框。

5-041-957-83(1) Copyright 2022 Sony Corporation
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使用網路應用程式自動調整

本裝置使用相位偵測自動對焦進行高速對焦，使用對比度自動對焦進行高精準度對焦。
這兩種自動對焦方法的組合可提供高速和高精準度的自動對焦。

注意

需要支援自動對焦的鏡頭。

視拍攝條件而定，可能無法達到精準度。

無法在 A 接環鏡頭上自動調整對焦。

提示

在自動對焦模式下，您可以使用攝像機控制面板中的 Focus 滑桿來調整對焦。有關詳細資料，請參閱“使用網路應用程式手動設定
自動對焦目標 (AF Assist)”。

相關主題

檢查鏡頭開關

使用網路應用程式手動設定自動對焦目標 (AF Assist)

5-041-957-83(1) Copyright 2022 Sony Corporation

如果鏡頭裝有對焦選取器開關，請將開關設定在“AF/MF”或“AF”位置。

注意

如果將開關設定在“Full MF”或“MF”位置，則無法從裝置操作鏡頭對焦。請參閱“檢查鏡頭開關”中的“針對附帶對焦模式開關的
鏡頭”。

1

將 [Auto Focus] 開關滑到攝像機控制面板的右側位置以開啟。

啟動自動對焦。

 (AF)

2
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用隨附的紅外線遙控器自動調整

您可以使用隨附的紅外線遙控器自動調整對焦。

注意

手動調整為主要操作方法時，也可以使用自動對焦。有關詳細資料，請參閱“使用隨附的紅外線遙控器在自動對焦期間手動對焦”。

相關主題

使用隨附的紅外線遙控器在自動對焦期間手動對焦

5-041-957-83(1) Copyright 2022 Sony Corporation

按下紅外線遙控器上的 AF 按鈕。

會自動調整拍攝對象的對焦。

1
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

設定自動對焦區域/位置（對焦區域）

您可以設定自動對焦的目標區域並調整該區域的對焦。

按下 GUI 控制面板中的 [Menu] 按鈕，開啟攝影機功能表。1

使用攝像機功能表中的 [Shooting] > [Focus] > [Focus Area] 來設定自動對焦的目標區域。

[Wide]：
對焦時在影像的廣角範圍內搜尋拍攝對象。不會顯示外框。

[Zone]：
自動搜尋指定區域內的對焦位置。
選擇後，使用 GUI 控制區塊中的箭頭按鈕來指定位置。

按住 [Set] 按鈕可返回中心位置。
[Flexible Spot]：
對焦於影像中的指定位置。
選擇後，使用 GUI 控制區塊中的箭頭按鈕來指定位置。

2
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注意

使用攝像機影像窗格上的 [Display] 按鈕時不會隱藏對焦區域框。

Clear Image Zoom 期間，對焦區域設定為 [Wide]（固定）。

提示

您可以使用攝像機功能表的 [Monitoring] > [Display On/Off] > [Focus Area Indicator] 來顯示/隱藏對焦區域框。

5-041-957-83(1) Copyright 2022 Sony Corporation

按住 [Set] 按鈕可返回中心位置。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

快速變更對焦區域（對焦設定）

將 [Focus Setting] 指派給可指派按鈕，可以在拍攝過程中快速變更自動對焦區域的位置和尺寸。

有關可指派按鈕的詳細資料，請參閱“可指派按鈕”。

操作因對焦區域設定而異。

當攝像機功能表中的 [Shooting] > [Focus] > [Focus Area] 設定為 [Flexible Spot] 或 [Zone] 時。

您可以按下指派了[Focus Setting] 的可指派按鈕並使用 GUI 控制面板中的箭頭按鈕進行調整來變更對焦區域的位置。
您可以按下 [Set] 按鈕，在調整位置的同時將對焦區域的位置返回中央。
您可以按住指派給 [Focus Setting]的可指派按鈕來變更對焦區域的尺寸。變更尺寸後，您可以透過按下 [Set] 按鈕來變
更對焦區域的位置。完成後，按下指派給 [Focus Setting] 的可指派按鈕以返回原始畫面。

當攝像機功能表中的 [Shooting] > [Focus] > [Focus Area] 設定為 [Wide] 時

您只能透過按住指派給 [Focus Setting] 的可指派按鈕來變更對焦區域的尺寸。也可以先將類型變更為 [Flexible Spot] 或
[Zone] 來變更位置。

提示

攝像機功能表中的 [Shooting] > [Focus] > [Push AF Mode] 均設定為 [Single-shot AF(AF-S)] 且 [Auto Focus] 開關設定在 Off 位置時
（手動對焦模式），您可以更改 [Focus Area (AF-S)] 對焦區域的位置。

可以變更對焦區域的位置時，對焦區域框顯示為橘色。

相關主題

可指派按鈕

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用觸控操作來移動對焦區域框（觸控對焦區域）

按下指派了 [Focus Setting] 的可指派按鈕將對焦區域顯示變更為橘色，以變更對焦區域的位置，接著使用攝像機影像面板
中的觸控操作來移動對焦區域外框。
點選畫面以移動對焦區域，對焦區域位於點選位置的中央。在畫面上拖動，以便將對焦區域移動到手指所追蹤的位置。

提示

您可以使用指派了 [Focus Setting] 的可指派按鈕，在拍攝畫面上啟用/停用觸控對焦區域。

點選任何位置。

點選的位置會成為對焦區域的中心。

1

拖動以移動對焦區域，以便追蹤您的手指位置。2
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注意

如果點選某個位置或將對焦區域拖到超出設定範圍的位置，則對焦區域將設定為設定範圍的上/下/左/右邊緣。

在下列情況下，此功能不可用。

攝像機控制面板中的 [Touch Focus] 開關關閉時
對焦區域框顯示為灰色或完全不顯示時

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

調整自動對焦操作（AF 轉變速度、AF 拍攝對象移動靈敏度）

您可以透過變更轉變速度和拍攝對象移動靈敏度來調整自動對焦操作。

設定 AF 轉變速度

您可以使用攝像機控制面板中的 [AF Transition Speed] 按鈕來設定變更拍攝對象時的對焦驅動器速度。

以 1 為增量，在 [Speed 1]（慢）至 [Speed 7]（快）的範圍內選擇速度。按下 < 按鈕以降低數值（變慢），或按下 > 按鈕
以增加數值（變快）。
如果設定為低速，則當要對焦的拍攝對象變更時，對焦會緩慢移動，從而拍攝出絕佳的影像。
設定為高速時，對焦會在拍攝對象之間快速切換。在下列範例中，對焦從背景中的建築物快速變為前景中行走的人。會立
即對焦進入畫面的拍攝對象，因此此設定非常適合需要快速對焦的記錄拍攝。

AF 拍攝對象移動靈敏度

您可以使用攝像機控制面板中的 [AF Subj. Shift Sens.] 按鈕來設定在拍攝對象之間變換的靈敏度。
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以 1 為增量，在 [Sens 1] (Locked On) 至 [Sens 5] (Responsive) 的範圍內選擇靈敏度。按下 < 按鈕以降低數值（緩慢變
更），或按下 > 按鈕以增加數值（快速變更）。
設定為低靈敏度時，即使另一個拍攝對象在對焦拍攝對象前面移動，對焦也不會輕易移動。

設定為高靈敏度時，對焦將移動以優先對焦在前面移動的拍攝對象。

提示

如果將 [AF Speed/Sens.] 指派給可指派按鈕，每次按下該按鈕時，將按下列順序在攝像機影像面板中顯示用於調整值的程度列，以
便您變更 AF 轉變速度和 AF 拍攝對象移動靈敏度設定。
AF 轉變速度 → AF 拍攝對象移動靈敏度 → 不顯示…

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用網路應用程式手動設定自動對焦目標 (AF Assist)

手動移動和調整焦點後，您可以將焦點控制轉為自動對焦來對焦點進行精細調整。

注意

在 AF Assist 狀態下，無論攝像機功能表中的 [Shooting] > [Focus] > [AF Subj. Shift Sens.] 如何設定，都難以移動焦點。

可透過下列方式取消 AF Assist 狀態。

使用 [Focus] 滑桿對焦的拍攝對象不再可見時
切換到手動對焦時
即時追蹤自動對焦開始時

提示

使用指派給 [Push AF/MF] 的可指派按鈕，可以快速取消 AF Assist 狀態。

操作 [Focus] 滑桿時，即時追蹤自動對焦會停止。

在 Face/Eye Only AF 模式中，自動對焦將對焦在最靠近 [Focus] 滑桿之對焦位置的臉部。

在攝像機功能表中，將 [Shooting] > [Focus] > [AF Assist] 設定為 [On]。1

在網路功能表中，將 [Shooting] > [Focus] > [AF Assist Control] 設定為 [On]。2

將 [Auto Focus] 開關滑到攝像機控制面板的右側位置以開啟。

啟動自動對焦。

3

使用攝像機控制面板中的 [Focus] 滑桿來設定對焦目標。

[Near]：對焦近處的拍攝對象。
[Far]：對焦遠處的拍攝對象。

在 AF Assist 狀態下，位於使用 [Focus] 滑桿設定之距離處的拍攝對象將會自動對焦。

4
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用隨附的紅外線遙控器在自動對焦期間手動對焦

當攝影機功能表中的 [Shooting] > [Focus] > [AF Assist] 設定為 [On] 時，即使在自動對焦期間，您也可以使用隨附紅外線
遙控器上的 F（遠）按鈕和 N（近）按鈕來調整拍攝對象的對焦。

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

在自動對焦期間暫時使用手動對焦（鍵控手動對焦）

自動對焦模式中，按下 [Push AF/MF] 按鈕，在按下按鈕時手動對焦。釋放按鈕後，對焦將恢復自動對焦。
您可以藉此暫時停止自動對焦，並在非拍攝對象的物體經過拍攝對象前方時進行手動對焦。

提示

使用指派給 [Push AF/MF] 的可指派按鈕支援相同的操作。

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用臉部和眼部偵測進行追蹤 (Face/Eye Detection AF)

本裝置可以偵測人的臉部和眼部做為追蹤目標，然後在對焦區域內調整對臉部和眼部的對焦。
偵測到臉部時，將顯示灰色的臉部/眼部偵測框。可以進行自動對焦時，此框會變成白色並開始追蹤。偵測到眼部並調整對
焦時，臉部/眼部偵測框會顯示在眼部上。偵測到多人時，將自動確定主要拍攝對象。
只有對焦模式為 AF 模式或鍵控自動對焦時，才能使用此功能。

提示

對焦區域設定為 [Zone] 或 [Flexible Spot] 且臉部或眼部在指定對焦區域內重疊時，臉部/眼部偵測框將變成白色，同時裝置將自動
對焦於這些臉部/眼部。

使用鍵控自動對焦 (AF-S) 時，對於對焦狀態的臉部/眼部出現的臉部/眼部偵測框會變成綠色。

使用攝像機控制面板中的 [Face/Eye Detection AF] 按鈕來設定

按下 [Face/Eye Detection AF] 按鈕，並設定臉部/眼部偵測自動對焦操作。

[Face/Eye Only AF]：攝影機偵測拍攝對象（人）的臉部/眼部，並僅對這些人的臉部/眼部進行對焦和追蹤。未偵測到臉
部或眼部時，AF 會暫時停止，並顯示 （Face/Eye Only AF 模式自動對焦暫停）圖示。只想要自動對臉部/眼部進行對
焦和追蹤時，此模式很有效。
[Face/Eye Priority AF]：攝影機偵測拍攝對象（人）的臉部/眼部，並優先對臉部/眼部進行對焦/追蹤。未偵測到臉部或眼
部時，對焦處於 AF 模式（預設設定）。
[AF]：臉部/眼部偵測自動對焦功能停用。

注意

鍵控自動對焦操作期間，即使目前選取 [Face/Eye Only AF]，也會啟用 [Face/Eye Priority AF]。

[Auto Focus] 開關設定在 Off 位置時，臉部/眼部偵測自動對焦會停用（鍵控自動對焦操作期間除外）。

如果在選取 [Face/Eye Only AF] 的情況下關閉攝影機，則在下次開啟攝影機時，模式會自動切換為 [Face/Eye Priority AF]。

提示

您可以使用攝像機功能表的 [Shooting] > [Focus] > [Face/Eye Detection AF] 來設定臉部/眼部偵測自動對焦操作。

隱藏臉部/眼部偵測框
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您可以使用攝像機功能表的 [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] 來顯示/隱藏臉部/眼部偵測外
框。

注意

使用鍵控自動對焦 (AF-S) 對焦的臉部和眼部會顯示綠色的臉部/眼部偵測框，而使用 [Display] 按鈕或將 [Face/Eye Detection
Frame] 設定為 [Off] 時，這些畫面不會隱藏。

使用可指派按鈕來切換臉部/眼部偵測自動對焦操作

將 [Face/Eye Detection AF] 指派給可指派按鈕。然後，每次按下該按鈕，就可以按照 [Face/Eye Priority AF]、[Face/Eye
Only AF] 和 [AF] 的順序來切換臉部/眼部偵測自動對焦操作。

使用直接功能表進行設定

您也可以使用直接功能表來設定臉部/眼部偵測自動對焦操作。

有關直接功能表的詳細資料，請參閱“直接功能表操作”。

相關主題

直接功能表操作

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

追蹤指定拍攝對象（即時追蹤自動對焦）

您可以透過觸控操作或在攝像機控制區塊中選取臉部偵測框指定拍攝對象，來保持拍攝對象的對焦。
選取拍攝對象後，白色追蹤框會顯示並開始追蹤。

提示

無論對焦區域設定如何，都會對整個影像區域進行追蹤。

在網路功能表或攝像機功能表中將 [Shooting] > [Focus] > [Touch Function in MF] 設定為 [Tracking AF] 時，即使對焦模式為 MF 模
式，也支援即時追蹤自動對焦。

根據臉部/眼部偵測自動對焦操作模式設定，追蹤目標會發生下列動作。

[Face/Eye Only AF] 或 [Face/Eye Priority AF]：對焦和追蹤指定拍攝對象。
如果追蹤目標是人而且偵測到臉部/眼部，則攝影機會對焦該臉部/眼部。
偵測到追蹤目標臉部/眼部時，將儲存追蹤目標臉部。儲存時，會顯示 （儲存的追蹤臉部圖示）。

注意

如果在手動對焦期間啟動追蹤自動對焦，則不會儲存追蹤目標臉部。

[AF]：用於對指定主體進行對焦和追蹤。即使追蹤目標是人，也不會進行臉部/眼部偵測。

注意

如果將鏡頭設定為手動對焦，則即時追蹤自動對焦功能將不會起作用。

啟動即時追蹤自動對焦

將特定拍攝對象指定為追蹤目標時，該目標的追蹤就會開始。

透過觸控操作來指定

將攝影機控制面板 (Focus) 索引標籤上的 [Touch Focus] 開關滑動到右側位置將其開啟，然後在下列任意一種狀態下，
點選要追蹤的目標拍攝對象。
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在手動對焦或鍵控手動對焦期間，並且網路功能表或攝像機功能表中的 [Shooting] > [Focus] > [Touch Function in MF]
設定為 [Tracking AF] 時
在自動對焦或鍵控自動對焦期間 (AF)

透過臉部偵測框選取來指定

使用 GUI 控制區塊中的箭頭按鈕將臉部選取游標（橘色底線）移至要追蹤的目標拍攝對象，然後按下 [Set] 按鈕。

A：臉部偵測框（灰色）
B：追蹤框
C：臉部選取游標（橘色）

注意

在手動對焦期間，無法透過臉部偵測框選取開始追蹤。

提示

您也可以在即時追蹤自動對焦期間變更要追蹤的目標。

停止即時追蹤自動對焦

按下 （即時追蹤自動對焦停止）按鈕。

提示

即時追蹤自動對焦會在下列情況下停止：

切換鏡頭上的 [Auto Focus] 開關或 AUTO/MANUAL 控制時
對焦模式變更時
執行 AF Assist 時
對焦區域設定或臉部/眼部偵測自動對焦動作發生變化時
按下指派了 [Push AF/MF] 的可指派按鈕時
追蹤目標不在拍攝畫面內或拍攝對象模糊幾秒鐘時
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儲存追蹤臉部時（顯示 （儲存的追蹤臉部圖示）時），在儲存的追蹤臉部進入影像區域的情況下，將恢復即時追蹤自動對焦。
若要清除追蹤臉部，請如上所述停止即時追蹤自動對焦。

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
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亮度調整畫面

要調整亮度，您可以調整光圈、增益、快門速度，以及使用在網路應用程式即時操作畫面之下列控制面板中的 ND 濾鏡來
調整亮度等級。您還可以自動調整亮度。

注意

[Shooting Mode] 設定為 [Cine EI Quick] 或 [Cine EI] 時，無法調整增益。此外，設定為 [Cine EI Quick] 或 [Cine EI] 時，無法使用
快門速度自動調整亮度。支援使用光圈和 ND 濾鏡進行亮度自動調整。

提示

Cine EI 模式是一種為盡可能提高影像感測器性能以便在不使用增益的情況下以基本感光度進行拍攝的模式。使用照明和 ND 濾鏡
來調整亮度，調整到達影像感測器的光量。有關 Exposure Index (EI) 的詳細資料，請參閱 “變更錄製影像中陰暗區域和明亮區域的
分佈”。

攝像機控制面板 –  (Main) 索引標籤1.

攝像機基本配置面板
在按鈕上顯示拍攝所需的基本功能之設定狀態。按下按鈕，可顯示下方攝像機基本配置調整面板中每個功能相對應的
設定畫面。

2.

攝像機基本配置調整面板
顯示在攝像機基本配置窗格中所選設定項目的調整面板。

3.
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相關主題

變更錄製影像中陰暗區域和明亮區域的分佈

5-041-957-83(1) Copyright 2022 Sony Corporation
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設定基本感光度

您可以在開始調整亮度之前設定基本感光度。

[Shooting Mode] 設定為 [Custom] 時

按下攝像機基本配置面板中的 [ISO/Gain] 按鈕，然後將 ISO/Gain 調整面板上的 [Base Sensitivity] 設定為 [High] 或
[Low]。
正常光照條件下選擇 [Low]，低光照條件下選擇 [High]。
[AGC] 關閉時的畫面

[AGC] 開啟時的畫面

[Shooting Mode] 設定為 [Flexible ISO] 或 [Cine EI] 時

按下攝影機基本配置面板中的 [Base ISO/Exposure Index] 按鈕，然後將 Base ISO/Exposure Index 調整面板上的 [Base
ISO] 設定為 [ISO 12800] 或 [ISO 800]。
正常光照條件下選擇 [ISO 800]，低光照條件下選擇 [ISO 12800]。

提示
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您也可以在攝像機控制區塊的  (Main) 索引標籤上進行此設定。

也可以使用攝像機功能表中的 [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] 或 [Base ISO] 進行設定。

您也可以將 [Base ISO/Sensitivity] 指派給可指派按鈕。

在 [Cine EI Quick] 拍攝模式中，根據曝光指數來設定自動設定基本感光度。

5-041-957-83(1) Copyright 2022 Sony Corporation
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設定自動亮度調整的目標程度

使用攝像機控制面板中的 [AE Level] 滑桿來設定自動亮度調整的目標程度。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下攝像機控制面板中的  (Main) 索引標籤。

如果沒有顯示 [AE Level] 滑桿，請選擇兩個滑桿功能選擇按鈕的其中之一，並從列表中選擇 [AE Level] 滑桿。

顯示 [AE Level] 滑桿。

1

使用滑桿來設定目標程度。

將滑桿旋鈕調到左側使影像變暗。將滑桿旋鈕調到右側使影像變亮。

提示

也可以使用攝像機功能表中的 [Shooting] > [Auto Exposure] > [Level] 進行設定。

2
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自動調整光圈

您可以根據拍攝對象自動調整亮度。需要相容的鏡頭。

注意

無法在 A 接環鏡頭上自動調整光圈。

提示

您也可以將 [Auto Iris] 指派給可指派按鈕。

5-041-957-83(1) Copyright 2022 Sony Corporation

如果安裝具有 Auto Iris 開關的鏡頭，請將該開關設定為 AUTO。1

按下攝像機基本配置面板中的 [Iris] 按鈕。

[Iris] 按鈕的外框變成橘色。

Iris 調整面板隨即顯示。

2

將 [Auto] 開關滑到右側位置以開啟。

光圈切換至自動調整模式。自動調整的光圈值會顯示在開關的右側。

3
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手動調整光圈

您可以手動調整亮度。

暫時自動調整光圈

您也可以按下 Iris 調整面板上的 [Push Auto] 按鈕，在按下按鈕時自動調整光圈。

如果安裝具有 Auto Iris 開關的鏡頭，請將該開關設定為 AUTO。

注意

鏡頭的 Auto Iris 開關設定為 MANUAL 時，裝置上的 [Auto Iris] 和 [Push Auto Iris] 功能沒有作用。攝影機上的手動光圈調整
也沒有作用。

1

按下攝像機基本配置面板中的 [Iris] 按鈕。

[Iris] 按鈕的外框變成橘色。

Iris 調整面板隨即顯示。

2

將 [Auto] 開關滑到左側位置以關閉。

光圈切換至手動調整模式。

3

使用 [Iris] 滑桿或 [Iris] 調整按鈕來調整光圈。

提示

滑桿和調整按鈕設定相互連動。

您也可以將光圈指派給攝像機控制區塊中  (Main) 索引標籤上的滑桿。

4
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提示

按下指派了 [Push Auto Iris] 功能的可指派按鈕，在按下按鈕時自動調整光圈。
鬆開按鈕後，光圈將恢復成手動調整模式。

5-041-957-83(1) Copyright 2022 Sony Corporation
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自動調整增益

[Shooting Mode] 設定為 [Custom] 或 [Flexible ISO] 時，您可以使用增益設定來自動調整亮度。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表或攝像機功能表中，將 [Project] > [Shooting Mode] 設定為 [Custom]。1

按下攝像機基本配置面板中的 [ISO/Gain] 按鈕。

[ISO/Gain] 按鈕的外框變成橘色。

ISO/Gain 調整面板隨即顯示。

2

將 [AGC] 開關滑到右側位置以開啟。

增益切換至自動調整模式。自動調整的增益值會顯示在開關的右側。

提示

您也可以透過在攝像機功能表中將 [Shooting] > [Auto Exposure] > [AGC] 設定為 [On] 以執行相同的動作。

您也可以將 [AGC] 指派給可指派按鈕。

3
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手動調整增益

[Shooting Mode] 設定為 [Custom] 或 [Flexible ISO] 時，您可以使用增益設定來手動調整亮度。
您想要在使用固定光圈設定時調整曝光或要防止增益由於 AGC 而增加時，可以控制增益。

暫時手動調整增益

您還可以透過將 [ISO/Gain] 指派給攝像機控制面板中  (Main) 索引標籤上的滑桿功能選擇按鈕並使用滑桿來暫時調整增
益。
您想要以一個步驟調整曝光而不變更景深時，此功能很實用。
執行下列任意一項操作後，調整結果將恢復成使用 [ISO/Gain<L>] 配置的預設值。

變更 ISO/Gain 調整項目
切換基本感光度
將 AGC 開關設定至 On 位置

在網路功能表或攝像機功能表中，將 [Project] > [Shooting Mode] 設定為 [Custom]。1

按下攝像機基本配置面板中的 [ISO/Gain] 按鈕。

[ISO/Gain] 按鈕的外框變成橘色。

ISO/Gain 調整面板隨即顯示。

2

將 [AGC] 開關滑到左側位置以關閉。

增益切換至手動調整模式。

3

使用 [ISO/Gain] 滑桿或 [ISO/Gain] 調整按鈕來調整增益。

提示

滑桿和調整按鈕設定相互連動。

4

194



將本裝置的電源切換至待機狀態

使用可指派按鈕暫時自動調整增益

按下指派了[Push AGC] 功能的可指派按鈕，在按下按鈕時自動調整增益。
鬆開按鈕後，增益恢復成手動調整模式。
執行下列任意一項操作後，調整結果將恢復成使用 [ISO/Gain<L>] 配置的預設值。

變更 ISO/Gain 調整項目
切換基本感光度
將 AGC 開關設定至 On 位置
將本裝置的電源切換至待機狀態

注意

當攝像機功能表中的 [Shooting] > [Iris] > [Bokeh Control] 設定為 [On] 時，無法執行此功能。

5-041-957-83(1) Copyright 2022 Sony Corporation
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自動調整快門

您可以根據影像的亮度自動調整快門。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下攝像機基本配置面板中的 [Shutter] 按鈕。

[Shutter] 按鈕的外框變成橘色。

Shutter 調整面板隨即顯示。

1

按下 [Shutter Type] 按鈕，並從列表中選擇[Auto]。

提示

您也可以透過在攝像機功能表中將 [Shooting] > [Auto Exposure] > [Auto Shutter] 設定為 [On] 以執行相同的動作。

您也可以將 [Auto Shutter] 指派給可指派按鈕。

2
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手動調整快門

您可以手動調整快門。

按下攝像機基本配置面板中的 [Shutter] 按鈕。

[Shutter] 按鈕的外框變成橘色。

Shutter 調整面板隨即顯示。

1

按下 [Shutter Type] 按鈕，並從列表中選擇[Speed]。2

使用 [Speed] 滑桿或 [Speed] 調整按鈕來調整快門。

若要調整曝光時間以符合畫面間隔，請在步驟 2 中選取 [Off]。您還可以使用 [ECS]（頻率）來設定固定值，或者使用
[Auto] 進行自動調整。
範例：使用 [ECS]（頻率）進行設定

提示

滑桿和調整按鈕設定相互連動。

要使用 [Angle] 而非 [Speed] 或 [Off]，請在攝像機功能表中將 [Shooting] > [Shutter] > [Mode] 設定為 [Angle]。

3
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關於 ND 濾鏡

在光線過亮的情況下，可以透過變更 ND 濾鏡來設定適當的亮度。
拍攝明亮的拍攝對象時，過多關閉光圈可能會導致衍射模糊，因此產生開始模糊的影像（攝影機中的常見現象）。您可以
使用 ND 濾鏡抑制該效果以獲得更好的拍攝效果。
本裝置有下列 ND 濾鏡模式。
預設模式

請參閱“在預設模式中調整”。

可變模式（自動調整）

請參閱“在可變模式中自動調整”。

可變模式（手動調整）

請參閱“在可變模式中手動調整”。

相關主題

在預設模式中調整

在可變模式中自動調整

在可變模式中手動調整

5-041-957-83(1) Copyright 2022 Sony Corporation
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在預設模式中調整

您可以預先選擇三個 ND 濾鏡透射率值，並在拍攝時於三者之間快速切換。

提示

按下指派了 [ND Filter Position] 的可指派按鈕時，ND 濾鏡會按照 [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear] 的順序變
化。
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在攝像機功能表中，將 [Shooting] > [ND Filter] > [Mode] 設定為 [Preset]。1

按下攝像機基本配置面板中的 [ND Filter] 按鈕。

[ND Filter] 按鈕的外框變成橘色。

ND Filter 調整面板隨即顯示。

2

按下 [ND Filter] 按鈕，並從列表中選擇下列其中之一。

[Clear]：無 ND 濾鏡。
[Preset1]：透過攝像機功能表中的 [Shooting] > [ND Filter] > [Preset1] 設定透射率。
[Preset2]：透過攝像機功能表中的 [Shooting] > [ND Filter] > [Preset2] 設定透射率。
[Preset3]：透過攝像機功能表中的 [Shooting] > [ND Filter] > [Preset3] 設定透射率。

當為 ND 濾鏡選擇 [Preset1] 至 [Preset3] 其中之一時，透射率值會顯示在 ND 濾鏡名稱旁邊。

3
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在可變模式中自動調整

您可以使用 ND 濾鏡啟用自動曝光調整。

注意

在拍攝過程中將 ND 濾鏡切換為 [Clear] 或從 [Clear] 進行切換時，ND 濾鏡框會顯示在影像上，且會發出操作聲音。

提示

您也可以將 [Auto ND Filter] 指派給可指派按鈕，然後按下該按鈕在 [Auto] 和 [Manual] 之間切換。
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在攝像機功能表中，將 [Shooting] > [ND Filter] > [Mode] 設定為 [Variable]。1

按下攝像機基本配置面板中的 [ND Filter] 按鈕。

[ND Filter] 按鈕的外框變成橘色。

ND Filter 調整面板隨即顯示。

2

按下 [ND Filter] 按鈕，並從列表中選擇[Auto]。

自動調整的 ND 濾鏡透射率值顯示在 [ND Filter] 按鈕旁邊。

3

201



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

在可變模式中手動調整

您可以使用 ND 濾鏡執行手動曝光調整。

暫時自動調整

您可以將 [Push Auto ND] 指派給可指派按鈕，按下該按鈕時可暫時開啟自動 ND 濾鏡。釋放該按鈕可將自動 ND 濾鏡重新
設定為 Off。
將 ND 濾鏡設定成 [Manual]。

注意

在拍攝過程中將 ND 濾鏡切換為 [Clear] 或從 [Clear] 進行切換時，ND 濾鏡框會顯示在影像上，且會發出操作聲音。

提示

在攝像機功能表中，將 [Shooting] > [ND Filter] > [Mode] 設定為 [Variable]。1

按下攝像機基本配置面板中的 [ND Filter] 按鈕。

[ND Filter] 按鈕的外框變成橘色。

ND Filter 調整面板隨即顯示。

2

按下 [ND Filter] 按鈕，並從列表中選擇[Manual]。3

使用 [ND Filter] 滑桿或 [ND Filter] 調整按鈕來調整 ND 濾鏡的透射率。

提示

滑桿和調整按鈕設定相互連動。

您也可以在攝像機控制區塊中的  (Main) 索引標籤上調整 ND 濾鏡。

4
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您也可以將 [ND Filter Position] 指派給可指派按鈕，然後按下該按鈕在 [Manual] 和 [Clear] 之間切換。

您也可以按下 ND Filter 調整面板上的 [Push Auto] 按鈕，在按下按鈕時開啟自動 ND 濾鏡。

5-041-957-83(1) Copyright 2022 Sony Corporation
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白平衡調整畫面

您可以使用網路應用程式的即時操作畫面來調整白平衡，以獲得使影像看起來更加自然的白平衡。

5-041-957-83(1) Copyright 2022 Sony Corporation

攝像機基本配置面板1.

攝像機基本配置調整面板
顯示在攝像機基本配置窗格中所選設定項目的調整面板。

2.
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自動調整白平衡

您可以使用 ATW（自動追蹤白平衡）隨時獲得適當調整的白平衡。
啟用 ATW 後，白平衡會隨著光源色溫的變化而自動調整。

注意

當 [Shooting Mode] 設定為 [Cine EI] 或 [Cine EI Quick] 時，無法使用 ATW。

按照光線和拍攝對象的情況，可能無法使用 ATW 調整為適當的顏色。
範例：

拍攝對象多為單色時，例如天空、海洋、地面或花朵。
色溫極高或極低時。

如果 ATW 自動追蹤速度較慢或者無法獲得適當的效果，請按下 [WB SET] 按鈕執行自動白平衡。

提示

您可以藉由使用攝像機功能表中的 [Shooting] > [White Setting] > [ATW Speed]，從五個步驟（1、2、3、4、5）中選擇處於 ATW
模式時的回應速度。數字越小，回應速度越快。

您可以將 [ATW Hold] 功能指派給可指派按鈕，然後在 ATW 模式下按下可指派按鈕來暫時暫停 ATW，以凍結目前的白平衡設定。
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按下攝像機基本配置面板中的 [White Balance] 按鈕。

[White Balance] 按鈕的外框變成橘色。

White Balance 調整面板隨即顯示。

1

按下 [White Mode] 按鈕，並從列表中選擇[ATW]。2
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手動調整白平衡

您可以手動調整白平衡。

按下攝像機基本配置面板中的 [White Balance] 按鈕。

[White Balance] 按鈕的外框變成橘色。

White Balance 調整面板隨即顯示。

1

按下 [White Mode] 按鈕，並從列表中選擇下列其中之一。

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

使用滑桿或調整按鈕來調整白平衡。

提示

滑桿和調整按鈕設定相互連動。

[Memory A(T/T)] 和 [Memory A(R/B)] 之間的區別在於調整的軸不同，但調整結果相互連動。

有關 [Memory A(T/T)]
此模式透過調整色溫 (Temp) 和 Tint 來調整記憶卡 A 中儲存的白平衡。
您可以在 2000 K 到 5600 K 的範圍內以 20 K 為增量設定色溫。對於大於 5600 K 的值，可以在等於 5580 K 到 5600
K 的顏色變化量（邁爾德）的間隔內設定。
按下 [Temp] 或 [Tint] 右側的 [Reset] 按鈕，可將相對應設定還原為預設值。

3
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有關 [Memory A(R/B)]
此模式透過調整 R Gain 和 B Gain 來調整記憶卡 A 中儲存的白平衡。
按下 [Reset] 按鈕，可將相對應的增益值還原成預設值。
有關 [Preset]
此模式將色溫調整為預設值。
您能夠以 100 K 為增量來設定該值。
預設模式中，您也可以將 [Preset White Select] 指派給可指派按鈕，然後按下該按鈕變更成預先配置的預設值。
[Custom]：3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO]、[Cine EI]、[Cine EI Quick]：3200 K → 4300 K → 5500 K → 3200 K…
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執行自動白平衡

在記憶卡 A 模式中，將自動調整要儲存的白平衡。

按下攝像機基本配置面板中的 [White Balance] 按鈕。

[White Balance] 按鈕的外框變成橘色。

White Balance 調整面板隨即顯示。

1

按下 [White Mode] 按鈕，並從列表中選擇 [Memory A(T/T)] 或 [Memory A(R/B)]。

[Memory A(T/T)]

[Memory A(R/B)]

2

將白紙（或其他物體）放置在與拍攝對象具有相同光源和條件的位置，然後放大白紙以在畫面上顯示白色。3

調整亮度。

使用“手動調整光圈”中的步驟來調整光圈。

4

按下白平衡調整面板上的 [WB SET] 按鈕。

[Memory A(T/T)]

[Memory A(R/B)]

5
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注意

如果調整不成功，畫面上會顯示錯誤訊息約 3 秒。反覆嘗試設定白平衡後，如果錯誤訊息仍然存在，請聯絡 Sony 服務代表。

提示

您也可以在 ATW 模式下運行。當您想在 ATW 操作期間快速調整白平衡時，您可以使用它。調整後，模式將返回正常的 ATW 操
作。

相關主題

手動調整光圈

5-041-957-83(1) Copyright 2022 Sony Corporation

如果在記憶卡模式中運行自動白平衡，自動調整的結果將儲存在記憶卡 A 中。
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音訊配置畫面

您可以在網路應用程式的即時操作畫面上調整要由本裝置錄製的音訊音量。配置裝置連接器插頭塊上的開關，並使用攝像
機功能表或網路功能表配置音訊。

5-041-957-83(1) Copyright 2022 Sony Corporation

攝像機控制面板 –  (Audio) 索引標籤1.
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選取音訊輸入裝置

根據連接到 AUDIO IN 連接器的裝置來設定以下開關。

注意

在 Interval Rec 模式或 Slow & Quick Motion 模式中不會錄製音訊。

5-041-957-83(1) Copyright 2022 Sony Corporation

連接麥克風時，設定本機後側連接器插頭塊上的 SETUP 開關 2。

CH-1 及 CH-2 具有通用設定。

1

設定 描述

OFF（預
設）

使用動圈式麥克風或電池供電的麥克風時選擇。這將關閉 +48 V 幻象電源，並將 LINE 或 MIC 輸入
設定為 CH-1 和 CH-2 音訊源。

ON
使用 +48 V 幻象電源相容麥克風時選擇。這將開啟 +48 V 幻象電源，並將相容幻象電源的麥克風設
定為 CH-1 和 CH-2 音訊源。

使用攝像機功能表中的 [Audio] > [Audio Input] > [AUDIO IN Select] 來設定連接裝置的類型。2

使用網路功能表或攝像機功能表中的 [Audio] > [Audio Input] > [CH1 Input Select] 至 [CH4 Input Select] 來選擇
音訊輸入。

3
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自動調整音訊錄製音量

在網路功能表中的 [Audio] 頁面上或使用攝像機功能表中的 [Audio] > [Audio Input] > [CH1 Level Control] 至 [CH4 Level
Control]，將您想要自動調整音訊錄製音量的通道設定為 [Auto]。
指定為自動調整的通道將由即時操作畫面的  (Audio) 索引標籤上之相對應通道旁邊的 （自動）圖示指示。

5-041-957-83(1) Copyright 2022 Sony Corporation
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手動調整音訊錄製音量

您可以手動調整音訊錄製音量。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表中的 [Audio] 頁面上或使用攝像機功能表中的 [Audio] > [Audio Input] > [CH1 Level Control] 至
[CH4 Level Control]，將您想要手動調整音訊錄製音量的通道設定為 [Manual]。

1

按下攝像機控制面板中的  (Audio) 索引標籤。2

在攝像機控制區塊的 [Audio] 畫面上，針對您想要手動設定音訊錄製音量的通道，使用滑桿或調整按鈕來設定音訊錄
製音量。

注意

顯示  （自動）圖示的通道會自動調整。使用滑桿或按鈕對數值做的變更不會套用到錄製的音訊。

提示

每一行的滑桿和調整按鈕設定相互連動。

您可以使用拍攝畫面上顯示的音訊音量表即時檢查音訊輸入音量。

3
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直接功能表操作

您可以檢查重疊在攝像機影像上的本裝置狀態和設定，並使用紅外線遙控器上的 GUI 控制按鈕來選擇和更改設定。
可以配置下列項目。
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter] 值
[Auto Iris]
[Iris] 值
[AGC]
[Gain] 值
[ISO] 值
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter] 值
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] 和 [Frame Rate]

提示

您還可以使用可指派按鈕和網路應用程式的 GUI 控制區塊來執行相同功能。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下紅外線遙控器上指派了 [Direct Menu] 的可指派按鈕。

原廠預設將 [Direct Menu] 按鈕指派給可指派按鈕 1。
使用橘色游標只能選取可以使用直接功能表配置的畫面上出現的項目。

1

使用 GUI 控制面板中的箭頭按鈕將游標移動到要設定的項目，然後按下 [Set] 按鈕。

顯示功能表或項目顯示在白色背景上。

2

使用箭頭按鈕選擇設定，然後按下 [Set] 按鈕。

功能表或白色背景消失，新設定以橘色游標顯示。
再次按下指派給 [Direct Menu] 的可指派按鈕，或者等待 3 秒而不執行任何操作以退出直接功能表。

3
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可指派按鈕

本裝置上有 10 個可指派按鈕，可供您指派功能。
可指派按鈕顯示在即時操作畫面和播放操作畫面上。

注意

在即時操作畫面的攝像機基本操作面板中配置設定時，不會顯示可指派按鈕列表。要結束操作，請按下調整面板右上方的 [X] 按
鈕。

原廠預設將下列功能指派給按鈕。
按鈕 1：[Direct Menu]
按鈕 2：[Focus Setting]
按鈕 3：[Rec Review]

按鈕 1 至 3 等同於隨附紅外線遙控器上的相同數字按鈕。

按鈕 4：[Push Auto ND]
按鈕 5：[Crop Select]
按鈕 6：[Marker]
按鈕 7：[Video Signal Monitor]
按鈕 8：[Clip Flag OK]
按鈕 9：[Color Bars]
Focus Hold 按鈕：[Focus Hold]

Focus Hold 按鈕等同於 E 接環鏡頭上的 Focus Hold 按鈕。

變更按鈕功能

使用攝像機功能表中的 [Project] > [Assignable Button]。
更改指派時，可指派按鈕列表的顯示會變更。
有關可指派功能的詳細資料，請參閱“攝像機功能表和詳細設定”中的“Assignable Button”。

相關主題

Assignable Button

5-041-957-83(1) Copyright 2022 Sony Corporation
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慢動作和快動作

將錄製格式設定為下列值時，可以為拍攝影格率和播放影格率指定不同的值。
下表顯示了可配置的影格率。

系統頻率：59.94/50/29.97/25/23.98，成像儀掃描模式：FF

系統頻率：59.94/50/29.97/25/23.98，成像儀掃描模式：S35

系統頻率：24，成像儀掃描模式：FF

注意

在錄製、播放或顯示縮圖畫面時，無法設定 Slow & Quick Motion。

Slow & Quick Motion 模式不支援音訊錄製。

在 Slow & Quick Motion 模式中，自動光圈和自動快門功能會停用。

自動對焦在慢動作和快動作模式中有下列限制。

限制基於鏡頭型號、系統頻率和拍攝影格率

轉碼器 視訊格式 配置影格率

RAW 3840×2160P 1–60、100、120

RAW & XAVC-I 3840×2160P 1–60、100、120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60、100、120

1920×1080P 1–60、100、120、150、180、200、240

XAVC-L
3840×2160P 1–60、100、120

1920×1080P 1–60、100、120、150、180、200、240

轉碼器 視訊格式 配置影格率

XAVC-I 1920×1080P 1–60、100、120

XAVC-L 1920×1080P 1–60、100、120

轉碼器 視訊格式 配置影格率

XAVC-I 4096×2160P 1–60

Sony 鏡頭 系統頻率 AF 可用性

SEL16F28 除外 – 支援 7 fps 或更高
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如果光圈設定為 F18 或更高，自動對焦功能將暫時停用。

有關使用 RAW 輸出的詳細資料，請參閱“錄製 RAW 視訊”。

相關主題

錄製 RAW 視訊

5-041-957-83(1) Copyright 2022 Sony Corporation

Sony 鏡頭 系統頻率 AF 可用性

SEL16F28

59.94/29.97/23.98 支援 30、60、120、240 fps

50.00/25.00 支援 25、50、100、200 fps

24.00 不支援
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間歇錄製視訊 (Interval Rec)

借助 Interval Rec 功能，您可以以間歇錄製視訊到本裝置的內部記憶體。此功能是拍攝慢動作拍攝對象的有效方法。
開始錄製時，裝置會在指定的間隔時間 (Interval Time) 自動錄製指定數量的畫面 (Number of Frames)。

A：拍攝間隔 (Interval Time)
B：一次拍攝的畫面數 (Number of Frames)

注意

任何時候都只能使用一種特殊的錄製功能，例如 Interval Rec 錄製。

如果在使用 Interval Rec 時啟用另一種特殊的錄製模式，則 Interval Rec 會自動解除。

變更系統設定（例如視訊格式）後，Interval Rec 模式將自動解除。

在錄製或播放期間或顯示縮圖畫面時，無法變更 Interval Rec 設定。

錄製期間的限制

不會錄製音訊。
無法查核錄製 (Rec Review)。

如果在錄製過程中關閉本裝置

如果將本裝置上的電源設定為待機狀態，可存取該媒介幾秒，以錄製儲存在記憶卡中的影像直至此時為止，然後本裝
置會自動切換至待機狀態。
如果拔除直流電源線、關閉交流變壓器的電源或斷開 PoE++ 電源供電，則該點的拍攝畫面可能會遺失（最長 10
秒）。請務必小心操作。

設定影格數和拍攝間隔

在網路功能表中，將 [Project] > [Interval Rec] > [Setting] 設定為 [On] ，然後設定 [Number of Frames] 和 [Interval Time]。
關閉電源後，本裝置將退出 Interval Rec 模式，不過會保持 [Number of Frames] 及 [Interval Time] 設定。下次在 Interval
Rec 模式中拍攝時，無需再次進行這些設定。

提示
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也可以使用攝像機功能表中的 [Project] > [Interval Rec] 進行設定。

開始拍攝

按下錄製 START/STOP 按鈕開始錄製。“Int●Rec”及“Int●Stby”交替出現。

停止拍攝

停止錄製。
拍攝結束時，會將截至該時間在記憶卡中儲存的視訊資料寫入媒介。
要退出 Interval Rec 模式，請執行下列操作之一。

將本裝置的電源切換至待機狀態。
在錄製待機模式下，將 [Project] > [Interval Rec] > [Setting] 設定為 [Off]。

此外，重啟裝置後，會自動解除 Interval Rec 模式。

5-041-957-83(1) Copyright 2022 Sony Corporation
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錄製快取的圖像 (Picture Cache Rec)

Picture Cache Rec 功能可供您在開始錄製時透過在拍攝時保留指定持續時間的內部快取記憶體來回溯錄製視訊。

設定快取大小

在網路功能表中，將 [Project] > [Picture Cache Rec] > [Setting] 設定為 [On] ，然後使用 [Cache Size] 來設定快取大小。

注意

Picture Cache Rec 無法與 Interval Rec、2 插槽同時錄製或代理錄製結合使用。Picture Cache Rec 設定為 On 時，這些其他特殊
錄製模式將強制設定為 Off。

在錄製或 Rec Review 進行時無法選取 Picture Cache Rec 模式。

當 Picture Cache Rec 設定為 On 時，即使設定為 [Regen] 或 [Rec Run]，時間碼還是以 [Free Run] 模式錄製。

在 Picture Cache Rec 模式中，可能無法配置 [Output Format] 設定。如果發生這種情況，請暫時將 Picture Cache Rec 設定為
Off，然後變更設定。

提示

快取時間可能會較短，具體取決於錄製格式。檢查網路功能表中的 [Project] > [Picture Cache Rec] > [Cache Rec Time] 顯示的時
間。

也可以使用攝像機功能表中的 [Project] > [Picture Cache Rec] 進行設定。

您也可以使用可指派按鈕，在 On 和 Off 之間切換 [Picture Cache Rec]。

啟動 Picture Cache Rec

[Picture Cache Rec] 設定為 On, 時，會出現“●Cache”（● 為綠色）。
按下錄製 START/STOP 按鈕時，錄製會開始，視訊會從儲存視訊的快取記憶體寫入記憶卡。

注意

變更錄製格式或基本風格會清除快取記憶體中直至當時儲存的視訊，並開始快取新視訊。因此，即使您在變更格式後立即開始錄
製，也無法在變更格式之前對圖像進行快取錄製。

如果在插入記憶卡後立即將 Picture Cache Rec 設定為 On 或 Off，則快取資料可能不會錄製在記憶卡上。

Picture Cache Rec 功能設定為 On 時，視訊會儲存在快取記憶卡中。該功能設定為 On 之前的視訊不會予以快取。

正在存取記憶卡時，視訊不會儲存在快取記憶體中，例如在播放、Rec Review 或縮圖畫面顯示期間。無法在該時間間隔內對視訊
進行圖像快取錄製。

[Cache Size] 設定 快取時間（大約）

[Short] 5 秒

[Medium] 10 秒

[Long] 20 秒

[Max] 各個錄製格式的最大值
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取消 Picture Cache Rec

在網路功能表中，將 [Project] > [Picture Cache Rec] > [Setting] 設定為 [Off]，或按下指派了 [Picture Cache Rec] 功能的
可指派按鈕。

5-041-957-83(1) Copyright 2022 Sony Corporation
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同時錄製到記憶卡 A 和 B (2-slot Simul Rec)

在網路功能表或攝像機功能表中，將 [Project] > [Simul Rec] > [Setting] 設定為 [On]，即可同時錄製到記憶卡 A 和記憶卡
B。

分別錄製到記憶卡 A 和記憶卡 B

您可以使用錄製 START/STOP 按鈕或  (Others) 索引標籤上的錄製 [2nd Rec START/STOP] 按鈕個別開始/停止錄製到
各個記憶卡。
依據原廠預設，兩個按鈕都設定為開始/停止同時錄製到記憶卡 A 和 B。
按鈕設定為控制不同記憶卡的錄製時，[SDI/HDMI Rec Control] 錄製開始/停止控制遵循插槽 A 的錄製狀態。

變更設定

使用攝像機功能表中的 [Project] > [Simul Rec] > [Rec Button Set] 來進行下列設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

[Rec Button Set] 設定 按鈕和記憶卡

Rec Button：<Slot A >
<Slot B >
2nd Rec Button：<Slot A
> <Slot B >

使用任一按鈕開始/停止同時錄製到記憶卡 A 和 B。

Rec Button：<Slot A >
2nd Rec Button：<Slot B
>

錄製 START/STOP 按鈕開始/停止錄製到記憶卡 A，且  (Others) 索引標籤上的 [2nd
Rec START/STOP] 按鈕開始/停止錄製到記憶卡 B。

Rec Button：<Slot B >
2nd Rec Button：<Slot A
>

錄製 START/STOP 按鈕開始/停止錄製到記憶卡 B，且  (Others) 索引標籤上的 [2nd
Rec START/STOP] 按鈕開始/停止錄製到記憶卡 A。
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視訊訊號監視器

您可以使用攝像機功能表中的 [Monitoring] > [Video Signal Monitor] > [Setting]，將攝像機影像面板中顯示的視訊訊號類型
設定為波形、向量示波器或直方圖。
橘線表示 [Level Marker 1] 及 [Level Marker 2] 的設定值。
您也可以將 [Video Signal Monitor] 功能指派給可指派按鈕。

監視目標顯示

在日誌拍攝模式中，色域設定或監視器 LUT 設定資訊顯示於視訊訊號監視器的右上角，用以指示監視器目標。

5-041-957-83(1) Copyright 2022 Sony Corporation
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剪輯旗標

透過按下已指派 [Clip Flag OK] 功能的可指派按鈕，並選擇 [Add OK]，可以將 [OK] 剪輯旗標添加至剪輯。
按下該按鈕兩次，並選取 [Delete Clip Flag]，可以刪除 [OK] 剪輯旗標。

提示

您還可以使用攝像機功能表中的 [Thumbnail] > [Set Clip Flag] 來添加剪輯旗標。

縮圖畫面可以按剪輯旗標類型分類顯示（已過濾剪輯縮圖畫面）。有關詳細資料，請參閱“縮圖畫面”中的“已錄製剪輯的操作”。

相關主題

已錄製剪輯的操作

5-041-957-83(1) Copyright 2022 Sony Corporation
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呼吸補償

您可以使用攝像機功能表中的 [Technical] > [Lens] > [Breathing Compensation] 來設定是否對鏡頭進行呼吸補償。
此功能可校正隨著焦點位置變化而發生視角變化的現象。
執行呼吸補償時，影像的一部分會受到電子方式的裁斷而保持恆定的視角，因此不會出現呼吸現象。

注意

啟用呼吸補償時，視角和影像品質可能會略微變化。

根據鏡頭的不同，啟用呼吸補償時可能無法校正視角的變化。

安裝不支援呼吸補償的鏡頭時，無法進行補償。

在下列情況下，此功能設定為 Off（固定）。

當攝像機功能表中的 [Technical] > [Lens] > [Distortion Comp.] 設定為 [Off] 時
當網路功能表或攝像機功能表中的 [Shooting] > [S&Q Motion] > [Setting] 設定為 [On] 時
當網路功能表或攝影機功能表中的 [Project] > [Rec Format] > [Codec] 設定為 [RAW] 或 [RAW & XAVC-I] 時

5-041-957-83(1) Copyright 2022 Sony Corporation
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代理錄製概述

此功能允許您在錄製高解析度原始資料視訊時，同時錄製低解析度代理資料。

有關所支援記憶卡、將記憶卡格式化以及檢查剩餘容量的詳細資料，請參閱“準備記憶卡”中的“支援的記憶卡”。

關於錄製的檔案

檔案副檔名是“.mp4”。
也會同時錄製時間碼。

錄製檔案的儲存目的地

將錄製的檔案儲存在下列目錄中。

關於檔案名稱

檔案名稱由記憶卡上錄製的剪輯名稱和尾碼“S03”組成。
有關剪輯名稱，請參閱攝像機功能表中的 [TC/Media] > [Clip Name Format]。

相關主題

支援的記憶卡

5-041-957-83(1) Copyright 2022 Sony Corporation

錄製媒介 資料夾路徑

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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錄製代理

您可以在啟用代理錄製時開始錄製。

停止拍攝

停止錄製。

設定代理錄製的音訊通道

使用攝像機功能表中的 [Project] > [Proxy Rec] > [Audio Channel] 來設定代理資料錄製的音訊通道。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表或攝像機功能表中，將 [Project] > [Proxy Rec] > [Setting] 設定為 [On]。1

將記憶卡插入 CFexpress Type A / SD 記憶卡插槽。

插入 CFexpress 記憶卡時，標籤朝上。
插入 SD 記憶卡時，標籤朝下。

注意

無法將 Proxy Rec 與 S&Q Motion 或 Interval Rec 同時設定為 On。將 Proxy Rec 設定為 On 時，其他這些錄製模式將被強制
設定為 Off。

2

按下錄製 START/STOP 按鈕。

開始代理錄製。

注意

如果在存取記憶卡時關閉攝影機或取出記憶卡，將無法保證記憶卡中的資料完整性。
在記憶卡上錄製的所有資料可能會遺失。關閉裝置或取出記憶卡之前，務必確認記憶卡存取指示燈已熄滅。

確認插入或取出記憶卡時未彈出記憶卡。

3
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風格概述

裝置處於 Custom 模式時，您可以對黑色、矩陣和其他參數進行調整，以按照基本風格建立“風格”。

您也可以在場景檔案中儲存不同的設定組合來快速選取其他風格。
本裝置總共提供七種預設風格。

5-041-957-83(1) Copyright 2022 Sony Corporation
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選取風格

本主題介紹如何選取風格。

檢查網路功能表或攝像機功能表中的 [Project] > [Base Setting] > [Shooting Mode] 是否設定為 [Custom]。

提示

在 [Custom] 模式中，[ISO/Gain] 按鈕及 [Scene File] 按鈕顯示在攝像機基本配置面板中。

1

按下攝像機基本配置面板中的 [Scene File] 按鈕。

[Scene File] 按鈕的外框變成橘色。

Scene File 調整面板隨即顯示。

2

按下調整面板上的 [Scene File] 按鈕，然後從列表中選取具有所需風格的場景檔案。

下列預設是原廠預設配置。

提示

您還可以使用攝像機功能表中的 [Paint/Look] > [Scene File] > [Recall] 來選擇風格。您也可以使用 [Scene File] > [Preset
Recall] 叫用預設風格。

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

場景檔案 1 [S-Cinetone] [HLG Live]

場景檔案 2 [Standard] [HLG Natural]

場景檔案 3 [Still] （不登錄）

場景檔案 4 [ITU709] （不登錄）

場景檔案 5 [709tone] （不登錄）

場景檔案 6 至 16 （不登錄） （不登錄）
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注意

場景檔案 5 預設設定為 [709tone] 軟體版本 2.0 或更高版本。執行網路功能表中的 [Maintenance] > [Reset] > [Factory
Default] 時，這會顯示。
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匯入所需的基本風格

您可以匯入在電腦或其他裝置上建立的 3D LUT 檔案做為基本風格。最多可以匯入 16 個檔案。

檔案格式：使用 Catalyst Browse、RAW Viewer 或 DaVinci Resolve*（由 Blackmagic Design Pty. Ltd. 提供）建立的 17
格線或 33 格線 3D LUT 的 CUBE 檔案 (*.cube)。

輸入色域/Gamma：[S-Gamut3.Cine/S-Log3] 或 [S-Gamut3/S-Log3]

調整曝光不足

經由 Resolve V9.0、V10.0 和 V11.0 進行驗證。*

將 3D LUT 檔案儲存在運行網路應用程式的裝置上。1

在網路功能表中，開啟 [Paint/Look] > [Base Look]。

已註冊基本風格清單隨即顯示。

2

在要匯入檔案之列中，按下 [Import] 按鈕。

出現檔案選取對話框。

3

選取準備好的 3D LUT 檔案。

匯入的 3D LUT 檔案將成為本裝置的基本風格。

4

使用攝像機功能表中的 [Paint/Look] > [Base Look] > [Select] 來選取匯入的 3D LUT 檔案。5

在攝像機功能表中配置 [Paint/Look] > [Base Look] > [Input] 及 [Output] 以符合匯入的 3D LUT 檔案之屬性。6
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使用匯入的基本風格時，如果選取自動曝光時有曝光不足的傾向，請使用網路功能表中的 [Paint/Look] > [Base Look] >
[AE Level Offset] 來調整外觀。

注意

僅匯入 3D LUT 檔案不會影響影像。使用攝像機功能表中的 [Paint/Look] > [Base Look] > [Select] 來載入匯入的 3D LUT 檔案。

如果未正確設定 [Input]，將無法獲得正確的風格。

[Input]、[Output] 和 [AE Level Offset] 功能表項目設定將套用於使用 [Select] 選取的基本風格。如果匯入多個 3D LUT 檔案，請使
用 [Select] 選取每個 3D LUT 檔案，然後分別對每個檔案配置 [Input]、[Output] 及 [AE Level Offset] 。

會為每個 3D LUT 檔案儲存配置的 [Input]、[Output] 和 [AE Level Offset] 設定。

匯入的 3D LUT 檔案的基本風格/LUT 選取選項在 [SDR(BT.709)]、[HDR(HLG)] 和日誌拍攝模式中通用，但並不會按照這些模式來
執行色域和 Gamma 轉換。

在網路功能表中執行 [Maintenance] > [Reset] > [All Reset (except for Network Settings)] 時，不會刪除 3D LUT 檔案。

[Base Look Name] 前面顯示的 （3D LUT 檔案附加錯誤）顯示表示 3D LUT 檔案無法附加到以日誌拍攝模式錄製的剪輯。再次
匯入 3D LUT 檔案。

5-041-957-83(1) Copyright 2022 Sony Corporation
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自訂風格

如需根據基本風格自訂風格，您可以使用攝像機基本配置面板之 Scene File 調整面板中的 [Master Black]、[R Black] 及 [B
Black] 滑桿，以及攝像機功能表中的[Paint/Look] > [Matrix] 及其他設定項目。
將裝置連接至電視或監視器，並在觀看電視或監視器畫面上的圖像時調整圖像品質。

1：[R Black] 滑桿/調整按鈕
2：[B Black] 滑桿/調整按鈕
3：[Master Black] 滑桿/調整按鈕

注意

匯入 3D LUT 檔案並將其套用於影像時，如果變更攝像機功能表中的 [Paint/Look] > [Matrix] 和除基本風格設定以外的設定，則將無
法獲得 3D LUT 檔案中定義的所需風格。

您還可以使用攝像機功能表中的 [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] 來重設所有自訂設定。

5-041-957-83(1) Copyright 2022 Sony Corporation
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儲存風格

您可以使用攝像機功能中的 [Paint/Look] > [Scene File] > [Store]，將目前風格作為場景檔案儲存在內部記憶體中。
您可以使用 Scene File 調整面板或者使用直接功能表操作來迅速叫用已儲存的風格。

注意

如果您選取另一個風格而不儲存目前風格，則目前風格將遺失。

提示

您可以覆寫預設的場景檔案。若要還原預設的場景檔案，請使用攝像機功能表中的 [Paint/Look] > [Scene File] > [Preset Recall] 來
載入要還原的風格，然後使用 [Scene File] > [Store] 儲存場景檔案。

刪除儲存的風格

您可以使用攝像機功能表中的 [Paint/Look] > [Scene File] > [Delete] 來刪除保存在內部記憶體中的場景檔案。

提示

刪除後，將不再顯示在 Scene File 調整面板或直接功能表中。

5-041-957-83(1) Copyright 2022 Sony Corporation
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刪除基本風格

您可以使用攝像機功能表中的 [Paint/Look] > [Base Look] > [Delete] 來個別刪除匯入的 3D LUT 檔案。
您可以使用攝像機功能表中的 [Paint/Look] > [Base Look] > [Delete All] 來刪除所有匯入的 3D LUT 檔案。

注意

刪除之前，請檢查所有場景檔案中未使用基本風格。如果刪除正在使用的基本風格，則相對應場景檔案的風格不正確。

在網路功能表中執行 [Maintenance] > [Reset] > [All Reset (except for Network Settings)] 時，不會刪除匯入的 3D LUT 檔案。

在日誌拍攝模式中，已刪除的基本風格無法再用作 LUT。

5-041-957-83(1) Copyright 2022 Sony Corporation
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以後期製作的風格調整進行拍攝

在日誌拍攝模式*1中使用裝置，並從陰暗區域到明亮區域均勻地錄製灰階，可以在後期製作中進行微調，例如局部還原陰
暗區域和明亮區域的灰階。
不過，在一般監視器上觀看錄製的影像時，整體對比度會顯得很低，因此不容易進行對焦和曝光調整。
您可以將 LUT 套用於裝置的監視器目標，以協助拍攝過程中的各種調整。您也可以在播放過程中套用自動拍攝時使用的
LUT，以快速檢查最終結果。
LUT 由下列系統套用。不過，只能套用一個 LUT。

SDI 輸出
HDMI 輸出和串流
在錄製媒介上錄製的代理剪輯
在錄製媒介上錄製的高解析度（主要）剪輯

5-041-957-83(1) Copyright 2022 Sony Corporation

Flexible ISO 模式/Cine EI 模式/Cine EI Quick 模式的總稱*1
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將 LUT 套用於 HDMI 輸出和串流

您可以將 LUT 套用於 HDMI 輸出和串流。

注意

網路應用程式攝像機影像窗格中的影像也包含在串流影像中。

提示

也可以使用攝像機功能表中的 [Shooting] > [LUT On/Off] > [HDMI/Stream] 進行設定。

SDI 輸出可以用同樣方式進行設定。

針對錄製媒介上的視訊，您可以使用攝影機功能表中的 [Shooting] > [LUT On/Off] > [Internal Rec] 及 [Proxy] 進行設定。

[Base Look/LUT] 前面顯示的 （3D LUT 檔案附加錯誤）顯示表示 3D LUT 檔案無法附加到以日誌拍攝模式錄製的剪輯。再次匯
入 3D LUT 檔案。
附加因暫時處理擁塞而失敗時，也會顯示此圖示。

5-041-957-83(1) Copyright 2022 Sony Corporation

檢查網路功能表或攝影機功能表中的 [Project] > [Base Setting] > [Shooting Mode] 是否設定為 [Flexible ISO]、
[Cine EI] 或 [Cine EI Quick]。

提示

在日誌拍攝模式中，[Base ISO/Exposure Index] 按鈕及 [Base Look/LUT] 按鈕顯示在攝影機基本配置面板中。

1

按下攝像機基本配置面板中的 [Base Look/LUT] 按鈕。

[Base Look/LUT] 按鈕的外框變成橘色。

Base Look/LUT 調整面板隨即顯示。

2

選取 [HDMI/Stream] > [MLUT]。3
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變更 LUT

您可以變更套用的 LUT。

提示

本裝置提供 [s709]、[709(800%)] 和 [S-Log3] 作為預設 LUT。

您也可以匯入和套用 3D LUT 檔案。有關詳細資料，請參閱“匯入所需的基本風格”和“刪除基本風格”。

也可以使用攝像機功能表中的 [Paint/Look] > [Base Look] > [Select] 進行設定。

相關主題

匯入所需的基本風格

刪除基本風格

5-041-957-83(1) Copyright 2022 Sony Corporation

按下攝像機基本配置面板中的 [Base Look/LUT] 按鈕。

[Base Look/LUT] 按鈕的外框變成橘色。

Base Look/LUT 調整面板隨即顯示。

1

按下 [Base Look/LUT] 按鈕並選取基本風格以套用。2
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變更錄製影像中陰暗區域和明亮區域的分佈

例如，在 Cine EI 和 Cine EI Quick 拍攝模式中，如果您想要從基本感光度變更 Exposure Index，以便優先使用陰暗區域
的色調，而非明亮區域的色調，您可以變更陰暗區域和明亮區域的分佈。

按下攝像機基本配置面板中的 [Base Look/LUT] 按鈕。

[Base Look/LUT] 按鈕的外框變成橘色。

Base Look/LUT 調整面板隨即顯示。

1

選取 [HDMI/Stream] > [MLUT]。

LUT 套用至 HDMI 輸出及串流。

2

按下攝像機基本配置面板中的 [Base ISO/Exposure Index] 按鈕。

[Base ISO/Exposure Index] 按鈕的外框變成橘色。

Base ISO/Exposure Index 調整面板隨即顯示。

3

使用 [Exposure Index] 滑桿或 [Exposure Index] 調整按鈕，根據所需的陰暗區域和明亮區域分佈來調整曝光指
數。

有關 [Cine EI]

有關 [Cine EI Quick]
根據指定的曝光指數，自動設定基本感光度。

4
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提示

也可以使用攝像機功能表中的 [Shooting] > [ISO/Gain/EI] > [Exposure Index] 進行設定。

SDI 輸出可以用同樣的方式使用。

設定的第二個數值表示對於明亮區域（亮度高於 18% 的灰階）指派多少個亮度檔位的資訊。比這些明亮的區域會過度曝光。
範例：在“400EI/5.0E”中，明亮面指派 5.0 檔。

您也能夠據此在拍攝過程中檢查陰暗和明亮區域的色調。檢查曝光後，記得返回原始 EI 值。另外，在 Cine EI Quick 模式中，請注
意不要對基本感光度產生不利影響。

5-041-957-83(1) Copyright 2022 Sony Corporation

調整照明和/或 ND 濾鏡，確保從 [HDMI/Stream] 輸出的攝像機影像具有適當的曝光。5
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錄製 RAW 視訊

您可以將從攝影機的 SDI OUT 連接器輸出的 RAW 視訊訊號錄製到支援的外部錄影機。
支援的 RAW 輸出格式如下所示。

系統頻率 [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

將外部 RAW 錄影機連接到裝置的 SDI OUT 連接器。1

在網路功能表或攝影機功能表中，將 [Project] > [Base Setting] > [Shooting Mode] 設定為 [Cine EI]、[Cine EI
Quick] 或 [Flexible ISO]。

2

使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Imager Scan Mode]，將視角設定為（FF限
定）。

3

在網路功能表或攝像機功能表中，將 [Project] > [Rec Format] > [Codec] 設定為 [RAW]。

選取 [RAW & XAVC-I]，會將視訊錄製到外部 RAW 錄影機，同時將視訊錄製到本裝置中的記憶卡。

4

使用網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [RAW Output Format] 來設定解析度。5

檢查外部錄影機是否已開啟，然後按下即時操作畫面上的錄製 START/STOP 按鈕。

RAW 視訊錄製狀態由攝像機影像窗格中的圖示表示。

6
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注意

在外部錄影機上開始錄製時，如果不使用即時操作畫面上的錄製 START/STOP 按鈕，則可能無法正確錄製剪輯。

5-041-957-83(1) Copyright 2022 Sony Corporation

注意

錄製控制訊號是從裝置的 SDI OUT 連接器輸出，不過無法獲得外部錄影機的狀態。因此，外部錄影機未實際錄製時，裝置可
能指示 RAW 視訊錄製正在進行中。檢查外部錄影機上的指示燈以獲取正確的操作狀態。
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以慢動作和快動作模式錄製 RAW 視訊

您可以在慢動作和快動作模式下錄製 RAW 視訊。

有關支援的影格率詳細資料，請參閱“慢動作和快動作”。

相關主題

慢動作和快動作

5-041-957-83(1) Copyright 2022 Sony Corporation
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開啟/關閉散景控制功能

您可以將 ND 濾鏡和增益連結至光圈操作來輕鬆調整散景的程度。

開啟/關閉散景控制功能

只有在手動調整曝光時才能啟用此功能。將 ND 濾鏡設定為可變模式，然後將光圈、增益、快門和 ND 濾鏡設定為手動調
整。
您可以使用攝像機功能表中的 [Shooting] > [Iris] > [Bokeh Control] 來開啟/關閉散景控制功能。
散景控制功能設定為 On 時，ND 濾鏡和增益指示燈會顯示  (B) 圖示。

注意

此功能僅在可與本機通訊的 E 接環鏡頭上啟用。

使用 Sony E 接環鏡頭可以獲得此功能的最大效果。

執行下列任何操作時，散景控制功能將設定為 Off。

本裝置關閉時
任何光圈、增益、快門或 ND 濾鏡設定為 Auto 時
切換拍攝模式時
ND 濾鏡設定為清除或預設模式時
取下鏡頭時
本裝置重新啟動時，例如切換頻率後

提示

您也可以將 [Bokeh Control] 功能指派給可指派按鈕，並使用該按鈕在 On 和 Off 之間切換散景控制功能。

5-041-957-83(1) Copyright 2022 Sony Corporation
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調整散景的程度

根據需要調整步驟 2 至 4 中的設定。

注意

外觀可能因操作速度、鏡頭、拍攝設定和拍攝對象而異，亮度也可能會發生變化。強烈建議在拍攝前進行攝影機測試。

光圈操作方向發生變化（例如關閉光圈後開啟光圈或開啟光圈後關閉光圈）時，亮度可能會變化。在這種情況下，請事先比要求的
量稍微多調整一點，然後稍微後退，並檢查亮度，然後開始拍攝。例如，如果您想將光圈開啟到 F8 光圈並使背景模糊，先把光圈
關閉超過 F8 再回到 F8，並檢查亮度，然後開始拍攝。

緩慢執行散景控制操作。如果您需要加快操作速度，請在檢查影像變化時嘗試逐漸調整。

提示

散景控制功能設定為 On 時，ND 濾鏡和增益會共同抵消由於光圈調整引起的曝光變化，以便您變更散景的程度。

散景控制會先與 ND 濾鏡相連結，藉以回應光圈操作。ND 濾鏡無法再變化時，增益會連結。

在 MF 模式中，建議先開啟光圈，然後調整對焦。

如果您使用自動 ND 濾鏡而不是散景控制功能，ND 濾鏡會隨著拍攝對象亮度的變化而變化。

增益連結操作期間的顯示

散景控制功能設定為 On 時，增益可能會隨著光圈的調整而變化。
增益連結已啟動且增益發生變化時，畫面頂部會出現訊息，增益指示燈上的  (B) 圖示會閃爍。

5-041-957-83(1) Copyright 2022 Sony Corporation

將散景控制功能設定為 On。1

完全開啟光圈。2

將 ND 濾鏡設定為 1/128。3

將增益設定為 0 dB 並使用照明進行正確的曝光。4

調整對焦。5

調整光圈。

散景的程度發生變化。

6
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儲存和載入配置資料概述

您可以使用網路應用程式將本裝置的設定儲存為配置資料。這樣，即可藉此快速叫用適合目前情況的一組功能表設定。
使用本裝置，您可以將除下列註釋之外的幾乎所有攝像機功能相關設定儲存成 ALL 檔案（包含所有設定的檔案）。

注意

網路功能設定和驗證資訊不會儲存。有關儲存項目的詳細資料，請參閱“功能表項目清單”。

相關主題

功能表項目清單

5-041-957-83(1) Copyright 2022 Sony Corporation
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儲存 ALL 檔案

本主題介紹如何儲存 ALL 檔案。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表中，開啟 [Project] > [All File]。1

按下 [Save All File] > [Save] 按鈕。

網頁瀏覽器將立刻下載名為 all-file.ALL 的檔案。

2

為下載的 all-file.ALL 檔案指定儲存位置及文件名稱，然後儲存檔案。

有關檔案操作的詳細資料，請參閱裝置的操作說明。

3
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載入 ALL 檔案

本主題介紹如何載入 ALL 檔案。

注意

載入配置資料後，本裝置將自動重新啟動。重新啟動後，在網頁瀏覽器中重新載入頁面。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路功能表中，開啟 [Project] > [All File]。1

按下 [Load All File] > [Load] 按鈕。

開啟檔案對話框出現在運行網路應用程式的裝置上。

2

開啟您想要載入的檔案。

有關檔案操作的詳細資料，請參閱裝置的操作說明。

3

載入檔案名稱確認畫面顯示時，按下 [OK] 按鈕。4

顯示執行結果畫面時，按下 [OK] 按鈕。5

等候裝置重新啟動，然後重新連接網路應用程式。6
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關於檔案傳輸

您可以將本裝置上錄製的代理檔案或原始檔案上傳到網際網路上的伺服器或區域網路上的伺服器。

注意

當電源設定為待機狀態時，即使裝置仍通電，也會暫停檔案傳輸。

5-041-957-83(1) Copyright 2022 Sony Corporation
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登錄檔案傳輸目的地

您可以在開始檔案傳輸之前登錄檔案傳輸目的地伺服器。

在網路功能表中，選取 [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1]（或 [Server
Settings2]、[Server Settings3]）。

提示

選取選項的名稱將依據下一個步驟中o [Display Name] 的配置而改變。

1

在網路功能表中，為 [Network] > [FTP Server 1] 至 [FTP Server 3] 配置下列項目。

[Display Name]
輸入選取傳輸目的地伺服器時要在傳輸作業清單中顯示的伺服器名稱。
[Service]
顯示伺服器類型。
[FTP]：FTP 伺服器
[Host Name]
輸入伺服器位址或主機名稱。
[Port]
輸入要連接的伺服器連接埠號碼。
[User Name]
輸入使用者名稱。
[Password]
輸入密碼。
[Passive Mode]
開啟/關閉被動模式。
[Destination Directory]
輸入目的地伺服器上的目錄名稱。

注意

如果在 [Destination Directory] 中輸入在目的地伺服器上無效的字元，則檔案將被傳輸到使用者的主目錄。無效字元取決於伺
服器。

[Using Secure Protocol]
設定是否執行安全 FTP 傳輸。
[Root Certificate]
載入/清除憑證。
[Load]：載入 CA 憑證。載入 PEM 格式憑證。
[Clear]：清除 CA 憑證。
[None]：不載入或清除憑證。

注意

載入 CA 憑證之前，請將本裝置的時鐘設定為正確時間。

以 XAVC-I 4096×2160P/3840×2160P 59.94/50P 錄製時，無法選取 [Load]。

[Root Certificate Status]：顯示憑證的載入狀態。

2
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[Reset]：將 Server Settings 設定重設為預設值。
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從縮圖畫面上傳記憶卡上的代理檔案

您可以從縮圖畫面單獨上傳記憶卡上的代理檔案。

注意

最多可以登錄 200 個傳輸工作。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路應用程式的即時操作畫面上，按下 [Thumbnail] 按鈕。

顯示畫面會從攝影機影像變成縮圖畫面。

1

在攝像機功能表中選取 [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip]。

要同時傳輸所有代理檔案，請選取 [Transfer Clip (Proxy)] > [All Clips]。
可以從縮圖畫面或已篩選的剪輯縮圖畫面傳輸剪輯。

2

使用 [Set] 按鈕來選取您要傳輸的剪輯，然後按下 [Menu] 按鈕。

傳輸確認畫面隨即出現。

3

選取 [Execute]。

與所選取剪輯相對應的代理檔案會登錄為傳輸工作，且會開始上傳。
成功登錄傳輸工作後，將顯示傳輸結果畫面。

4

按下 [OK] 按鈕。5
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從縮圖畫面上傳記憶卡上的原始檔案

您可以從縮圖畫面上傳記憶卡上的原始檔案。

注意

最多可以登錄 200 個傳輸工作。

5-041-957-83(1) Copyright 2022 Sony Corporation

在網路應用程式的即時操作畫面上，按下 [Thumbnail] 按鈕。

顯示畫面會從攝影機影像變成縮圖畫面。

1

在攝像機功能表中選取 [Thumbnail] > [Transfer Clip] > [Select Clip]。

要同時傳輸所有原始檔案，請選取 [Transfer Clip] > [All Clips]。
可以從縮圖畫面或已篩選的剪輯縮圖畫面傳輸剪輯。

2

使用 [Set] 按鈕來選取您要傳輸的剪輯，然後按下 [Menu] 按鈕。

傳輸確認畫面隨即出現。

3

選取 [Execute]。

所選取剪輯的原始檔案會登錄為傳輸工作，並開始上傳。
成功登錄傳輸工作後，將顯示傳輸結果畫面。

4

按下 [OK] 按鈕。5
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檢查檔案傳輸狀態

您可以透過在攝像機功能表中選擇[Network] > [File Transfer] > [View Job List] 來檢查檔案傳輸狀態。

注意

最多可以登錄 200 個傳輸工作。

本裝置切換到待機狀態時會保留傳輸作業，但如果是以任何其他方式斷開電源，則可能會遺失多達 10 分鐘的最新進度資訊。

如果在檔案傳輸過程中發生錯誤，則按照傳輸目的地伺服器的設定和狀態，可能無法對於與傳輸的剪輯相同名稱的剪輯恢復傳輸。
在這種情況下，請檢查傳輸目的地伺服器設定和狀態。

提示

如果攝像機功能表中的 [Network] > [File Transfer] > [Auto Upload (Proxy)] 設定為 [On]，並且有網路連線，則在錄製結束時，代理
檔案會自動上傳到使用 [Default Upload Server] 指定的伺服器。

5-041-957-83(1) Copyright 2022 Sony Corporation

254



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用安全 FTP 上傳

您可以使用顯式模式 (FTPES) 中的 FTPS 以加密的方式上傳檔案，以便連接目的地檔案伺服器。
對於安全 FTP 傳輸，請將目的地檔案伺服器上的 [Using Secure Protocol] 設定為 [On] 並載入憑證。

有關配置的詳細資料，請參閱“登錄檔案傳輸目的地”。

相關主題

登錄檔案傳輸目的地

5-041-957-83(1) Copyright 2022 Sony Corporation
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關於串流

本裝置可以同時串流從 HDMI 連接器輸出的視訊及音訊。

注意

要將串流作為主要視訊，請在網路功能表中將 [Monitoring] > [Output Display] > [SDI] 設定為 [On]，並將 [HDMI/Stream] 設定為
[Off]，然後在 SDI 監視器上監視攝影機狀態。

如果連接到 HDMI 連接器的監視器不支援使用攝像機功能表或網路功能表中的 [Monitoring] 功能表配置的 HDMI 輸出格式，則攝像
機影像將不會輸出到網路應用程式中。也無法輸出串流影像。

串流解析度不能設為高於 HDMI 輸出訊號解析度。

多個使用者查看時，影像可能會因轉碼器設定而失真。

本裝置支援以下串流方式。可供選擇的視訊轉碼器顯示在括號中。

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

依次配置串流格式設置、視訊轉碼器設定及音訊轉碼器設定。

●：啟用、–：停用

提示

網路應用程式攝像機影像面板中的影像也是串流系統。

串流格式
轉碼器設定

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

網路應用程式 – – ● –

當網路功能表中的 [Stream] > [Audio Stream] 設定為 [On] 時，可以選擇 RTMP。*1

系統頻率為 59.94 或 50 且 HDMI 輸出格式為 3840×2160 或更高時，video 2 輸出不可用。*2
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設定串流格式

使用網路功能表中的 [Stream] > [Stream] > [Stream Setting] > [Setting] 來設定串流格式。

[Setting] 設定為 [RTSP] 時

在 RTSP 串流中，可以最多五個使用者同時查看來自單個攝像機的影像。
您可以設定最多兩種視訊轉碼器模式。
[Port Number]
設定用於 RTSP 串流的連接埠號碼。預設值為 554。
若更改設定，將重新啟動 RTSP 伺服器。
[Time Out]
指定 RTSP 串流的 Keep-Alive 命令之逾時時間。逾時時間可以設定在 0 秒至 600 秒的範圍內。預設值為 60 秒。
設定為 0 秒時，不會出現因 Keep-Alive 命令而逾時的狀況。
[Authentication]
設定是否需要驗證。
[Video Port Number 1]、[Video Port Number 2]
指定用於 RTSP 單點傳播串流的影像資料通訊連接埠號碼。Video Port Number 1 的原廠預設值為 51000。Video Port
Number 2 的原廠預設值為 53000。指定一個介於 1024 至 65534 之間的偶數。此處設定的編號和其後加 1 獲得的奇數，
將作為用於影像資料通訊和控制的兩個連接埠號碼。
[Video Port Number 1] 和 [Video Port Number 2] 對應 [Stream] > [Video Stream] > [Video Stream 1] 及 [Video Stream 2].
[Audio Port Number]
指定用於 RTSP 單點傳播串流的音訊資料通訊連接埠號碼。預設值為 57000。指定一個介於 1024 至 65534 之間的偶數。
此處設定的編號和其後加 1 獲得的奇數，將作為用於音訊資料通訊和控制的兩個連接埠號碼。

[Setting] 設定為 [RTMP] 時

RTMP 可使用的視訊轉碼模式僅為 H.264。若要使用 RTMP，必須在網路功能表中將 [Stream] > [Audio Stream] 設定為
[On]。
[Server URL]
設定上傳目的地 URL。指定以“rtmp://”或“rtmps://”開頭的字元字串。
[Stream Key]
輸入從您所使用網站取得的串流金鑰。按下 [Clear] 按鈕，將清除輸入的內容。

注意

處理串流金鑰時，請務必小心。如果第三方知道串流金鑰，則存在欺騙串流的風險。

[Root Certificate]
匯入使用 RTMPS 協定進行串流傳輸所需的根憑證。若要匯入根憑證，請按下 [Load] 按鈕並選擇根憑證。按下檔案選擇對
話方塊中的 [OK] 按鈕，將選擇的檔案匯入到裝置。如果裝置中有匯入的根憑證，則會更新根憑證。若要刪除已匯入的根憑
證，請按下設定畫面上的 [Delete] 按鈕。根憑證狀態顯示在 [Root Certificate Status] 中。

注意

匯入串流服務所需的根憑證。

[Setting] 設定為 [SRT-Caller] 或 [SRT-Listener] 時

視訊轉碼器模式僅限 H.264。
[Destination]
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串流模式設定為 [SRT-Caller] 時顯示。設定連接目的地 URL。
[Port Number]
串流模式設定為 [SRT-Listener] 時顯示。設定要收聽的連接埠號碼。預設值為 4201。
[Latency]
設定介於 20 毫秒至 8000 毫秒之間的延遲。預設值為 120。
[TTL]
設定介於 1 至 255 之間的 TTL 值。預設值為 64。
[Encryption]
選擇加密方法。選擇 Off、AES128 或 AES256。預設值為 Off。
[Passphrase]
設定用於加密的密碼片語。按下 [Clear] 按鈕，將重設配置的密碼片語。
[ARC]
要啟用 Adaptive Rate Control 功能，請設定為 On。
若啟用 Adaptive Rate Control 功能，可以減少因通訊線路擁塞而導致的影像中斷。

[Setting] 設定為 [NDI|HX] 時

本裝置符合 NewTek 的 NDI|HX 版本 2 。
要使用 NDI|HX，必須購買授權金鑰。
購買授權金鑰
在下列 NewTek URL 購買。
https://www.newtek.com/ndihx/products/upgrade/

注意

下載最新的 NDI|HX 驅動程式並將其安裝在 NewTek 產品中。

有關 NDI|HX 註冊和操作的詳細資料，請參閱 NewTek 產品的操作說明。

[License]
顯示已啟用授權的授權資訊。
[Source Name]
顯示來源名稱。
[Group]
要啟用 NDI 分組功能，請設定為 On。
[Group Name]：設定 NDI 群組名稱。可以用逗號分隔，以便配置多個設定。
[Discovery Server 1]、[Discovery Server 2]
設定 NDI 發現伺服器 1 及 NDI 發現伺服器 2。
[Reliable UDP Mode]
要啟用 Reliable UDP 模式，請設定為 On。
[Multicast Mode]
要啟用多點傳送串流，請設定為 On.。
[Multicast Prefix]：設定用於多點傳送串流的首碼。
[Multicast Netmask]：設定決定多點傳送位址範圍的網路遮罩。
[Multicast TTL]：在 1 至 256 的範圍內設定多點傳送串流的 TTL 值。預設值為 3。
[Multi-TCP Mode]
要啟用 Multi-TCP 模式，請設定為 On。
[Unicast UDP Mode]
要啟用 Unicast UDP 模式，請設定為 On。

關於第三方服務及軟體

可能適用不同的使用條款。

提供的服務和軟體更新可能會被中斷或終止，恕不另行通知。
服務和軟體說明如有更改，恕不另行通知。
可能需要個別註冊和訂閱。

對於使用者或第三方因使用其他公司服務和軟體而造成問題的任何索賠，Sony 概不負責。
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設定串流的視訊轉碼器

使用網路功能表中的 [Stream] > [Video Stream] 來設定視訊轉碼器。

[Video Stream 1]、[Video Stream 2]、[Video Stream 3]
您最多可以設定三種影像轉碼器模式。為每種影像模式分別配置以下設定。
[Video Stream 3] 用於網路應用程式攝像機影像面板顯示。

注意

當 [Stream] > [Stream Setting] > [Setting] 設定為 [RTMP]、[SRT-Caller] 或 [SRT-Listener] 時，某些 [Video Stream 1]、[Video
Stream 2] 及 [Video Stream 3] 設定（[Codec]、[Size]、[Frame Rate]、[Bit Rate Compression Mode]）具有預設值。

[Codec 1]、[Codec 2]、[Codec 3]
選擇 [H.264]、[H.265] 或 [Off]。請注意，[Codec 1] 不能設定為 [Off]。此外，[Codec 3] 設定為 [JPEG]（固定）。

注意

根據 [Codec 1]、[Codec 2] 及 [Codec 3] 的影像尺寸、影格率和位元速率等各種設定組合，可能會出現下列徵兆。

視訊延遲增加。
視訊播放時跳幀。
音訊斷斷續續。
攝像機對各種命令的回應緩慢。
攝像機對遙控器操作的回應緩慢。
監視器畫面顯示和配置操作緩慢。

如果遇到此類徵兆，請減小圖片尺寸、影格率及比特速率參數之值，或者更改其他設定參數之值，以期解決問題。

當 [Stream] > [Stream Setting] > [Setting] 設定為 [RTMP]、[SRT-Caller] 或 [SRT-Listener] 時，[Codec 1] 設定為 [H.264]（固
定）。[Codec 2] 設定為 [Off]（固定）。

當 HDMI 輸出的圖像尺寸或系統頻率發生變化時，[Codec 2] 設定為 [Off]。

[Size 1]、[Size 2]、[Size 3]
選擇要從攝像機串流的圖像尺寸。
可用的圖像尺寸選項將根據 HDMI 輸出的圖像尺寸而有所不同。

注意

HDMI 輸出的圖像尺寸或系統頻率有變時，將選擇最大的圖像尺寸。

[Frame Rate 1]、[Frame Rate 2]、[Frame Rate 3]
設定影像的影格率。
“fps”單位表示每秒串流的影格率。
可用的影格率選項將視 HDMI 輸出的圖像尺寸而有所不同。

注意

一旦 HDMI 輸出的圖像尺寸或系統頻率有變，將選擇最大影格率。

[I-Picture Mode 1]、[I-Picture Mode 2]
將指定 H.264 和 H.265 的 I-Picture 插入間隔的方式設定為 [Time] 或 [Frame]。
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不能設定為 [Codec 3]。
[Time]：以時間來設定 I-picture 插入間隔。
[Frame]：以影格數來設定 I-picture 插入間隔。
[I-Picture Interval 1]、[I-Picture Interval 2]
以秒為單位，設定 I-picture 插入間隔。設定介於 1 秒至 5 秒之間的值。預設值為 1 秒。
不能設定為 [Codec 3]。
[I-Picture Ratio 1]、[I-Picture Ratio 2]
將 H.264 及 H.265 的 I-picture 插入間隔設定為 15 至 300 的影格數。預設值為 300 影格。
不能設定為 [Codec 3]。
[Profile 1]、[Profile 2]
設定 H.264 或 H.265 影像轉碼器設定檔。
[H.264]：選擇 [high]、[main] 或 [baseline] 設定檔。
[H.265]：選擇 [main] 或 [main10] 設定檔。啟用兩個視訊編解碼器時，僅 [main] 設定檔選取選項可用。
影像壓縮效率按照 [high]、[main] 及 [baseline] 的順序遞增。選擇系統支援的設定檔。
若將 [H.265] 設定為 [main10]，則當 HDMI 輸出為 YCrCb 時，會在 [main10] 中操作，或當 HDMI 輸出為 RGB 時，會在
[main] 中操作。
不能設定為 [Codec 3]。
[Bit Rate Compression Mode 1]、[Bit Rate Compression Mode 2]
選擇 [CBR] 或 [VBR]。
要維持恆定的位元速率，請選擇 [CBR]。要維持影像品質，請選擇 [VBR]。
不能設定為 [Codec 3]。

注意

實際串流的影格率和位元速率可能有別於設定值，具體取決於圖像尺寸、拍攝場景、網絡環境及其他因素。

當 [Stream] > [Stream Setting] > [Setting] 設定為 [RTMP]、[SRT-Caller] 或 [SRT-Listener] 時，[Bit Rate Compression Mode 1] 設
定為 [CBR]（固定）。

[Bit Rate 1]、[Bit Rate 2]
當 [Bit Rate Compression Mode] 設定為 [CBR] 時，您可以設定每個視訊串流的位元速率。若設定高位元速率，您將可以
串流高畫質視訊。
不能設定為 [Codec 3]。
[Quality 1]、[Quality 2]、[Quality 3]
設定介於 1 至 10 之間的影像品質。數值 10 為設定最高畫質影像。預設值為 6。
對於 [Quality 1] 及 [Quality 2]，透過將 [Bit Rate Compression Mode] 設定為 [VBR]，並將 [Codec] 設定為 [H.264]，您可
以設定 H.264 的影像品質。透過將 [Bit Rate Compression Mode] 設定為 [VBR] 並將 [Codec] 設定為 [H.265]，您可以設定
H.265 的影像品質。

5-041-957-83(1) Copyright 2022 Sony Corporation
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設定串流的音訊轉碼器

使用網路功能表中的 [Stream] > [Audio Stream] 來設定音訊轉碼器。
[Setting]
要啟用音訊串流，請設定為 On。

注意

若要選擇 RTMP，務必預先設定為 On。

[Codec]
選擇用於串流音訊的轉碼器類型。
[AAC (256kbps)]：優先考慮音質時選此項。
[AAC (128kbps)]：優先考慮資料容量時選此項。
此設定不會對本裝置錄製的剪輯或嵌入在 HDMI/SDI 訊號中的音訊訊號造成影響。

5-041-957-83(1) Copyright 2022 Sony Corporation
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開始/停止串流

對於 [RTSP]、[SRT-Listener] 和 [NDI|HX]

本裝置等候串流傳輸要求。
啟動用戶端應用程式，以查看串流，並存取下表中顯示的 URL。
輸入在本裝置上配置的使用者名稱及密碼。

<camera_address>：本裝置的 IP 位址
<Port>：使用 [Port Number] 配置的收聽器連接埠

注意

不保證能在所有應用程式或裝置中播放。

對於 [RTMP] 和 [SRT-Caller]

按下即時操作畫面中  (Stream) 索引標籤上的 [Stream now] 按鈕，以開始串流。按鈕標籤變成 [Stop stream]，並且
[Stream] 圖示出現在攝影機影像窗格的頂部。
在串流過程中按下 [Stop stream] 按鈕，可停止串流。按鈕變回 [Stream now]，並且攝影機影像窗格頂部的 [Stream] 圖示
消失。

注意

不保證能在所有應用程式或裝置中播放。

5-041-957-83(1) Copyright 2022 Sony Corporation

串流格式 URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX 請參閱 NDI|HX 相容用戶端裝置的操作說明。
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縮圖畫面

按下播放操作畫面上的 [Thumbnail] 按鈕或紅外線遙控器上的 THUMBNAIL 時，記憶卡上錄製的剪輯會顯示在攝影機影像
窗格中。此時，攝像機影像窗格上顯示的畫面稱之為縮圖畫面。
您可以在縮圖畫面上選取剪輯，然後開始播放該剪輯。
縮圖畫面顯示期間，按下 [Thumbnail] 按鈕可關閉縮圖畫面並返回顯示拍攝影像。

注意

縮圖畫面上只會顯示以目前選取的錄製格式錄製的剪輯。如果未顯示預期的錄製剪輯，請檢查錄製格式。在格式化（初始化）媒介
之前，請特別注意這一點。

畫面配置

所選剪輯的縮圖背景會顯示橘色。
畫面底部會顯示所選剪輯的資訊。
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選擇記憶卡
如果記憶卡有寫入保護，右側會顯示鎖定圖示。

1.

剪輯編號/剪輯總數2.

縮圖（索引圖像）
顯示剪輯的索引圖像。錄製剪輯時，第一個畫面會自動設定為索引圖像。
剪輯/畫面資訊會顯示在縮圖下方。您可以使用攝像機功能表中的 [Thumbnail] > [Customize View] > [Thumbnail
Caption] 來更改顯示的資訊。

3.

剪輯名稱
顯示所選剪輯的名稱。

4.

錄製格式
顯示所選剪輯的檔案格式。

5.

特殊錄製資訊
只有在剪輯是使用特殊錄製模式錄製時，才會顯示錄製模式。
對於慢動作和快動作剪輯，影格率顯示在右側。

6.

剪輯持續時間7.

建立日期8.
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播放錄製的剪輯

裝置處於錄製待機 (Stby) 模式時，可以播放錄製的剪輯。
本主題介紹如何使用 GUI 控制區塊來播放錄製的剪輯。

插入記憶卡即可播放。1

按下 [Thumbnail] 按鈕。

剪輯縮圖隨即顯示。

2

使用 GUI 控制區塊中的箭頭按鈕、將游標移至要播放的剪輯縮圖上。3
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注意

剪輯之間的邊界可能會出現瞬時圖像撕裂或靜止影像顯示的情況。在此期間，您無法操作本裝置。

您在縮圖畫面中選取剪輯並開始播放時，剪輯的開頭可能會出現短暫的圖像失真。若要檢視沒有失真的剪輯開頭，請按下 （上
一個）按鈕以返回剪輯的開頭，接著再次開始播放。
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注意

不能透過觸控操作選擇剪輯。

按下 GUI 控制面板中的 [Set] 按鈕。

播放將從所選剪輯的開頭開始。

4

根據需求操作播放控制面板。

提示

您還可以使用 GUI 控制面板控制操作。

播放：按下 [Set] 按鈕。
暫停播放：播放期間按下 [Set] 按鈕。再次按下即可恢復正常播放。
跳到剪輯的開頭/下一個剪輯的開頭：按下左按鈕/右按鈕。
快速前進/快速倒退：持續按住左按鈕/右按鈕。鬆開按鈕後，將恢復正常速度播放。
停止播放：按下 [Cancel/Back] 按鈕。

5

按鈕 功能

（播放/暫停）按鈕 播放剪輯。播放期間，暫停剪輯。

（快速前進）按鈕、 （快速倒退）按鈕 高速播放剪輯。按下按鈕時，播放速度分三階段變化。

（上一個）按鈕、 （下一個）按鈕 跳到剪輯的開頭或上一個/下一個剪輯。

（停止）按鈕 停止播放並切換到拍攝畫面。
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已錄製剪輯的操作

在縮圖畫面上，您可以使用攝像機功能表中的 [Thumbnail] 功能表操作剪輯或檢查剪輯屬性。
在播放操作畫面上，按下 [Menu] 按鈕，即可在攝影機影像窗格中顯示攝影機功能表。
您可以使用攝像機功能表中的 [Thumbnail] 功能表進行以下操作。
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提示

或者，在即時操作畫面上，按下 [Menu] 按鈕，以顯示攝影機功能表。

使用攝像機功能表中的 [Thumbnail] 功能表來操作
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使用 GUI 控制面板中的箭頭按鈕來選擇 要操作的功能，然後按下 [Set] 按鈕。
按下 [Cancel/Back] 按鈕，即可返回上一個畫面。

注意

按照顯示功能表時的狀態，無法選取某些項目。

剪輯操作的功能表項目

攝像機功能表中的 [Thumbnail] 功能表具有下列與剪輯操作有關的功能表項目。
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

有關各個功能表項目的詳細資料，請參閱 “[Thumbnail] 功能表”。

顯示剪輯屬性畫面

在攝像機功能表中，選取 [Thumbnail] > [Display Clip Properties] 以顯示剪輯屬性畫面。
按下 （上一個）按鈕或 （下一個）按鈕，跳到上一個/下一個剪輯。

新增剪輯旗標

您可以對剪輯新增剪輯旗標（OK、NG 或 KP 標記），以便按照剪輯旗標篩選剪輯的顯示。
選取要新增剪輯旗標的剪輯縮圖，然後使用攝像機功能表中的 [Thumbnail] > [Set Clip Flag] 來選取剪輯旗標。

提示

您也可以使用指派給剪輯旗標功能的可指派按鈕，以新增剪輯旗標。

顯示篩選的剪輯縮圖畫面

在攝像機功能表中選取 [Thumbnail] > [Filter Clips]，然後選取剪輯旗標類型，即可僅顯示具有指定旗標的剪輯。
若要顯示全部剪輯，請選取 [All]。
您也可以按下 [Display] 按鈕，依照旗標對縮圖顯示進行排序。

刪除剪輯

您可以從記憶卡中刪除剪輯。
在攝像機功能表中選取 [Thumbnail] > [Delete Clip] > [Select Clip] 或 [All Clips]。
[Select Clip]：刪除選取的剪輯。支援多個剪輯選取。
[All Clips]：刪除所有顯示的剪輯。

變更縮圖畫面上顯示的資訊

您可以變更縮圖下方顯示的剪輯/畫面資訊。
在攝像機功能表中，選擇 [Thumbnail] > [Customize View] > [Thumbnail Caption]，然後選擇要顯示的資訊。
[Date Time]：顯示建立和最後修改剪輯的日期及時間。

設定 新增剪輯旗標

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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[Time Code]：顯示時間碼。
[Duration]：顯示剪輯的持續時間。
[Sequential Number]：在每個縮圖上顯示序列編號。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

攝像機功能表配置

按下 GUI 控制區塊中的 [Menu] 按鈕或紅外線遙控器上的 MENU 按鈕時，配置拍攝和播放所需各種設定的攝影機功能表將
顯示在攝影機影像窗格中。

該功能表包括下列功能表。

功能表配置

[User] 功能表
包含由使用者配置的功能表項目。
可以使用 [Edit User Menu] 進行編輯。
[Edit User] 功能表
包含用於編輯 [User] 功能表的功能表項目。
[Shooting] 功能表
包含與拍攝有關的設定。
[Project] 功能表
包含基本專案設定。
[Paint/Look] 功能表
包含與影像品質有關的設定。
[Pan-Tilt] 功能表
包含與平移/傾斜有關的設定。
[TC/Media] 功能表
包含與時間碼和錄製媒介有關的設定。
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[Monitoring] 功能表
包含與視訊輸出和畫面顯示有關的設定。
[Audio] 功能表
包含與音訊有關的設定。
[Thumbnail] 功能表
包含與縮圖顯示有關的設定。
[Technical] 功能表
包含技術項目的設定。
[Network] 功能表
包含與網路有關的設定。
[Maintenance] 功能表
包含裝置設定，例如時鐘和語言。

攝像機功能表配置和階層

層級 1 層級 2

User
（原廠設定）

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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層級 1 層級 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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層級 1 層級 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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層級 1 層級 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter

277



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

操作攝像機功能表

按下 GUI 控制區塊中的 [Menu] 按鈕或紅外線遙控器上的 MENU 按鈕時，配置拍攝和播放所需各種設定的攝影機功能表將
顯示在攝影機影像窗格中。
使用 GUI 控制面板中的按鈕操作功能表。

[Menu] 按鈕：按下以顯示攝影機功能表。在顯示攝像機功能表時再次按下，以隱藏功能表。
箭頭按鈕：按下箭頭按鈕，在攝像機功能表中向上/下/左/右移動游標，以選取功能表項目或設定。
[Set] 按鈕：按下可套用選取的項目。
[Cancel/Back] 按鈕：按下可返回上一個功能表。會取消未完成的變更。

注意

按照顯示功能表時的狀態，無法選取某些項目。

設定功能表項目

使用 GUI 控制區塊中的箭頭按鈕，將游標移動到要設定的項目，然後按下 [Set] 按鈕以套用設定。

功能表項目選取區域最多可顯示八行。如果無法同時顯示項目的可用選項，請向上/下移動游標來捲動顯示。
對於設定範圍較大的子項目（例如 −99 至 +99），不會顯示設定區域。目前設定會反白顯示，表示可以變更該值。
選取某項功能的 [Execute] 將執行相對應的功能。
選取執行前需要確認的項目，將暫時隱藏功能表並顯示確認訊息。檢查訊息，然後選取執行或取消相應功能。

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

輸入字元字串

選取需要輸入字元的項目（例如檔案名稱）時，將出現字元輸入畫面。

5-041-957-83(1) Copyright 2022 Sony Corporation

按下 GUI 控制區塊中的箭頭按鈕，選擇字元類型並套用設定。

[ABC]：大寫字母字元
[abc]：小寫字母字元
[123]：數字字元
[!#$]：特殊字元

1

選擇一個字元並按下 [Set] 按鈕，以套用設定。

游標移至下一個欄位。
[Space]：在游標位置，輸入空格字元。
[←] [→]：移動游標的位置。
[BS]：刪除游標左側的字元（退格鍵）。

2

完成後，按下 [Done] 按鈕以套用設定。

確認字元字串，而且字元輸入畫面會消失。

3
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

User

本主題介紹各個功能表項目的功能和設定。

注意

您可以使用 [Edit User] 功能表，在 [User] 功能表中新增和刪除功能表項目。最多可以配置 20 個項目。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 描述

Base Setting Project > Base Setting 項目

Focus Shooting > Focus 項目

S&Q Motion Shooting > S&Q Motion 項目

LUT On/Off Shooting > LUT On/Off 項目

Simul Rec Project > Simul Rec 項目

Proxy Rec Project > Proxy Rec 項目

Interval Rec Project > Interval Rec 項目

Picture Cache Rec Project > Picture Cache Rec 項目

Assignable Button Project > Assignable Button 項目

Scene File Project > Scene File 項目

Base Look Paint/Look > Base Look 項目

P/T Acceleration Pan-Tilt > P/T Acceleration 項目

Clip Name Format TC/Media > Clip Name Format 項目

Format Media TC/Media > Format Media 項目

Video Signal Monitor Monitoring > Video Signal Monitor 項目

Marker Monitoring > Marker 項目

Zoom Technical > Zoom 項目

Lens Technical > Lens 項目

Edit User Menu 顯示 Edit User 功能表。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Edit User

在 [User] 功能表中選取 [Edit User Menu] 時，[Edit User] 功能表顯示在最上層。
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項目 子項目設定
原廠預
設

描述

Add Item
將項目新增到 [User] 功能表

– – 將層級 2 功能表項目新增到 [User] 功能表。

Customize Reset
重設 [User] 功能表中的項目

– –
將在 [User] 功能表中登錄的功能表項目還原為原廠預設設
定。

編輯期間選取的層級 2 功能表
項目

Delete – 從 [User] 功能表中，刪除登錄的層級 2 功能表項目。

Move – 重新排列 [User] 功能表中登錄的功能表項目。

Edit Sub
Item

–
在 [User] 功能表中編輯（登錄/刪除）已登錄的層級 3 功能
表子項目。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

ISO/Gain/EI

設定增益設定。

項目 子項目設定 原廠預設 描述

Mode ISO/dB dB 選取增益設定模式。

ISO/Gain<L>
有關設定的詳細資料，請參閱
“ISO/Gain 設定和預設值”。 – 設定 <L> 增益預設值。

Exposure
Index<L>

當 Base ISO 設定為 ISO 800 時：
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
當 Base ISO 設定為 ISO 12800
時：
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

當 Base ISO 設定為 ISO 800
時： 800EI / 6.0E
當 Base ISO 設定為 ISO
12800 時； 12800EI / 6.0E

設定 Exposure Index<L> 值。

Shockless Gain On / Off Off
開啟/關閉平滑切換增益功
能。

Base Sensitivity High / Low Low
設定 Custom 模式的基本感光
度。

Base ISO ISO 12800 / ISO 800 ISO 800
設定 Cine EI/Flexible ISO 模
式的基本 ISO 感光度。
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相關主題

ISO/Gain 設定和預設值
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

ND Filter

設定 ND 濾鏡的預設值。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Mode Preset / Variable Variable 選擇 ND 濾鏡模式。

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 設定 ND 濾鏡的預設 1 值。

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 設定 ND 濾鏡的預設 2 值。

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 設定 ND 濾鏡的預設 3 值。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Shutter

設定電子快門操作。
用於清晰拍攝快速移動的拍攝對象。

項目 子項目設定 原廠預設 描述

Mode Speed / Angle Speed
選取以秒為單位設定快門
速度 (Speed) 或設定為快
門角度 (Angle) 的模式。

Shutter
Speed
On/Off

On / Off Off

設定選取 Speed 模式時的
曝光時間是依據 [Shutter
Speed] 值或設定為完全曝
光。

Shutter
Speed

64F 至 1/8000
可用設定取決於所選視訊格式的影格率。
59.94P： 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
50P： 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
29.97P： 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
25P： 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F /
1/25 / 1/33 / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23.98P： 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 1/60 / 1/96 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000

59.94P：
1/60
50P： 1/50
29.97P： 1/30
25P： 1/25
24P/23.98P：
1/24

選擇 Speed 模式時設定快
門速度。

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 2F / 360.0°
/ 300.0° / 270.0° / 240.0° / 216.0° / 210.0° / 180.0° /
172.8° / 150.0° / 144.0° / 120.0° / 90.0° / 86.4° / 72.0° /
45.0° / 30.0° / 22.5° / 11.25° / 5.6°

180.0°
選擇 Angle 模式時設定快
門視角。

ECS On/Off On / Off Off 開啟/關閉 Extended Clear
Scan 功能。

ECS
Frequency

23.99 至 8000
可用設定取決於所選錄製格式的影格率。

59.94P：
60.00
50P： 50.00
29.97P：
30.00
23.98P：
23.99
25P： 25.02
24P: 24.02

Mode 設定為 ECS 時，設
定 ECS 頻率。
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Iris

設定光圈設定。
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項目 子項目設定 原廠預設 描述

Bokeh Control On / Off Off 開啟/關閉散景控制功能。
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可換鏡頭數位攝像機
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Auto Exposure

設定自動曝光調整設定。

項目 子項目設定 原廠預設 描述

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / +1.5 / +1.25 /
+1.0 / +0.75 / +0.5 / +0.25 / ±0 / −0.25 / −0.5 / −0.75 /
−1.0 / −1.25 / −1.5 / −1.75 / −2.0 / −2.25 / −2.5 / −2.75 /
−3.0

±0 設定自動偵測曝光的亮度程度。

Mode Backlight / Standard / Spotlight Standard

設定自動曝光調整的操作模式。
Backlight：背光模式（用於在
拍攝對象有背光時減少拍攝對象
變暗程度的模式）
Standard： 標準模式
Spotlight：聚光燈模式（用於
拍攝對象受到聚光燈照明時減少
白色裁剪的模式）

Speed −99 至 +99 ±0 設定自動曝光調整的調整速度。

AGC On / Off Off
開啟/關閉 AGC（自動增益控
制）功能。

AGC Limit
有關設定的詳細資料，請參閱“AGC Limit 設定和預
設值”。 – 設定 AGC 功能的最大增益。

AGC Point F2.8 / F4 / F5.6 F2.8
設定 AGC 功能為 On 時 AGC
操作開始的光圈 F-stop 值。

Auto Shutter On / Off Off 開啟/關閉自動快門控制功能。

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
設定自動快門功能的最快快門速
度。

A.SHT Point F5.6 / F8 / F11 / F16 F11
設定自動快門操作開始的光圈 F-
stop 值。

Clip High light On / Off Off
開啟/關閉忽略最明亮區域的功
能，以便在高亮度下提供更平坦
的回應。

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1
設定測光範圍，以按照拍攝對象
的亮度自動調整曝光。（手動調
整曝光時不可用）

Detect
Window
Indication

On / Off Off 開啟/關閉測光範圍指示。

Custom Width 40 至 999 500 設定測光範圍的寬度。
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相關主題

AGC Limit 設定和預設值
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項目 子項目設定 原廠預設 描述

Custom
Height

70 至 999 500 設定測光範圍的高度。

Custom H
Position

−479 至 +479 ±0 設定測光範圍的水平位置。

Custom V
Position

−464 至 +464 ±0 設定測光範圍的垂直位置。
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White

設定白平衡設定。
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項目 子項目設定
原廠預
設

描述

Preset
White

2000K 至
15000K

3200K 設定白平衡預設值。

Color Temp
<A>

2000K 至
15000K

3200K

設定記憶卡 A 中儲存的白平衡色溫。

注意

R Gain/B Gain 操作期間，將 Color Temp 限制在 2000K 和 15000K 之間，因此
可能無法顯示 R Gain/B Gain 值的正確Color Temp值。

Tint<A> −99 至 +99 ±0

設定白色記憶卡 A 中儲存的白平衡色調值。

注意

R Gain/B Gain 操作期間，將 Tint 限制在 ±99，因此可能無法顯示 R Gain/B
Gain 值的正確色調值。

R Gain <A>
−99.0 至
+99.0

±0.0 設定記憶卡 A 中儲存的白平衡 R 增益值。

B Gain <A>
−99.0 至
+99.0

±0.0 設定記憶卡 A 中儲存的白平衡 B 增益值。
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White Setting

調整白平衡設定。
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項目 子項目設定 原廠預設 描述

Shockless White Off / 1 / 2 / 3 2
設定切換白平衡模式時的白平衡回應速度。
Off： 瞬時切換。
1 至 3：數字愈大，切換愈慢。

ATW Speed 1 / 2 / 3 / 4 / 5 3
設定 ATW 模式中的回應速度。
最快回應速度為 1，最慢回應速度為 5。
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Offset White

設定白平衡偏移設定。
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項目
子項目設

定
原廠預
設

描述

Offset White <A> On / Off Off 選取是對記憶卡 A 中的白平衡新增 (On) 還是不新增 (Off) 偏移值。

Offset Color Temp<A>
−99 至
+99

±0
將 [Offset White <A>] 設定為 On 時，設定要新增到記憶卡 A 中的白平
衡的色溫偏移。

Offset Tint<A>
−99 至
+99

±0
將 [Offset White <A>] 設定為 On 時，設定要新增到記憶卡 A 中的白平
衡的色調值偏移。

Offset White<ATW> On / Off On 選取是對 ATW 白平衡新增 (On) 還是不新增 (Off) 偏移值。

Offset Color
Temp<ATW>

−99 至
+99

±0
將 [Offset White<ATW>] 設定為 On 時，設定要新增到 ATW 白平衡的
色溫偏移。

Offset Tint<ATW>
−99 至
+99

±0
將 [Offset White<ATW>] 設定為 On 時，設定要新增到 ATW 白平衡的
色調值偏移。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Focus

設定對焦設定。

相關主題

設定自動對焦區域/位置（對焦區域）

使用臉部和眼部偵測進行追蹤 (Face/Eye Detection AF)

使用網路應用程式手動設定自動對焦目標 (AF Assist)

使用隨附的紅外線遙控器在自動對焦期間手動對焦

項目 子項目設定 原廠預設 描述

AF Transition
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6
/ 7(Fast)

5
設定自動對焦過程中拍攝對象變化時的對焦驅動器速
度。

AF Subj. Shift
Sens.

1(Locked On) / 2 / 3 / 4
/ 5(Responsive)

5(Responsive) 設定在自動對焦期間變更拍攝對象對焦的靈敏度。

Focus Area
Wide / Zone / Flexible
Spot

Wide

設定自動對焦和鍵控自動對焦 (AF) 的目標區域。

請參閱“自動調整對焦 (Auto Focus)”及“設定自動對
焦區域/位置（對焦區域）”。

Wide：對焦時在影像的廣角範圍內搜尋拍攝對象。
Zone：自動搜尋指定區域內的對焦點。
Flexible Spot：對焦於影像中的指定位置。

Focus Area
(AF-S)

Flexible Spot Flexible Spot 設定鍵控自動對焦 (AF-S) 的目標區域。

Face/Eye
Detection AF

Face/Eye Only AF /
Face/Eye Priority AF /
Off

Face/Eye
Priority AF

啟用/停用臉部偵測自動對焦。

請參閱“使用臉部和眼部偵測進行追蹤 (Face/Eye
Detection AF)”。

Push AF Mode
AF / Single-shot AF(AF-
S)

AF 設定鍵控自動對焦模式。

Touch
Function in MF

Tracking AF / Spot
Focus

Tracking AF
設定 MF 模式下在網路應用程式即時操作畫面上觸控攝
影機影像時的操作。

AF Assist On / Off On

設定為 On 時，可讓您暫時解除自動對焦並手動設定對
焦。

請參閱“使用網路應用程式手動設定自動對焦目標
(AF Assist)”和“使用隨附的紅外線遙控器在自動對焦
期間手動對焦”。

293



5-041-957-83(1) Copyright 2022 Sony Corporation

294



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

S&Q Motion

設定 Slow & Quick Motion 模式設定（請參閱“慢動作和快動作”）。

相關主題

慢動作和快動作

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Setting On / Off Off 開啟/關閉 Slow & Quick Motion 模式。

Frame
Rate

1fps 至 60fps / 100fps / 120fps / 150fps / 180fps /
200fps / 240fps

–

設定慢動作和快動作拍攝的影格率。

注意

可用設定取決於選取的系統頻率、轉碼器
和視訊格式。
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ILME-FR7 / ILME-FR7K

LUT On/Off

設定 LUT 設定。
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項目 子項目設定 原廠預設 描述

SDI MLUT On / MLUT Off MLUT Off
選擇是否將 Monitor LUT 套用於 SDI 輸出
視訊。

HDMI/Stream MLUT On / MLUT Off MLUT Off
選擇是否將 Monitor LUT 套用於 HDMI 和
Stream 輸出視訊。

Proxy MLUT On / MLUT Off MLUT Off
選擇是否將 Monitor LUT 套用於代理錄製視
訊。

Internal Rec MLUT On / MLUT Off MLUT Off 選擇是否將 Monitor LUT 套用於主要錄製視
訊。

LUT On/Off Button
Target

SDI / HDMI/Stream / SDI &
HDMI/Stream

HDMI/Stream
設定由指派了 LUT On/Off 的可指派按鈕控
制的目標輸出。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Noise Suppression

設定雜訊抑制設定。

提示

[Setting(Custom)] 及 [Level(Custom)] 設定反映在 [Target Display] 設定中。
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項目 子項目設定 原廠預設 描述

Setting(Custom) On / Off On 在 Custom 模式中開啟/關閉雜訊抑制功能。

Level(Custom) Low / Mid / High Mid 在 Custom 模式中設定雜訊抑制程度。

Setting (Cine EI/Flex. ISO) On / Off Off 在日誌拍攝模式中，開啟/關閉雜訊抑制功能。

Level (Cine EI/Flex. ISO) Low / Mid / High Mid 在日誌拍攝模式中，設定雜訊抑制程度。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Flicker Reduce

設定閃爍校正設定。
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項目 子項目設定 原廠預設 描述

Mode Auto / On / Off Off 設定閃爍校正模式。

Frequency 50Hz / 60Hz 60Hz 設定提供導致閃爍的照明所用的電源頻率。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

SteadyShot

設定影像穩定設定。
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項目 子項目設定
原廠預
設

描述

Setting
Active / Standard /
Off

Off

設定影像穩定功能。

注意

安裝相容鏡頭時啟用。

設定為 Active 或 Standard 時，在平移/傾斜操作期間，可能會發生非預期的
行為。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Base Setting

設定基本設定。

相關主題

配置基本操作
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項目 子項目設定 原廠預設 描述

Shooting
Mode

Custom / Flexible ISO / Cine EI Quick /
Cine EI

Custom

設定拍攝模式。

請參閱“配置基本操作”中的“設定拍攝
模式”。

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
在 Custom 模式中，設定錄製/輸出的色
域。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Rec Format

設定錄製格式設定。

[RAW Output Format] 設定

預設值以粗體顯示。
省略了無法設定 [RAW Output Format] 的條件。

[Video Format] 設定

項目 子項目設定
原廠預
設

描述

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 選取系統頻率。

Imager Scan
Mode

FF / S35 FF 選取成像儀尺寸。

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

設定剪輯錄製/播放轉碼器。

注意

[Imager Scan Mode] 設定為 [S35] 時，無法選擇
[RAW] 及 [RAW & XAVC-I]。

RAW Output
Format

可用設定取決於 [Frequency] 設定。

請參閱下列的“[RAW Output
Format] 設定”。

–

設定要輸出到外部 RAW 錄影機的 RAW 影像之尺
寸。

注意

[Codec] 設定為 [RAW & XAVC-I] 時，[Video
Format] 設定會與 [RAW Output Format] 設定同
步切換。

Video Format

可用設定取決於 [Frequency]、[Imager
Scan Mode] 及 [Codec] 設定。

請參閱下列的“[Video Format] 設
定”。

– 設定影像尺寸及位元速率。

Frequency Imager Scan Mode Codec 設定

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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預設值以粗體顯示。
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Frequency Imager Scan Mode Codec 設定

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P

302



說明指南
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ILME-FR7 / ILME-FR7K

Cine EI/Flex.ISO Set

設定日誌拍攝模式的設定（請參閱“配置基本操作”中的“設定拍攝模式”）。

相關主題

配置基本操作
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項目 子項目設定 原廠預設 描述

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

設定日誌拍攝模式的色域（[Flexible ISO]、
[Cine EI Quick]、[Cine EI]）。

Embed LUT
File

On / Off On
開啟/關閉 3D LUT 檔案（CUBE 檔案）中繼
資料錄製。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Simul Rec

設定 2 槽同時錄製模式之設定（請參閱“同時錄製到記憶卡 A 和 B (2-slot Simul Rec)”）。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off
開啟/關閉 2 槽
同時錄製模
式。

Rec
Button
Set

Rec Button：<Slot A > <Slot B >2nd Rec Button：<Slot A
> <Slot B > /Rec Button：<Slot A >2nd Rec Button：<Slot
B > /Rec Button：<Slot B >2nd Rec Button：<Slot A >

Rec Button：<Slot A >
<Slot B >2nd Rec Button：
<Slot A > <Slot B >

指派用於控制
每個錄製媒介
的錄製按鈕。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Proxy Rec

設定代理錄製模式設定（請參閱“代理錄製”）。
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項目 子項目設定 原廠預設 描述

Setting On / Off Off 開啟/關閉代理錄製模式。

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 選取要錄製到代理資料的音訊通道。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Interval Rec

設定間隔錄製模式的設定（請參閱“間歇錄製視訊 (Interval Rec)”）。
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項目 子項目設定 原廠預設 描述

Setting On / Off Off
開啟/關閉間隔錄製模式。（將此
模式設定為 On 會將其他全部特
殊模式設定為 Off。）

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50（秒）
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50（分鐘）
1 / 2 / 3 / 4 / 6 / 12 / 24（小時）

1
設定 Interval Rec 錄製模式中的
錄製間隔（將 Interval Rec 設定
為 On 時）。

Number of
Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
可用設定取決於所選視訊格式的影格
率。
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P：1frame /
3frames / 6frames / 9frames

59.94P/50P：2frames
29.97P/25P/24P/23.98P：
1frame

設定在 Interval Rec 錄製模式中
每次拍攝要錄製的畫面數（將
Interval Rec 設定為 On 時）。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Picture Cache Rec

設定圖像快取錄製模式的設定（請參閱“錄製快取的圖像 (Picture Cache Rec)”）。

相關主題

錄製快取的圖像 (Picture Cache Rec)
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項目 子項目設定
原廠預
設

描述

Setting On / Off Off 開啟/關閉圖像快取功能。

Cache Size
Short / Medium / Long /
Max

Max
設定圖像快取記憶卡中影像的累積時間（圖像快取錄製時
間）。

Cache Rec
Time

– –
顯示圖像快取記憶卡中影像的累積時間（圖像快取錄製時
間）。
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SDI/HDMI Rec Control

設定 SDI/HDMI 錄製控制設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠
預設

描述

Setting
Off / SDI/HDMI Remote
I/F / Parallel Rec

Off

透過 SDI/HDMI 輸出訊號設定外部連接裝置的錄製開始/停止控制。
Off：不使用遙控器。
SDI/HDMI Remote I/F：裝置中未插入媒介時，錄製外部連接裝置的停
止/開始控制。與本裝置中媒介的畫面精準度不同步。
Parallel Rec：裝置中插入媒介時，錄製外部連接裝置的停止/開始控
制。與本裝置中媒介的畫面精準度同步。

注意

要使用 HDMI 輸出訊號進行控制，請在攝像機功能表中將[TC/Media] >
[HDMI TC Out] > [Setting] 設定為 [On]。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Assignable Button

將功能指派設定為可指派按鈕（<1> 至 <9>）和 [Focus Hold Button]。
可以指派下列功能。
[Off]：沒有功能指派。
[Base ISO/Sensitivity]：切換影像感測器的基本感光度。
[AGC]：開啟/:關閉 AGC 功能。
[Push AGC]：在按下按鈕時啟用 AGC 功能。
[ND Filter]

可變模式下：調整 ND 濾鏡的透射率。持續按住，可在 Clear/Manual/Auto 之間切換。
預設模式下：持續按住以切換預設。

[ND Filter Position]：切換 ND 濾鏡。
[Auto ND Filter]：開啟/關閉自動 ND 濾鏡功能。
[Push Auto ND]：在按下按鈕時啟用自動 ND 濾鏡功能。
[Auto Iris]：開啟/關閉光圈功能。
[Push Auto Iris]：在按下按鈕時啟用自動光圈功能。
[Bokeh Control]：開啟/關閉散景控制模式。
[Auto Shutter]：開啟/關閉自動快門功能。
[AE Level/Mode]：調整 AE 等級。持續按住，可切換 AE 模式。
[Backlight]：在 Backlight 及 Standard 之間切換。
[Spotlight]：在 Spotlight 及 Standard 之間切換。
[Preset White Select]：切換白平衡預設模式值。
[ATW]：開啟/:關閉 ATW 功能。
[ATW Hold]：暫停 ATW 功能操作。
[AF Speed/Sens.]：切換 AF 轉變速度設定和 AF 拍攝對象移動靈敏度設定。
[Focus Setting]：設定對焦區域。
[Face/Eye Detection AF]：切換臉部偵測自動對焦設定。
[Push AF Mode]：切換 Push AF 模式設定。
[Push AF/MF]：在手動對焦模式中，按下該按鈕可啟動自動對焦。在自動對焦模式中，按下該按鈕可啟動手動對焦。
[Focus Hold]：在自動對焦模式中，按下該按鈕可固定對焦。
[S&Q Motion]：開啟/關閉 Slow & Quick Motion 模式。如果持續按住，可設定拍攝影格率。
[LUT On/Off]： 開啟/關閉 LUT 功能。使用 [Shooting] > [LUT On/Off] > [LUT On/Off Button Target] 設定切換目標。
[SteadyShot]：在 Active、Standard 及 Off 之間切換。
[Crop Select]：切換成 Imager Scan Mode.在範圍內切換，而不變更錄製格式。
[Rec]：開始/停止錄製。
[Picture Cache Rec]：開啟/關閉圖像快取錄製模式。
[Rec Review]：開啟/關閉錄製查核功能。
[Clip Flag OK]：執行 Add OK。按下兩次可執行 Delete Clip Flag。
[Clip Flag NG]：執行 Add NG。按下兩次可執行 Delete Clip Flag。
[Clip Flag Keep]：執行 Add KEEP。按下兩次可執行 Delete Clip Flag。
[Slot Select]：在記憶卡插槽 (A) 及 (B) 之間切換。
[Color Bars]：開啟/關閉色條。
[DURATION/TC/U-BIT]：在 Time Code、Users Bit 及 Duration 之間切換。
[Display]：開啟/關閉畫面指示燈。
[Lens Info]：切換景深指示燈。
[Video Signal Monitor]：切換視訊訊號監視器（例如波形監視器）。
[Marker]：開啟/:關閉標記功能。
[Thumbnail]：顯示/退出縮圖畫面。
[Auto Upload (Proxy)]：開啟/關閉代理檔案自動傳輸。
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[Direct Menu]：顯示/退出直接功能表。
[User Menu]：顯示/退出 User 功能表。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Scene File

設定與場景檔案有關的設定（請參閱“以所需風格拍攝”）。
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項目 子項目設定
原廠
預設

描述

Recall – –
載入在內部記憶體中儲存的場景檔
案，並套用設定成為目前影像品質
設定。

Store – –
在內部記憶體中將目前影像品質狀
態另存為場景檔案。

Delete – – 刪除內部記憶體中儲存的場景檔
案。

Preset
Recall

當 Shooting Mode 設定為 Custom 且Target Display 設定為
SDR(BT.709) 時：S-Cinetone / Standard / Still / ITU709/
709tone
When Shooting Mode 設定為 Custom 且 Target Display 設
定為 HDR(HLG) 時：HLG Live / HLG Natural

–
套用預設的影像品質設定（不可重
寫）成為目前影像品質設定。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Base Look

設定與基本風格有關的設定。
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項目 子項目設定 原廠預設 描述

Select

當 Shooting Mode 設定為 Custom 且Target
Display 設定為 SDR(BT.709) 時：S-Cinetone /
Standard / Still / ITU709 / 709tone / User1 至
User16
當 Shooting Mode 設定為 Custom 且 Target
Display 設定為 HDR(HLG) 時：HLG Live / HLG
Natural / User1 至 User16
當 Shooting Mode 設定為日誌拍攝模式時：
s709 / 709(800) / S-Log3 / User1 至 User16

當 Shooting Mode 設定為 Custom
且Target Display 設定為
SDR(BT.709) 時：S-Cinetone
當 Shooting Mode 設定為 Custom
且 Target Display 設定為
HDR(HLG) 時：HLG Live
當 Shooting Mode 設定為日誌拍攝
模式時：s709

選取基本風格。

Delete – –
刪除選取的基本
風格。

Delete
All

– –
刪除全部基本風
格。

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 S-Gamut3.Cine/SLog3
使用 [Select] 為
選取的基本風格
設定輸入色域。

Output BT.709 / HLG BT.709
使用 [Select] 為
選取的基本風格
設定輸出色域。

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV / 5/3EV / 2EV 0EV

使用 [Select] 為
選取的基本風格
設定曝光參考
值。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Reset Paint Settings

重設 [Paint/Look] 功能表設定，不包括基本風格。
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項目 子項目設定 原廠預設 描述

Reset without Base Look Execute / Cancel –
重設 [Paint/Look] 功能表設定，不包括基本風格。
Execute：執行功能。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Black

設定黑色設定。
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項目 子項目設定 原廠預設 描述

Master Black −99.0 至 +99.0 ±0.0 設定主要黑色量。

R Black −99.0 至 +99.0 ±0.0 設定 R 黑色量。

B Black −99.0 至 +99.0 ±0.0 設定 B 黑色音量。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Knee

設定曲折點校正設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting

當 Target Display 設定為
SDR(BT.709) 時： On / Off /
---
當 Target Display 設定為
HDR(HLG) 時： On / Off / ---

當 Target Display 設定
為 SDR(BT.709) 時：Off
當 Target Display 設定
為 HDR(HLG) 時：Off

開啟/關閉曲折點校正功能。

注意

僅在 [Base Look] > [Select] 設定為
[Standard]、[ITU709]、[709tone]、[HLG Live]
或 [HLG Natural] 時啟用。

Auto
Knee

當 Target Display 設定為
SDR(BT.709) 時： On / Off /
---
當 Target Display 設定為
HDR(HLG) 時： On / Off / ---

當 Target Display 設定
為 SDR(BT.709) 時：On
當 Target Display 設定
為 HDR(HLG) 時：Off

開啟/關閉自動曲折點功能。

注意

僅在 [Base Look] > [Select] 設定為
[Standard]、[ITU709] 或 [709tone] 時啟用。

Point 75% 至 109% 90% 設定曲折點。

Slope −99 至 +99 ±0 設定曲折點斜度。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Detail

設定細部調整設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Setting On / Off On 開啟/關閉細部功能。

Level −7 至 +7 ±0 設定細部程度。

Manual
Setting

On / Off / --- Off 開啟/關閉細部手動調整功能。

H/V Ratio −2 至 +2 ±0

在水平 (H) 細部和垂直 (V) 細部之間設定平衡，以進行細部手動
調整。

注意

此項目因軟體版本而異。*1

B/W Balance
Type1 / Type2 / Type3 /
Type4 / Type5

Type3
對於細部手動調整，設定低亮度區域的黑色 (B) 細部與高亮度區
域的白色 (W) 細部之間的平衡。

Limit 0 至 7 7 設定細部手動調整的細部極限程度。

Crispening 0 至 7 0 設定細部手動調整的細化程度。

High Light
Detail

0 至 4 0 設定細部手動調整的高亮度區域細部程度。

在軟體版本 1.00 中，功能表項目為 [V/H Balance]。在軟體版本 1.10 或更新版本中，功能表項目為 [H/V Ratio]。設定範圍不變，從 -2 至 0 至
+2，不過對影像品質的影響不同。
軟體版本 1.00：設定值愈高，水平 (H) 細部愈高。
軟體版本 1.10 或更新版本：設定值愈高，垂直 (V) 細部愈高。
軟體從 1.00 版本更新到 1.10 或更新版本後，會沿用 [All File]、[Scene File] 等設定，不過極性反接（畫質不變）。
如果您在 [User] 功能表中註冊 [V/H Balance] 功能表項目，這將在更新軟體後自動替換為 [User] 功能表中的 [H/V Ratio] 功能表項目。

*1
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Matrix

設定矩陣校正設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

User Matrix On / Off Off 開啟/關閉使用者矩陣校正功能。

User Matrix Level −99 至 +99 ±0 調整整個影像的色彩飽和度。

User Matrix Phase −99 至 +99 ±0 調整整個影像的色調（相位）。

User Matrix R-G −99 至 +99 ±0 設定使用者定義的 R-G 使用者矩陣。

User Matrix R-B −99 至 +99 ±0 設定使用者定義的 R-B 使用者矩陣。

User Matrix G-R −99 至 +99 ±0 設定使用者定義的 G-R 使用者矩陣。

User Matrix G-B −99 至 +99 ±0 設定使用者定義的 G-B 使用者矩陣。

User Matrix B-R −99 至 +99 ±0 設定使用者定義的 B-R 使用者矩陣。

User Matrix B-G −99 至 +99 ±0 設定使用者定義的 B-G 使用者矩陣。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Multi Matrix

設定多矩陣校正設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Setting On / Off Off 開啟/關閉多矩陣校正功能。

Reset Execute / Cancel –
將每個軸色彩的色調和飽和度重
設為預設值。

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL− / YL / YL+ / G− / G
/ G+ / CY / CY+ / B−

B 選取軸。

Hue −99 至 +99 ±0 設定用於多矩陣校正的色調。

Saturation −99 至 +99 ±0
設定用於多矩陣校正的色彩飽和
度。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

P/T Acceleration

設定與平移/傾斜操作加速有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Ramp Curve 1 至 9 8 選擇平移/傾斜操作的加速/減速。數字越大，加速越快。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Timecode

設定時間碼設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Mode Preset / Regen / Clock Preset

設定時間碼執行模式。
Preset：從預設值開始執行。
Regen：從上一個剪輯結尾的時間碼開始執行。
Clock：使用內部時鐘做為時間碼。

Run Rec Run / Free Run Rec Run
Rec Run：僅在錄製時執行。
Free Run：無論進行何種錄製操作，一律執行。

Setting – – 將時間碼設定為任意值。
Set：設定數值。

Reset Execute / Cancel –
將時間碼重設為 00:00:00:00。
Execute：執行功能。

TC Format DF / NDF DF
設定時間碼格式。
DF： 捨棄畫面
NDF： 非捨棄畫面
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

TC Display

設定時間資料顯示設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Display Select Timecode / Users Bit / Duration Timecode 切換時間資料顯示。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Users Bit

設定與使用者位元有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Mode Fix / Time Fix
設定使用者位元模式。
Fix：使用者位元中使用任意固定值。
Time：在使用者位元中使用目前小時、分鐘及秒數。

Setting – – 將使用者位元設定為任意值。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

HDMI TC Out

設定使用 HDMI 時與時間碼輸出有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off 設定是否使用 HDMI 將時間碼輸出到裝置以用於其他目的。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Clip Name Format

設定與剪輯命名和刪除有關的設定。
[Auto Naming] 設定為 [Cam ID + Reel#] 時，為每個錄製媒介確定剪輯名稱的前四個字元。插入新的錄製媒介時，或者當
錄製媒介上的最後一個剪輯與 [Camera ID] 或 [Reel Number] 設定不相符時，剪輯名稱會閃爍以通知您。
[Auto Naming] 設定為 [Title]，您可以使用任意字元字串作為剪輯名稱的第一個部分。

設定 [Title Prefix]

項目 子項目設定
原廠預
設

描述

Auto Naming Cam ID + Reel# / Title

選擇剪輯命名格式。
Cam ID + Reel#：攝影機 ID + 膠捲編號 + 鏡頭編號 + 日期 + 隨機
字串
Title：[Title Prefix] 指定的任意字串 + 剪輯編號

Camera ID A 至 Z A

設定產生剪輯名稱時使用的攝影機 ID。

注意

僅限 [Auto Naming] 設定為 [Cam ID + Reel#] 時可配置。

Reel Number 001 至 999 001

設定產生剪輯名稱時使用的膠捲編號部分。

注意

僅限 [Auto Naming] 設定為 [Cam ID + Reel#] 時可配置。

Camera
Position

C / L / R C

設定產生剪輯名稱時所用鏡頭編號的第一個字元部分。

注意

僅限 [Auto Naming] 設定為 [Cam ID + Reel#] 時可配置。

Title Prefix
nnn_（nnn 是序號的後
3 位數）
（最多顯示 7 位數）

nnn

設定剪輯名稱的標題部分（4 到 46 個字元）。
開啟字元字串輸入畫面。

有關設定標題和字元輸入畫面的詳細資料，請參閱下方的“設定
標題”和“輸入字元字串”。

注意

僅限 [Auto Naming] 設定為 [Title] 時可配置。

Number Set 0001 至 9999 0001

設定剪輯名稱的 4 位數尾碼。

注意

僅限 [Auto Naming] 設定為 [Title] 時可配置。
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相關主題

輸入字元字串

5-041-957-83(1) Copyright 2022 Sony Corporation

使用 GUI 控制面板中的箭頭按鈕從字元選取區域中選取要插入到 [Title Prefix] 區域中游標位置的字元（字元被加亮
顯示），然後按下 GUI 控制面板中的 [Set] 按鈕。

插入選取的字元，且游標向右移動。

1

重複步驟 1 以設定標題。

如有需要，使用 [BS]。

2

設定標題後，按下 [Done] 按鈕，以關閉字元輸入畫面。

有關字元輸入畫面上的操作詳細資料，請參閱“輸入字元字串”。

可以選擇下列字元。
!#$%()+,-.;=@[ ]^_~ 空格字元
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Update Media

更新記憶卡上的管理檔案（請參閱“還原記憶卡”）。

相關主題

還原記憶卡

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Media(A) Execute / Cancel –
更新插槽 A 中記憶卡上的管理檔案。
Execute：執行功能。

Media(B) Execute / Cancel –
更新插槽 B 中記憶卡上的管理檔案。
Execute：執行功能。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Format Media

格式化（初始化）記憶卡（請參閱“格式化（初始化）記憶卡”）。

相關主題

格式化（初始化）記憶卡

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Media(A) Full Format / Quick Format / Cancel – 格式化插槽 A 中的記憶卡。

Media(B) Full Format / Quick Format / Cancel – 格式化插槽 B 中的記憶卡。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Media Life

顯示記憶卡的剩餘壽命。

注意

需要支援顯示剩餘媒介壽命的記憶卡。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Media(A) – – 顯示插槽 A 中記憶卡的剩餘壽命。

Media(B) – – 顯示插槽 B 中記憶卡的剩餘壽命。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Output Format

設定輸出格式設定。

相關主題

輸出格式和限制

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

SDI
有關設定的詳細資料，請參閱“輸出格式和限制”。

–
設定 SDI 和 HDMI 輸出解析度。

HDMI –
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Display On/Off

設定顯示項目設定。
要顯示顯示項目，請選擇 On。要隱藏顯示項目，請選擇 Off。

項目 子項目設定 原廠預設

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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項目 子項目設定 原廠預設

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Video Signal Monitor

設定視訊訊號監視器設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting Off / Waveform / Vector / Histogram Off 設定視訊訊號監視器的類型。

Level Marker 1 0% 至 109% 70% 設定亮度等級標記 1 之等級。

Level Marker 2 0% 至 109% 100% 設定亮度等級標記 2 之等級。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Marker

設定標記顯示設定。

項目 子項目設定 原廠預設 描述

Setting On / Off On 開啟/關閉全部標記的顯示。

Color
White / Yellow / Cyan / Green / Magenta /
Red / Blue

White 選取標記訊號色彩。

Center Marker 1 / 2 / 3 / 4 / Off Off 選取中央標記。

Safety Zone On / Off Off 開啟/關閉安全區域標記。

Safety Area 80% / 90% / 92.5% / 95% 90%
選取安全區域標記的大小（佔整體畫面
大小的百分比）。

Aspect
Marker

Line / Mask / Off Off 選取長寬比標記的類型。

Aspect Mask 0 至 15 12 設定標記外部的視訊訊號強度。

Aspect Safety
Zone

On / Off Off 開啟/關閉長寬比安全區域標記。

Aspect Safety
Area

80% / 90% / 92.5% / 95% 90%
選取長寬比安全區域標記的大小（佔整
體畫面大小的百分比）。

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 /
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

2.39:1 設定顯示長寬比標記時的模式。

Custom
Aspect Ratio

輸入任意值。 01.00:01.00

將寬高比設定為任意值。

注意

[Aspect Select] 設定為 [Custom] 時
啟用。

Guide Frame On / Off Off 開啟/關閉引導畫面顯示。

100% Marker On / Off Off 開啟/關閉 100% 標記。

User Box On / Off Off 開啟/關閉使用者方塊標記顯示。

User Box
Width

3 至 479 240
設定使用者方塊標記寬度（從中央到左
右邊緣的距離）。

User Box
Height

3 至 269 135
設定使用者方塊標記高度（從中央到上
下邊緣的距離）。

User Box H
Position

−476 至 +476 0 設定使用者方塊標記中央的水平位置。
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項目 子項目設定 原廠預設 描述

User Box V
Position

−266 至 +266 0 設定使用者方塊標記中央的垂直位置。

334



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Audio Input

設定音訊輸入設定。

項目 子項目設定 原廠預設 描述

AUDIO IN
Select

MIC / LINE MIC 選擇連接到 AUDIO IN 連接器的裝置類型。

Phantom Power
+48V

On / Off Off 顯示 +48 V 幻象電源的狀態。

CH1 Input
Select

AUDIO IN CH1
AUDIO IN
CH1

顯示通道 1 上用於錄製的輸入來源。

CH2 Input
Select

AUDIO IN CH1 / AUDIO
IN CH2

AUDIO IN
CH2

在通道 2 上切換用於錄製的輸入來源。

CH3 Input
Select

Off / AUDIO IN CH1
AUDIO IN
CH1

在通道 3 上切換用於錄製的輸入來源。

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN
CH2

在通道 4 上切換用於錄製的輸入來源。

AUDIO IN CH1
MIC Ref.

−80dB / −70dB / −60dB
/ −50dB / −40dB /
−30dB

−50dB
對來自 AUDIO IN CH1 的 XLR 麥克風輸入，設定參考錄製
音量。

AUDIO IN CH2
MIC Ref.

−80dB / −70dB / −60dB
/ −50dB / −40dB /
−30dB

−50dB
對來自 AUDIO IN CH2 的 XLR 麥克風輸入，設定參考錄製
音量。

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB 選擇 [AUDIO IN Select] 設定為 LINE 時的參考輸入音量。

Reference
Level

−20dB / −18dB / −16dB
/ −12dB / EBUL

−20dB 選取 1 kHz 參考音調訊號的錄製音量。

CH1 Wind Filter On / Off Off 啟用/停用通道 1 錄製的濾風切聲過濾器。

CH2 Wind Filter On / Off Off 啟用/停用通道 2 錄製的濾風切聲過濾器。

CH3 Wind Filter On / Off Off 啟用/停用通道 3 錄製的濾風切聲過濾器。

CH4 Wind Filter On / Off Off 啟用/停用通道 4 錄製的濾風切聲過濾器。

CH1 Level
Control

Auto / Manual Auto 為錄製通道 1 選擇音訊輸入音量是自動調整還是手動調整。

CH2 Level
Control

Auto / Manual Auto 為錄製通道 2 選擇音訊輸入音量是自動調整還是手動調整。

CH3 Level
Control

Auto / Manual Auto 為錄製通道 3 選擇音訊輸入音量是自動調整還是手動調整。
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項目 子項目設定 原廠預設 描述

CH4 Level
Control

Auto / Manual Auto 為錄製通道 4 選擇音訊輸入音量是自動調整還是手動調整。

CH1 Input Level 0 至 99 49 設定錄製通道 1 的輸入音量。

CH2 Input Level 0 至 99 49 設定錄製通道 2 的輸入音量。

CH3 Input Level 0 至 99 49 設定錄製通道 3 的輸入音量。

CH4 Input Level 0 至 99 49 設定錄製通道 4 的輸入音量。

Master Input
Level

0 至 99 99 設定主音訊輸入音量。

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB / −17dB

Off
手動調整音訊輸入音量時，為大型輸入訊號選取限制器特
性。

CH1&2 AGC
Mode

Mono / Stereo Stereo
設定錄製通道 1 和通道 2 的自動音量調整模式。設定為
Stereo 時，在通道之間連結 AGC。

CH3&4 AGC
Mode

Mono / Stereo Stereo
設定錄製通道 3 和通道 4 的自動音量調整模式。設定為
Stereo 時，在通道之間連結 AGC。

AGC Spec
−6dB / −9dB / −12dB /
−15dB / −17dB

−6dB 選取 AGC 特性。

1kHz Tone on
Color Bars On / Off Off

顯示色條時開啟/關閉 1 kHz 參考音調訊號。

注意

設定 [On] 時，即使將 [CH3 Input Select] 和 [CH4 Input
Select] 設定為 [Off]，也會於通道 3 和通道 4 上的錄製設定
1 kHz 參考音調訊號。
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Audio Output

設定音訊輸出設定。
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項目 子項目設定 原廠預設 描述

HDMI/Stream Output CH CH1/CH2 / CH3/CH4 CH1/CH2 設定 HDMI/串流輸出上的音訊通道組合。
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Display Clip Properties

顯示剪輯屬性畫面。
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項目 子項目設定 原廠預設 描述

Display Clip Properties – – 顯示剪輯屬性畫面。
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Set Clip Flag

設定剪輯旗標設定。
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項目 子項目設定 原廠預設 描述

Add OK – – 新增 OK 旗標。

Add NG – – 新增 NG 旗標。

Add KEEP – – 新增 KEEP 旗標。

Delete Clip Flag – – 刪除全部旗標。
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Lock/Unlock Clip

設定剪輯保護設定。
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項目 子項目設定 原廠預設 描述

Select Clip – – 選取並鎖定/解除鎖定剪輯。

Lock All Clips – – 鎖定全部剪輯。

Unlock All Clips – – 解除鎖定全部剪輯。
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Delete Clip

刪除剪輯。
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項目 子項目設定 原廠預設 描述

Select Clip – – 刪除選取的剪輯。

All Clips – – 刪除全部剪輯。
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Transfer Clip

傳輸剪輯。
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項目 子項目設定 原廠預設 描述

Select Clip – – 傳輸選取的剪輯。

All Clips – –

傳輸全部剪輯。

注意

最多可以登錄 200 個傳輸工作。
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Transfer Clip (Proxy)

傳輸代理剪輯。
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項目 子項目設定 原廠預設 描述

Select Clip – – 傳輸與選取的剪輯相對應的代理剪輯。

All Clips – –

傳輸與全部剪輯相對應的代理剪輯。

注意

最多可以登錄 200 個傳輸工作。
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Filter Clips

設定要顯示的剪輯設定。
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項目 子項目設定 原廠預設 描述

OK – – 僅顯示有 OK 旗標的剪輯。

NG – – 僅顯示有 NG 旗標的剪輯。

KEEP – – 僅顯示有 Keep 旗標的剪輯。

None – – 僅顯示沒有旗標的剪輯。

All – – 顯示全部剪輯，無論是否有任何旗標。
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Customize View

切換縮圖畫面檢視。
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項目 子項目設定 原廠預設 描述

Thumbnail
Caption

Date Time / Time Code / Duration / Sequential
Number

Time
Code

切換縮圖下方顯示的資
訊。
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Color Bars

設定色條設定。
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項目 子項目設定 原廠預設 描述

Setting On / Off Off 開啟/關閉色條。

Type ARIB / 100% / 75% / SMPTE ARIB 選取色條類型。

346



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Genlock

配置同步鎖定狀態顯示（請參閱“同步視訊訊號的相位（同步鎖定））”。

相關主題

同步視訊訊號的相位（同步鎖定）
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項目 子項目設定 原廠預設 描述

Reference Internal / External(HD) / External(SD) – 顯示同步鎖定參考訊號的類型。
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Tally

設定錄製/提示燈設定（請參閱“連接提示訊號”）。

相關主題

連接提示訊號
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項目 子項目設定 原廠預設 描述

Tally Lamp Brightness High / Low / Off High 設定錄製/提示燈的亮度。

G Tally Lamp Enable / Disable Enable 啟用/停用 G 提示燈。

Tally Control External / Internal Internal
選擇接受本裝置錄製/提示燈控制資訊的目標。
External：從攝像機外部進行提示控制。
Internal：透過攝像機錄製操作進行控制。
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Rec Review

設定錄製查核設定（請參閱“查核錄製 (Rec Review)”）。

相關主題

查核錄製 (Rec Review)
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項目 子項目設定 原廠預設 描述

Setting 3s / 10s / Clip 3s 針對剛才錄製以進行錄製查核的剪輯，設定其播放時間。
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Zoom

設定變焦設定（“調整變焦”）。
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項目 子項目設定 原廠預設 描述

Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only 設定變焦類型。
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Lens

設定與鏡頭有關的設定。

相關主題

呼吸補償
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項目 子項目設定 原廠預設 描述

Lens Calibration Execute / Cancel –
使用電動變焦鏡頭時，執行相應功能，校正因各
鏡頭差異所致的變焦位置差異。

Zoom Ring Direction
Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

設定變焦環操作的方向。

注意

僅在使用支援變焦環方向切換的 E 接環鏡頭時
啟用。

Shading
Compensation Auto / Off Auto 設定自動陰影補償。

Chroma Aberration
Comp.

Auto / Off Auto 設定自動色差補償。

Distortion Comp. Auto / Off Auto 設定自動失真補償。

Breathing
Compensation

Auto / Off Off
設定鏡頭呼吸補償。

請參閱“呼吸補償”。

Distance Display Meter / Feet Meter 設定用於顯示鏡頭資訊和對焦位置的顯示單位。

Zoom Position
Display

Focal Length / Number /
Bar

Focal Length 設定變焦位置的顯示格式。

351



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

APR

執行 APR。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

APR Execute / Cancel –

執行 APR（自動像素還原）以進行影像感測器自動調整。
Execute：執行功能。

注意

在執行 APR 之前，務必蓋上鏡頭護蓋。
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Wired LAN

設定與有線區域網路連線有關的設定。
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項目 子項目設定 原廠預設 描述

HTTP Port – 80 顯示 HTTP 存取連接埠。

Detail Settings

– – 顯示有線區域網路連線的屬性。

DHCP
On / Off

On 顯示 DHCP 是啟用 (On) 還是停用 (Off)。

IP Address – [DHCP] 設定為 [Off] 時，顯示本裝置的 IP 位址。

Subnet Mask – [DHCP] 設定為 [Off] 時，顯示本裝置的子網路遮罩。

Gateway – 當 [DHCP] 設定為 [Off] 時，顯示預設閘道。

DNS Auto
On / Off

On 顯示 DNS 自動擷取設定。
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File Transfer

設定與檔案傳輸有關的設定（請參閱“關於檔案傳輸”）。

相關主題

關於檔案傳輸
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項目 子項目設定
原廠
預設

描述

Auto Upload
(Proxy)

On / Off Off 開啟/關閉代理檔案自動上傳。

Default Upload
Server

Server Settings1 至 3 >
Display Name

–
選取檔案的上傳伺服器。這裡選取的伺服器將成為代理檔案的自
動上傳目的地，並成為從縮圖畫面上傳檔案的目的地。
顯示在 [Server Settings1 至 3] 中配置的 [Display Name] 設置。

Clear
Completed Jobs

Execute / Cancel – 從清單中清除完成的傳輸工作。
Execute：執行功能。

Clear All Jobs Execute / Cancel –
從清單中清除全部的傳輸工作。
Execute：執行功能。

View Job List – – 顯示傳輸工作清單。
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Language

設定顯示語言。
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項目 子項目設定 原廠預設 描述

Select – –
設定顯示語言。
Set：設定數值。
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Clock Set

設定內部時鐘設定。

注意

從攝像機功能表變更此設定時，請關閉本裝置的電源並重新啟動本裝置。如果使用紅外線遙控器或網路應用程式啟動電源待機，可
能會發生非預期的行為。
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項目 子項目設定 原廠預設 描述

Time Zone UTC − 12:00 至 UTC + 14:00 – 以 30 分鐘為單位設定與 UTC 的時差。

Date Mode YYMMDD / MMDDYY / DDMMYY YYMMDD

選取日期的顯示格式。
YYMMDD：年、月、日
MMDDYY： 月、日、年
DDMMYY：日、月、年

12H/24H 12H / 24H 24H
選取時鐘顯示格式。
12H：12 小時模式
24H：24 小時模式

Date – –
設定目前日期。
Set：設定數值。

Time – –
設定目前時間。
Set：設定數值。
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Hours Meter

顯示累計執行時間。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Hours(System) – – 顯示累計使用小時數（無法重設）。

Hours(Reset) – – 顯示累計使用時間（可以重設）。

Reset Execute / Cancel –
將累計執行時間重設為 0。
Execute：執行功能。
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ISO/Gain 設定和預設值

[ISO/Gain<L>] 設定和預設值的範圍取決於 [Mode]、[Base Look] > [Select] 及 [Base Sensitivity] 設定。
表格中的預設值以粗體顯示。

[Mode] 設定為 [ISO] 時

[Base Look] > [Select] 設定為 [S-Cinetone]、[Standard]、[ITU709]、[709tone] 或 [Still] 時

[Base Look] > [Select] 設定為 [HLG Live] 或 [HLG Natural] 時

[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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[Base Look] > [Select] 設定為 [User1] 至 [User16] 時

[Mode] 設定為 [dB] 時

以 1dB 為增量，可配置範圍為 −3dB 至 +30dB 之值。
預設值為 0dB。
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[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit 設定和預設值

[AGC Limit] 功能表設定和預設值的範圍取決於 [Mode]、[Base Look] > [Select] 及 [Base Sensitivity] 設定。
表格中的預設值以粗體顯示。

[Mode] 設定為 [ISO] 時

[Base Look] > [Select] 設定為 [S-Cinetone]、[Standard]、[ITU709]、[709tone] 或 [Still] 時

[Base Look] > [Select] 設定為 [HLG Live] 或 [HLG Natural] 時

[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

360



[Base Look] > [Select] 設定為 [User1] 至 [User16] 時

[Mode] 設定為 [dB] 時

從 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB 中選擇。
預設值為 15dB。
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[ISO/Gain/EI] > [Base Sensitivity] 設定為 [Low] 時 [ISO/Gain/EI] > [Base Sensitivity] 設定為 [High] 時

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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對於每個拍攝模式儲存的影像品質設定

對於下列每個拍攝模式，都會儲存與影像品質有關的配置項目的目前狀態。變更拍攝模式時，會套用為目標拍攝模式儲存
的相對應設定。

Custom 模式 SDR(BT.709) 目標顯示
Custom 模式 HDR(HLG) 目標顯示
日誌拍攝（Cine EI、Cine EI Quick、Flexible ISO）

各拍攝模式所儲存影像品質相關的配置項目如下表所示。
“是”表示已儲存設定，“否”表示未儲存設定。橫跨多列的“是”代表通用設定。

項目

拍攝模式

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting 功
能表

ISO/Gain/EI

ISO/Gain 是1) 是 否

Exposure Index 否 否 是 是

Base Sensitivity 是 否

Base ISO 否 是4) 否3) 是4)

White
Preset White 是 是

以上項目除外 是

White Setting 是

Offset White 是 否

LUT On/Off 否 是

Noise
Suppression

Setting(Custom) 是 是 否

Level(Custom) 是 是 否

Setting (Cine
EI/Flex. ISO)

否 是

Level (Cine EI/Flex.
ISO) 否 是
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項目

拍攝模式

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look 功
能表

Base Look

Select 是 是 是

Input2) 是

Output2) 是

AE 等級偏移2) 是

Black 是 是 否

Knee
Auto Knee 是 否 否

以上項目除外 是 是 否

Detail 是 是 否

Matrix 是 是 否

Multi Matrix 是 是 否

針對 Custom 模式 SDR(BT.709) 和 HDR(HLG)，儲存個別的 ISO 感光度設定。1)

儲存每個基本風格的設定，且不取決於拍攝模式。2)

基本 ISO 感光度隨著曝光指數的變化而改變。3)

Flexible ISO和Cine EI拍攝模式中的通用設定值。4)
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網路功能表配置

按下 [Settings] 操作畫面切換索引標籤，以顯示設定畫面。
使用設定畫面配置本裝置的各種設定項目，包括使用網路功能表的初始設定、網路設定、拍攝/播放設定。

該功能表包括下列功能表。

功能表配置和階層

層級 1 層級 1 描述 層級 2

Shooting 包含與拍攝有關的設定。 Focus
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層級 1 層級 1 描述 層級 2

Project 包含基本專案設定。

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look 包含與影像品質有關的設定。 Base Look

Pan-Tilt 包含與平移/傾斜有關的設定。

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring 包含與視訊輸出和畫面顯示有關的設定。
Output Format

Output Display

Audio 包含與音訊有關的設定。 Audio

Technical 包含技術項目的設定。

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network 包含與網路有關的設定。

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection
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注意

[Accessibility] 僅適用於北美機型。

5-041-957-83(1) Copyright 2022 Sony Corporation

層級 1 層級 1 描述 層級 2

Stream 包含與串流有關的設定。

Stream

Video Stream

Audio Stream

Maintenance 包含裝置設定，例如時鐘和語言。

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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網路功能表操作

按下 [Settings] 操作畫面切換索引標籤，以顯示用於配置本裝置各種設定項目的設定畫面，包括使用網路功能表的初始設
定、網路設定、拍攝/播放設定。
在平板電腦上使用觸控操作或在電腦上使用滑鼠操作，以配置網路功能表中的設定。
按下您要配置的項目之功能表，在該功能表中顯示設定項目及其設定。

配置方式

選取值

按下項目的無線電按鈕。所選項目的無線電按鈕顯示為橘色。

功能表（層級 1）1.

功能表（層級 2）2.

設定3.
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項目開啟/關閉

按下開關以開啟／關閉項目。項目開啟時開關為橘色，關閉時為白色。

從列表中選取值

按下下拉按鈕，並從顯示的列表中選擇一個項目。

數值選擇

按下 < 或 > 來變更數值。如果數值下有加底線，也可以直接輸入數值。

輸入字元/數字

單獨畫面上的配置

按下按鈕，在單獨的畫面上執行設定操作。

導引訊息

顯示幫助您配置一些設定訊息及引起使用者注意的訊息。

儲存設定

完成配置設定後，按下 [OK] 按鈕以儲存設定。
按下 [Cancel] 按鈕以放棄變更設定並回復到之前的設定。
按下 [Reload] 按鈕以更新畫面顯示。

注意

如果儲存設定之前按下 [Reload] 按鈕，將放棄目前變更的設定。

如果儲存設定之前移動至不同頁面，將放棄目前變更的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation
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Focus

設定對焦設定。

相關主題

使用網路應用程式手動設定自動對焦目標 (AF Assist)

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Push AF Mode
AF / Single-shot
AF(AF-S)

AF 設定鍵控自動對焦模式。

Touch Function
in MF

Tracking AF / Spot
Focus

Tracking
AF

設定在 MF 模式下觸控攝像機影像畫面時的操作。

AF Assist
Control

On / Off On

設定為 [On] 時，您可以在自動對焦期間使用網路應用程式中的
對焦滑桿來調整對焦位置。

有關詳細資料，請參閱“使用網路應用程式手動設定自動對焦
目標 (AF Assist)”。

注意

此項目僅在攝像機功能表中的 [AF Assist] 設定為 [On] 時啟用。
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Base Setting

設定基本設定。

相關主題

配置基本操作

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Shooting
Mode

Custom / Flexible ISO / Cine EI Quick /
Cine EI

Custom

設定拍攝模式。

請參閱“配置基本操作”中的“拍攝模
式”。

Target Display SDR(BT.709) / HDR(HLG) SDR(BT.709)
在 Custom 模式中，設定錄製/輸出的色
域。
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Rec Format

設定錄製格式設定。

[RAW Output Format] 設定

預設值以粗體顯示。
省略了無法設定 [RAW Output Format] 的條件。

項目 子項目設定
原廠預
設

描述

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

選取系統頻率。

注意

如果頻率改變，攝像機將重新啟動。重新啟動
後，在網頁瀏覽器中重新載入頁面。

Imager Scan
Mode

FF / S35 FF 選取成像儀尺寸。

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

設定剪輯錄製/播放轉碼器。

注意

[Imager Scan Mode] 設定為 [S35] 時，無法選擇
[RAW] 及 [RAW & XAVC-I]。

RAW Output
Format

可用設定取決於 [Frequency] 設定。

請參閱下列的“[RAW Output
Format] 設定”。

–

設定要輸出到外部 RAW 錄影機的 RAW 影像之尺
寸。

注意

[Codec] 設定為 [RAW & XAVC-I] 時，[Video
Format] 設定會與 [RAW Output Format] 設定同
步切換。

Video Format

可用設定取決於 [Frequency]、[Imager
Scan Mode] 及 [Codec] 設定。

請參閱下列的“[Video Format] 設
定”。

– 選取影像尺寸。

Frequency Imager Scan Mode Codec 設定

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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[Video Format] 設定

預設值以粗體顯示。

5-041-957-83(1) Copyright 2022 Sony Corporation

Frequency Imager Scan Mode Codec 設定

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I / XAVC-I 4096×2160P
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Simul Rec

設定 2 槽同時錄製模式之設定（請參閱“同時錄製到記憶卡 A 和 B (2-slot Simul Rec)”）。

相關主題

同時錄製到記憶卡 A 和 B (2-slot Simul Rec)

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off 開啟/關閉同時錄製功能，並設定錄製目的地媒介。

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot
B 顯示每個錄製媒介的錄製按鈕指派。

在攝像機功能表中設定 [Project] > [Simul Rec] > [Rec
Button Set]。2nd Rec

Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot
B
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Proxy Rec

設定代理錄製模式設定（請參閱“代理錄製”）。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off 開啟/關閉代理錄製模式。
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Interval Rec

設定間隔錄製模式的設定（請參閱“間歇錄製視訊 (Interval Rec)”）。

相關主題

間歇錄製視訊 (Interval Rec)

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off
開啟/關閉間隔錄製模式。（將此
模式設定為 On 會將其他全部特
殊模式設定為 Off。）

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50（秒）
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 /
20 / 30 / 40 / 50（分鐘）
1 / 2 / 3 / 4 / 6 / 12 / 24（小時）

1
設定 Interval Rec 錄製模式中的
錄製間隔（將 Interval Rec 設定
為 On 時）。

Number of
Frames

1frame / 2frames / 3frames / 6frames
/ 9frames / 12frames
可用設定取決於所選視訊格式的影格
率。
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P：1frame /
3frames / 6frames / 9frames

59.94P/50P：2frames
29.97P/25P/24P/23.98P：
1frame

設定在 Interval Rec 錄製模式中
每次拍攝要錄製的畫面數（將
Interval Rec 設定為 On 時）。
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Picture Cache Rec

設定圖像快取錄製模式的設定（請參閱“錄製快取的圖像 (Picture Cache Rec)”）。

相關主題

錄製快取的圖像 (Picture Cache Rec)

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Setting On / Off Off 開啟/關閉圖像快取功能。

Cache Size
Short / Medium / Long /
Max

Max
設定圖像快取記憶卡中影像的累積時間（圖像快取錄製時
間）。

Cache Rec
Time

– –
顯示圖像快取記憶卡中影像的累積時間（圖像快取錄製時
間）。
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All File

執行 ALL 檔案操作（請參閱“儲存和載入配置資料”）。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目
子項目設

定
原廠預
設

描述

Load All
File

– –

從執行網路應用程式的設備將 ALL 檔案載入至本裝置中。

注意

將 ALL 檔案載入至本裝置後，本裝置將重新啟動。重新啟動後，在網頁瀏覽器中重
新載入頁面。

Save All
File

– – 將本裝置的設定作為 ALL 檔案儲存到執行網路應用程式的設備中。
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Base Look

您可以將基本風格載入到本裝置中。
畫面上會顯示可用的基本風格清單。當前套用的基本風格由基本風格編號左側的 ● 標記予以表示。

[No.]：基本風格編號
[Base Look Name]：基本風格名稱
[Input]：基本風格輸入訊號
[Output]：基本風格輸出訊號
[AE Level Offset]：基本風格曝光參考偏移值

新增基本風格

按下 [Import] 按鈕以匯入新的基本風格。請按照畫面上的說明進行操作。
匯入後，為 [Input]、[Output] 及 [AE Level Offset] 設定適當的數值。有關詳細資料，請參閱“匯入所需的基本風格”。

相關主題

匯入所需的基本風格

5-041-957-83(1) Copyright 2022 Sony Corporation
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P/T Speed

設定與平移/傾斜速度有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Speed
Step

Normal /
Extended

Extended

設定平移/傾斜驅動器的速度階段數。
Normal：可以使用24階段範圍指定速度。使用此設定可與現有的 Sony 遠
端攝像機相容。
Extended：可以使用50階段範圍指定速度。

Speed
Mode

Normal / Slow Normal

設定平移/傾斜驅動器的速度模式。
僅限 [Speed Step] 設定為 [Normal] 時啟用。
Normal：在正常速度範圍內運行（最小至最大（60 度/秒））。
Slow：在低速度範圍內運行（最小至最大（40 度/秒））。
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P/T Acceleration

設定與平移/傾斜速度有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Acceleration 1 至 9 8 選擇平移/傾斜操作的加速/減速。數字越大，加速越快。
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P/T Range Limit

設定與限制平移/傾斜操作範圍相關的設定。
使用下列畫面來設定平移/傾斜操作範圍限制。

注意

當本裝置開啟或執行平移/傾斜重設時，此範圍限制設定將被忽略。此功能不能用於避開本裝置附近的障礙物。

將 [Setting] 開關設定至 On 位置。

平移/傾斜操作範圍限制功能將會啟用。

1

使用攝像機平移/傾斜控制來檢查影像。2

要設定限制操作的位置，請在這些位置按下 [Left]、[Right]、[Up]、[Down] > [Set Current Value] 按鈕。

[Left]：攝像機左側
[Right]：攝像機右側
[Up]：攝像機頂部
[Down]：攝像機底部

3
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注意

超出極限位置的攝像機位置無法儲存為預設位置。

如果變更 [Pan-Tilt] > [P/T Direction] > [Ceiling] 設定，配置的極限位置設定將恢復為原廠預設。

播放期間、縮圖顯示期間、平移/傾斜發生錯誤時、平移/傾斜未初始化時以及平移/傾斜被鎖定時，無法變更設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

設定極限位置，並以數值顯示（角度）。
要取消限制，請按下各個位置的 [Reset] 按鈕。

按下 [OK] 按鈕。

平移/傾斜操作被限制在配置的極限位置內。

4
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P/T Direction

設定與平移/傾斜方向有關的設定。

注意

套用變更的 [Ceiling] 設定時，因為平移/傾斜座標會反轉，將刪除所有預設位置。

根據 [Ceiling] 設定，平移/傾斜驅動範圍會如下圖所示發生變化。

A：[Ceiling] 設定為 [Off] 時
B：[Ceiling] 設定為 [On] 時

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Ceiling On / Off Off
當本裝置安裝在桌面上時，設定為 [Off]。當本裝置安裝在天花板上時，設定為
[On]。[Ceiling] 設定為 [On] 時，[Pan Direction] 會自動設定為 [Opposite]。

Pan
Direction

Normal /
Opposite

Normal 設定平移驅動方向。變更設定時，驅動方向反轉。

Tilt
Direction

Normal /
Opposite

Normal 設定傾斜驅動方向。變更設定時，驅動方向反轉。
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P/T Preset

設定與攝像機預設有關的設定。

Pan-Tilt
設定預設的速度。

Default
設定儲存預設位置時配置的預設值。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate 設定是單獨配置預設速度還是使用通用設定。

Pan-Tilt Speed for
Common

1 至 50 50

設定預設的通用速度。

注意

[Pan-Tilt] > [P/T Speed] > [Speed Step] 設定為 [Normal] 時，如果設
定了 25 或更高之值，將使用最高驅動速度 24。

項目 子項目設定 原廠預設 描述

Pan-Tilt Speed for Separate 1 至 50 50 設定當預設速度選擇方法設定為 [Separate] 時的預設速度。

Zoom Sync On / Off On 設定恢復預設位置時是否同步平移/傾斜操作和變焦操作。

Zoom Speed 0 至 32767 32767 設定變焦速度。

Focus Recall On / Off On 設定是否恢復焦點設定。

MF Speed 0 至 32767 32767 設定手動對焦的對焦速度。
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Output Format

設定輸出格式設定。

相關主題

輸出格式和限制

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

SDI
有關設定的詳細資料，請參閱“輸出格式和限制”。

–
設定 SDI 和 HDMI 輸出解析度。

HDMI –
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Output Display

設定與輸出訊號有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目
子項目設

定
原廠預
設

描述

SDI On / Off Off 設定功能表、狀態和畫面顯示是否嵌入於 SDI 輸出訊號中。

HDMI/Stream On / Off On

設定功能表、狀態和畫面顯示是否嵌入於 HDMI 輸出訊號中。

注意

此設定也適用於 HDMI 輸出訊號影像、串流輸出影像和網路應用程式攝像機影像窗
格中的影像。
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Audio Input

設定與 CH1 至 CH4 音訊輸入有關的設定。

設定主音訊輸入音量。主音訊輸入音量用於 1 至 4 之所有通道。
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項目 子項目設定 原廠預設 描述

Level
Control

Auto / Manual Auto
選擇音訊輸入音量自動調整或手動調
整。

Level 0 至 99 49 設定輸入音量。

Input Select
AUDIO IN CH1 / AUDIO IN CH2
/ Off

CH1 和 CH3： AUDIO IN
CH1
CH2 和 CH4： AUDIO IN
CH2

設定音訊輸入來源。

注意

CH1 設定為 [AUDIO IN CH1]（固
定）。

Wind Filter On / Off Off 開啟/關閉風聲降噪過濾器。

項目 子項目設定 原廠預設 描述

Master 0 至 99 99 設定主輸入音量。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Audio Output

設定與音訊輸出有關的設定。

注意

此設定也適用於串流輸出音訊。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

HDMI/Stream Output CH CH1/CH2 / CH3/CH4 CH1/CH2 設定 HDMI/串流輸出上的音訊通道組合。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Tracking Data Output

設定與追蹤資訊（符合 free-d 協定）輸出相關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Transfer Mode
Off / Always / On
Demand

Off 選擇追蹤資訊輸出方法。

Camera ID 0 至 255 255 設定本裝置的 ID。

Destination
Address

IPv4 位址 –
[Transfer Mode] 設定為 [Always] 時，設定追蹤訊息目的地 IP 位
址。

Destination Port 1024 至 65534 40000 [Transfer Mode] 設定為 [Always] 時，設定追蹤資訊目的地連接埠
號碼。

Listen Port 1024 至 65534 40000
[Transfer Mode] 設定為 [On Demand] 時，設定裝置上用於偵聽
用戶端請求的連接埠號碼。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Tally

設定錄製/提示燈設定（請參閱“連接提示訊號”）。

相關主題

連接提示訊號

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Tally Lamp Brightness High / Low / Off High 設定錄製/提示燈的亮度。

G Tally Lamp Enable / Disable Enable 啟用/停用 G 提示燈。

Tally Control External / Internal Internal 選擇接受本裝置錄製/提示燈控制資訊的目標。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

IR Remote

設定與紅外線遙控器有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off On 透過紅外線遙控器啟用/停用裝置操作。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

RCP/MSU

配置連接 RCP/MSU（選購件）時的設定。
有關詳細資料，請參閱“連接 RCP/MSU（選購件）”。

注意

根據需要配置 RCP/MSU 上的設定。

多攝像頭系統需要 MSU。

使用多台 MSU 裝置時，將一台 MSU 裝置設定為主裝置，將其他所有 MSU 裝置設定為用戶端。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

CNS Mode
Off / Bridge / MCS / PC
Control

Off 設定 RCP/MSU 的連接模式。

Master IP
Address

IPv4 位址 0.0.0.0 建立基於 LAN 的多攝像機系統時，設定主裝置的 IP 位址。

Camera No. Camera No.（1 至 96） 1 建立基於 LAN 的多攝像機系統時，在系統內設定唯一的攝
像機編號。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Lens Controller

設定所連接鏡頭控制器（選購件）的設定。
如需詳細資料，請參閱“連接鏡頭控制器”。

注意

[Setting] 改變時，本裝置將重新啟動。在網頁瀏覽器中，重新載入頁面。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目
子項目
設定

原廠預
設

描述

Setting On / Off Off 設定是否使用鏡頭控制器（選購件）。

Mode 0 至 15 0
設定鏡頭控制器（選購件）的操作模式。
可用範圍為 0 至 15，但實際可選擇的值會因鏡頭控制器（選購件）而異。如需詳細資
料，請參閱鏡頭控制器的操作說明。

Reverse On / Off Off 反轉鏡頭控制器（選購件）的旋轉方向。

Initialize – – 初始化鏡頭控制器（選購件）。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Camera Name

設定與攝像機名稱（本裝置名稱）有關的設定。

Camera Name可輸入最多 8 個（0 至 8）下列字元。
英數字元
符號（空格字元 !#$`*+-./;<=>?@[\]^_`{|}）

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Camera Name – FR7 設定攝像機名稱。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

User

設定與本裝置使用者存取有關的設定。

與管理員使用者 (Administrator) 有關的設定（必填）

與一般使用者有關的設定（User 1 至 User 9）（選填）

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

User Name – admin 設定使用者名稱。

Current Password – – 更改密碼時，請輸入當前密碼。

New Password – – 輸入新密碼。

Re-Type Password – – 再次輸入新密碼以進行確認。

項目 子項目設定 原廠預設 描述

User Name – – 設定使用者名稱。

Current Password – – 更改密碼時，請輸入當前密碼。

New Password – – 輸入新密碼。

Re-Type Password – – 再次輸入新密碼以進行確認。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Wired LAN

Status
顯示網路狀態。

IPv4
設定與 IPv4 網路有關的設定。

IPv6
設定與 IPv6 網路有關的設定。

項目 子項目設定 原廠預設 描述

Host Name – – 顯示主機名稱。

MAC Address – – 顯示本裝置的 Mac 位址。

Ethernet Status – – 顯示當前的通訊速度。

IP Address – – 顯示本裝置的 IP 位址。

Subnet Mask – – 顯示本裝置的子網路遮罩。

Gateway – – 顯示本裝置的 IPv4 預設閘道。

Primary DNS Server – – 顯示本裝置的主要 DNS 伺服器。

Secondary DNS Server – – 顯示本裝置的次要 DNS 伺服器。

IPv6 Address 1 – – 顯示本裝置的 IPv6 位址 1。

IPv6 Address 2 – – 顯示本裝置的 IPv6 位址 2。

IPv6 Gateway – – 顯示本裝置的 IPv6 預設閘道。

Link-local IPv6 Address – – 顯示本裝置的 IPv6 本地鏈路位址。

項目 子項目設定 原廠預設 描述

DHCP On / Off On 開啟/關閉 [DHCP] 功能。

IP Address – – [DHCP] 設定為 Off 時，設定 IPv4 位址。

Subnet Mask – – [DHCP] 設定為 Off 時，設定子網路遮罩。

Gateway – – 當 [DHCP] 設定為 Off 時，設定 IPv4 預設閘道。
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Common
設定 IPv4/IPv6 網路的通用設定。
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項目 子項目設
定

原廠預
設

描述

Obtain an IP Address
Automatically

On / Off On 開啟/關閉自動 IPv6 位址擷取。

IP Address – –
[Obtain an IP Address Automatically] 設定為 Off 時，設定 IPv6
位址。

Prefix Length – –
[Obtain an IP Address Automatically] 設定為 Off 時，設定前
綴。

Gateway – – 當 [Obtain an IP Address Automatically] 設定為 Off 時，設定
IPv6 預設閘道。

項目 子項目設定 原廠預設 描述

HTTP Port 80、1024 至 65534 80 設定 HTTP 連接埠號碼。

DNS Auto On / Off On 設定是否從 DHCP 伺服器取得 DNS 位址。

Primary DNS Server IPv4/IPv6 位址 – [DNS Auto] 設定為 Off 時，設定主要 DNS 伺服器。

Secondary DNS Server IPv4/IPv6 位址 – [DNS Auto] 設定為 Off 時，設定次要 DNS 伺服器。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

File Transfer

設定與檔案傳輸有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Auto Upload
(Proxy)

On / Off Off 開啟/關閉代理檔案自動上傳。

Default
Upload
Server

Server Settings1 至 3
> Display Name

Server
Settings1

選取檔案的上傳伺服器。這裡選取的伺服器將成為代理檔案
的自動上傳目的地，並成為從縮圖畫面上傳檔案的目的地。
顯示在 [Server Settings1 至 3] 中配置的 [Display Name] 設
置。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

FTP Server 1 至 3

設定與檔案 FTP 傳輸有關的設定。
這些設定通用於 FTP Server 1 至 3。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Display Name – – 設定在傳輸目的地設定功能表中顯示的顯示名稱。

Service – – 顯示伺服器的類型。

Host Name – – 設定傳輸目的地伺服器的主機名稱。

Port 21、990、1024 至 65534 21 設定傳輸目的地伺服器的連接埠號碼。

User Name – – 設定傳輸目的地伺服器連接的驗證使用者名稱。

Password – – 設定傳輸目的地伺服器連接的驗證密碼。

Passive Mode On / Off Off 開啟/關閉被動模式。

Destination Directory – – 設定傳輸目的地目錄的名稱。

Using Secure Protocol On / Off Off 設定是否使用 (On) 或不使用 (Off) 安全 FTP 傳輸。

Root Certificate – –
載入根憑證以進行安全 FTP 傳輸。
按下 [Load] 按鈕，並在顯示的畫面上選取根憑證。
按下 [Delete] 按鈕以刪除載入的根憑證。

Root Certificate Status – – 顯示根憑證的載入狀態。

Reset – – 將 [Server Settings] 設定重設為預設值。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

SSL

設定與 SSL 有關的設定。

SSL
啟用/停用 SSL 功能。

SSL Server Authentication
設定與 SSL 伺服器驗證有關的設定。

項目 子項目設定 原廠預設 描述

Function Disable / Enable / Enable (Allow HTTP connection for some clients) Disable 啟用/停用 SSL 功能。

項目 子項目設定
原廠
預設

描述

Certificate Options
Use a self-signed certificate (For
test use) / Use an external
certificate

– 設定 SSL 伺服器憑證的安裝方式。

Status – –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示 SSL 伺服器憑證的
有效性。

Issuer DN – –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示 SSL 伺服器憑證頒
發者的可分辨名稱。

Subject DN – –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示 SSL 伺服器憑證主
題的可分辨名稱。

Available Period – –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示 SSL 伺服器憑證的
有效期限。

Extended Key
Usage

– –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示擴充金鑰使用方
法。

Delete – –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，顯示此按鈕。
刪除已安裝的 SSL 伺服器憑證。

Import – –
[Certificate Options] 設定為 [Use an external
certificate] 時，從列表中安裝外部 SSL 伺服器憑證。

Private Key
Password

– –
[Certificate Options] 設定為 [Use an external
certificate] 時，設定 SSL 伺服器憑證的私密金鑰資
訊。
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項目 子項目設定 原廠
預設

描述

Reset – – 此按鈕可以清除顯示的私密金鑰密碼以輸入新密碼。

Self-Signed
Certificate
Generation

– –
[Certificate Options] 設定為 [Use a self-signed
certificate (For test use)] 時，按下 [Generate] 按鈕生
成自我簽署憑證。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Referer Check

設定與 Referer 檢查有關的設定。

Exception List
設定與 Referer 檢查例外清單有關的設定。
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項目 子項目設定 原廠預設 描述

Setting On / Off On 啟用/停用 Referer 檢查功能。

項目 子項目設定 原廠預設 描述

No. 1 至 10 – 從清單中設定例外編號。

Host Name – – 設定例外的主機名稱。

Port Number – – 設定例外的連接埠號碼。

Set – – 按下可在例外清單中登錄配置的例外。

Delete – – 選擇您要刪除的例外，並按下按鈕從例外清單中刪除已登錄的例外。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Brute Force Attack Protection

設定與蠻力攻擊保護有關的設定。

偵測到攻擊者時，會顯示攻擊者列表資訊。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Setting On / Off On 開啟/關閉 [Brute Force Attack Protection] 功能。

Count 3 至 100 8
設定將被視為攻擊的嘗試次數。
[Setting] 設定為 On 時啟用。

Release
Mode

Always /
Timer Timer

設定釋放條件。
[Setting] 設定為 On 時啟用。
Always：不要從攻擊者清單中刪除。
Timer：在經過使用 [Release Time] 設定的釋放時間後，從攻擊者列表中刪
除。

Release Time
30 至 86400
s

60

設定釋放時間。
[Setting] 設定為 On 時啟用。
Release Mode 設定為 [Timer] 時，會在經過釋放時間後從攻擊者列表中刪
除條目。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Stream

設定串流設定（請參閱“關於串流”）。

Stream Setting
設定與串流協定有關的設定。

注意

若要使用 RTMP，請預先將 [Stream] > [Audio Stream] > [Setting] 設定為 [On]。

RTSP
[Stream Setting] 設定為 [RTSP] 時，會顯示下列項目。
設定與 RTSP 串流有關的設定。

RTMP
[Stream Setting] 設定為 [RTMP] 時，會顯示下列項目。
設定與 RTMP 串流有關的設定。

SRT

項目 子項目設定 原廠預設 描述

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP 選取串流協定。

項目 子項目設定 原廠預設 描述

Port Number 554、1024 至 65534 554 設定 RTSP 連接埠號碼。

Time Out 0 至 600 60 對於 RTSP 串流設定 Keep Alive 命令的逾時時間。

Authentication On / Off On 開啟/關閉 RTSP 驗證功能。

Video Port Number 1 1024 至 65534 51000 為 RTSP 單點傳播串流設定發送視訊 1 的連接埠號碼。

Video Port Number 2 1024 至 65534 53000 為 RTSP 單點傳播串流設定發送視訊 2 的連接埠號碼。

Audio Port Number 1024 至 65534 57000 為 RTSP 單點傳播串流設定發送音訊的連接埠號碼。

項目 子項目設定 原廠預設 描述

Server URL – – 設定 RTMP 或 RTMPS 連接目的地 URL。

Stream Key – – 設定從 RTMP 伺服器端取得的串流金鑰。

Root Certificate – –

載入連接 RTMP 伺服器所需的根憑證。
按下 [Load] 按鈕，並在顯示的畫面上選取根憑證。
按下 [Delete] 按鈕以刪除載入的根憑證。
狀態顯示在 [Root Certificate Status] 中。
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[Stream Setting] 設定為 [SRT-Caller] 或 [SRT-Listener] 時，會顯示下列項目。
設定與 SRT 串流有關的設定。

NDI|HX
[Stream Setting] 設定為 [NDI|HX] 時，會顯示下列項目。
設定與 NDI|HX 有關的設定。

相關主題

關於串流

項目 子項目設定 原廠預設 描述

Destination – – 當本裝置作為呼叫者操作時，設定連接目的地 URL。

Port Number 1024 至 65534 4201 當本裝置作為收聽者操作時，設定收聽的連接埠號碼。

Latency 20 至 8000 ms 120 設定延遲。

TTL 1 至 255 64 設定 TTL 值。

Encryption Off / AES128 / AES256 Off 啟用/停用加密，並設定加密方法。

Passphrase 0 或 10 至79 個字元的字串 0
設定用於加密的密碼片語。
按下 Reset 以清除輸入的密碼片語。

ARC On / Off On 開啟/關閉 Adaptive Rate Control 功能。

項目 子項目設定 原廠預設 描述

License – – 顯示 NDI 授權金鑰的安裝狀態。

Source Name – – 顯示 NDI 來源名稱。

Group On / Off Off 開啟/關閉 NDI 分組功能。

Group Name – –
NDI 分組功能設定為 On 時顯示。
設定群組名稱。

Discovery Server 1 – – 設定 NDI 發現伺服器 1。

Discovery Server 2 – – 設定 NDI 發現伺服器 2。

Multicast Mode On / Off Off 開啟/關閉多點傳送串流。

Multicast Prefix 239.255.0.0 239.255.0.0
[Multicast Mode] 設定為 On 時顯示。
設定用於多點傳送串流的首碼。

Multicast Netmask 255.255.0.0 255.255.0.0
[Multicast Mode] 設定為 On 時顯示。
設定決定多點傳送位址範圍的網路遮罩。

Multicast TTL 1 至 256 3
[Multicast Mode] 設定為 On 時顯示。
設定多點傳送串流的 TTL 值。

Multi-TCP Mode On / Off Off 開啟/關閉 Multi-TCP 模式。

Unicast UDP Mode On / Off On 開啟/關閉 Unicast UDP 模式。
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Video Stream

設定與串流視訊轉碼器有關的設定。

Video Stream 1
設定與視訊轉碼器 1 有關的設定。

Video Stream 2
設定與視訊轉碼器 2 有關的設定。

項目 子項目設定 原廠預設 描述

Codec 1 H.264 / H.265 H.264 設定影像 1 的轉碼器。

Size 1
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360

1920×1080 設定影像 1 的圖像尺寸。

Frame Rate 1
有關所支援的影格率詳細資料，請參閱“設定串
流的視訊轉碼器”。 – 設定影像 1 的影格率。

I-Picture Mode 1 Time / Frame Time
將影像 1 的 IDR-Frame 插入
間隔設定為時間或影格數。

I-Picture Interval 1 1 / 2 / 3 / 4 / 5 s 1

[I-Picture Mode 1] 設定為
Time 時顯示。
將 H.264 和 H.265 的 IDR-
Frame 插入間隔設定為時
間。

I-Picture Ratio 1 15 至 300 影格 30

[I-Picture Mode 1] 設定為
Frame 時顯示。
將 H.264 及 H.265 的 IDR-
Frame 插入間隔設定為影格
數。

Profile 1
H.264：high / main / baseline
H.265：main / main10

H.264：
high

設定 H.264 或 H.265 設定
檔。

Bit Rate
Compression
Mode 1

CBR / VBR VBR
設定影像 1 的位元速率壓縮模
式。

Bit Rate 1
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

16000

[Bit Rate Compression Mode
1] 設定為 On 時顯示。
位元速率壓縮模式設定為
CBR 時，設定位元速率目標
值。

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 設定 H.264 或 H.265 品質。
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Video Stream 3
設定與視訊轉碼器 3 有關的設定。

項目 子項目設定 原廠預設 描述

Codec 2 H.264 / H.265 / Off Off 設定影像 2 的轉碼器。

Size 2
4096×2160 / 3840×2160 / 2048×1080 /
1920×1080 / 1280×720 / 640×360 / 512×270

1920×1080 設定影像 2 的圖像尺寸。

Frame Rate 2
有關所支援的影格率詳細資料，請參閱“設
定串流的視訊轉碼器”。 –

[Codec 2] 未設定為 Off 時顯示。
設定影像 2 的影格率。

I-Picture Mode 2 Time / Frame Time
[Codec 2] 未設定為 Off 時顯示。
將影像 2 的 IDR-Frame 插入間隔
設定為時間或影格數。

I-Picture Interval 2 1 / 2 / 3 / 4 / 5 s 1

[Codec 2] 未設定為 Off 且 [I-
Picture Mode 2] 設定為 [Time] 時
顯示。
將 H.264 和 H.265 的 IDR-Frame
插入間隔設定為時間。

I-Picture Ratio 2 15 至 300 影格 30

[Codec 2] 未設定為 Off 且 [I-
Picture Mode 2] 設定為 [Frame] 時
顯示。
將 H.264 及 H.265 的 IDR-Frame
插入間隔設定為影格數。

Profile 2
H.264：high / main / baseline
H.265：main

– 設定 H.264 或 H.265 設定檔。

Bit Rate
Compression
Mode 2

CBR / VBR VBR
[Codec 2] 未設定為 Off 時顯示。
設定影像 2 的位元速率壓縮模式。

Bit Rate 2
512 / 768 / 1000 / 2000 / 3000 / 4000 / 5000 /
6000 / 7000 / 8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

8000

[Codec 2] 未設定為 Off 且 [Bit
Rate Compression Mode 2] 設定
為 [On] 時顯示。
位元速率壓縮模式設定為 CBR
時，設定位元速率目標值。

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

[Codec 2] 設定為 H.264 且 [Bit
Rate Compression Mode 2] 設定
為 Off 時顯示。
設定 H.264 或 H.265 品質。

項目 子項目設定 原廠預設 描述

Codec 3 JPEG JPEG 設定影像 3 的轉碼器。

Size 3 1280×720 / 1024×540 / 640×360 1280×720 設定影像 3 的圖像尺
寸。

Frame Rate
3

有關所支援的影格率詳細資料，請參閱“設定串流的視訊轉碼
器”。 – 設定影像 3 的影格率。
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相關主題

設定串流的視訊轉碼器

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 設定品質。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Audio Stream

設定與串流音訊轉碼器有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Setting On / Off Off 開啟/關閉音訊串流輸出。

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
[Setting] 設定為 On 時顯示。
設定串流的音訊轉碼器。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Language

設定顯示語言。

注意

可用語言可能因國家或地區而異。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Language – – 設定顯示語言。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Accessibility

設定與音訊朗讀（文字轉語音）相關的設定。

注意

此功能僅適用於北美銷售的型號。畫面閱讀器功能只能在語言設定為英語時使用（截至發布日期）。

在運行網路應用程式的裝置上啟用網頁瀏覽器的畫面閱讀器功能。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Screen
Reader

On / Off Off 
開啟/關閉網路應用程式的攝像機影像窗格中的
畫面閱讀器功能。

Speech Rate
Slow2 / Slow1 / Normal / Fast1 / Fast2 /
Fast3 / Fast4

Normal
設定畫面閱讀器功能的速度。
以配置的速度大聲朗讀一段例句。

Speech
Volume

1 至 15 7
設定網路應用程式的畫面閱讀器功能之音量。
以配置的音量大聲朗讀一段例句。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Clock Set

設定內部時鐘設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定
原廠預
設

描述

Current Date
& Time

– – 顯示本裝置配置的當前時間。

PC Clock – – 顯示用於配置的平板電腦或電腦的當前時間

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-yyyy
hh:mm:ss / dd-mm-yyyy hh:mm:ss

yyyy-
mm-dd

設定日期和時間的顯示格式。

12 h / 24 h 12 h / 24 h 24 h 將時間顯示格式設定為 12 小時制/24 小時
制。

Time Setting
Keep current setting / Synchronize with PC /
Manual setting / Synchronize with NTP

– 設定日期和時間的配置方式。

yy-mm-dd
hh:mm:ss

yy：19 至 37
mm：01 至 12
dd：01 至 31
hh：00 至 23
mm：00 至 59
ss：00 至 59（秒）

–
[Time Setting] 設定為 Manual setting 時顯
示。
手動設定日期和時間。

NTP Auto On / Off Off

[Time Setting] 設定為 Synchronize with
NTP 時顯示。
設定是否從 DHCP 伺服器取得 NTP 伺服器
的 IP 位址。

NTP Server IPv4/IPv6 位址或主機名稱 –
[Time Setting] 設定為 [Synchronize with
NTP] 且 [NTP Auto] 設定為 Off 時顯示。
指定用於同步時間的 NTP 伺服器。

Time Zone UTC − 12:00 至 UTC + 14:00 – 選取時區。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Reset

初始化本裝置。

Reboot
重新啟動本裝置。

Reset
重設本裝置的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Reboot Execute –

重新啟動本裝置。
Execute：執行功能。

注意

重新啟動後，在網頁瀏覽器中重新載入頁面。

項目
子項目設

定
原廠預
設

描述

All Reset (except for Network
Settings)

Execute –

重設本裝置的設定（不包含網路設定）。
Execute：執行功能。

注意

已刪除匯入的基本風格和 LUT 檔案。

Network Reset Execute –

重設本裝置的網路設定。
Execute：執行功能。

注意

執行 Network Reset 後，本裝置將重新啟動。重新啟動後，在網
頁瀏覽器中重新載入頁面。

Factory Default Execute –

將本裝置的設定恢復到原廠預設狀態。
Execute：執行功能。

注意

執行 Factory Default 後，本裝置將重新啟動。重新啟動後，在網
頁瀏覽器中重新載入頁面。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Information

顯示攝像機和鏡頭資訊。也用於更新軟體。

Camera
顯示攝像機資訊和更新軟體。

Lens
顯示鏡頭資訊和更新軟體。

相關主題

更新 E 接環鏡頭軟體

項目 子項目設定 原廠預設 描述

Model Name – – 顯示攝像機的型號名稱。

Serial Number – – 顯示攝像機的序號。

Version Number – – 顯示攝像機的軟體版本。

Version Up – –

按下 [Choose File] 按鈕，並按照畫面上的說明更新攝像機軟體。

注意

更新後，本裝置將重新啟動。重新啟動後，在網頁瀏覽器中重新載入頁面。

項目
子項目設

定
原廠預
設

描述

Model Name – – 顯示鏡頭的型號名稱。

Serial Number – – 顯示鏡頭的序號。

Version
Number

– – 顯示鏡頭的軟體版本。

Version Up – –

按下 [Choose File] 按鈕，並按照畫面上的說明更新鏡頭軟體。

有關詳細資料，請參閱“更新 E 接環鏡頭軟體”。

注意

更新鏡頭後，本裝置將重新啟動。重新啟動後，在網頁瀏覽器中重新載入頁
面。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

System Log

設定與系統日誌有關的設定。

獲取的日誌如下圖所示。

相關主題

更新 E 接環鏡頭軟體

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Log Level
Critical, Warning & Info / Critical
& Warning / Critical

Critical, Warning
& Info

設定將錄製新增至系統日誌的層級。

Log Size 200 至 1024 1024 設定要儲存在系統日誌中的日誌大小。

Download as
File

– –
按下 [Download] 按鈕，並從顯示的畫面將系統
日誌儲存至平板電腦或電腦。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

HTTP Access Log

設定與 HTTP 存取日誌有關的設定。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目 子項目設定 原廠預設 描述

Log Level
Critical, Warning & Info / Critical
& Warning / Critical

Critical,
Warning & Info

設定將錄製新增至 HTTP 讀取日誌的層級。

Log Size 200 至 1024 1024 設定要儲存在 HTTP 讀取日誌中的日誌大小。

Download as
File

– –
按下 [Download] 按鈕並從顯示的畫面將 HTTP
存取日誌儲存至平板電腦或電腦。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Service

取得本裝置的裝置資訊。聯繫您的 Sony 服務代表時使用。

5-041-957-83(1) Copyright 2022 Sony Corporation

項目
子項目
設定

原廠
預設

描述

I agree to download
device information.

– –

勾選此處，以同意獲取裝置資訊，然後按下 [OK] 按鈕。
按下顯示的 [Download] 按鈕。網頁瀏覽器將立刻下載名為
deviceinformation.dat 的檔案。

注意

下載後，本裝置將重新啟動。如果本裝置並未自動重新啟動，請手動重新
啟動。重新啟動後，在網頁瀏覽器中重新載入頁面。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

EULA

顯示終端使用者授權協議 (EULA)。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

Software

顯示軟體授權。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

連接外部監視器和錄製裝置

若要在外部監視器上顯示錄製/播放的圖像，請設定外部監視器的視訊輸出類型，並使用適當的纜線連接要連接的監視器。
您也可以連接外部錄製裝置，並錄製本裝置的輸出訊號。
您可以在外部監視器上顯示攝像機影像窗格中可見的相同資訊，例如狀態資訊和功能表。使用網路功能表中的 [Monitoring]
> [Output Display] 將畫面顯示所需的系統類型設定為 On。

注意

如果連接到 HDMI 連接器的監視器不支援使用攝像機功能表或網路功能表中的 [Monitoring] 功能表配置的 HDMI 輸出格式，則攝像
機影像將不會輸出到網路應用程式中。也無法輸出串流影像。

您可以將 [Output Display] > [SDI] 和 [HDMI/Stream] 都設定為 [Off]，但會導致依靠畫面顯示的攝影機功能表和功能不可用。此外，
本裝置的錯誤通知將僅限於本裝置的指示燈（亮起或閃爍）以及網路應用程式右上角參閱標記顯示。為了解詳細狀態，請將
[Output Display] 設定為 [On]。

提示

在原廠預設中，[Output Display] > [SDI] 設定為 [Off]，且 [HDMI/Stream] 設定為 [On]。要將串流用作主要視訊，請將 [SDI] 設定為
[On]，並將 [HDMI/Stream] 設定為 [Off]，然後在 SDI 監視器上監視攝影機狀態。

SDI OUT 連接器（BNC 類型）

使用網路功能表或攝像機功能表中的 [Monitoring] 功能表來設定輸出格式。
使用市售的 75 Ω 同軸纜線進行連接。

注意

開啟裝置之前，請檢查本裝置和外部裝置之間的連接是否已接地。

建議在連接 75 Ω 同軸纜線之後開啟本裝置和外部裝置。
如果必須在本機開機時將外部裝置連接本機，請先將 75 Ω 同軸纜線連接到外部裝置，再將其連接到本機。

同時在本機和外部裝置上開始錄製

在啟用 SDI 訊號輸出的情況下，在攝像機功能表中將 [Project] > [SDI/HDMI Rec Control] > [Setting] 設定為 [SDI/HDMI
Remote I/F] 或 [Parallel Rec]，以便將 REC 觸發訊號輸出至連接到 SDI OUT 連接器的外部裝置。此時，外部裝置上的錄
製與本機同步。

注意

如果連接的外部裝置不支援 REC 觸發訊號，則無法操作該裝置。

攝像機功能表中的 [Project] > [SDI/HDMI Rec Control] > [Setting] 設定為 [SDI/HDMI Remote I/F] 時，如果當前未插入任何錄製媒
介且操作錄製 START/STOP 按鈕，則僅會輸出 REC 觸發訊號。

HDMI OUT 連接器（Type A 連接器）

在攝像機功能表的 [Monitoring] 功能表中設定輸出 On/Off 設定和輸出格式。

同時在本機和外部裝置上開始錄製
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在啟用 HDMI 訊號輸出的情況下，在攝像機功能表中將 [TC/Media] > [HDMI TC Out] > [Setting] 設定為 [On] 以及 [Project]
> [SDI/HDMI Rec Control] > [Setting] 設定為 [SDI/HDMI Remote I/F] 或 [Parallel Rec]，以便將 REC 觸發訊號輸出至連接
到 HDMI OUT 連接器的外部裝置。此時，外部裝置上的錄製與本機同步。

注意

如果連接的外部裝置不支援 REC 觸發訊號，則無法操作該裝置。

攝像機功能表中的 [Project] > [SDI/HDMI Rec Control] > [Setting] 設定為 [SDI/HDMI Remote I/F] 時，如果當前未插入任何錄製媒
介且操作錄製 START/STOP 按鈕，則僅會輸出 REC 觸發訊號。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

與 RCP/MSU 連接

透過 LAN 電纜將 RCP-3500/3501 等遠端控制面板 (RCP) 或 MSU-3500 等主設定裝置 (MSU) 連接到本裝置，可以遠端控
制本裝置的某些功能。
連接方法將根據相關裝置的配置和應用程式而有所不同。

有關裝置與 RCP 之間的一對一連接的詳細資料，請參閱“裝置與 RCP 之間的一對一連接”。
有關使用 MSU 或攝像機控制軟體連接多台攝像機的詳細資料，請參閱“透過 MSU/攝像機遠端控制軟體在多攝像機環境
中使用本裝置”。

相關主題

裝置與 RCP 之間的一對一連接

透過 MSU/攝像機遠端控制軟體在多攝像機環境中使用本裝置

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

裝置與 RCP 之間的一對一連接

注意

請參閱“支援功能清單”並配置本裝置，確實滿足您要使用的功能有關的操作條件，然後使用下列程序進行與 RCP 的連接。

相關主題

支援功能清單

5-041-957-83(1) Copyright 2022 Sony Corporation

開啟每個裝置。1

在攝影機的網路功能表中，將 [Technical] > [RCP/MSU] > [CNS Mode] 設定為 [Bridge]。2

在 RCP 上配置下列設定。

有關配置的詳細資料，請參閱 RCP 的操作說明。

3

將連接模式設定為 Bridge 模式。1.
註冊攝像機的 IP 位址。2.
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

透過 MSU/攝像機遠端控制軟體在多攝像機環境中使用本裝置

您可以使用 MSU 或攝像機遠端控制軟體連接多台攝像機。

注意

請參閱“支援功能清單”並配置本裝置，確實滿足您要使用的功能有關的操作條件，然後使用下列程序進行與 MSU 或攝像機遠端控
制軟體的連接。

相關主題

支援功能清單

5-041-957-83(1) Copyright 2022 Sony Corporation

開啟每個裝置。1

使用 MSU 或攝像機遠端控制軟體配置系統網路設定。

有關配置的詳細資料，請參閱 MSU 或攝像機遠端控制軟體的操作說明。

2

使用攝影機網路功能表中的 [Technical] > [RCP/MSU]，配置下列設定。3

如果使用 MSU，請將 [CNS Mode] 設定為 [MCS]。如果使用攝像機遠端控制軟體，請將 [CNS Mode] 設定為
[PC Control]。

1.

在 [Master IP Address] 中設定主裝置 MSU 或攝像機遠端控制軟體的 IP 位址。2.
在 [Camera No.] 中設定攝像機要註冊的攝像機編號。3.
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支援功能清單

下表顯示支援的功能及其相對應的操作條件。

操作面板 裝置功能 操作條件

IRIS 手動調整光圈 –

AUTO IRIS 開啟/關閉 Auto Iris –

ND
切換 ND 濾鏡預設位置（Clear/Preset1 至
Preset3）

攝像機功能表中的 [Shooting] > [ND Filter] > [Mode] 設定
為 [Preset] 時，此功能會啟用。

MASTER
GAIN

手動調整增益（單位為 3 dB）
拍攝模式設定為 Custom 模式並且攝影機功能表中的
[Shooting] > [ISO/Gain/EI] > [Mode] 設定為 [dB] 時啟
用。

WHITE (R/B) 手動調整白平衡 (R Gain/B Gain)

[White Mode] 設定為 [Memory A(R/B)] 或 [Memory
A(T/T)] 時啟用。WHITE (Color

Temp)

手動調整白平衡（色溫/色調）

RCP – [Color Temp]：白平衡色溫
RCP – [Balance]：白平衡色調值

ATW 開啟/關閉 ATW（自動追蹤白平衡）功能 拍攝模式設定為 Custom 模式時啟用。

BLACK R/B 調整黑平衡 拍攝模式設定為 Custom 模式時啟用。

MASTER
BLACK

調整主要黑色量

拍攝模式設定為 Custom 模式時啟用。
H/V Ratio 和 Crispening 會啟用，此時攝影機功能表
中的 [Paint/Look] > [Detail] > [Manual Setting] 設定
為 [On]。

DETAIL

開啟/關閉細部功能
設定細部程度
設定 H/V Ratio
設定 Crispening

User Matrix

開啟/關閉使用者矩陣校正功能
設定矩陣校正值 (R-G/R-B/G-R/G-B/B-
R/B-G)

Multi Matrix

開啟/關閉多矩陣校正功能
對於用於多矩陣校正的色彩設定色相和
飽和度

Knee
開啟/關閉曲折點校正功能
開啟/關閉自動曲折點功能
設定曲折點和曲折點斜率

BARS 開啟/關閉色條
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注意

配置本裝置，確實滿足您要使用的功能有關的操作條件，然後進行與 RCP/MSU 的連接。如果在啟用連接後調整操作條件，可能會
發生非預期的行為。

5-041-957-83(1) Copyright 2022 Sony Corporation

操作面板 裝置功能 操作條件

SHUTTER

開啟/關閉快門功能
設定快門速度值
（不支援開啟/關閉自動快門、設定角
度快門、設定慢速快門、設定
ECS。）

注意

根據配置的快門速度值，RCP 快門
設定可能不會顯示。

如果無法從 RCP 操作快門，RCP
快門設定可能無法正確顯示。

自動快門開啟時，即使您開啟/關閉快門或從 RCP 變更快
門速度值，自動快門也會繼續運作。
快門設定為 [Angle] 時，不支援從 RCP 開啟/關閉快門或
變更快門速度設定。
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關於使用 RM-IP500 遙控器（選購件）進行的操作

您可以使用執行軟體版本 2.2 或更新版本的 Sony RM-IP500 遙控器來操作本裝置。本設備使用 VISCA over IP (LAN) 進行
通訊。
根據要操作的目標項目，您可能需要觀看本裝置的畫面顯示。準備一台可用於檢查畫面顯示的監視器。
RM-IP500 遙控器支援以下操作。

選取目標攝像機
調整取景（平移、傾斜、變焦）
調整對焦（不包含觸控操作）
登錄和叫用預設位置
操作本裝置的功能表（不包含網路功能表）
調整亮度
調整白平衡
調整黑平衡
調整音訊輸入音量
開始/停止錄製
執行本裝置的可指派按鈕功能

有關 RM-IP500 操作的詳細資料，請參閱 RM-IP500 的操作說明。

提示

使用 RM-IP500 時，請使用 RM-IP500 隨附的裝置面板。

RM-IP500（本裝置的使用面板）

429



5-041-957-83(1) Copyright 2022 Sony Corporation

430



說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

連接 RM-IP500 遙控器

有關功能指派的詳細資料，請參閱 RM-IP500 的操作說明。

5-041-957-83(1) Copyright 2022 Sony Corporation

將本裝置的 SETUP 開關 3 設定到 ON 位置，以啟用 VISCA over IP 通訊。

注意

下次開啟本裝置時，會套用這些開關設定。

1

將 RM-IP500 連接到與本機連接的同一網路。2

按照 RM-IP500 操作說明中的步驟，在 RM-IP500 上配置 VISCA over IP (LAN) 連線。

使用 RM 功能表 > AUTO IP SETUP > ASSIGN CAM 來指派本裝置。

3

根據需求，使用 RM-IP500 的下列 RM 功能表項目，將本裝置的功能指派給各個按鈕及旋鈕。

SW ASSIGN
AE CONFIG2
WB MODE

4
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關於與外部裝置同步

使用多台裝置拍攝時，可透過裝置的同步鎖定連接器，將這些裝置同步到特定的參考訊號或時間碼。

有關同步鎖定的詳細資料，請參閱“同步視訊訊號的相位（同步鎖定）”。
有關同步時間碼的詳細資料，請參閱“將時間碼鎖定到其他裝置”。

相關主題

同步視訊訊號的相位（同步鎖定）

將時間碼鎖定到其他裝置

5-041-957-83(1) Copyright 2022 Sony Corporation
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同步視訊訊號的相位（同步鎖定）

您可以向 GENLOCK 連接器提供參考訊號，以啟用同步鎖定。
可使用的輸入參考訊號各有不同，具體取決於所選錄製格式的系統頻率。

您可以使用攝像機功能表中的 [Technical] > [Genlock] > [Reference] 來檢查外部同步狀態。

注意

如果參考訊號不穩定，則無法實現同步鎖定。

副載波不同步。

5-041-957-83(1) Copyright 2022 Sony Corporation

錄製格式的系統頻率 支援的輸入參考訊號

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23.98PsF
1920×1080 23.98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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將時間碼鎖定到其他裝置

將提供時間碼的裝置設定為時間碼輸出保持執行的模式（例如 Free Run 或 Clock）。

注意

檢查所提供參考時間碼和參考視訊訊號的相位關係是否符合 SMPTE 時間碼標準。

使用外部鎖定進行操作時，時間碼會立即取得外部時間碼的鎖定，而且外部時間碼的值會出現在時間資料顯示區域中。不過，切勿
立即開始錄製。等待數秒，直到時間碼產生器穩定，再進行錄製。

如果參考視訊訊號的頻率和本裝置上的影格率不同，則無法取得鎖定，且本裝置將無法正常運作。如果發生這種情況，時間碼將無
法成功取得外部時間碼的鎖定。

如果外部時間碼來源斷開連接，相對於參考時間碼而言，時間碼每小時可能會移動一個畫面。

解除外部鎖定

變更攝像機功能表中的 [TC/Media] > [Timecode] 設定。
如果變更系統頻率，而且在特殊錄製模式（Slow & Quick Motion 或 Interval Rec）中開始錄製，則也將解除外部同步。

5-041-957-83(1) Copyright 2022 Sony Corporation

使用攝像機功能表中的 [TC/Media] > [Timecode]，設定下列內容。

將 [Mode] 設定為 [Preset]。
將 [Run] 設定為 [Free Run]。

1

按下指派給 [DURATION/TC/U-BIT] 功能的可指派按鈕，以便在畫面上顯示時間碼。2

將 HD 或 SD 參考視訊訊號提供給 GENLOCK 連接器，並將參考時間碼提供給 TC IN 連接器。

本裝置的時間碼產生器會取得參考時間碼的鎖定，而且“EXT-LK”會出現在畫面上。
在時間碼鎖定後大約 10 秒時，即使中斷外部參考時間碼來源，仍將保持外部鎖定狀態。

3
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連接外部麥克風或外部音訊裝置

您可以從外部麥克風或外部音訊裝置輸入訊號，並將音訊嵌入至本裝置的錄製視訊或輸出視訊中。

使用 XLR 纜線連接外部麥克風或外部音訊裝置。

使用攝影機功能表中的 [Audio] > [Audio Input] > [AUDIO IN Select] 將音訊設定為 [LINE] 時，AUDIO IN 連接器將充
當 AUDIO IN CH-1 連接器及 AUDIO IN CH-2 連接器。

1

插針編號 功能

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

關閉本裝置，並將 XLR 纜線連接到 AUDIO IN 連接器。2

根據需求，設定 SETUP 開關 2 以啟用幻象電源。

如下所述，切換 +48 V 電源（幻象電源）。
開關 2
設定在連接音訊輸入裝置時是否開啟/關閉 +48 V 電源（幻象電源）。

3

設定 描述

OFF（預設） 這將關閉 +48 V 幻象電源，並將 LINE 或 MIC 輸入設定為 CH-1 和 CH-2 音訊源。

ON 這將開啟 +48 V 幻象電源，並將相容幻象電源的麥克風設定為 CH-1 和 CH-2 音訊源。
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注意

若將此開關設定為 ON 位置並連接與 +48 V 電源不相容的麥克風，可能會損壞連接的裝置。連接裝置之前，請檢查設定。

開啟本裝置，並使用攝像機功能表中的 [Audio] > [Audio Input] > [AUDIO IN Select] 來設定連接裝置的類型。4
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使用電腦管理/編輯剪輯

您可以使用電腦來管理/編輯剪輯。

使用讀卡機（選購件）來匯入剪輯

將 CFexpress Type A 讀卡機或 SD 讀卡機連接到電腦，並使用 Catalyst Browse 等支援本裝置錄製格式的軟體來匯入剪
輯。

使用非線性編輯系統

在非線性編輯系統中，需要支援本裝置錄製格式的編輯軟體（選購件）。

5-041-957-83(1) Copyright 2022 Sony Corporation
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輸出光纖訊號

將 SFP+ 模組（選購件）連接到本裝置的 OPTICAL 連接器，即可輸出轉換為光學訊號的 SDI 訊號。使用與每種格式之訊
號帶相符的 SFP+ 模組。
訊號帶

4K（59.94p、50p）：12G
4K（59.94p、50p 除外）：6G
HD（59.94p、50p）：3G
HD（59.94p、50p 除外）：1.5G

注意

使用符合下列標準的模組。

SFF 標準
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI 標準
ST297/ST292/ST424/ST425/ST2081/ST2082

與 SDI 輸出連接器相同的訊號輸出到 SFP+ 模組。

本裝置不支援光纖訊號輸入。

使用 SFP+ 模組進行光纖訊號輸出。有關經過驗證的 SFP+ 模組的詳細資料，請聯絡您的經銷商或 Sony 服務代表。

5-041-957-83(1) Copyright 2022 Sony Corporation

* Power Level I (1.0 W)
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連接提示訊號

本主題介紹提示訊號控制。

使用來自遙控器的訊號來點亮提示燈

您可以藉由 RM-IP500 等外部裝置，使用 VISCA over IP 命令來點亮提示燈。
在網路功能表或攝像機功能表中，將 [Technical] > [Tally] > [Tally Control] 設定為 [External]。

您可以從外部裝置點亮提示燈

您可以藉由 RM-IP500 或切換器等外部裝置，將本裝置的提示燈點亮成紅色或綠色。您可以使用透過網路傳輸的命令或使
用本裝置 OPTION 連接器上的提示訊號輸入來控制提示。
在網路功能表或攝像機功能表中，將 [Technical] > [Tally] > [Tally Control] 設定為 [External]。
在 OPTION 連接器上輸入提示訊號時，將針腳 7 短路至 GND（針腳 4 或 5）以將提示燈點亮成綠色，或將針腳 ８ 短路至
GND（針腳 4 或 5）以將提示燈點亮成紅色。

注意

[Tally Control] 設定為 [External] 時，本裝置的錄製狀態不會由提示燈指示。

同時輸入紅色提示和綠色提示時，本裝置的提示燈會亮起紅色。

OPTION 連接器針腳規格

插針編號 訊號方向 訊號規格

1 – RS-232C TX 訊號（用於鏡頭控制器）

2 – RS-232C RX 訊號（用於鏡頭控制器）

3 OUT

輸出綠色提示燈
綠色提示燈亮起時輸出低電平。
綠色提示燈不亮時 Hi-Z（漏極開路輸出）。

4 – GND（接地）

5 – GND（接地）
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使用來自本裝置的訊號，點亮外部裝置的提示燈

如下所示，您可以連接 OPTION 連接器的針腳 3 和針腳 6，以便使用來自本裝置的訊號來點亮外部裝置的提示燈。
OPTION 連接器針腳 3 和 6 連接範例

注意

請勿在針腳 7 和 8 上施加電壓。

請勿連接可以向 OPTION 連接器施加電壓的外部裝置。

如果超過額定值的湧浪或反向電壓施加到針腳 3 或 6，可能會導致故障、冒煙或失火。

使用網路功能表或攝像機功能表中的 [Technical] > [Tally] > [Tally Control] 來設定輸出訊號。
[Internal]：記錄本裝置的操作狀態
[External]：本裝置透過 IN 訊號或遙控器接收的紅色/綠色提示訊號之邏輯 AND。

5-041-957-83(1) Copyright 2022 Sony Corporation

插針編號 訊號方向 訊號規格

6 OUT

輸出紅色提示燈
紅色提示燈亮起時輸出低電平。
紅色提示燈不亮時 Hi-Z（漏極開路輸出）。

7 IN
綠色提示外部控制輸入
對地短路（針腳 4 或 5）會導致裝置的提示燈亮起綠色。

8 IN
紅色提示外部控制輸入
對地短路（針腳 4 或 5）會導致裝置的提示燈亮起紅色。
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輸出追蹤資料 (free-d)

該裝置可以輸出與同步訊號同步的平移/傾斜/變焦、焦點和光圈追蹤資訊。
資料輸出符合業界標準 free-d 協定。您可以選擇輸出方式，在恆定輸出和根據客戶要求輸出之間進行選擇。根據您的
VR/AR 系統，選擇輸出方式。

資料輸出格式

提示

“free-d 整合手冊”提供技術詳細資訊。請聯絡 Sony 銷售代表。

根據 free-d 協定之 Type D0/D1 指定的格式，本裝置輸出的追蹤資料包括下列資料。
Type D0 – poll/command

Type D1 – camera position/orientation data

檢查本裝置是否已開啟。1

設定追蹤資料輸出方式。

用於恆定輸出

適用於根據客戶要求進行的輸出

2

在網路功能表中，將 [Technical] > [Tracking Data Output] > [Transfer Mode] 設定為 [Always]。1.
在 [Camera ID] 中，設定本裝置的 ID。2.
在 [Destination Address] 中，指定輸出目的地 IP 位址。3.
在 [Destination Port] 中，指定輸出目的地連接埠號碼。4.
按下 [OK] 按鈕。5.

在網路功能表中，將 [Technical] > [Tracking Data Output] > [Transfer Mode] 設定為 [On Demand]。1.
在 [Camera ID] 中，設定本裝置的 ID。2.
在 [Listen Port] 中，指定偵聽用戶端請求的連接埠號碼。3.
按下 [OK] 按鈕。4.

符號 內容 描述

<D0> Message type

<CA> Camera ID

<CD> command

支援下列命令：

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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注意

在下列情況下，追蹤資料可能會延遲或者值可能無法更新：

輸出 RAW 視訊時
S&Q Motion 開啟時
顯示攝影機功能表時
顯示縮圖畫面時
播放錄製的剪輯時
顯示網頁功能表時

5-041-957-83(1) Copyright 2022 Sony Corporation

符號 內容 描述

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle 平移角度（−170° 至 +170°）

<TH><TM><TL> Camera Tilt Angle 傾斜角度（−30° 至 +195°）

<RH><RM><TL> Camera Roll Angle 不支援（始終為 0）

<XH><XM><XL> Camera X-Position 不支援（始終為 0）

<YH><YM><YL> Camera Y-Position 不支援（始終為 0）

<HH><HM><HL> Camera Height 不支援（始終為 0）

<ZH><ZM><ZL> Camera Zoom 焦距

<FH><FM><FL> Camera Focus 焦距

<SH><SL> Spare/User Defined 光圈位置

<CK> Checksum
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

連接鏡頭控制器

您可以連接與本機相容的市售鏡頭控制器（選購件），從網路應用程式、RM-IP500（選購件）或紅外線遙控器來操作手動
變焦鏡頭的變焦。
如需連接鏡頭控制器的詳細資料，請參閱鏡頭控制器的操作說明。
如需使用鏡頭控制器調整變焦的詳細資料，請參閱“使用鏡頭控制器調整變焦”。

注意

使用鏡頭控制器之前，請仔細閱讀鏡頭控制器的操作說明，並確保充分了解其使用方法。對於因使用鏡頭控制器而導致各類索賠，
Sony 概不負責。

啟用鏡頭控制器時，Clear Image Zoom 無法使用。建議您將 Clear Image Zoom 倍率設定為 1.0 倍或停用 Clear Image Zoom。

鏡頭控制器啟用時，無法錄製或播放攝影機取景操作。

相關主題

使用鏡頭控制器進行變焦調整

5-041-957-83(1) Copyright 2022 Sony Corporation
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用鏡頭控制器進行變焦調整

依照下列步驟，安裝鏡頭控制器（選購件）並調整變焦。

檢查鏡頭控制器狀態

按下網路應用程式之螢幕通用區域中的 （攝影機狀態）按鈕，可顯示攝影機狀態畫面。

將鏡頭控制器連接到本裝置連接器插頭上的 OPTION 連接器。

如需有關安裝的詳細資料，請參閱鏡頭控制器的操作說明。

1

為變焦鏡頭設定鏡頭控制器。

如需詳細資料，請參閱鏡頭控制器的操作說明。

2

鎖定本裝置的平移/傾斜，並安裝變焦鏡頭。

如需詳細資料，請參閱“安裝鏡頭”。

3

調整鏡頭控制器，使其可以操作變焦鏡頭。4

保持攝像機頭部的前後平衡，使滑動底座保持水平。

如需詳細資料，請參閱鏡頭控制器的操作說明和“安裝鏡頭”。

5

在網路功能表中，將 [Technical] > [Lens Controller] > [Setting] 設定為 [On]，並且按下 [OK] 按鈕。

本裝置將重新啟動。等待平移/傾斜重設操作完成。

6

在網路應用程式之即時操作畫面的攝像機控制面板  (Others) 索引標籤上，按下 （初始化鏡頭控
制器）按鈕。

鏡頭控制器會移動以偵測變焦範圍。如需詳細資料，請參閱鏡頭控制器的操作說明。
在攝影機影像面板的左上方，當 （鏡頭控制器錯誤）指示變成 （鏡頭控制器準備就緒）時，表示準備完成。

注意

初始化鏡頭控制器時，請注意鏡頭的操作範圍。

7

使用網路應用程式中的 [Zoom] 滑桿或紅外線遙控器的變焦控制按鈕來調整變焦。8
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在此畫面上，您可以檢查鏡頭控制器的狀態。

注意

更換鏡頭時，請初始化鏡頭控制器。

啟用鏡頭控制器時，Clear Image Zoom 無法使用。建議您將 Clear Image Zoom 倍率設定為 1.0 倍或停用 Clear Image Zoom。

5-041-957-83(1) Copyright 2022 Sony Corporation

狀態 描述

Off 在 E 接環鏡頭中，使用電動變焦。

Communication
Error

本裝置和鏡頭控制器之間發生通訊錯誤。
檢查本裝置和鏡頭控制器之間的連接，然後參閱鏡頭控制器操作說明並初始化鏡頭控制器。

Uninitialized 執行初始化。

Initializing 等待初始化完成。

Initialization Failed 檢查本裝置和鏡頭控制器之間的連接，然後參閱鏡頭控制器操作說明並初始化鏡頭控制器。

Working 使用鏡頭控制器來控制變焦。

Rotation Error 儲存的變焦移動範圍和鏡頭移動範圍可能不相符。初始化鏡頭控制器。

System Error 檢查本裝置和鏡頭控制器之間的連接，請參閱鏡頭控制器操作說明並初始化鏡頭控制器，或重新
啟動本裝置和鏡頭控制器。Unknown Error
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可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

使用注意事項

運輸和包裝時的注意事項

運輸或包裝本裝置時，請確保符合下列條件，並避免裝置受到強烈振動或衝擊。

取下鏡頭，並蓋上機身護蓋。
攝影機頭部 (A) 移動到前方後，沿箭頭方向轉動攝影機頭部鎖定桿 (B)，以鎖定攝影機頭部。

調整攝影機方向，使其面向前方，並使用平移/傾斜鎖定桿進行鎖定。

拆下連接纜線。

凝結

如果突然將裝置自低溫處移至溫暖處，或是環境溫度突然上升，裝置外部表面和/ 或內部可能會產生濕氣，此為凝結現象。
如果發生凝結，請將裝置關閉，並等候直到凝結消除後再行操作。請勿在凝結狀態下使用本裝置，否則裝置將會損壞。

攝影機 CMOS 影像感測器現象

注意

影像中可能出現的下列現象是影像感測器的特有現象。這些並不表示故障。

白色微粒
雖然影像感測器是採用高精度技術製造而成，不過，在極罕見的情況下，畫面會由於宇宙射線等等而出現細小的白色
微粒。
這與影像感測器的原理有關，而不是故障。定期執行 APR。
在下列情況下特別容易出現白色微粒：

在高環境溫度下操作時
提高增益（感光度）時
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閃爍
如果在螢光燈、鈉燈、水銀蒸氣燈或 LED 產生的照明下拍攝，畫面可能會閃爍，或者色彩可能發生變化。

鏡頭及平移/傾斜驅動裝置

如果鏡頭和平移/傾斜驅動機制長時間未操作，內部塗抹的潤滑脂黏度可能會增加，進而妨礙機制移動。定期操作鏡頭和平
移/傾斜機制。

在耗損零件上

風扇和內建的可充電電池是耗材，需要定期更換。
在室溫下運作時，正常的更換週期約為5年。但是，此更換週期僅為一般基準，並不保證此類消耗品的預期壽命。
有關部件更換的詳情，請聯絡您的經銷商。

在正常操作溫度下正常使用（每天8小時；每月25天），交流變壓器和電解電容器的預期壽命約為5年。如果使用頻率
超過上述正常使用頻率，其預期壽命可能會對應縮短。

建議建議定期檢查，確保本產品可正常運作並延長使用壽命。有關檢查的詳細資料，請聯絡 Sony 服務代表。

關於內建充電電池

本裝置具有內建的可充電電池，即使關閉本裝置，也可以儲存日期、時間和其他設定。如果使用交流變壓器將本裝置連接
至電源插座或透過 PoE++ 供電，則無論開啟或關閉本裝置，內建充電電池都將在 24 小時後充電。如果未連接交流變壓
器，則充電電池將在大約 2 個月內完全放電。為電池充電後，使用您的裝置。不過，即使不對充電電池充電，只要不需要
記錄日期，本裝置的操作也不會受到影響。

使用和存放位置

存放在水平、通風處。
避免在下列地點使用或存放本裝置。

暴露在雨水或水中的位置（包括屋簷下）
戶外和溫度超過 40 °C 的位置
請記住，在炎熱的夏季，關閉車窗的車內溫度很容易超過 50 °C。
溫度低於 0 °C 的位置。
在潮濕或充滿灰塵的地點。本裝置可能會遭受雨淋的地點
會受到震動或衝擊的位置
產生輻射、X 射線和強烈磁場的位置。
靠近產生強力電磁場的無線電或電視發射器。
陽光直射或長時間靠近加熱器

關於雷射光束的注意事項

雷射光束可能會損壞 CMOS 影像感測器。如果拍攝的場景有雷射光束，請勿讓雷射光束直射到攝像機的 CMOS 影像感測
器中。具體而言，來自醫療裝置或其他裝置的高功率雷射光束可能會由於反射光和散射光而造成損壞。

防止可攜式通訊裝置產生的電磁干擾

在本裝置附近使用可攜式電話和其他通訊裝置可能會導致故障以及對音訊和視訊訊號的干擾。建議在本裝置附近關閉可攜
式通訊裝置的電源。

請勿將本產品放在醫療器材的附近

本產品（含配件）有磁力，可能會干擾心律調節器、用於腦積水治療的可調式引流閥或其他醫療器材。請勿將本產品放在
此類醫療器材使用者的附近。如果您使用任何此類醫療器材，請在使用本產品前諮詢您的醫生。

安全注意事項

SONY對於因未針對傳輸裝置採取適當安全措施、因傳輸規格造成無法避免的資料洩漏，或是任何安全問題所導致的任
何損壞一概不負責。
視操作環境而定，網路上的第三方人士可能可以擅自存取本機。本機連接至網路時，請確認網路受到安全防護。
為了安全考量，本機在連接網路的狀態下使用時，強烈建議透過網頁瀏覽器進入控制視窗，變更原廠預設值的存取限
制設定。另外，建議您設定一組其他人很難猜測且字元數達到最低限度的密碼，並予以妥善儲存。
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本產品連線到網路時，透過可提供保護功能的系統 (例如，路由器或防火牆) 進行連線。如果在沒有此類保護的情況下
連線，則可能會發生安全問題。

電源

本裝置未配備電源開關。要關閉本裝置時，請先確保所有操作均已結束且本裝置處於電源待機狀態，然後再斷開交流
變壓器。使用 PoE++ 電源供電時，拔除 LAN 纜線。
如果可能，使用易於插入和拔除電源插頭的地方之電源。
如果在灰塵較多的地方使用插座，請定期清潔插座周圍區域以防止電痕。
不使用時，請斷開電源。

活動零件的注意事項

確保異物不會進入活動零件。
用手移動零件時，不要施加過大的負載。否則，可能會導致故障。
移動過程中，不要干擾活動零件的操作。否則，可能會導致損傷或故障。
如果長時間未使用本裝置，活動零件可能無法正常作業。請定期操作本裝置的平移/傾斜功能。

連續操作注意事項

本裝置可全年 365 天、每天 24 小時供電（電源待機狀態）。
務必進行拍攝測試，並驗證本裝置是否正常運作。

不保證連續拍攝時間超過 24 小時。
若拍攝時間超過 24 小時，請將本裝置置於電源待機狀態，然後重新啟動本裝置。

請注意，如果您在使用本機時因任何故障而無法拍攝，Sony 不對影像內容承擔任何形式的賠償。
使用前請務必確認本機運作正常。無論保固期內外或基於任何理由，SONY對任何形式的損壞，包含但不限於因本機故
障造成的現有或預期利潤損失一概不負責，亦不做任何退貨或賠償動作。
SONY 對本機使用者或第三方人士所提出任何形式的賠償要求一概不負責。
SONY 對因任何形式之環境因素中止或停止本機相關服務，一概不負責。

錄製功能注意事項

請務必進行錄製測試，並確認錄製是否成功。SONY對任何形式的損壞，包含但不限於因本機或其錄製媒體、外部儲存
系統，或者用於錄製任何形式內容的其他媒體或儲存系統之故障一概不負責，亦不做任何賠償或補償動作。
使用前請務必確認本機運作正常。無論保固期內外或基於任何理由，SONY對任何形式的損壞，包含但不限於因本機故
障造成的現有或預期利潤損失一概不負責，亦不做任何退貨或賠償動作。
SONY 對本機使用者或第三方人士所提出任何形式的賠償要求一概不負責。
SONY 對內部儲存系統、錄製媒體、外部儲存系統或任何其他媒體或儲存系統上的資料損失、維修或複製，一概不負
責。
SONY 對因任何形式之環境因素中止或停止本機相關服務，一概不負責。

5-041-957-83(1) Copyright 2022 Sony Corporation
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輸出格式和限制

本主題介紹輸出格式和限制。

注意

輸出格式的解析度受限於網路功能表或攝像機功能表中的 [Project] > [Rec Format] > [Frequency]、[Codec] 及 [Video Format] 之設
定。

輸出格式的解析度也受限於與 S&Q 畫面速率的組合。除了下列 SDI OUT/HDMI OUT 連接器輸出格式表之外，滿足下列所有條件
時，HDMI 輸出會變更為 Full HD 或較低的格式。

[Shooting] > [S&Q Motion] > [Setting] 設定為 [On]
[Shooting] > [S&Q Motion] > [Frame Rate] 高於 60fps

滿足上述條件時，[Monitoring] > [Output Format] > [SDI/HDMI] 的 HDMI 輸出 4096×2160P 和 3840×2160P 選取選項將變成灰
色，無法選取。

如果配置比播放影像解析度更高的解析度，則不會輸出影像。

SDI OUT/HDMI OUT 連接器輸出格式

系統頻率為 50/59.94 Hz 時

設定 可選擇的輸出格式

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P（預設）
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P（預設）
1920×1080i
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系統頻率為 25/29.97 Hz 時

設定 可選擇的輸出格式

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)（預設）
1920×1080P（預設）
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)（預設） 1920×1080P（預設）
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)（預設）
1920×1080P（預設）
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

（輸出停止）
720×480P2)

720×576P3)

螢幕顯示不能重疊。1)

系統頻率為 59.94 時2)

系統頻率為 50 時3)

設定 Output Format（輸出解析度）

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i（預設）

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
1920×1080i（預設）
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系統頻率為 23.98 Hz 時

系統頻率為 24 Hz 時

設定 Output Format（輸出解析度）

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF（預設） 1920×1080i（預設）

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF（預設） 1920×1080i（預設）

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

設定 Output Format（輸出解析度）

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
3840×2160P
1920×1080P（預設）

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P（預設）

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI) 3840×2160P
1920×1080P

1920×1080P（預設） 1920×1080P（預設）

3840×2160
3840×2160 (2SI)

3840×2160P
1920×1080P

1920×1080P（預設） 1920×1080P（預設）

1920×1080 1920×1080P（預設） 1920×1080P（預設）
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設定 Output Format（輸出解析度）

錄製/播放模式
RAW 輸出解析度/
內部錄製解析度

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P（預設）

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P（預設）

4096×2160P
1920×1080P（預設）
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

疑難排解

電源

影像輸出

徵狀 原因 解決方案

本裝置無法
開機。

交流變壓器未牢牢連接至 DC IN 連接器。 將電源線牢牢插到底。

交流電源線未牢牢插入交流變壓器或交流電源插座。 將電源線牢牢插到底。

PoE++ 供電裝置和本裝置之間的 LAN 纜線連接不牢
固。

檢查纜線是否已插入直至鎖定。

LAN 纜線連接到 OPTION 連接器，但未連接到 LAN
連接器。

將 LAN 纜線正確連接到 LAN 連接器。

本裝置連接到不支援 PoE ++（符合 IEEE802.3bt
Type 4 Class 8）的供電裝置。

連接到支援 PoE ++（符合 IEEE802.3bt Type 4
Class 8）的供電裝置。

總耗電量超出 PoE ++ 供電裝置的最大額定值。 請參閱 PoE ++ 供電裝置的操作說明。

連接到不支援 PoE ++ 供電類別評定的網路纜線。 請使用 5e 類或更高類別的網路纜線連接到 LAN
連接器。

攝像機、PoE++ 供電裝置和周邊裝置未接地。
請將攝像機、PoE++ 供電裝置和周邊裝置接
地。

徵狀 原因 解決方案

影像未輸出。

連接的裝置未正確連接。 請正確連接到連接裝置。

初始設定未完成。
使用網路應用程式完成初始設
定。

影像未從 HDMI 連接
器輸出。

配置輸出 HDMI 輸出目的地裝置不支援的訊號。
請變更 HDMI 輸出格式設定，
或者使用支援輸出訊號的裝
置。

正在使用不支援 HDMI 輸出標準的纜線。
使用支援目前所使用 HDMI 輸
出標準的纜線。
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遙控器

紅外線遙控器

RM-IP500

徵狀 原因 解決方案

影像未從 SDI 連接器
輸出。

正在使用不支援輸出 SDI 標準的纜線。
使用支援目前所用 SDI 輸出標
準的纜線。

連接到 SDI 連接器的監視器不支援輸出訊號。
使用支援 SDI 輸出標準的監視
器。

錄製格式設定為 RAW 輸出。
將錄製格式變更為 RAW 輸出
以外的設定。

HDMI 輸出設定為 SD 解析度。
將 HDMI 輸出設定為 SD 以外
的解析度。

影像未從光纖輸出或
影像失真。

正在使用的模組不符合 SFF 或 SMPTE 標準，或者不滿足
Power Level I (1.0 W)。

請參閱“輸出光纖訊號”。

使用外部同步時，影
像未被輸出或失真。

未輸入符合配置的視訊訊號格式之外部同步訊號。
請輸入符合配置的視訊訊號格
式之外部同步訊號。

音訊中有噪音。

攝像機、PoE++ 供電裝置和周邊裝置未接地。
請將本裝置、PoE++ 供電裝置
和周邊裝置接地。

本裝置的使用環境中具有會產生強電場及磁場的設備（例如電
視/無線電發射機天線、業餘無線電發射機、空調馬達、電源
變壓器）。

請遠離會產生強電場及磁場的
設備。

鏡頭、鏡頭支架及驅動設備與本裝置或周圍環境中的物體接
觸，並發出異常噪音。

正確安裝鏡頭。

請檢查察攝像機附近是否有
任何障礙物。

徵狀 原因 解決方案

按下紅外線遙控器時沒有
用。

紅外線遙控器操作被停用。 在網路功能表中，將 [Technical] > [IR Remote] > [Setting]
設定為 [On]。

電池已放電，或電池極性不正
確。

請在本裝置的紅外線感測器附近操作紅外線遙控器。如果
Power LED 閃爍，請更換電池。

初始設定未完成。 使用網路應用程式完成初始設定。

平移/傾斜操作速度緩
慢。

紅外線遙控器的平移/傾斜速
度設定為正常模式。

將本裝置之連接器插頭塊上的 SETUP 開關 4 設定為 ON
位置。

操作預定相機以外的相機
作為目標相機。

由預定相機以外的相機接收紅
外線訊號。

在您不想控制的攝像機之網路功能表中，將 [Technical] >
[IR Remote] > [Setting] 設定為 [Off]。
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網路應用程式

徵狀 原因 解決方案

無法透過 RM-IP500 操作攝像機。

未連接攝像機電源。 檢查本裝置的 POWER 燈是否亮起綠色或橘色。

攝像機或遙控器未連接
到網路。

檢查本裝置和遙控器連接。

未完成攝像機的初始設
定。

使用網路應用程式完成初始設定。

未啟用 VISCA over IP
通訊。

將本裝置之連接器面板上的 SETUP 開關 3 設定
為 ON 位置，然後重新啟動本裝置。

攝像機的 IP 位址已變
更。

使用網路功能表或攝像機功能表中的 [Network] >
[Wired LAN] 來檢查攝像機的 IP 位址。

使用 RM-IP500 遙控器上的 AUTO IP
SETUP 來變更攝像機的 IP 位址。

自攝像機啟動以來，已
過去至少 20 分鐘。

重新啟動本裝置。本裝置啟動後 20 分鐘內，可使
用 AUTO IP SETUP 變更 IP 位址。

徵狀 原因 解決方案

無法使用網頁瀏覽器進行連
接。

未連接 5e 類或更高類別的
LAN 纜線。

請連接 5e 類或更高類別的 LAN 纜線。

未正確連接 LAN 或連接的
網路沒有正常運作。

請檢查 LAN 連接器的 Link LED 是否亮起。如果 Link LED
未亮起，請聯絡網路管理員。

未連接攝像機電源。 請參閱上方的“電源”部分。

沒有為裝置配置有效的 IP
位址。

執行網路重設。

配置的 IP 位址已被另一台
裝置使用。

請檢查周邊裝置的 IP 位址是否唯一。

配置的子網路遮罩與使用
的網路子網路不相符。 執行網路重設。

正在經由代理伺服器在同
一區域網路上存取本裝
置。

請變更配置，以便不使用代理伺服器。

為本裝置配置的預設閘道
不正確。

執行網路重設。

輸入的 URL 不正確。 請輸入正確的 URL，然後重試。

HTTP 連接埠不正確。

在外部監視器上顯示攝像機功能表，並檢查 [Network] >
[Wired LAN] > [HTTP Port] 的設定。如果配置除 80 以外的
數值，請將 HTTP 連接埠號碼添加至在網頁瀏覽器中輸入的
主機名稱或 IP 位址。
範例：如果 HTTP 連接埠號碼設定為 8080，請輸入
http://<IP Address>:8080

本裝置的 HTTP 連接埠號
碼正在被篩選或阻擋。

將本裝置的 HTTP 連接埠號碼變更成未被篩選或阻擋的連接
埠。

網頁瀏覽器儲存的快取正
產生不利影響。 從網頁瀏覽器中刪除快取。
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徵狀 原因 解決方案

無法使用二維條碼（QR
碼）連接到網路應用程式。

目前使用的設備不支援
mDNS。

請使用支援 mDNS 的設備。
如果使用不支援 mDNS 的設備，請直接在網頁瀏覽器中輸
入 IP 位址。

平板電腦或電腦連接到的
網路與攝像機不同。

請將平板電腦或電腦連接到與本裝置相同的區域網路。

無法透過手動輸入 URL 的
方式連接到網路應用程式。

目前使用的設備不支援
mDNS。

請使用支援 mDNS 的設備。

平板電腦或電腦連接到的
網路與攝像機不同。

請將平板電腦或電腦連接到與本裝置相同的區域網路。

持續顯示驗證畫面。

未輸入正確的使用者名稱
或密碼。

請輸入登錄的使用者名稱和密碼。如果您忘記了登錄的使用
者資訊，請參閱“連接器插頭塊”的“RESET 開關”來初始化網
路連線的使用者資訊。

使用者名稱和密碼可能已
被使用其他網頁瀏覽器登
入的使用者變更。

請與裝置管理員核對使用者名稱和密碼是否正確。

攝像機影像未在網路應用程
式中顯示。

攝像機的 HDMI 輸出設定
為 720×480 或 720×576。

請變更本裝置 HDMI 輸出的解析度。

連接了不支援攝像機 HDMI
輸出訊號的 HDMI 監視
器。

請取下 HDMI 監視器，或者使用支援 HDMI 輸出設定的
HDMI 監視器。

本裝置重新啟動，且斷開
會話。

請等候大約一分鐘，然後重新載入網頁瀏覽器。

網頁瀏覽器儲存的快取正
產生不利影響。

從網頁瀏覽器中刪除快取。

網路應用程式中顯示的攝像
機影像解析度低。

網路應用程式使用的視訊
串流 3 之影像解析度設定
為低。

使用網路功能表中的 [Stream] > [Video Stream] > [Size 3]
來增加該值。

按下 [Menu] 按鈕後，攝影
機功能表沒有出現。

攝像機功能表被配置為不
會嵌入於 HDMI 輸出訊號
中。

在網路功能表中，將 [Monitoring] > [Output Display] >
[HDMI/Stream] 設定為 [On]。

設定畫面上的設定值未正確
更新/顯示。

在其他網路應用程式中變
更的設定會自動反應到網
路應用程式的設定畫面。

按下網路應用程式之設定畫面底部的 [Reload] 按鈕。重新載
入並更新所顯示設定畫面的設定值。

網路暫存檔案的設定正產
生影響。

從網頁瀏覽器中刪除快取。

無法下載配置檔案或日誌。
網頁瀏覽器的下載檔案功
能被停用。

請啟用網頁瀏覽器的下載檔案功能。

您可以存取網路應用程式的
設定畫面，但無法在即時操
作畫面和播放操作畫面上進
行操作。

網路應用程式操作畫面被
鎖定。

將網路應用程式右上方的操作鎖定開關設定到  （操作
解鎖）位置。

網路應用程式畫面需要花些
時間才會顯示。

多個使用者同時觀看本裝
置的串流影像。

請減少可以同時存取網路應用程式的使用者數量。
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拍攝

攝像機

平移/傾斜

徵狀 原因 解決方案

影像失真或扭曲。

由於通訊路徑擁塞，視訊
資訊無法正常傳輸。

降低位元速率，將 [Video Stream 3] > [Size] 設定為最小選
項，或者降低速率以便在通訊頻帶中建立邊限。

在平板電腦上執行多個網
頁瀏覽器並佔用記憶體。

關閉在背景執行的所有網頁瀏覽器。

開啟過多網頁瀏覽器標
籤，會導致操作速度變
慢。

關閉所有不使用的標籤。

若網路瀏覽器累積過多快
取和瀏覽歷史記錄，會減
慢執行速度。

刪除網頁瀏覽器的快取。

徵狀 原因 解決方案

開始和結束平移/傾斜操作時，影像看起來
失真。

如果開啟鏡頭的影像穩定功能，影像可能會
失真。

請關閉鏡頭的影像穩定功
能。

無需使用者操作，即可變更視角。 發生鏡頭呼吸。 請參閱“呼吸補償”。

無法操作對焦、變焦或光圈。 鏡頭上的開關設定可能不正確。 請參閱“檢查鏡頭開關”。

徵狀 原因 解決方案

無法重設平移/傾斜。
平移/傾斜鎖定桿處於
LOCK 位置。

將平移/傾斜鎖定桿滑動到 UNLOCK 位置。

攝像機未停在預期位
置。

攝像機區塊不平衡。
如“安裝鏡頭”所述，將攝像機區塊向前/向後移動到適當的位置，然
後再次開啟本裝置。

安裝了不支援平移/傾斜
的鏡頭。

請參閱鏡頭相容性資訊，並安裝支援平移/傾斜的鏡頭，然後再次
開啟本裝置。

無法執行平移/傾斜重
設。

請按照“重設平移/傾斜”的說明來執行平移/傾斜重設。對攝像機頭部施加了非
預期的力量，導致平移/
傾斜控制錯誤。

按下 （平移/傾
斜主目錄）時，攝影機
不會返回正面。

天花板安裝模式已啟
用。

根據實際安裝狀況，在網路功能表中設定 [Pan-Tilt] > [P/T
Direction] > [Ceiling]，然後重新啟動本裝置。安裝在天花板上時，
連接器插頭塊位於攝像機的前方。

平移/傾斜操作受到限
制。

平移/傾斜範圍限制已配
置。

如“P/T Range Limit”所述，根據需要清除平移/傾斜範圍限制設定。

對攝像機頭部施加了非
預期的力量，導致平移/
傾斜錯誤。

請按照“重設平移/傾斜”的說明來執行平移/傾斜重設。
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徵狀 原因 解決方案

平移/傾斜操作往相反方
向移動。

天花板安裝模式設定與
實際安裝狀態不同。

根據實際安裝狀況，在網路功能表中設定 [Pan-Tilt] > [P/T
Direction] > [Ceiling]。

平移/傾斜方向相關設定
已變更。

檢查網路功能表中的 [Pan-Tilt] > [P/T Direction] 之設定。

開始和結束平移/傾斜操
作時，影像移動不流
暢。

平移/傾斜操作加速/減速
設定過高。

使用網路功能表或攝像機功能表中的 [Pan-Tilt] > [P/T Acceleration]
> [Ramp Curve] 來降低平移/傾斜操作加速/減速設定，確保開始和
結束平移/傾斜操作的動作更加流暢。請注意，這意味著鏡頭需要
花費更長時間才能達到最高速度。

平移/傾斜操作停止。

攝像機區塊不平衡。
如“安裝鏡頭”所述，將攝像機區塊向前/向後移動到適當的位置，然
後再次開啟本裝置。

對安裝的鏡頭而言，漸
變曲線（加速/減速）設
定過高。

如果安裝了大鏡頭，請減少網路功能表或攝像機功能表中的 [Pan-
Tilt] > [P/T Acceleration] > [Ramp Curve] 之數值。

正在使用大鏡頭。 請與您的 Sony 支援代表聯繫。

操作平移/傾斜時，本裝
置受到阻礙。

鏡頭支架底座連結螺絲
夾緊桿撞擊攝像機。

轉動鏡頭支架底座連結螺絲夾緊桿，使其指向上方。

鏡頭支架夾緊桿撞擊攝
像機。

轉動鏡頭支架夾緊桿，使其指向上方。

攝像機頭部鎖定桿撞擊
攝像機。

檢查攝像機頭部鎖定桿是否完全位於 LOCK 位置。

平移/傾斜操作過程中，
出現異常噪音。

攝像機不平衡。 將攝像機頭部向前/向後移動到適當位置，使滑座處於水平狀態。

對安裝的鏡頭而言，漸
變曲線（加速/減速）設
定過高。

如果安裝了大鏡頭，請減少網路功能表或攝像機功能表中的 [Pan-
Tilt] > [P/T Acceleration] > [Ramp Curve] 之數值。

攝像機頭部位置未固
定，操作期間會產生移
動噪音。

將攝像機頭部鎖定桿設定到 LOCK 位置。

無法儲存預設位置。
如果正在執行 Clear
Image Zoom，則無法儲
存預設。

將 Clear Image Zoom 倍率設定回 1 倍。（ （變焦倍率）右側
不顯示倍率的狀態）

播放預設位置時，取景
會偏移。

在儲存預設位置和播放
預設位置之間，環境溫
度可能有顯著變化。

再次儲存預設位置。

不執行鏡頭校準。
使用攝像機功能表中的 [Technical] > [Lens] > [Lens Calibration] 來
運行校準。

安裝的鏡頭與儲存預設
時安裝的鏡頭不同。或
者手動變焦的變焦位置
不同。

再次儲存預設位置。
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錄製/播放

檔案轉移

徵狀 原因 解決方案

網路應用程式的取景控
制面板變成灰色，無法
操作。

顯示縮圖畫面和播放期
間，無法進行平移/傾斜
操作。

顯示播放控制畫面並退出縮圖畫面顯示或者停止播放。

無法在網路應用程式中
顯示攝像機影像時，也
無法進行平移/傾斜操
作。

請參閱“疑難排解”中的“網路應用程式”。

平移/傾斜鎖定桿處於
LOCK 位置。

將平移/傾斜鎖定桿滑動到 UNLOCK 位置。

“Execute Pan-Tilt
Reset”顯示在網路應用
程式的取景控制面板下
方。

對攝像機頭部施加了非
預期的力量，導致平移/
傾斜錯誤。

請按照“重設平移/傾斜”的說明來執行平移/傾斜重設。

徵狀 原因 解決方案

您按下錄製 START/STOP
按鈕時，錄製並未開始。

記憶卡已滿。 換成空間足夠的記憶卡。

記憶卡需要還原。 按照“還原記憶卡”的說明，還原記憶卡。

錄製/提示燈配置為提示燈，因
此無法透過指示燈來判斷錄製
狀態。

如“連接提示訊號”所述，將錄製/提示燈配置為錄製燈。

無法錄製音訊。

未連接麥克風。
將麥克風或音訊裝置連接到連接器插頭塊上的 AUDIO
IN 連接器。

[Master Input Level] 設定成最
小值。 調整 [Master Input Level]。

錄製的聲音失真。 音訊輸入音量設定過高。

將 [CH1 Input Level] 調整為 [CH4 Input Level] 和
[Master Input Level]。

在現場音樂場所等喧鬧環境中使用麥克風時，請先調整
[AUDIO IN CH1 MIC Ref.] 和 [AUDIO IN CH2 MIC
Ref.]。

錄製的聲音有很高的噪音
量。

音訊輸入音量設定過低。
調整 [Audio Input Level] 和 [Audio] > [Audio] > [Audio
Input] > [AUDIO IN CH1 MIC Ref.] 或 [AUDIO IN CH2
MIC Ref.] 之設定。

無法播放剪輯。

正在編輯剪輯。
如果修改了檔案名稱或資料夾，或者正在電腦上使用剪
輯，則無法播放剪輯。這並非故障。

剪輯是使用本裝置以外的攝像
機所錄製。

使用本裝置以外的攝像機所錄製的剪輯可能無法播放，
或以不正確的尺寸顯示。這並非故障。

徵狀 原因 解決方案

檔案上傳失敗。 伺服器的使用者名稱和密碼不正確。 伺服器的使用者名稱和密碼可能不正確。請輸入正確的內容。
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IP 串流

與外部裝置連接

外部同步

徵狀 原因 解決方案

串流不可用。

在用戶端應用程式中輸入以便查
看本裝置串流的使用者名稱或密
碼不正確。

如果本裝置的串流格式設定為 [RTSP]、[SRT-
Listener] 或 [NDI|HX]，需要在用戶端應用程式中輸
入本裝置設定的使用者名稱和密碼。請輸入正確的使
用者名稱和密碼。

串流協定未設定。
使用網路功能表中的 [Stream] > [Stream Setting] 來
選擇目標協定。

已設定六個或更多 RTSP 會話。 將會話數設定為五個或以下。

UDP 連接埠號碼設定不正確。
使用網路功能表中的 [Stream] > [Stream] > [Stream
Setting]，設定目標協定的連接埠號碼及其他設定。

UDP 通訊被阻擋。 檢查安全軟體設定。

音訊未被串流。 音訊輸出串流設定為 [Off]。
在網路功能表中，將 [Stream] > [Audio Stream] >
[Setting] 設定為 [On]。

串流已斷開連接。
串流期間，更改了協定設定或串
流轉碼器設定。

開始串流之前，請設定協定設定或串流轉碼器設定。

[Video Stream 1] 的圖像尺
寸不能設定為 4096×2160
或 3840×2160。

當 [Output Format] 設定為 HDMI
時，圖像尺寸為 1920×1080。

串流的圖像尺寸設定不能高於 HDMI 圖像尺寸。使用
網路功能表中的 [Monitoring] > [Output Format] 變更
HDMI 圖像尺寸。

[Video Stream 1] 的畫面速
率不能設定為 60 FPS 或 50
FPS。

串流畫面速率設定為 29.97 或以
下。

用於串流的畫面速率受限於系統頻率。使用網路功能
表中的 [Rec Format] > [Frequency] 來變更系統頻
率。

[Video Stream 3] 串流無法
被存取。

[Video Stream 3] 不支援
RTSP/SRT/NDI。

使用 [Video Stream 1] 或 [Video Stream 2]。

RTSP/SRT 畫面未正確更新/
顯示。

用於 RTSP 或 SRT 的連接埠號
碼正在被篩選或阻擋。

將 RTSP 或 SRT 的連接埠號碼變更為未被接收串流
之裝置篩選或阻擋的連接埠號碼。或者變更裝置上用
於 RTSP 或 SRT 的連接埠號碼。

影像失真或扭曲。

由於通訊路徑擁塞，視訊資訊無
法正常傳輸。

降低位元速率，或將 [Video Stream 2] 轉碼器
([Codec 2]) 設定為 [Off]，以在通訊頻帶中建立邊
限。

視訊封包的順序在通訊通道內發
生變化。

在本裝置端和接收器端，使用相同的網際網路服務供
應商。

未偵測為 NDI 設備。 串流協定未設定為 NDI|HX。
串流協定必須設定為 NDI|HX，才能將本裝置偵測為
NDI 設備。在網路功能表中，將 [Stream] > [Stream
Setting] 設定為 [NDI|HX]。

不能用作 NDI 設備。 未安裝 NDI|HX 授權。
請安裝 NDI|HX 授權。您可以透過網路功能表中的
[Stream] > [Stream] > [Stream Setting] > [NDI|HX] >
[License] 來檢查是否有 NDI|HX 授權。
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Tally

鏡頭控制器

相關主題

輸出光纖訊號

連接器插頭塊

呼吸補償

檢查鏡頭開關

安裝鏡頭

重設平移/傾斜

P/T Range Limit

還原記憶卡

連接提示訊號

徵狀 原因 解決方案

無法同步到外
源。

未輸入符合配置的視訊訊號格式之
外部同步訊號。

請輸入符合配置的視訊訊號格式之外部同步訊號。

本裝置是雙端接載。
本裝置有一個內建的 75 Ω 終端。直接連接到訊號源（一對一）
或使用分配器（分叉器）。

徵狀 原因 解決方案

提示燈未亮
起。

提示燈亮度被設定為 Off。
使用網路功能表中的 [Technical] > [Tally] > [Tally Lamp
Brightness] 來設定適當的亮度。

錄製/提示燈被配置為錄製燈。 如“連接提示訊號”所述，將錄製/提示燈配置為提示燈。

連接至 RM-IP500，並停用 VISCA over
IP。

將本裝置之連接器插頭塊上的 SETUP 開關 3 設定為 ON 位
置。

OPTION 連接器連接不正確，或者目標針
腳未與 GND 短路。

如“連接提示訊號”所述，將 OPTION 連接器的針腳 7 或 8 短
路至 GND。

徵狀 原因 解決方案

[Communication Error] 在 （攝
影機狀態）中顯示。

攝影機無法與鏡
頭控制器通訊。

檢查本裝置和鏡頭控制器之間的連接，然後重新啟動本裝置和
鏡頭控制器。

[Rotation Error] 在 （攝影機狀
態）中顯示。

鏡頭控制器發生
旋轉錯誤。

儲存的變焦移動範圍和鏡頭移動範圍可能不相符。初始化鏡頭
控制器。
如果問題仍然存在，請聯絡鏡頭控制器製造商代表。

[System Error] 在 （攝影機狀
態）中顯示。

鏡頭控制器發生
系統錯誤。

檢查本裝置和鏡頭控制器之間的連接，請參閱鏡頭控制器操作
說明並初始化鏡頭控制器，或重新啟動本裝置和鏡頭控制器。
如果問題仍然存在，請聯絡鏡頭控制器製造商代表。

[Unknown Error] 在 （攝影機狀
態）中顯示。

鏡頭控制器發生
未知錯誤。

檢查本裝置和鏡頭控制器之間的連接，請參閱鏡頭控制器操作
說明並初始化鏡頭控制器，或重新啟動本裝置和鏡頭控制器。
如果問題仍然存在，請聯絡鏡頭控制器製造商代表。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

錯誤/警告訊息

如果本裝置發生需要確認的警告、注意或操作條件，則攝像機影像窗格中將會顯示訊息，並且前方面板上的 POWER 燈和
NETWORK 燈以及錄製/提示燈會開始閃爍。

注意

僅當在網路功能表或攝影機功能表中將 [Technical] > [Tally] > [Tally Control] 設定為 [Internal] 且 [Tally Lamp Brightness] 設定為
[Off] 時，才會啟用錄製/提示燈閃爍指示。

錯誤訊息

如果 POWER 燈和 NETWORK 燈開始閃爍，如下所述，請採取下列措施。

出現下列顯示的訊息時，本裝置將停止操作。

警告訊息

如果出現下列顯示，請按照提供的說明進行操作。

POWER
燈

NETWORK
燈

原因與解決方法

緩慢閃爍
橘燈

緩慢閃爍綠
燈

本裝置無法正常運作。有關詳細資料，請參閱網路功能表中的 [Maintenance] > [System
Log]。如果將本裝置置於待機模式或者關閉電源並重新開啟後問題仍然存在，請聯繫您的
Sony 服務代表。

快速閃爍
橘燈

快速閃爍綠
燈

本裝置發生故障。請與您的 Sony 服務代表聯繫。

訊息顯
示

錄製/提
示燈

原因與解決方法

E + 錯
誤代碼

高速閃
爍

表示本裝置出現異常。即使攝像機影像窗格中顯示 ●REC，錄製也會停止。
關閉裝置電源，並檢查連接的裝置、纜線或媒介是否有問題。再次開啟裝置電源後，如果仍然出現
錯誤，請聯絡 Sony 服務代表。根據本裝置的狀態，可能不會出現錯誤顯示或警告聲。

訊息顯示 錄製/提示燈 原因與解決方法

Temperature High 閃爍
內部溫度過高。
關閉攝影機，將其靜置降溫再操作。

Media Temperature High 閃爍
CFexpress 記憶卡的溫度過高。
更換記憶卡或靜置記憶卡降溫後再使用。

Voltage Low 閃爍 DC IN 電壓偏低（層級 1）。檢查電源。

Insufficient Voltage 高速閃爍
DC IN 電壓過低（層級 2）。錄製停用。
連接其他電源。
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注意和操作訊息

畫面中央可能出現下列注意和操作訊息。請按照提供的說明解決問題。

訊息顯示 錄製/提示燈 原因與解決方法

Media Near Full 閃爍
記憶卡的剩餘容量變少。
儘早更換。

Media Full 高速閃爍
由於記憶卡沒有剩餘容量，無法錄製或複製剪輯。
立即更換。

Clips Near Full 閃爍
記憶卡可以錄製的其他剪輯數量變少。
儘早更換。

Clips Full 高速閃爍
已達到記憶卡可以錄製的剪輯數量上限。
無法錄製或複製更多剪輯。立即更換。

Last Clip Recording 閃爍
目前錄製的剪輯是可以錄製的最後一個剪輯，因為已經達到剪輯數量上限。
準備新的記憶卡。

Media(A) Life Near End1) 閃爍 記憶卡的使用壽命將盡。儘早更換。

Media(A) Life End1) 高速閃爍 記憶卡的使用壽命已盡。立即更換。

Media(A) Near Full1) 閃爍 使用 Simul Rec 功能時

Media(A) Full1) 高速閃爍 使用 Simul Rec 功能時

Media(A) Clips Near Full1) 閃爍 使用 Simul Rec 功能時

Media(A) Clips Full1) 高速閃爍 使用 Simul Rec 功能時

Media(A) Last Clip Rec1) 閃爍 使用 Simul Rec 功能時

（未顯示） 閃爍
鏡頭控制器發生未知錯誤。
在網路應用程式中檢查攝影機狀態。
如需詳細資料，請查看網路應用程式中的系統日誌。

針對插槽 B 中的記憶卡顯示“(B)”。1)

顯示訊息 原因與解決方法

Backup Battery End
Please Change

備用電池的剩餘電量不足。
將裝置連接電源至少 24 小時，以便為備用電池充電。

Unknown Media(A)1)

Please Change

插入了已分區的記憶卡或包含更多可以由本裝置處理的
剪輯之記憶卡。
無法在本裝置中使用該記憶卡，必須予以更換。

Cannot Use Media(A)1)

Unsupported File System

插入了使用其他檔案系統的記憶卡或未格式化的記憶
卡。
無法在本裝置中使用該記憶卡，必須予以更換或使用本
裝置將其格式化。

Media Error
Media(A) Needs to be Restored1)

記憶卡發生錯誤，必須予以還原。
還原記憶卡。
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RTMP 串流錯誤訊息

本裝置可能會顯示下列錯誤訊息。根據需要，執行下列操作。

顯示訊息 原因與解決方法

Media Error
Cannot Record to Media(A)1)

記憶卡可能已損壞，無法再用於錄製。
可以播放，因此建議進行複製並更換記憶卡。

Media Error
Cannot Use Media(A)1)

記憶卡可能已損壞，無法再用於錄製或播放。
無法在本裝置中使用該記憶卡，必須予以更換。

Media(A) Error1)

Recording Halted
Playback Halted

由於使用記憶卡時發生錯誤，錄製和播放已停止。
如果問題仍然存在，請更換記憶卡。

Media Reached Rewriting Limit
Change Media(A)1)

記憶卡的使用壽命已盡。
進行備份，並且立即更換記憶卡。如果繼續使用記憶
卡，則記憶卡可能無法錄製或播放。
如需詳細資料，請參閱記憶卡的操作說明。

The specified address is invalid.
指定的位址無效。
檢查設定是否正確。

Cannot Use Specified Port Number
指定的連接埠號碼無效。
檢查設定是否正確。

Lens I/F Error(xx:xx)

安裝 E 接環鏡頭後，在鏡頭 I/F 通訊中偵測到鏡頭錯
誤。
檢查 E 接環鏡頭的連接狀態。
如果問題仍然存在，請聯絡 Sony 服務代表並告知錯誤
代碼（括號中的五個字元）。

Cannot add auto upload job of Proxy file because maximum
number of upload jobs was reached.

已達到傳輸工作數量上限。
清除任何不需要的工作。代理檔案的自動上傳目的地設
定也可能不正確。檢查設定是否正確。

Fan Stopped

風扇已停止運轉。
請確認有沒有灰塵或異物。
如果清除任何灰塵或異物後仍然出現錯誤，請聯絡 Sony
服務代表。

針對插槽 B 中的記憶卡顯示“(B)”。1)

錯誤代碼
描述 解決方案

RTMP RTMPS

1002
1004

2002
2004 無法連接到 RTMP 伺服器。

檢查伺服器 URL 設定是否正確。
檢查網路連線。

1003 2003 無法解析網域名稱。
檢查伺服器 URL 設定是否正確。
檢查 DNS 伺服器連線。

–
2005
2008

CRL 錯誤
檢查伺服器 URL 設定是否正確。
檢查連線目的地是否為可信任站點。

2006 CA 憑證錯誤
檢查時鐘設定是否正確。
檢查 CA 憑證是否正確。
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SRT 串流錯誤訊息

本裝置可能會顯示下列錯誤訊息。根據需要，執行下列操作。

5-041-957-83(1) Copyright 2022 Sony Corporation

錯誤代碼
描述 解決方案

RTMP RTMPS

– 2007
未安裝 CA 憑證。
伺服器憑證驗證錯誤。

安裝 CA 憑證。
檢查連線目的地是否為可信任站點。

4002 RTMP 會話已中斷。
本裝置可能已在 RTMP 伺服器端中斷連線。
檢查設定是否與服務建議的轉碼器參數相符。

4003 網路連線品質低。 檢查網路連線。

其他 其他錯誤。

錯誤代碼
描述 解決方案

SRT 呼叫者

1001 非預期錯誤 本裝置可能無法正常運作。重新啟動本裝置。

1002 由於設定變更，導致通訊中斷
由於設定變更，導致通訊中斷。
重新建立連線。

5001 非預期錯誤 本裝置可能無法正常運作。重新啟動本裝置。

5005 連線失敗 檢查連接目的地設定是否正確。

5006 加密錯誤 檢查加密設定是否正確。

5007 非預期錯誤
本裝置可能無法正常運作。重新啟動本裝置。

5008 非預期錯誤

5009 傳輸故障
本裝置在通訊過程中已斷開。
檢查網路連線。
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

功能表項目清單

下表列出了本裝置的功能表項目。

圖例

“攝像機功能表”及“網路功能表”
●：可用
▲：一些項目可用
–：不可用

“All File”和“Scene File”
是：項目儲存在 ALL 檔案 或場景檔案中
否：未儲存項目

“All Reset (except for Network Settings)”
執行網路功能表中的 [Reset]> [Reset] > [All Reset (except for Network Settings)] 時：
是：初始化項目（不包含網路設定）
否：不適用

“Network Reset”
執行網路功能表中的 [Reset]> [Reset] > [Network Reset] 時：
是：初始化項目（網路設定）
否：不適用

“Factory Default”
是：項目重設為原廠預設
否：不適用

Shooting

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – 是 是 是 是 是

ND Filter ● – 是 是*1 是 否 是

Shutter ● – 是 是 是 否 是

Iris ● – 是 是 是 否 是

Auto Exposure ● – 是 是*2 是 否 是

White ● – 是 是*3 是 否 是

White Setting ● – 是 否 是 否 是

Offset White ● – 是 否 是 否 是

Focus ● ▲ 是 否 是 否 是

S&Q Motion ● – 是 否 是 否 是
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Project

Paint/Look

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – 是 否 是 否 是

Noise
Suppression

● – 是 是 是 否 是

Flicker Reduce ● – 是 否 是 否 是

SteadyShot ● – 是 否 是 否 是

[Mode] 不適用*1

[Clip High light]、[Detect Window]、[Average Peak Level Ratio]、[Custom Width]、[Custom H Position]、[Custom V Position] 不適用*2

[Preset White] 不適用*3

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● 是 否 是 否 是

Rec Format ● ● 是 否 是*1 否 是

Cine EI/Flex.ISO
Set

● – 是 否 是 否 是

Simul Rec ● ● 是 否 是 否 是

Proxy Rec ● ▲ 是 否 是 否 是

Interval Rec ● ● 是*2 否 是 否 是

Picture Cache
Rec

● ● 是*2 否 是 否 是

SDI/HDMI Rec
Control

● – 是 否 是 否 是

Assignable
Button

● – 是 否 是 否 是

All File – ● 否 否 否 否 否

[Frequency] 不適用*1

[Setting] 不適用*2

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – 否 否 否 否 否

Base Look ● ▲ 是*1 否 是*1 否 是*1

Reset Paint
Settings

● – 否 否 否 否 否
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Pan-Tilt

TC/Media

Monitoring

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – 是 是 是 否 是

Knee ● – 是 是 是 否 是

Detail ● – 是 否 是 否 是

Matrix ● – 是 是 是 否 是

Multi Matrix ● – 是*2 是*2 是 否 是

作為基本風格匯入的 LUT 資料不適用*1

[Axis] 不適用*2

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● 否 否 是 否 否

P/T
Acceleration

● ● 否 否 是 否 否

P/T Range
Limit

– ● 否 否 是 否 否

P/T Direction – ● 否 否 是 否 否

P/T Preset – ● 否 否 是 否 否

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – 是*1 否 是 否 是

TC Display ● – 是 否 是 否 是

Users Bit ● – 是*1 否 是 否 是

HDMI TC Out ● – 是 否 是 否 是

Clip Name
Format

● – *2 否 是 否 是

Update Media ● – 否 否 否 否 否

Format Media ● – 否 否 否 否 否

Media Life ● – 否 否 否 否 否

[Setting] 不適用*1

[Auto Naming] 適用、[Camera ID] 不適用*2
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Audio

Thumbnail

Technical

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output Format ● ● 是 否 是 否 是

Output Display – ● 是 否 是 否 是

Display On/Off ● – 是 否 是 否 是

Video Signal
Monitor

● – 是 否 是 否 是

Marker ● – 是 否 是 否 是

項目
（層級 2）

攝像機功
能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ 是 否 是 否 是

Audio
Output

● ▲ 是 否 是 否 是

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – 否 否 否 否 否

Set Clip Flag ● – 否 否 否 否 否

Lock/Unlock Clip ● – 否 否 否 否 否

Delete Clip ● – 否 否 否 否 否

Transfer Clip ● – 否 否 否 否 否

Transfer Clip
(Proxy)

● – 否 否 否 否 否

Filter Clips ● – 否 否 否 否 否

Customize View ● – 是 否 是 否 是

項目
（層級

2）

攝像機功
能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color Bars ● – *1 否 *1 否 是

Genlock ● – 否 否 否 否 否
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Network

Stream

項目
（層級

2）

攝像機功
能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Tally ● ● 是 否 是 否 是

Rec
Review

● – 是 否 是 否 是

Zoom ● – 是 否 是 否 是

IR
Remote

– ● 否 否 是 否 是

Lens ● – 是 否 是 否 是

APR ● – 否 否 否 否 否

[Type] 適用、[Setting] 不適用*1

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● 否 否 否 否 是

User – ● 否 否 否 是 是

Wired LAN*1 ▲ ● 否 否 否 是 否

File Transfer ● ▲ 是 否 是 是 是

FTP Server 1 – ● 否 否 是 否 是

FTP Server 2 – ● 否 否 是 否 是

FTP Server 3 – ● 否 否 是 否 是

SSL – ● 否 否 否 是 是

Referer Check – ● 否 否 否 是 是

Brute Force Attack
Protection

– ● 否 否 否 是 是

無法使用攝像機功能表進行配置（僅顯示）*1

項目
（層級 2）

攝像機功
能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● 否 否 是*1 否 是*1

Video
Stream

– ● 是 否 是 否 是
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Maintenance

5-041-957-83(1) Copyright 2022 Sony Corporation

項目
（層級 2）

攝像機功
能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Stream

– ● 是 否 是 否 是

[NDI|HX] > [License] 不適用*1

項目
（層級 2）

攝像機
功能表

網路功
能表

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● 是 否 是 否 是

Accessibility – ● 是 否 否 否 是

Clock Set ● ● 是*1 否 是*2 否 是

Reset – ● 否 否 否 否 否

Hours Meter ● – 否 否 否 否 否

Information – ● 否 否 否 否 否

System Log – ● 否 否 否 否 是

HTTP Access
Log

– ● 否 否 否 否 是

Service – ● 否 否 否 否 否

EULA – ● 否 否 否 否 否

Software – ● 否 否 否 否 否

日期和時間資訊不適用*1

[Time Zone]、日期和時間資訊不適用*2
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

預設位置儲存項目

“是”表示為預設位置儲存項目，“否”表示未儲存設定。

平移/傾斜項目

變焦項目

對焦項目

顯示位置 項目 儲存目標

即時操作畫面之取景控制面板
平移/傾斜位置 是

[Pan-Tilt Speed] 否

網路功能表中的 [Pan-Tilt]

[P/T Speed] 否

[P/T Acceleration] 否

[P/T Range Limit] 否

[P/T Direction] 否

[P/T Preset] > [Pan-Tilt] 否

[P/T Preset] > [Default] > [Pan-Tilt Speed] 是1)

儲存預置位置時的設定值將儲存為該預置位置的值。儲存值後，可以變更每個預設位置的值。如需詳細資料，請參閱“使用網路應用程式變更預設
位置的轉變速度（平移-傾斜/變焦/對焦）”。

1)

顯示位置 項目 儲存目標

即時操作畫面之取景控制面板
變焦位置（焦距） 是

[Zoom Speed] 否

網路功能表中的 [Pan-Tilt] > [P/T Preset] > [Default]
[Zoom Sync] 是1)

[Zoom Speed] 是1)

攝像機功能表中的 [Technical] > [Zoom] [Zoom Type] 否

儲存預置位置時的設定值將儲存為該預置位置的值。儲存值後，可以變更每個預設位置的值。如需詳細資料，請參閱“使用網路應用程式變更預設
位置的轉變速度（平移-傾斜/變焦/對焦）”。

1)

顯示位置 項目 儲存目標

即時操作畫面的攝像機影像窗格
替即時追蹤自動對焦指定追蹤目標 否

為點對焦指定座標 否
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相關主題

在恢復預設位置時變更轉變速度（平移-傾斜/變焦/對焦）

5-041-957-83(1) Copyright 2022 Sony Corporation

顯示位置 項目 儲存目標

即時操作畫面的  (Focus) 索引標籤

[Touch Focus] 開關 否

[Auto Focus] 開關 是

[Focus Hold] 按鈕狀態 否

[Push AF/MF] 按鈕狀態 否

[Face/Eye Detection AF] 是

[AF Subj. Shift Sens.] 是

[AF Transition Speed] 是

Focus Position 是1)

網路功能表中的 [Shooting] > [Focus]

[Push AF Mode]（包括使用可指派按鈕的設定） 否

[Touch Function in MF] 否

[AF Assist Control] 否

網路功能表中的 [Pan-Tilt] > [P/T Preset] > [Default]
[Focus Recall] 是2)

[MF Speed] 是2)

攝像機功能表中的 [Shooting] > [Focus]
使用 [Focus Area] 設定的對焦區域大小和位置 是

使用 [Focus Area (AF-S)] 設定的對焦區域位置 是

[Auto Focus] 開關設定為 On 位置時不會恢復。設定為 Off 時恢復。1)

儲存預置位置時的設定值將儲存為該預置位置的值。儲存值後，可以變更每個預設位置的值。如需詳細資料，請參閱“恢復預設位置時變更轉變速
度（平移-傾斜/變焦/對焦）”。

2)
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

區塊圖

Audio Input

Audio Output

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

更新 E 接環鏡頭軟體

您可以使用本裝置更新 E 接環鏡頭的軟體。
如需可以更新的鏡頭和相對應的軟體，請參閱鏡頭的網站。
使用網路功能表來更新軟體。

注意

更新完成之前，切勿執行以下操作。

斷開網路
取下鏡頭
關閉電源

如果跳出更新失敗的訊息，請確認訊息描述的內容並重新嘗試更新。

5-041-957-83(1) Copyright 2022 Sony Corporation

將 E 接環鏡頭安裝在本裝置上。1

在網路功能表中，檢查 [Maintenance] > [Information] > [Lens] > [Model Name] 和 [Version Number]。

E 接環鏡頭的軟體版本編號顯示在側面。
檢查軟體版本編號，然後根據需求更新軟體。

2

將適用於 Windows 的鏡頭軟體更新檔案（副檔名 .exe）下載至執行網路應用程式的裝置。3

在 [Maintenance] > [Information] > [Lens] > [Version Up] 中，按下 [Choose File] 按鈕，並選取要下載的更新
檔。

4

請按照畫面上的說明進行操作。5
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

安裝鏡頭釋放按鈕蓋

您可以將 CIB-PCM1 天花板托架（選購件）隨附的鏡頭釋放按鈕蓋安裝到鏡頭釋放按鈕上，以防止意外取下鏡頭。

注意

這不會妨礙完整取下鏡頭。

相關主題

安裝鏡頭

5-041-957-83(1) Copyright 2022 Sony Corporation

安裝鏡頭。

有關安裝鏡頭的詳細資料，請參閱“安裝鏡頭”。

1

將平移/傾斜鎖定桿滑到 LOCK 位置，以鎖定攝像機頭部平移/傾斜。2

將攝像機區塊移動至可以安裝鏡頭彈出蓋的位置。3

安裝鏡頭彈出蓋，使其覆蓋鏡頭釋放按鈕。4

使用鏡頭彈出蓋固定螺絲來固定鏡頭彈出蓋。5
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

授權

MPEG-4 AVC 專利產品組合授權

按照 AVC 專利產品組合授權授權，本產品供消費者個人使用，或用於不收取任何費用的其他用途
(i) 依照 AVC 標準（“AVC 視訊”）對視訊進行編碼，和/或
(ii) 解碼由從事個人活動的消費者編碼的 AVC 視訊和/或向獲授權提供 AVC 視訊的視訊提供者取得的 AVC 視訊。
未授予或暗示其他任何用途的授權。MPEG LA, L.L.C. 可能會發出其他資訊。請參閱 HTTP://WWW.MPEGLA.COM

按照 GPL/LGPL 授權取得軟體

本產品使用 GPL/LGPL 適用的軟體。這表示您有權在 GPL/LGPL 條件下存取、修改和重新分配這些軟體程式的原始程式
碼。
網際網路提供原始程式碼。使用下列 URL 並按照下載說明進行操作。
https://oss.sony.net/Products/Linux/
我們希望您不向我們洽詢原始程式碼的內容。

μT-Kernel 原始程式碼

本產品使用 TRON Forum (www.tron.org) 授予的 T-License 2.1 之下的 μT-Kernel 原始程式碼。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

規格

一般

質量

約 4.6 公斤（僅機身）
約 6.0 公斤（包括 SELP28135G 鏡頭）

尺寸

請參閱“外型尺寸”。

電源需求

19.5 V DC
PoE ++（符合 IEEE802.3bt Type 4 Class 8）

耗電量

19.5 V DC：80.0 W（最大）
PoE++：71.3 W（最大）　

操作溫度

0 °C 至 40 °C

存放溫度

−20 °C 至 +60 °C

錄製格式（視訊）

XAVC Intra
XAVC-I 4K/QFHD 模式：VBR、600 Mbps（最大）位元速率、MPEG-4 AVC/H.264
XAVC-I HD 模式：CBG、223 Mbps（最大）、MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD 模式：VBR、150 Mbps（最大）位元速率、MPEG-4 H.264/AVC
XAVC-L HD 50 模式：VBR、50 Mbps（最大）、MPEG-4 H.264/AVC
XAVC-L HD 35 模式：VBR、35 Mbps（最大）、MPEG-4 H.264/AVC

錄製格式（音訊）

LPCM 24 位元、48 kHz、4 通道

錄製畫面速率

XAVC Intra
XAVC-I 4K 模式：4096×2160/59.94P、50P、29.97P、25P、24P、23.98P
XAVC-I QFHD 模式：3840×2160/59.94P、50P、29.97P、25P、23.98P
XAVC-I HD 模式：1920×1080/59.94P、50P、29.97P、25P、23.98P

XAVC Long
XAVC-L QFHD 模式：3840×2160/59.94P、50P、29.97P、25P、23.98P
XAVC-L HD 50 模式：1920×1080/59.94P、50P、29.97P、25P、23.98P
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XAVC-L HD 35 模式：1920×1080/59.94P、50P、29.97P、25P、23.98P

錄製/播放時間

XAVC Intra
XAVC-I QFHD 模式：59.94P、約 30 分鐘（使用 CEA-G160T）
XAVC-I HD 模式：59.94P、約 78 分鐘（使用 CEA-G160T）

XAVC Long
XAVC-L QFHD 模式：59.94P、約 115 分鐘（使用 CEA-G160T）
XAVC-L HD 50 模式：59.94P、約 155 分鐘（使用 CEA-G80T）
XAVC-L HD 35 模式：59.94P、約 210 分鐘（使用 CEA-G80T）

注意

錄製/播放時間可能由於使用條件和儲存特性而不盡相同。錄製和播放時間是單一剪輯連續錄製的時間。實際時間可能較短，具體取
決於錄製的剪輯數量。

平移/傾斜驅動部分

最低平移速度：0.02 度/秒
最低傾斜速度：0.02 度/秒
最高平移速度：60 度/秒
最高傾斜速度：60 度/秒
平移範圍：-170 度至 +170 度。
傾斜範圍：-30 度至 +195 度。
噪音準則評比：NC35 或更低
預設位置：100

攝影機部分

成像裝置

35mm 全畫面（35.6 × 23.8 公釐）、Exmor R CMOS 感測器

像素數

約 12.9 百萬像素（總像素）
約 10.3 百萬像素（有效像素）

自動對焦

偵測方式：相位偵測/對比度偵測

內部 ND 濾鏡

CLEAR：OFF
1：1/4ND
2：1/16ND
3：1/64ND
線性可變 ND：1/4ND 至 1/128ND

ISO 感光度

ISO 800/12800（Cine EI 模式、D55 光源）

鏡頭接環

E 接環

緯度

15 段以上
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快門速度

64F 至 1/8000 秒 (23.98P)

快門角度

5.6° 至 360°、2 至 64 個畫面

慢動作和快動作

XAVC QFHD：1 fps 至 120 fps
XAVC HD：1 fps 至 240 fps
XAVC 4K：1 fps 至 60 fps
XAVC HD (S35)：1 fps 至 120 fps

白平衡

2000 K 至 15000 K

增益

−3 dB 至 +30 dB（增量為 1 dB）

基本風格

S-Cinetone、Standard、Still、ITU709、709tone、s709、709(800%)、S-Log3、HLG Live、HLG Natural

音訊部分

取樣頻率

48 kHz

量化

24 位元

頻率回應

XLR 輸入 MIC 模式：20 Hz 至 20 kHz（±3 dB 或更小）
XLR 輸入 LINE 模式：20 Hz 至 20 kHz（±3 dB 或更小）

動態範圍

XLR 輸入 MIC 模式：80 dB（典型）
XLR 輸入 LINE 模式：90 dB（典型）

失真

XLR 輸入 MIC 模式：0.08% 或更低（−40 dBu 輸入音量）
XLR 輸入 LINE 模式：0.08% 或更低（+14 dBu 輸入音量）

輸入/輸出部分

輸入

DC IN

符合 EIAJ 標準，19.5 V DC

AUDIO IN

XLR 型、5 針腳、母頭
LINE / MIC / MIC+48V 可切換
MIC：參考 −30 dBu 至 −80 dBu
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GENLOCK IN

BNC 連接器、1.0 Vp-p、75 Ω

TC IN

BNC 連接器

輸出

SDI OUT

BNC 類型、12G-SDI、6G-SDI、3G-SDI (Level A/B)、HD-SDI

HDMI

Type-A 連接器

OPTICAL 輸出連接器

符合 SFP+
* 本機不支援光纖訊號輸入。

輸入/輸出

LAN 連接器

RJ-45，1000BASE-T

OPTION 連接器

RJ-45 提示輸入/輸出連接器

媒體插槽部分

CFexpress Type A / SD 記憶卡插槽 (2)

隨附項目

交流電變壓器 (1)
電源線 (1)
紅外線遙控器 (1)
機身護蓋 (1)（安裝在本機上）
HDMI 纜線固定板 (1)
使用本裝置前 (1)
保固手冊 (1)

外型尺寸

尺寸為約略值。
單位：公釐

攝像機機身
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天花板托架
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設計與規格如有變更恕不另行通知。

5-041-957-83(1) Copyright 2022 Sony Corporation
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說明指南

可換鏡頭數位攝像機
ILME-FR7 / ILME-FR7K

商標

 是 Sony Group Corporation 的商標。
XAVC 和  是 Sony Group Corporation 的註冊商標。
HDMI、HDMI高畫質多媒體介面及HDMI 標誌為HDMI Licensing Administrator, Inc.在美國及其他國家的商標或註冊商
標。
Microsoft 和 Windows 是 Microsoft Corporation 在美國和/或其他國家/地區的商標或註冊商標。
Mac 和 macOS 是 Apple Inc. 在美國和其他國家/地區的註冊商標。
“Catalyst Browse”標誌是 Sony Group Corporation 的商標或註冊商標。
IOS 是 Cisco 在美國和其他國家的商標或註冊商標，經授權後使用。
iPadOS、Safari 和 iPad 是 Apple Inc. 在美國和其他國家和地區的註冊商標。
Android 及 Google Chrome 是 Google LLC 的商標或註冊商標。
Wi-Fi 是 Wi-Fi Alliance 的註冊商標。
SDXC 標誌是 SD-3C, LLC 的商標。
CFexpress 和 CFexpress Type A 標誌是 CompactFlash Association 的商標。
NewTek™ 及 NDI® 是 NewTek, Inc 的商標或註冊商標。
JavaScript 是 Oracle 和/或其附屬公司的註冊商標。
Intel、Intel 標誌和 Intel Core 是 Intel Corporation 或其子公司的商標。
QR Code 是 Denso Wave Inc. 的商標。
其他全部公司名稱和產品名稱是個別所有權人的註冊商標或商標。本文件未使用 ™ 或 ® 符號表示商標商品。
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485




